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Preface

Welcome to the Microsoft Official Academic Course (MOAC) program for Windows 
Operating System Fundamentals. MOAC represents the collaboration between Microsoft 
Learning and John Wiley & Sons, Inc. publishing company. Microsoft and Wiley teamed up 
to produce a series of textbooks that deliver compelling and innovative teaching solutions to 
instructors and superior learning experiences for students. Infused and informed by in-depth 
knowledge from the creators of Microsoft products, and crafted by a publisher known world-
wide for the pedagogical quality of its products, these textbooks maximize skills transfer in 
minimum time. Students are challenged to reach their potential by using their new technical 
skills as highly productive members of the workforce.

Because this knowledge base comes directly from Microsoft, creator of the Microsoft Certified 
IT Professional, Microsoft Certified Technology Specialist (MCTS), and Microsoft Technology 
Associate (MTA) exams (see the Microsoft Learning website at https://www.microsoft.com/
learning), you are sure to receive the topical coverage that is most relevant to students’ personal 
and professional success. Microsoft’s direct participation not only assures you that MOAC 
textbook content is accurate and current; it also means that students will receive the best 
instruction possible to enable their success on certification exams and in the workplace.

■■ The Microsoft Official Academic Course Program

The Microsoft Official Academic Course series is a complete program for instructors and insti-
tutions to prepare and deliver great courses on Microsoft software technologies. With MOAC, 
we recognize that, because of the rapid pace of change in the technology and curriculum devel-
oped by Microsoft, there is an ongoing set of needs beyond classroom instruction tools for an 
instructor to be ready to teach the course. The MOAC program endeavors to provide solutions 
for all these needs in a systematic manner in order to ensure a successful and rewarding course 
experience for both instructor and student—technical and curriculum training for instructor 
readiness with new software releases; the software itself for student use at home for building 
hands-on skills, assessment, and validation of skill development; and a great set of tools for 
delivering instruction in the classroom and lab. All are important to the smooth delivery of an 
interesting course on Microsoft software, and all are provided with the MOAC program. We 
think about the model below as a gauge for ensuring that we completely support you in your 
goal of teaching a great course. As you evaluate your instructional materials options, you may 
wish to use the model for comparison purposes with available products.
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Illustrated Book Tour

■■ Pedagogical Features

The MOAC textbook for Windows Operating System Fundamentals is designed to cover all 
the learning objectives for MTA exam 98-349, which are referred to as its “objective domain.” 
The Microsoft Technology Associate (MTA) exam objectives are highlighted throughout the 
textbook. Many pedagogical features have been developed specifically for Microsoft Official 
Academic Course programs.

Presenting the extensive procedural information and technical concepts woven throughout the 
textbook raises challenges for the student and instructor alike. The Illustrated Book Tour that 
follows provides a guide to the rich features contributing to Microsoft Official Academic Course 
program’s pedagogical plan. Following is a list of key features in each lesson designed to pre-
pare students for success as they continue in their IT education, on the certification exams, 
and in the workplace:

•	 Each lesson begins with an Objective Domain Matrix. More than a standard list of 
learning objectives, the matrix correlates each software skill covered in the lesson to the 
specific exam objective domain.

•	 Concise and frequent Step-by-Step instructions teach students new features and pro-
vide an opportunity for hands-on practice. Numbered steps give detailed, step-by-step 
instructions to help students learn software skills.

•	 Illustrations: Screen images provide visual feedback as students work through the exer-
cises. The images reinforce key concepts, provide visual clues about the steps, and allow 
students to check their progress.

•	 Key Terms: Important technical vocabulary terms are listed at the beginning of the 
lesson. When these terms are used later in the lesson, they appear in bold italic type and 
are defined.

•	 Engaging point-of-use Reader Aids, located throughout the lessons, tell students why 
this topic is relevant (The Bottom Line) and provide students with helpful hints (Take 
Note). Reader Aids also provide additional relevant or background information that adds 
value to the lesson.

•	 Certification Ready features throughout the text signal students where a specific 
certification objective is covered. They provide students with a chance to check their 
understanding of that particular MTA objective and, if necessary, review the section of 
the lesson where it is covered. MOAC offers complete preparation for MTA certification.

•	 End-of-Lesson Questions: The Knowledge Assessment section provides a variety of 
multiple-choice, true-false, matching, and fill-in-the-blank questions.

•	 End-of-Lesson Exercises: Business case scenarios are projects that test students’ ability 
to apply what they’ve learned in the lesson.
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■■ Lesson Features

Take Note Reader Aid

Certification ready

194 | Lesson 6

Advanced sharing offers the greatest amount of control; for example, you can:

• Share files, folders, or an entire drive.
• Choose users or groups with which to share files and folders.
• Limit the number of users who can use a file or folder at the same time, mainly for secu-

rity purposes.
• Set permissions on shared files and folders, such as allowing users Read, Change, or Full 

Control permissions.
• Choose which files are available to users offline.

To set up basic or advanced shares, you must make sure that file sharing and network dis-
covery are turned on. You should also turn on password-protected sharing for security pur-
poses. File sharing, network discovery, and password-protected sharing options are enabled by 
default in the Network and Sharing Center (Advanced sharing settings page).

SET UP A BASIC SHARE

GET READY. To set up a basic share for a specific user, perform the following steps.

1. In File Explorer, navigate to the file or folder you want to share.

2. Right-click the file or folder and choose Properties. Click the Sharing tab in the 
Properties dialog box and click Share. The File Sharing dialog box opens (see 
Figure 6-5). You can also right-click the file or folder and choose Share with > 
Specific people.

3. Click the arrow next to the text box, click a name from the list, and then click 
Add. Alternatively, if you know the user name of the person you want to add, type 
it in the text box and click Add.

4. In the Permission Level column, click the down arrow for the new user and select 
Read or Read/Write. Read allows the user to open and view items but not make 
changes or delete them. Read/Write allows users to open, modify, and delete 
items. You can also click Remove to remove the user.

CERTIFICATION READY
Which permissions are 
available for Windows 10 
file sharing?
Objective 4.2

TAKE NOTE*

You’ll learn about per-
missions later in this 
lesson.

Figure 6-5

Windows 10 basic sharing

1

LESSON 1Installing and 
Upgrading Client 
Systems

O B J E C T I V E  D O M A I N  M A T R I X

Skill/ConCept exam objeCtive objeCtive number

Understanding Windows Systems Identify Windows operating system editions

Understand operating system architecture

2.1

2.4

Understanding Installation Types Identify upgrade paths

Understand installation types

2.2

2.3

K E Y  T E R M S

AppLocker

Assigned Access 8.1

BitLocker

BranchCache

Business Store

clean installation

Client Hyper-V

cloud

command-line interface (CLI)

Continuum

Cortana

Credential Guard

Current Branch for Business

desktop PC

device driver

Device Guard

DirectAccess

Encrypting File System (EFS)

Enterprise Mode Internet 
Explorer (EMIE)

graphical user interface (GUI)

Group Policy management

hardware interrupt request 
(IRQ)

High Touch Installation (HTI)

hybrid computer

joining to a domain

kernel mode

laptop

Lite Touch Installation (LTI)

LoadState.exe

Long-Term Servicing Branch

Private catalog

Remote Desktop

RemoteApp

ScanState.exe

smartphone

tablet

text user interface (TUI)

upgrade installation

User Experience control and 
lockdown

user interface (UI)

user mode

User State Migration Tool (USMT)

UsmtUtils.exe

virtual desktop

Windows 10

Windows 10 Education

Windows 10 Enterprise

Windows 10 Home

Windows 10 Media Creation tool

Windows 10 Pro

Windows Deployment Services

Windows Hello

Windows Spotlight

Windows To Go

Windows Update for Business

x64

x86

Zero Touch Installation (ZTI)

Objective Domain Matrix
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7. On the Create an account for this PC page, in the Who’s going to use this PC? text 
box, type DJoel.

8. In the Enter password text box and the Re‐enter password text box, type 
Pa$$w0rd.

9. In the Password hint text box, type default and click Next.
10. On the Settings page, click the DJoel account and click Change account type.

11. In the Change account type dialog box, in the Account type drop‐down list, click 
Administrator (see Figure 2‐2). Click OK.

12. Close the Settings page.

■■ Configuring and Optimizing User Account Control (UAC)

With UAC, when a user logs on to Windows 10, the system issues a token, which indi-
cates the user’s access level. Standard users receive a standard user token and members of the 
Administrators group receive two tokens, a standard user token and an administrator token. 
Normally, both types of users use the standard user token. However, if you need to perform 
an administrative task, UAC prompts indicate that a change needs to be made. If you are an 
administrator, click Yes to continue. If you are not an administrator, you must log on with 
an Administrator account. If malicious code tries to access your system and make changes 
without your knowledge, the UAC prompts notify you, and you can stop the program from 
making those changes.

In Windows 10, the number of operating system applications and tasks that require ele-
vated permission is fewer when compared with older versions of Windows. The default 
UAC setting allows a standard user to perform the following tasks without receiving a UAC 
prompt:

• View Windows settings
• Pair Bluetooth devices with the computer
• Reset the network adapter and perform other network diagnostic and repair tasks
• Establish a local area network (LAN) connection or wireless connection

CERTIFICATION READY
Which security 
mechanism is used 
to notify you when a 
program makes changes 
to the system?
Objective 3.2

Figure 2-2

Specifying an account type

THE BOTTOM LINE

User Account Control (UAC) is a technology used with Windows Vista, 7, 8/8.1, and 10 
to enhance system security by detecting and preventing unauthorized changes to the 
system. Some applications might not run properly using a standard user credential if the 
application needs to access restricted files or registry locations.

Screen Images

Bottom Line

Key Terms
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*Cortana is currently available in Windows 10 only for the United States, United Kingdom, China, France, Italy, Germany, and 
Spain.

Table 1-2

(Continued) Feature WindoWs 10

Home

WindoWs 10

Pro

WindoWs 10

enterPrise

WindoWs 10

education

Encrypting File 
System (EFS)

No Yes Yes Yes

Enterprise Mode 
Internet Explorer 
(EMIE)

No Yes Yes Yes

Group Policy 
management

No Yes Yes Yes

Joining to a 
domain

No Yes Yes Yes

Long‐Term 
Servicing Branch

No No Yes No

Private catalog No Yes Yes Yes

Remote Desktop Client only Client and 
host

Client and 
host

Client and 
host

RemoteApp Client only Client only Client and 
host

Client and 
host

User Experience 
control and 
lockdown

No No Yes Yes

Virtual desktops Yes Yes Yes Yes

Windows Hello Yes Yes Yes Yes

Windows 
Spotlight

Yes Yes Yes Yes

Windows To Go No No Yes Yes

Windows 
Update for 
Business

No Yes Yes Yes

Understanding Processor and Memory Architecture

The processor of a Windows computer runs in two different modes: kernel mode and 
user mode. The kernel mode has complete and unrestricted access to the underlying 
hardware, while the user mode does not have direct access to the hardware or reference 
memory.

Easy-to-Read Tables
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REVIEW PERMISSIONS USING THE EFFECTIVE ACCESS TAB

GET READY. To view the effective permissions for the local Administrator account, log on to 
your computer with administrative credentials and perform the following steps.

1. Click the File Explorer icon on the taskbar.

2. Click Local Disk (C:).

3. Right-click the Windows folder and choose Properties.
4. Click the Security tab and click Advanced.

5. Click the Effective Access tab.

6. Click Select a user.
7. In the Enter the object name to select field, type Administrator and click OK.

8. Click View effective access.
9. Review the current permissions for the local Administrator account on C:\Windows 

and click OK.

10. Click OK and then close the Windows Properties dialog box.

When planning your NTFS/Share permissions on storage spaces or any volumes in which 
files and folders are shared, the best approach is to set the Share permissions to provide Full 
Control to the appropriate user group and then use NTFS permissions to further lock down 
access to the resource. This process ensures that resources are secured regardless of how they 
are accessed (remotely or locally).

Combining NTFS and Share Permissions

For example, let’s say you create and share a folder with the following settings:

• Share permission (Share tab): Sales group, Read
• NTFS permission (Security tab): Sales group, Full Control

When users connect to the share over the network, both the share and NTFS permissions 
combine, and the most restrictive set is applied. In the preceding example, the share permis-
sion of Read is more restrictive than the NTFS permission, so users can read the folder and 
its contents. If the same users were to log on locally to the computer in which this share is 
located, they would bypass the share permissions and their level of access would be based on 
the NTFS permission. In this example, they would have Full Control.

Mapping Drives

It is very common to combine share and NTFS permissions when providing access to 
resources on NTFS volumes. When this happens, you must have a good understanding 
of the cumulative effects to ensure that your resources remain protected. Now that you 
have a better understanding of NTFS permissions and share permissions, you need 
to understand what happens when you combine the two permissions on the same 
resource.

Drive mapping allows you to create a shortcut to a shared folder across a network. 
Instead of finding and connecting to the shared drive each time you log on, you can 
create a mapped drive that is available at all times. Just double-click the mapped drive 
to access the shared folder.

Step-by-Step Exercises
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■■ Knowledge Assessment

Multiple Choice

Select the correct answer for each of the following questions.

1. Which of the following is not a network location in Windows 10?
a. Private
b. Office
c. Domain
d. Public

2. Which of the following should be used for file sharing when a peer-to-peer network has 
a mix of Windows 10, Windows 8/8.1, and Windows 7 computers?
a. Public folders
b. HomeGroup
c. A workgroup
d. A domain

S K I L L  S U M M A R Y

In thIs lesson you learned:

• A network location is a collection of security settings that’s appropriate for the type of 
network to which you want to connect.

• Network discovery is a Windows feature that enables your computer to find other com-
puters and devices (such as printers) on a connected network. It also lets you control 
whether other computers can see your computer on the same network.

• A homegroup is a group of computers on a home network that can share files and 
printers. To protect your homegroup, you use a password. Similar to share permissions, 
other people cannot change the files that you share unless you give them permission to 
do so. Homegroups are relatively limited, when compared to folder sharing, because you 
can only share the contents of the libraries in the user’s profile.

• Windows 10 provides Public folders and traditional file sharing capabilities to meet your 
networking needs. Public folders are a quick-and-easy way to share files with network 
users and with other users on your computer. Basic and advanced sharing allow you 
to control who may access specific files and folders located in your libraries. Advanced 
sharing offers the most options and is therefore the best choice for protecting confidential 
information.

• To provide access to a drive or folder, you can share the drive or folder, and users will 
access the data files over the network. To help protect against unauthorized drive or folder 
access, you should use share permissions along with NTFS permissions (if the shared 
folder is on an NTFS volume). When a user needs to access a network share, she will use 
the universal naming convention (UNC), which is \\servername\sharename.

• Printers are considered objects. Therefore, as with NTFS files and folders, you can assign 
permissions to a printer so that you can specify who can use the printer, who can manage 
the printer, and who can manage the print jobs.

Skill Summary
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■■ Business Case Scenarios
Scenario 7-1: Automating Computer Maintenance and Program 
Launching

Maria is a busy freelance writer who uses her computer several hours a day to research and 
write articles for several national magazines and newspapers. Her computer, which runs 
Windows 10 Professional, must be running at peak performance with little downtime. Maria 
has little time to devote to computer maintenance tasks. She also uses Internet Explorer 11  
and Microsoft Word 2016 every day and would like them to start automatically when 
Windows starts. Maria asks you for insight on how to maintain her computer with relatively 
little effort, and how to configure her computer to start programs automatically. Describe 
your recommended solution.

Scenario 7-2: Removing Viruses Safely

You are a support person for a computer consulting company. Rajeem is an independent tax 
consultant who calls you to report that he believes he infected his computer with a virus after 
downloading and installing a tax-related utility from the web. Describe your recommended 
solution.

Scenario 7-3: Gathering System Information

In an effort to troubleshoot an issue on a client computer, you posted a message on an online 
PC support forum. The forum moderator posts a message asking you to list all of the pro-
grams that launch at startup on the affected computer. Describe the easiest way to provide 
this information.

Scenario 7-4: Distributing Windows Updates Across a Network

You support Richman Investments, a brokerage firm that employs 20 brokers. Each broker 
has his own client computer, and the firm has a server running Windows Server. All the client 
computers are configured identically.

Over the past six months, some Windows updates have caused the computers to stop respond-
ing, leaving the brokers without computers to conduct business. Describe how to ensure that 
the Windows updates that install on client computers will not cause usability issues.

Photos
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UNIVERSAL SERIAL BUS (USB)

Universal serial bus (USB) (see Figure 4‐23) was a standard developed in the mid‐1990s that 
defines cable connectors and protocols used to connect external devices to a computer. The 
devices include keyboards, digital cameras, portable media players, and external hard drives, 
to name a few.

USB version 1.0 had data transfer rates of 1.5 megabits per second (Mbps) at low speed and 
12 Mbps at full speed.

USB 2.0 increased this speed to 480 Mpbs, which is 40 times faster. USB 2.0 has a read 
access time of 13.3 milliseconds (ms), a read throughput time of 40.1 megabytes per second 
(MBps), and a write throughput of 30.9 MBps. USB cables can be up to 16.4 feet (5 meters) 
in length.

USB 3.0 is the newest version and boasts transfer speeds up to 5 gigabits per second (Gbps). 
For this reason it has acquired the nickname SuperSpeed. USB 3.0 ports don’t need as much 
power and are backward compatible with USB 2.0 ports.

IEEE 1394 (ALSO KNOWN AS FIREWIRE)

IEEE 1394, also known as FireWire and i.link, has been around for many years and has 
undergone several revisions. One of the original reasons behind the creation of IEEE 1394 
was to serve as an interface between the computer and a digital video camera so that video 
could be imported for editing. Today, IEEE 1394 is used for many different types of high‐
speed data transfers, including video, and serves the same purpose as USB. Several types of 
IEEE 1394 cables are shown in Figure 4‐24.

Figure 4-23

USB cables

Figure 4-24

IEEE 1394 cables
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■■ Knowledge Assessment

Multiple Choice

Select the correct answer for each of the following questions.

1. Which of the following Windows built-in utilities helps delete unnecessary files from a 
computer?
a. Disk Defragmenter
b. Disk Cleanup
c. Task Scheduler
d. Registry Editor

2. Which of the following Windows built-in utilities helps improve a computer’s 
performance by moving sectors of data on the hard disk?
a. Disk Defragmenter
b. Disk Cleanup
c. Task Scheduler
d. Registry Editor

3. In Task Scheduler, which of the following commands creates a task using a wizard?
a. Create Task
b. Create Scheduled Task
c. Create Task Automatically
d. Create Basic Task

4. In Windows Defender, which of the following scans is not an available option?
a. Quick
b. Full
c. Partial
d. Custom

5. Which of the following is not part of the Maintenance section in Action Center?
a. Check for solutions to problem reports
b. Virus protection
c. Backup
d. Check for updates

6. If Action Center detects a maintenance or security issue that needs attention, which of 
the following indicate errors that require immediate attention?
a. A red circle with white X.
b. A yellow triangle with a black exclamation point.
c. An orange flashing triangle.
d. A green box.

7. By default, the Windows 10 Disk Defragmenter utility is set to run how often?
a. Every day
b. Once a week
c. Biweekly
d. Once a month

8. Which of the following programs are always updated on Patch Tuesday?
a. Windows Defender
b. The Microsoft website
c. The Malicious Software Removal Tool
d. The Windows Firewall

Knowledge Assessment

Business Case Scenarios
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Conventions and Features 
Used in This Book

This book uses particular fonts, symbols, and heading conventions to highlight important 
information or to call your attention to special steps. For more information about the features 
in each lesson, refer to the Illustrated Book Tour section.

Convention Meaning

THE BOTTOM LINE
This feature provides a brief summary of the material to be 
covered in the section that follows.

CERTIFICATION READY This feature signals the point in the text where a specific 
certification objective is covered. It provides you with a 
chance to check your understanding of that particular MTA 
objective and, if necessary, review the section of the lesson 
where it is covered.

MORE INFORMATION These notes provide pointers to information discussed else-
where in the textbook or describe interesting features of 
Windows that are not directly addressed in the current topic 
or exercise.

Example Key terms appear in bold italic.

Reader aids appear in shaded boxes found in your text. Take 
Note provides helpful hints related to particular tasks or 
topics.

Alt+Tab A plus sign (+) between two key names means that you 
must press both keys at the same time.
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Instructor Support Program

The Microsoft Official Academic Course programs are accompanied by a rich array of resources 
that incorporate the extensive textbook visuals to form a pedagogically cohesive package. 
These resources provide all the materials instructors need to deploy and deliver their courses. 
Resources available online for download include:

Note: A free trial version of Windows 10 can be downloaded from the Microsoft 
Evaluation Center (https://www.microsoft.com/en-us/evalcenter) for use by students in 
this course.

•	 The Instructor Guides contain solutions to all the textbook exercises, chapter sum-
maries, and lecture notes. The Instructor Guides are available from the Instructor’s 
Book Companion site (http://www.wiley.com/college/microsoft).

•	 The Test Bank contains hundreds of questions in multiple-choice, true-false, short 
answer, and essay formats, and is available to download from the Instructor’s Book 
Companion site (http://www.wiley.com/college/microsoft). A complete answer key is 
provided.

•	 A complete set of PowerPoint presentations and images are available on the Instructor’s 
Book Companion site (http://www.wiley.com/college/microsoft) to enhance classroom 
presentations. Approximately 50 PowerPoint slides are provided for each lesson. Tailored 
to the text’s topical coverage and Objective Domain Matrix, these presentations are 
designed to convey key concepts addressed in the text. All images from the text are on 
the Instructor’s Book Companion site (http://www.wiley.com/college/microsoft). You 
can incorporate them into your PowerPoint presentations, or create your own overhead 
transparencies and handouts. By using these visuals in class discussions, you can help 
focus students’ attention on key elements of technologies covered and help them under-
stand how to use it effectively in the workplace.
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Student Support Program

■■ About the Microsoft Technology Associate (MTA) 
Certification

Preparing Tomorrow’s Technology Workforce

Technology plays a role in virtually every business around the world. Possessing the 
fundamental knowledge of how technology works and understanding its impact on today’s 
academic and workplace environment is increasingly important—particularly for students 
interested in exploring professions involving technology. That’s why Microsoft created the 
Microsoft Technology Associate (MTA) certification—a new entry-level credential that 
validates fundamental technology knowledge among students seeking to build a career in 
technology.

The Microsoft Technology Associate (MTA) certification is the ideal and preferred path to 
Microsoft’s world-renowned technology certification programs, such as Microsoft Certified 
Technology Specialist (MCTS) and Microsoft Certified IT Professional (MCITP). MTA is 
positioned to become the premier credential for individuals seeking to explore and pursue a 
career in technology, or augment related pursuits such as business or any other field where 
technology is pervasive.

MTA Candidate Profile

The MTA certification program is designed specifically for secondary and post-secondary stu-
dents interested in exploring academic and career options in a technology field. It offers stu-
dents a certification in basic IT and development. As the new recommended entry point for 
Microsoft technology certifications, MTA is designed especially for students new to IT and 
software development. It is available exclusively in educational settings and easily integrates 
into the curricula of existing computer classes.
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MTA Empowers Educators and Motivates Students

MTA provides a new standard for measuring and validating fundamental technology 
knowledge right in the classroom while keeping your budget and teaching resources intact. 
MTA helps institutions stand out as innovative providers of high-demand industry creden-
tials and is easily deployed with a simple, convenient, and affordable suite of entry-level 
technology certification exams. MTA enables students to explore career paths in technology 
without requiring a big investment of time and resources, while providing a career foundation 
and the confidence to succeed in advanced studies and future vocational endeavors.

In addition to giving students an entry-level Microsoft certification, MTA is designed to be a 
stepping stone to other, more advanced Microsoft technology certifications, like the Microsoft 
Certified Technology Specialist (MCTS) certification.
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LESSON 1Installing and 
Upgrading Client 
Systems

O B J E C T I V E  D O M A I N  M A T R I X

Skill/Concept Exam Objective Objective Number

Understanding Windows Systems Identify Windows operating system editions

Understand operating system architecture

2.1

2.4

Understanding Installation Types Identify upgrade paths

Understand installation types

2.2

2.3

K E Y  T E R M S

AppLocker

Assigned Access 8.1

BitLocker

BranchCache

Business Store

clean installation

Client Hyper-V

cloud

command-line interface (CLI)

Continuum

Cortana

Credential Guard

Current Branch for Business

desktop PC

device driver

Device Guard

DirectAccess

Encrypting File System (EFS)

Enterprise Mode Internet 
Explorer (EMIE)

graphical user interface (GUI)

Group Policy management

hardware interrupt request 
(IRQ)

High Touch Installation (HTI)

hybrid computer

joining to a domain

kernel mode

laptop

Lite Touch Installation (LTI)

LoadState.exe

Long-Term Servicing Branch

Private catalog

Remote Desktop

RemoteApp

ScanState.exe

smartphone

tablet

text user interface (TUI)

upgrade installation

User Experience control and 
lockdown

user interface (UI)

user mode

User State Migration Tool (USMT)

UsmtUtils.exe

virtual desktop

Windows 10

Windows 10 Education

Windows 10 Enterprise

Windows 10 Home

Windows 10 Media Creation tool

Windows 10 Pro

Windows Deployment Services

Windows Hello

Windows Spotlight

Windows To Go

Windows Update for Business

x64

x86

Zero Touch Installation (ZTI)
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■■ Understanding Windows Systems

Windows XP merged the consumer-oriented Windows 9x series with Windows NT/2000, 
while introducing a redesigned user interface that included the Start menu, Internet Explorer 
6, and Remote Assistance functionality. As a result, Windows XP became one of the most 
popular client operating systems in history.

Microsoft attempted to replace Windows XP with Windows Vista, which had an updated 
graphical user interface and improved security. Unfortunately, Windows Vista was not well 
received, and it failed to overtake Windows XP. To overcome the shortcomings of Windows 
Vista, Microsoft released Windows 7, which offered increased performance, a more intuitive 
interface, and fewer User Account Control pop-ups. Windows 7 included some terrific 
new features as well, such as large and animated task thumbnails, homegroups, Jump Lists, 
libraries, and Windows XP Mode.

The next version of Windows introduced was Windows 8, which was upgraded to support 
desktop computers, mobile computers, and tablets, while being optimized for touch screens. 
Windows 8 replaced the Start button and menu with the Start screen, a new platform for 
developing apps, and the Windows Store. Unfortunately, the new interface made it confusing 
and difficult to learn. To address some of these concerns, Microsoft released Windows 8.1, 
which improved the Start screen.

There are some common threads throughout all editions of Windows. For example, every 
edition contains the same integrated applications, such as Network and Sharing Center, 
Control Panel, and Windows Media Player. The different editions also include many of the 
same multimedia features. All Windows editions support 32-bit systems, and all editions 
except Windows 7 Starter support 64-bit systems.

Windows 10 is the newest client operating system. After the failure of Windows 8, 
Microsoft listened to customer complaints to develop Windows 10. To distance the 
new version of Windows from Windows 8/8.1, Microsoft skipped Windows 9 and went 
to Windows 10. Unlike previous versions of windows, Windows 10 is released as an 
“operating system as a service,” which means that it will receive ongoing updates to its fea-
tures and functionality.

As client operating systems are developed and released, Microsoft also develops  
and releases server operating systems, as shown in Table 1-1. Until Windows 10, the  
client operating system and server operating system were introduced together. While  
both client and server operating systems can provide and request services, server  
operating systems can provide additional services and can service many more clients 
simultaneously.

You work as an IT technician for a mid-market food service and vending company. 
Management has decided to standardize on Windows 10 Pro and has asked your IT 
group to evaluate all existing computers to determine if they can support the operating 
system. Any newly acquired computers should have Windows 10 Pro installed. You 
need to learn as much as possible about Windows 10 system requirements, types of 
installations, and upgrade paths.

THE BOTTOM LINE

The client version of Windows is the version that is purchased and installed on personal 
computers such as desktop computers, laptops, workstations, and tablets. Windows Server 
operating systems are purchased and installed on stand-alone physical servers, blade servers, 
and virtual machines.
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Table 1-1

Client and Server Operating 
Systems

Client Operating Systems Server Operating Systems Version Number

Windows 10 Windows Server 2016 10.0

Windows 8.1 Windows Server 2012 R2 6.3

Windows 8 Windows Server 2012 6.2

Windows 7 Windows Server 2008 R2 6.1

Windows Vista Windows Server 2008 6.0

Windows XP Windows Server 2003/Windows  
Server 2003 R2

5.1/5.2

Windows 2000 Professional Windows 2000 Server 5.0

Windows NT 4.0 Workstation Windows NT 4.0 Server 4.0

Understanding User Interfaces

User interfaces are organized into two types:

•	 Graphical user interface (GUI): The user performs actions by clicking and moving 
buttons, icons, and menus with a pointing device, such as a mouse or track pad.

•	 Text user interface (TUI)/command-line interface (CLI): The user performs actions by 
using a keyboard to enter commands.

Most operating systems have a GUI, as do Windows 10 and Windows Server 2016. These 
operating systems include a Start menu with program groups, a taskbar showing the programs 
currently in use, a desktop, and various icons and quick-launch icons.

Early operating systems, such as UNIX and Microsoft DOS, were text user interface 
operating systems, in which you would type commands to perform tasks. However, even 
GUI operating systems include a text user interface that you can access to perform functions 
that may or may not also be available with the GUI. For example, when using Windows 10, 
you can use the command prompt (which allows you to type commands as you would for 
Microsoft DOS) or Windows PowerShell. Use the command prompt or Windows PowerShell 
to create scripts, which can be used for repetitive tasks or for automation.

Determining Appropriate Editions Per Device Type

A user interface (UI) is the part of the operating system, program, or device that users 
use to input and receive data, and to tell the computer what to do. For example, to play 
a video, navigate to the folder where the video file is located, and double-click the file. 
Windows typically identifies the program, opens a video player, and plays the file.

Like previous client version operating systems, Windows 10 offers multiple editions. 
The barest version is Windows 10 Home, which has the fewest number of features. 
Windows 10 Pro includes more features, and Windows 10 Enterprise and Windows 10 
Education have the most features. Of course, Windows 10 Home is the least expensive 
edition, whereas Windows 10 Enterprise is the most expensive edition.
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Before installing Windows, you should do a little bit of planning and ask the following questions:

	 1.	 What will the computer be used for?
	 2.	 What type of environment will the computer run in?
	 3.	 Does the computer need to be portable?

Determining what the computer will be used for will help you determine what hardware you 
need. For example, for a computer-aided design (CAD) system, you need a fast processor, lots 
of memory, and a fast video card. In addition, a CAD system would greatly benefit from a 
solid-state drive.

Examining the computer’s environment will help you determine if you need special equipment 
to keep the computer clean. If the computer is in a dusty environment, dust will accumulate, 
which can cause systems to overheat.

Today, being mobile brings its own challenges. You want a system that can give you long battery 
life as well as sufficient power to perform the necessary tasks. In addition, your requirements 
will help determine what portable hardware you might need. For example, does the system need 
external or high-quality speakers, or do you need to work with a large screen? In some situa-
tions, you might only need a smaller computer (such as a small laptop or notepad) that enables 
you to check emails, take notes, write reports, and construct spreadsheets.

Now that you understand how the computer will be used, you can determine its form factor, 
which specifies the size, configuration, and physical arrangement of a computing device. 
Common form factors include:

•	 Desktop PC: The traditional PC that consists of a case of system components that may 
be oriented horizontally or vertically. Desktop PCs can be inexpensive systems that 
handle basic office tasks, or they can be very expensive systems that provide maximum 
performance for uses such as CAD or video editing. Because desktop PCs tend to be 
large, they are not very portable.

•	 Laptop: A portable computer that provides mobility for traveling users or users who 
might work from home. The laptop case incorporates a screen, keyboard, and pointing 
device. Although laptops tend not to be as powerful as desktop PCs, today’s laptops can 
provide superior performance. Laptops can be enhanced with docking stations, external 
keyboards, mice, and monitors. Recently, laptop sales have surpassed desktop PC sales.

•	 Tablet: A smaller version of the laptop, with a screen that makes up the body of the 
computer. Tablets can be used for reading emails, doing presentations, creating reports, 
taking notes, and similar functions.

•	 Hybrid computer: A laptop that can convert to a tablet. These devices typically offer better 
performance than tablets and include a keyboard for faster typing.

•	 Smartphone: A cellular phone with a screen that displays information. These devices can be 
used to read email, keep track of tasks, access calendar information, manage address books, 
run a wide range of applications, and make and receive phone calls over a cellular network.

Another device worth mentioning is a gaming console, such as Xbox. Although this system is 
designed to run games, it might also have additional applications and features.

Windows 10 has multiple editions and versions. The desktop editions of Windows 10 
include:

•	 Windows 10 Home: The Home edition is designed for consumer-based personal 
computers and tablets.

•	 Windows 10 Pro: The Pro edition is designed for personal computers and tablets for small 
and medium-sized businesses, and for advanced users. It is similar to Windows 10 Home, 
but has extra features to meet the needs of small businesses. It includes BitLocker Drive 
Encryption, Encrypting File System (EFS), domain join, and Group Policy management.
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•	 Windows 10 Enterprise: The Enterprise edition is designed for personal computers and 
tablets for large enterprises. It builds on Windows 10 Pro by adding advanced features 
designed to meet the demands of medium- and large-sized organizations. It includes 
AppLocker, BranchCache, and DirectAccess. Windows 10 Enterprise is only available to 
Volume Licensing customers.

•	 Windows 10 Education: The Education edition is designed for personal computers 
and tablets for use in schools (including staff, administrators, teachers, and students). 
Windows 10 Education has the same features as Windows 10 Enterprise. Windows 10 
Education is only available through academic Volume Licensing.

Some of the features that are available in Windows 10 include:

•	 AppLocker: A feature that allows you to specify which groups or users can run, or not 
run, a particular application in your organization

•	 Assigned Access 8.1: A setting that lets you restrict a specific standard account to using 
only one Windows Store app, for use as a kiosk station

•	 BitLocker: A feature that encrypts a volume to protect a system from being accessed if 
the system is lost or stolen

•	 BranchCache: A wide area network (WAN) bandwidth optimization technology that 
allows the local caching of shared folders and websites so that you don’t always have to 
access data over a slower WAN link

•	 Business Store: A feature that allows administrators to find, acquire, manage, and 
distribute apps to Windows 10 devices

•	 Client Hyper-V: Virtualization technology that allows you to run virtual machines 
so that you can run older applications on older operating systems or run a different 
operating system on the same machine as Windows 10

•	 Continuum: A feature that allows you to turn your phone into a big-screen projector 
or attach a keyboard or mouse to your phone

•	 Cortana: A voice-activated personal assistant
•	 Credential Guard: A feature that stores credentials, such as NTLM hashes and Kerberos 

tickets, and provides them to the necessary applications; the credentials are stored  
in a secured isolated container, which uses Hyper-V and virtualization-based security 
(VBS)

•	 Current Branch for Business: A feature that allows you to delay upgrades (new ver-
sions) and updates, so that you can perform pilot testing before deploying updates

•	 Device Guard: A feature that helps protect a system by locking a device so that it can 
only run trusted applications

•	 DirectAccess: An advanced VPN technology that allows remote users to securely access 
internal network file shares while connected to the internet

•	 Encrypting File System (EFS): A feature that provides transparent file-level encryption
•	 Enterprise Mode Internet Explorer (EMIE): A compatibility mode that runs Internet 

Explorer 11 or higher and lets websites render using a modified browser configura-
tion that’s designed to emulate either Windows Internet Explorer 7 or 8, avoiding the 
common compatibility problems associated with web apps written and tested on older 
versions of Internet Explorer

•	 Group Policy management: An infrastructure that allows you to centrally manage com-
puter settings and configuration

•	 Joining to a domain: A feature that allows you to join an Active Directory domain
•	 Long-Term Servicing Branch: An option for organizations that only want to receive fea-

tures updates every two to three years, so that the current systems can be stable
•	 Private catalog: A feature that provides a list of applications that users within the orga-

nization can download apps from
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•	 Remote Desktop: A program or feature that allows you to connect to a remote 
computer and access the desktop and applications as if you were accessing the machine 
directly

•	 RemoteApp: A feature that enables you to run a program remotely through Remote 
Desktop Services, although the application appears to be running on your local 
machine

•	 User Experience control and lockdown: A feature that allows you to customize and lock 
down the Windows 10 user interface

•	 Virtual desktops: A feature that allows you to run and switch between multiple desktops
•	 Windows Hello: A credential technology that provides multi-factor authentication, 

including the recognition of a personal identification number (PIN) or biometrics (face, 
iris, or fingerprint recognition)

•	 Windows Spotlight: An option that displays a new image on the lock screen each day
•	 Windows To Go: A feature that allows you to boot and run Windows from USB mass 

storage devices such as USB flash drives and external hard drives
•	 Windows Update for Business: A free service for Windows 10 Pro, Enterprise, and 

Education editions that can provide updates to users based on distribution rings

Table 1-2 shows some of the common features available for the various editions of Windows 10.

Microsoft also introduced the Windows 10 Mobile and Windows 10 Mobile Enterprise edi-
tions, which are designed to run on smartphones and small tablets.

Table 1-2

Features Based on Windows 10 
Editions

Feature Windows 10

Home

Windows 10

Pro

Windows 10

Enterprise

Windows 10

Education

AppLocker No No Yes Yes

Assigned  
Access 8.1

No Yes Yes Yes

BitLocker No Yes Yes Yes

BranchCache No No Yes Yes

Business Store No Yes Yes Yes

Client Hyper-V No 64-bit SKUs 
only

64-bit SKUs 
only

64-bit SKUs 
only

Continuum Yes Yes Yes Yes

Cortana* Yes Yes Yes Yes

Credential 
Guard

No No Yes Yes

Current Branch 
for Business

No Yes Yes Yes

Device Guard No No Yes Yes

DirectAccess No No Yes Yes

(continued )
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*Cortana is currently available in Windows 10 only for the United States, United Kingdom, China, France, Italy, Germany, and 
Spain.

Table 1-2

(Continued) Feature Windows 10

Home

Windows 10

Pro

Windows 10

Enterprise

Windows 10

Education

Encrypting File 
System (EFS)

No Yes Yes Yes

Enterprise Mode 
Internet Explorer 
(EMIE)

No Yes Yes Yes

Group Policy 
management

No Yes Yes Yes

Joining to a 
domain

No Yes Yes Yes

Long-Term 
Servicing Branch

No No Yes No

Private catalog No Yes Yes Yes

Remote Desktop Client only Client and 
host

Client and 
host

Client and 
host

RemoteApp Client only Client only Client and 
host

Client and 
host

User Experience 
control and 
lockdown

No No Yes Yes

Virtual desktops Yes Yes Yes Yes

Windows Hello Yes Yes Yes Yes

Windows 
Spotlight

Yes Yes Yes Yes

Windows To Go No No Yes Yes

Windows 
Update for 
Business

No Yes Yes Yes

Understanding Processor and Memory Architecture

The processor of a Windows computer runs in two different modes: kernel mode and 
user mode. The kernel mode has complete and unrestricted access to the underlying 
hardware, while the user mode does not have direct access to the hardware or reference 
memory.



8  |  Lesson 1

Kernel mode is generally reserved for the most trusted part of the operating system. Code that 
crashes in the kernel mode will cause catastrophic errors such as the dreaded Stop error or 
“blue screen of death.”

Most programs that you install and use on a daily basis are stored in the user mode. When 
programs run in user mode, they are isolated from other programs. Therefore, when a 
program crashes, it usually only affects the individual program.

Windows 10 supports two platforms:

•	 IA-32 is designed to run on systems with the 32-bit x86 processors. IA-32 can only 
access up to 4 GB of memory.

•	 X86-64 is designed to run on the x86-64 processors. Windows 10 can support up to 128 
GB of memory, while the other desktop editions can support up to 2048 GB of memory.

Windows runs on a desktop computer that has a processor based on the x86 (32-bit) or x64 
(64-bit) architecture. The architectures determine how data is processed and how much memory 
can be accessed. A 64-bit architecture can process larger numbers or larger chunks of data, 
allowing for faster processing. In addition, a 32-bit processor can access up to 4 GB of memory, 
while a 64-bit processor can theoretically access up to 16 exabytes (16 billion gigabytes) of 
memory, although you will most likely be limited by the motherboard and software. The 32-bit 
versions of Windows 10 support up to 4 GB of memory. The 64-bit version of Windows 10 
Home supports up to 128 GB of memory and the 64-bit versions of Windows 10 Pro and 
Windows 10 Enterprise editions support up to 512 GB.

To install a 32-bit version of Windows, you can use an x86 or x64 processor. To install a 64-bit 
version of Windows, you can use only a 64-bit processor. Software written for a 64-bit 
architecture does not work on a 32-bit architecture. Most programs designed for 32-bit 
versions of Windows will work on a 64-bit version of Windows if you use Windows on 
Windows 64 (WoW64). However, some 32-bit system software, such as antivirus programs, 
do not operate on a 64-bit architecture. In addition, 64-bit hardware requires 64-bit drivers. 
Drivers designed for 32-bit versions of Windows do not run on 64-bit versions of Windows, 
and drivers designed for 64-bit versions of Windows do not run on 32-bit versions of 
Windows. If you transition from a 32-bit version architecture to a 64-bit architecture, you 
may not find 64-bit drivers for all your devices, particularly for older devices.

If you want to use 64-bit Windows, keep the following in mind:

•	 16-bit applications (applications generally written for Windows 9x) or 32-bit kernel 
drivers will fail to start or function properly on a 64-bit edition of Windows 10.

•	 Installation of 32-bit kernel drivers will fail on the 64-bit system.
•	 Installation of 64-bit unsigned drivers will fail by default on the 64-bit system.

Finally, many computers today have multi-core processors. A 32-bit version of Windows 10 
supports up to 32 processor cores; a 64-bit version of Windows 10 supports up to 256 pro-
cessor cores.

CERTIFICATION READY
What is the advantage 
of having programs run 
in user mode instead of 
kernel mode?
Objective 2.4

DETERMINE WHETHER YOUR PC IS RUNNING 32-BIT WINDOWS  
OR 64-BIT WINDOWS

GET READY. To find out if your computer is running a 32-bit or 64-bit version of Windows 
10, perform the following steps.

1.  Right-click Start and choose System. The System window opens.

2.  Look in the System area to view the system type (see Figure 1-1).

An alternative method is to check the System Information window. To do so, perform the fol-
lowing steps.

1.  Click Start, type system info in the Search programs and files search box, and 
then click System Information in the resulting list.
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Figure 1-1

Viewing system information

2.  Make sure System Summary is selected in the navigation pane on the left.

3.  Look at the System Type value in the right pane (see Figure 1-2):

• x86-based PC indicates a 32-bit operating system

• x64-based PC indicates a 64-bit operating system

Figure 1-2

Viewing the System Type value 
in the System Information 
window

Understanding Drivers

A computer is a collection of hardware devices, each of which requires a piece of 
software called a device driver in order to function. Windows 10 includes a large library 
of device drivers, but it is still sometimes necessary to obtain them yourself.
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Drives, keyboards, mice, modems, and printers are all types of devices. To communicate with 
the operating system running on the computer, each device also requires a software element 
called a device driver. The device driver provides the operating system with information 
about a specific device.

For example, when you use a word-processing application to save a file to a hard drive, the 
application issues a generic WriteFile function call to the operating system. The applica-
tion knows nothing specific about the drive hardware; it just issues an instruction to store a 
particular file there. When the operating system processes the function call, it accesses the device 
driver for the hard drive, which provides detailed information about how to communicate with 
the drive. If the user selects a different target location for the file, the operating system accesses 
the device driver for that location, whether it’s a hard drive, a disc drive, or a USB flash drive, or 
another type of storage device.

Device drivers run in the kernel mode or in user mode. A driver that runs in user mode provides 
for a more stable system, because poorly written user mode device drivers cannot crash the entire 
system. However, drivers that run in user mode are slower than drivers that run in kernel mode.

A driver communicates with the device through the computer bus or communications sub-
system. Hardware interrupt requests (IRQs) are used by devices that require attention from 
the operating system. For example, every time you press a key on a keyboard or move the 
mouse, you trigger a hardware interrupt that causes the processor to read and process the key-
stroke or mouse position.

Understanding Windows 10 System Requirements

The system requirements for Windows 10 include the following:

•	 Processor: 1 gigahertz (GHz) or faster processor
•	 RAM: 1 gigabyte (GB) for 32-bit or 2 GB for 64-bit
•	 Hard drive space: 16 GB for 32-bit OS or 20 GB for 64-bit OS
•	 Graphics card: DirectX 9 or later with WDDM 1.0 driver
•	 Display: 800 × 600

A clean installation of Windows is when you install Windows where there is no operating 
system, data, or programs stored on the hard drive, or you perform the installation of 
Windows while reformatting the current hard drive, so that you are installing Windows on 
an empty hard drive. An upgrade installation of Windows is when you have a system that 
is running Windows 7 or Windows 8/8.1, and you run the Windows installation program, 
replacing the Windows 7 or Windows 8/8.1 operating system with Windows 10.

A system that meets the minimum hardware specifications might not provide you with an 
optimal user experience. When preparing to run Windows 10, it’s best to exceed the processor, 
RAM, and hard drive space requirements, if possible. For example, a user who wants to 
simultaneously run a web browser, an email client, and productivity software (such as a word 
processor and a spreadsheet application) will have a good user experience on a computer with 
a 2 GHz dual-core processor and 4 GB of RAM. A user who needs to run memory-intensive 
graphic programs along with other applications will find the computer highly responsive with 
at least 8 GB of RAM. Computers that don’t have access to shared storage space on a network 
may also need secondary storage, such as an external flash hard drive. This is especially impor-

CERTIFICATION READY
What is the minimum 
amount of RAM a 
computer must have in 
order to run Windows 10 
on a 32-bit processor?
Objective 2.1

CERTIFICATION READY
How does a device get 
the attention of the 
processor?
Objective 2.4

CERTIFICATION READY
Which software 
component allows a 
hardware component 
to interface with the 
operating system?
Objective 2.4

Software manufacturers, including Microsoft, list the system requirements needed to 
run their products. The specifications are usually minimum requirements; recommended 
requirements—which allow for much better performance of the OS and applications—
are often much higher (in the case of memory, processor speed, or hard drive space) or 
involve more recent technology.
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tant if the user has a large number of image, video, or audio files, which tend to consume 
much more storage space than ordinary document files require.

In addition, Microsoft lists the following items as required for using specific features or for 
optimal performance:

•	 Internet access (be aware that you may need to pay for the service)
•	 Additional memory and advanced graphics hardware for video playback, depending on 

the resolution required or desired
•	 A graphics card compatible with DirectX 10 or higher for certain games and programs; 

DirectX enhances the multimedia capabilities of a computer by enabling some multi-
media functions to be processed by the graphics card rather than the CPU

•	 Specific hardware for Windows touch and tablet PCs
•	 A network and PCs running Windows 10 for HomeGroup utilization
•	 A compatible optical drive to burn DVDs and CDs
•	 Trusted Platform Module (TPM) 1.2 for BitLocker; TPM is a security chip on some 

motherboards that helps protect a computer from being used when the computer has 
been lost, stolen, or attacked by a hacker

•	 A Universal Serial Bus (USB) flash drive for BitLocker To Go
•	 An additional 1 GB of RAM and an additional 15 GB of available hard drive space for 

Windows XP Mode
•	 Audio output for music and sound

■■ Understanding Installation Types

Microsoft provides many different ways to install Windows 10, from manual methods like 
inserting a DVD to fully automated, “non-touch” installations performed over a network or 
even via the cloud. (The cloud generally refers to the internet or to a server accessible over the 
internet.) The method you choose depends mainly on the number of computers on which 
you need to install Windows and how much time you have to devote to the project.

Installing Windows 10 from removable media is common in smaller enterprise or home 
environments. When you think of removable media, you might think of DVDs, but many 
installations are performed from USB drives as well. Using a DVD or USB drive is considered 
a manual method of installation. If you’re installing Windows on one, two, or even ten com-
puters, a manual method works well. If you must install Windows on many computers, you’ll 
want to understand automated methods, in order to save time (and, thus, money).

The following are categories that correspond to the level of interaction required during an 
installation:

•	 High Touch Installation (HTI)
•	 Lite Touch Installation (LTI)
•	 Zero Touch Installation (ZTI)

High Touch Installation (HTI) may include retail media or a standard image (ISO file). 
Using this method, you use an installation DVD or USB drive and manually install the 
operating system on every computer. You must then also manually configure each system.

In a larger environment, where you have 25 or more computers that require Windows 10 
installations, you could use a tool called the Windows Assessment and Deployment Kit (ADK) 

CERTIFICATION READY
What is a cloud 
installation?
Objective 2.3

CERTIFICATION READY
What are the types 
of removable media 
installations?
Objective 2.3

Remember, some fea-
tures of Windows 10, 
such as BitLocker, 
are not included 
with every edition of 
Windows 10.

TAKE NOTE*

THE BOTTOM LINE

There are many different types of Windows 10 installations, from the manual DVD 
method to a fully automated setup over a network. Learn the various ways in which you 
can install Windows 10 and select the most efficient method for your needs.

An image file is an 
exact replica of the 
contents of a hard drive, 
saved to a file with 
an .iso extension, or a 
.wim extension if it’s 
a Windows Imaging 
Format image.

TAKE NOTE*
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to create bootable media. ADK includes Deployment Image Servicing and Management 
(DISM), which allows you to modify drive images. A High-Touch Installation to multiple 
computers involves these general steps:

1.	 Install Windows 10 on a clean hard drive.
2.	 Configure it with settings that will apply to all computers.
3.	 Use the Sysprep utility to create an image of the installation.
4.	 Boot to the Windows Preinstallation Environment (WinPE) and use DISM to save the 

image to a DVD, a USB drive, or whatever type of media you plan to use.
5.	 Install the image on the remaining computers.

Lite Touch Installation (LTI) requires some human intervention in the early phase of the 
installation but is automated (or unattended) from that point on. This installation method 
works well in environments with more than 150 computers.

You need the Windows ADK, Windows Deployment Services, and the Microsoft 
Deployment Toolkit for LTIs. Windows Deployment Services is a server role for Windows 
Server 2008 or higher. It allows a user to press the F12 key, log on, and select an image for 
installation. After that, the installation can be automated. For example, you can use an answer 
file to configure Windows settings during installation. The answer file contains all the settings 
that are required for an unattended installation. The Microsoft Deployment Toolkit is a free 
download used to automate high-volume operating system deployments.

Zero Touch Installation (ZTI) is a fully automated, “touchless” method of installing 
Windows. You need System Center Configuration Manager (SCCM) for ZTIs. You use 
SCCM to deploy and update servers, client computers, and all kinds of devices on a network.

The ZTI method is geared for environments with more than 500 computers, involves a fairly 
steep learning curve, and requires a considerable budget compared to the HTI method.

Performing a Clean Install of Windows 10

A clean installation of Windows 10 allows you to start as if the machine is new. If you decide 
to perform a clean installation on a machine that already has Windows 7 or Windows 8/8.1 
installed, you will remove any existing corrupted files, problem programs, or erroneous set-
tings. However, if you perform a clean installation, you have to then install all programs, copy 

The simplest way to perform a clean install (a new installation) of Windows 10 is to 
boot from a bootable Windows 10 installation disc or USB drive, which will start the 
setup program. You can also search for and find the Windows 10 Media Creation tool, 
which can be used create a copy of your Windows 10 ISO file on a USB flash drive or 
DVD. You can then use the USB flash drive to install Windows 10.

INSTALL WINDOWS 10 FROM A WINDOWS 10 INSTALLATION DVD

GET READY. To install Windows 10 from a Windows 10 installation DVD, perform the 
following steps.

Before you start, you need to make sure that your system can boot from the DVD drive, 
which may need to be configured using the BIOS Setup program. The BIOS Setup program 
is usually accessed by pressing the Del key, F10 key, or similar key during boot up.

TAKE NOTE*

1.  Turn on the computer and insert the Windows 10 installation disc into the DVD 
drive. Press any key to boot from the DVD (if necessary).

2.  The computer switches to the Windows graphical interface and the Windows Setup 
page appears, as shown in Figure 1-3. Using the drop-down lists, choose the appro-
priate Language to install, the Time and currency format, and the Keyboard or input 
method. Click Next.
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3.  On the Windows 10 Install now page, click Install now.

4.  On the License terms page, select the I accept the license terms check box and
click Next.

5.  Click the Custom: Install Windows only (advanced) option.

6.  The Where do you want to install Windows? page appears, as shown in Figure 1-4. From
the list, click the partition on which you want to install Windows 10, or click an area of
unallocated drive space where the Setup program can create a new partition. Click Next.

Figure 1-3

The Windows Setup page

Figure 1-4

The Where do you want to 
install Windows? page
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over desired data files from a backup, and reconfigure the system.

At this point, you can remove the installation disc from the drive.

If you need to upgrade from Windows 7 or Windows 8/8.1, visit the Download Windows 10 
website (https://www.microsoft.com/en-us/software-download/windows10) and click the 
Download tool now button. You would then launch the Download Tool to create installation 
media or to upgrade a PC with the older operating system.

After you install Windows, you should activate Windows 10. Activation helps verify that the 
copy of Windows is genuine, and that it is not in use on more devices than the number for 
which you own licenses. If you have a retail, OEM, or volume license key, you will need to 
type a valid 25-character product key.

A Windows 10 product key looks similar to:

xxxxx-xxxxx-xxxxx-xxxxx-xxxxx

but is composed of letters and numbers. It is usually located:

•	 On the installation disc holder inside the Windows package
•	 On a sticker on the back or bottom of your computer if the operating system came  

pre-installed on the computer
•	 In a confirmation e-mail if you purchased and downloaded Windows 10 online

During installation, you must enter the product key exactly as printed. (If you are off by even 
one character, the installation fails.) After you enter the product key correctly, the product key 
is then written to the Windows registry in an encrypted format, making it unreadable (for 
security purposes). Therefore, it’s important to keep your Windows 10 installation media and 
printed product key in a safe location after initial installation, in case you need to reinstall or 
repair the operating system at some point.

7.  After several minutes, during which the Setup program installs Windows 10, the 
computer reboots and the Get going fast page appears. Click Use Express Settings.

8.  On the Choose how you’ll connect page, click Join a domain and click Next.
9.  On the Create an account for this PC page, in the Who’s going to use this PC text 

box, type User1.

10.  In the Enter password text box and the Re-enter password text box, type 
Pa$$w0rd. In the Password hint box, type Default. Click Next.

11.  The Networks pane opens on the right side of the Windows desktop. When you are 
prompted to confirm that you want to allow your PC to be discoverable by other 
PCs and devices on the network, click Yes.

ACTIVATE WINDOWS 10

GET READY. To activate Windows 10, perform the following steps.

1.  Click Start > Settings.
2.  In the Settings window, click Update & security > Activation. In the Activate 

Windows section, click the Activate button.

a.  Alternatively, you can open System Properties by right-clicking Start and 
choosing Control Panel, then clicking System and Security > System. In the 
System window, click Activate Windows.

3.  Click Change product key.

4.  In the Enter a product key window, in the Product key text box, type the 25-character 
product key. The system will automatically activate over the internet.
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Upgrading to Windows 10

Before you upgrade to Windows 10, you need to ensure that your software will run on 
Windows 10. To help check application compatibility, you can visit the Windows Dev Center 
site (https://developer.microsoft.com/en-us/windows/ready-for-windows), and search for the 
software.

Upgrading to Windows 10 rather than performing a clean install saves time and allows you 
to keep your programs, files, and settings. After the upgrade, you will be able to use the same 
programs and access your data. However, if you have corrupt non-Windows files, problematic 
programs, or erroneous settings, you may still experience those problems after the upgrade. 
Sometimes, the upgrade does not go smoothly (usually caused by incompatible programs 
or device drivers), and it could make your system unusable. If you are using a legacy device, 
the device may not run under Windows 10. Of course, before you perform an upgrade, you 
should always make sure you have a current backup in case you need to roll back device 
drivers or recover lost programs and data.

You can upgrade from Windows 7 or Windows 8/8.1 to similar versions of Windows 10. For 
example:

•	 If you have Windows 7 Starter, Windows 7 Home Basic, Windows 7 Home Premium, 
Windows 8, or Windows 8.1, you can upgrade to Windows 10 Home.

•	 If you have Windows 7 Pro, Windows 7 Ultimate, Windows 8.1 Pro, or Windows 8.1 
Pro for Student, you can upgrade to Windows 10 Pro.

•	 If you have Windows 7 Enterprise or Windows 8/8.1 Enterprise, you can upgrade to 
Windows 10 Enterprise.

If you want to migrate to a different edition (such as from Windows 8.1 Pro to Windows 8.1 
Enterprise), you will have to perform a clean installation.

In addition, you can only upgrade from a 32-bit version of Windows 7 or Windows 8/8.1 to 
a 32-bit version of Windows 10; or from a 64-bit version of Windows 7 or Windows 8/8.1 
to a 64-bit version of Windows 10. If you want to upgrade from a 64-bit version to a newer 
32-bit version, or from a 32-bit version to a newer 64-bit version, you will have to perform a 
clean installation.

Before you perform any upgrade, you should always make sure that you have a current 
backup of all programs, settings, and data files. You should also make sure that the backup is 
stored away from the machine you are trying to upgrade.

CERTIFICATION READY
Which type of upgrade 
path is necessary to 
upgrade from Windows 7 
or 8/8.1 to Windows 10?
Objective 2.2

If you need to upgrade from Windows 7 or Windows 8/8.1 to Windows 10, you 
can use a Windows 10 bootable DVD or bootable USB drive. You can also upgrade 
Windows 10 by using the Windows 10 Media Creation tool.

UPGRADE TO WINDOWS 10 FROM A WINDOWS 10 INSTALLATION DVD

GET READY. To upgrade from Windows 7 or Windows 8/8.1 to Windows 10 using a 
Windows 10 installation DVD, perform the following steps.

1.  Turn on the computer and log on to the computer that is running Windows 7 or 
Windows 8/8.1.

2.  Insert the Windows 10 installation disc into the DVD drive.

3.  Click Start > Computer. The Computer window opens.

4.  Double-click the disc drive.

5.  In the Windows 10 Setup program, on the Get important updates page, keep the 
Download and install updates (recommended) option selected, and click Next.
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When Windows 10 was initially released, Microsoft offered a free upgrade from Windows 7 
or Windows 8/8.1 to Windows 10 for the first year. These free upgrades were done over the 
internet with Windows Update. In addition, because Windows 10 is released as an “operating 
system as a service,” Windows 10 machines will receive ongoing updates to its features and 
functionality.

Migrating to Windows 10 from Previous Versions of Windows

6.  On the License terms page, click Accept. The Windows 10 Setup program will
download any available updates.

7.  On the Ready to install page, click Change what to keep.

8.  On the Choose what to keep page (as shown in Figure 1-5), click one of the
following options and click Next:
• Keep personal files, apps, and Windows settings

• Keep personal files only

• Nothing

9.  On the Ready to install page, click Install.

After a few minutes, Windows will reboot and complete the upgrade.

Figure 1-5

Specifying what to keep during 
a Windows 10 upgrade

Sometimes, you might want to move a user from one system to another, including 
moving a user from a computer running Windows 7 or Windows 8/8.1 to a computer 
running Windows 10. One of the most time-consuming tasks you will perform as 
an administrator is to move user files and settings between computers and operating 
systems. The User State Migration Tool (USMT) eases this burden. USMT 10 is part of 
the Windows Assessment and Deployment Kit for Windows 10.
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The User State Migration Tool (USMT) is a command-line tool that migrates user data 
from a previous installation of Windows to a new installation of Windows. It provides you 
with the ability to customize the user-profile migration experience. This means you can copy 
selected user data and exclude any data that you do not want to migrate. USMT captures user 
accounts, user files, operating system settings, and application settings to migrate to your new 
Windows installation.

The USMT includes three command-line tools:

•	 ScanState.exe scans the source computer, collects the files and settings, and creates a 
store that contains the user’s files and settings.

•	 LoadState.exe loads the files and settings onto the destination computer.
•	 UsmtUtils.exe deletes hardlink folders in use by applications no longer removable 

through normal measures, checks the store file’s consistency, and restores selected files. 
A hardlink folder provides a way for the New Technology File System (NTFS) to point 
to the same file from multiple locations on the same volume. The store file contains the 
user state migration data. UsmtUtils can be used to check for corrupted files or a cor-
rupted catalog in the store file.

The ScanState.exe and LoadState.exe programs use a similar syntax, in which you specify the 
location of the migration store, the scripts you want to use to specify what to migrate, which 
user accounts you want to migrate, and how the program should store the data.

Table 1-3 lists some of the most common command-line options for ScanState and LoadState 
and their functions.

Table 1-3

USMT Command-Line Options Command-Line 
Option

ScanState  
or LoadState Description

StorePath Both Specifies the location where the program 
should create or from which it should read the 
migration store

/o ScanState Overwrites any existing data in the migration 
store

/vsc ScanState Uses the Volume Shadow Copy Service to 
migrate files that are locked open, eliminating 
some errors

/hardlink ScanState Creates a hardlink migration store at the loca-
tion specified in the StorePath variable

/encrypt:algorithm ScanState Creates an encrypted migration store, using 
the specified algorithm

/decrypt LoadState Decrypts the migration store as it restores the 
user state

/key:keystring Both Uses the key specified by the keystring vari-
able to encrypt or decrypt the migration store

/keyfile:filename Both Uses the key specified in the file identified by 
the filename variable to encrypt or decrypt the 
migration store

(continued )

CERTIFICATION READY
How can you migrate 
from previous versions of 
Windows?
Objective 2.2
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USMT also includes the following modifiable .xml files. Use these files with ScanState and 
LoadState if you want to perform a targeted migration:

•	 MigApp.xml includes rules to migrate application settings.
•	 MigDocs.xml includes rules to migrate user documents from the source computer.
•	 MigUser.xml includes rules to migrate user profiles and user data.

When you use USMT, you should use the following three-step process:

Step 1: Plan the migration.
•	 Determine whether to refresh or replace your system, identify what you want to 

migrate (application settings, operating system settings, files, and/or folders), deter-
mine where to store it (remotely, locally in a hardlink migration store, or directly 

Table 1-3

(Continued) Command-Line 
Option

ScanState  
or LoadState Description

/nocompress ScanState Disables the default data compression used 
when creating a migration store

/i:filename Both Specifies the name of an XML file that the 
program should use to determine what to 
migrate

/genconfig:filename ScanState Creates a Config.xml file containing all of the 
migratable data on the computer, but does not 
create the migration store

/config:filename Both Specifies the Config.xml file the program 
should use when creating or reading the 
migration store

/localonly ScanState Creates a migration store containing only the 
files on local, fixed drives

/c Both Causes the program to continue running, even 
if nonfatal errors occur

/all Both Migrates all user accounts on the computer

/ui:domain\user

/ui:computer\user

Both Migrates a specific user account

/ue:domain\user

/ue:computer\user

Both Excludes a specific account from migration

/uel:<numberofdays>

/uel:<YYYY/MM/DD>

/uel:0

Both Migrates only the users who have logged on 
to the computer within a specified number of 
days or since a specific date or who are cur-
rently logged on to the computer
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on the destination computer), and determine which files will be included in the 
migration.

•	 If necessary, modify the MigApp.xml and MigDocs.xml files or create and modify a 
config.xml file. In general, it’s best to leave the original .xml files in place and create 
and modify a config.xml file to keep your changes separate from the default .xml files.

Step 2: Collect the files and settings from the source computer.
•	 Back up the source computer and close all applications before running ScanState; 

otherwise, USMT might not be able to migrate all the data.
•	 Run ScanState to collect the files and settings using an account with administrative 

privileges. Specify all .xml files you want the command to use:
ScanState \\server\migration\mystore /config:config.xml 
/i:migdocs.xml /:migapp.xml /v:13 /l:scan.log

•	 After the store is completed, run UsmtUtils with the /verify switch to ensure  
that the store you created was not corrupted. Replace X with the store location and 
mystore with the actual name of the store:
UsmtUtils /verify x:\mystore\store.img

Step 3: Prepare the destination computer and restore the files and settings.
•	 Install the operating system on the destination computer, install any applications that 

were on the source computer, and then close any open applications.
•	 Run the LoadState command on the destination computer to migrate the files and 

settings. Make sure you specify the same .xml files you used when you ran ScanState 
during the collection process in Step 2:
LoadState \\server\migration\mystore /config:config.xml 
/i:migdocs.xml /i:migapp.xml /v:13 /l:load.log

•	 After completing the LoadState process, you must log off and then log back on to 
see if some of the settings changed (for example, the screen saver, the fonts, or the 
wallpaper).

CREATE A CUSTOM CONFIG.XML FILE AND EXCLUDE CONTENT FROM THE 
MY PICTURES FOLDER

GET READY. To create a custom config.xml file and exclude content from the My Pictures 
folder, log on as an administrator to a computer running Windows 10 Enterprise, and then 
perform the following steps.

1.  On LON-CL1, press the Windows logo key+r. In the Run dialog box, in the Open 
text box, type cmd. Click OK.

2.  From the search results list, right-click Command Prompt and choose Run as 
administrator.

3.  Change to the directory that contains the USMT tools. In a default installation, 
this would be found by executing the cd command as shown.

For 32-bit machines:

cd “c:\Program Files\Windows Kits\10.0\Assessment and Deployment 
Kit\User State Migration Tool\x86”

For 64-bit machines:

cd “c:\Program Files (x86)\Windows Kits\10.0\Assessment and 
Deployment Kit\User State Migration Tool\amd64”

To complete this 
exercise, you must 
have USMT installed 
on your Windows 10 
Enterprise computer.

TAKE NOTE*
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This file can now be used with ScanState to collect information from the source computer 
and with LoadState to prepare the destination computers.

4.  To create a config.xml file, execute the following command:

scanstate /i:migapp.xml /i:miguser.xml /genconfig:config.xml 
/v:13

Log messages regarding the creation of the file will be sent to the scanstate.log 
file. Both the log file and the config.xml file will be created in the directory from 
which you ran the ScanState command.

The following code is an excerpt from the config.xml file created in Step 4.

<?xml version=”1.0” encoding=”UTF-8”?>

<Configuration>

<Documents>

<component displayname=”My Pictures” migrate=”yes” ID=”folder 
URL”/>

</Documents>

5.  To exclude the My Pictures folder from the migration, change migrate="yes" to 
migrate="no".

6.  Save the file.

In this lesson, you learned:

•	 Windows 10 is the newest client operating system. Unlike previous versions of Windows, 
Windows 10 is released as an “operating system as a service,” which means that it will 
receive ongoing updates to its features and functionality.

•	 Windows 10 supports two platforms: IA-32 and X86-64. IA-32 is designed to run on sys-
tems with 32-bit x86 processors. IA-32 can only access up to 4 GB of memory. X86-64 
is designed to run on the x86-64 processors. Windows 10 can support up to 128 GB of 
memory, while the other desktop editions can support up to 2048 GB of memory.

•	 A clean installation of Windows is when you install Windows where there is no operating 
system, data, or programs stored on the hard drive, or you perform the installation of 
Windows while reformatting the current hard drive, so that you are installing Windows on 
an empty hard drive.

•	 An upgrade installation of Windows is when you have a system that is running 
Windows 7 or Windows 8/8.1, and you run the Windows installation program, replacing 
the Windows 7 or Windows 8/8.1 operating system with Windows 10. You can upgrade 
from Windows 7 or Windows 8/8.1 to like versions of Windows 10.

•	 The User State Migration Tool (USMT) is a command-line tool that migrates user data from 
a previous installation of Windows to a new installation of Windows. Installation methods 
fall into three main categories: High Touch Installation (HTI), Lite Touch Installation (LTI), 
and Zero Touch Installation (ZTI). HTI is mostly manual, and ZTI is almost completely 
automated.

S K I L L  S U M M A R Y
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■■ Knowledge Assessment

Multiple Choice

Select the correct answer for each of the following questions.

	 1.	 Which of the following Windows 10 editions allow you to join the system to a domain? 
(Choose all that apply.)
a.	 Windows 10 Home
b.	 Windows 10 Pro
c.	 Windows 10 Enterprise
d.	 Windows 10 Education

	 2.	 Which of the following tools can be used to download Windows 10 installation files and 
create a bootable USB flash drive so that it can be used to install Windows 10?
a.	 Windows 10 Media Creation tool
b.	 Setup.exe program
c.	 USB Create tool
d.	 Express tool

	 3.	 Which edition of Windows 10 requires a volume license agreement with Microsoft? 
(Choose all that apply.)
a.	 Home
b.	 Pro
c.	 Education
d.	 Enterprise

	 4.	 Which of the following features is not included in Windows 10 Pro?
a.	 Encrypting File System
b.	 BranchCache
c.	 Support for joining domains
d.	 BitLocker

	 5.	 Which of the following tools or features can be used to determine if a copy of Windows 
is genuine?
a.	 An antivirus program
b.	 Activation
c.	 USB/DVD Download tool
d.	 Device Manager

	 6.	 Which Windows 10 installation method uses System Center Configuration Manager 
for deployment across a network?
a.	 HTI
b.	 LTI
c.	 ZTI
d.	 Windows Anytime Upgrade

	 7.	 Which Windows 10 installation method requires some human interaction but uses 
Windows Deployment Services to automate most of the installation?
a.	 HTI
b.	 LTI
c.	 ZTI
d.	 Windows Anytime Upgrade
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	 8.	 The upgrade installation method can be used when upgrading from Windows 7 Home 
Premium to which of the following? (Choose all that apply.)
a.	 Windows 10 Enterprise
b.	 Windows 10 Home
c.	 Windows 10 Pro
d.	 Windows 10 Education

	 9.	 Which of the following are common methods for determining whether your computer  
is running a 32-bit version of Windows 10 or a 64-bit version of Windows 10?  
(Choose two answers.)
a.	 Run Windows 7 Upgrade Advisor.
b.	 Open the Computer window.
c.	 Open the System window.
d.	 Run the System Information utility.

	10.	 Which of the following describes where you might find a Windows 10 product key? 
(Choose all that apply.)
a.	 On the installation disc holder inside the Windows package
b.	 On a sticker on the back or bottom of your computer
c.	 On the installation media itself
d.	 In a confirmation email received after purchasing and downloading Windows 10 

online

Fill in the Blank

Complete the following sentences by writing the correct word or words in the blanks provided.

	 1.	 A(n) _____________ is the set of options you have to upgrade from one Windows 
operating system to another.

	 2.	 _____________ is the process of verifying that your copy of Windows is genuine  
and that it is not in use on more computers than the number for which you own  
licenses.

	 3.	 A _____________-bit computer is also designated as x86.

	 4.	 An _____________ installation replaces your current version of Windows with Windows 
10 while retaining your files, settings, and programs.

	 5.	 The _____________ method involves manual installation of Windows 10 from media 
such as a DVD or USB drive.

	 6.	 Windows 10 _____________ edition is targeted mainly toward small business  
users.

	 7.	 Windows 10 _____________ edition includes all Windows 10 features aimed at 
corporations and advanced users.

	 8.	 _____________ is a fully automated, touchless method of installing Windows.

	 9.	 _____________ is a server role for Windows Server 2008 or higher that allows for 
mostly automated installation of Windows 10 over a network.

	10.	 Windows 10 is released as an _____________, which means that Windows 10 will 
receive ongoing updates to its features and functionality.
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■■ Business Case Scenarios
Scenario 1-1: Troubleshooting a Compatibility Problem

You need to replace an aging Windows 7 computer with a new computer that runs Windows 
10, ensuring the programs, settings, and data files are transferred to the new computer. 
Describe your recommended solution.

Scenario 1-2: Converting a Small Office to Windows 10

Danielle provides IT support for a small cleaning service in the Pacific Northwest. The 
company has eight computers. Four of the computers run Windows 8.1 Pro and the other 
four computers run Windows 7 Pro. The company president has asked her to make sure all 
eight computers are running Windows 10 Pro by the beginning of the next quarter. What 
type of installations must Danielle perform, and what additional steps (if any) must Danielle 
take to retain the users’ files and settings?

Scenario 1-3: Selecting the Right Computer and Operating System

The cleaning service is beginning to grow. The president now wants Danielle to acquire com-
puters for three new staff members. Randi has been hired as the president’s personal assistant 
and will need to run a word processor, spreadsheet application, a web browser, and an email 
client. Pooja will provide marketing and graphics services, such as press releases, brochures, 
flyers, advertisements, and graphics for the new web site. Stan is the new salesperson who will 
travel locally each day. When he’s in the office, he will share a desktop computer with another 
salesperson, but Stan needs to be able to check email and access the internet while he’s out 
of the office. Which computer specifications should be recommended, and which editions of 
Windows 10 should run on each computer?

Scenario 1-4: Installing Windows 10

You are an administrator of an organization that has 150 client computers. 60 systems are 
running Windows 7 Enterprise, 60 systems are running Windows 7 Pro, and 30 systems 
are running Windows 8.1 Pro. You also need to purchase 25 more systems, which will run 
Windows 10. Which edition and version of Windows 10 should be recommended? Describe 
how to deploy Windows 10.

True / False

Circle T if the statement is true or F if the statement is false.

T F 	1.	 A custom installation must be performed in order to upgrade from Windows 7 
to Windows 10.

T F 	2.	 A 1 GHz or faster 32-bit (x86) processor is required to run Windows 10  
64-bit edition.

T F 	3.	 Windows 10 must be registered before it can be run.

T F 	4.	 The purpose of a Windows 10 product key is to help avoid illegal installations.

T F 	5.	 Windows 10 will always remain a free upgrade for Windows 8.1 systems.
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K E Y  T E R M S

accessibility options

Administrative Tools

Administrator account

checkpoint

Control Panel

desktop

differencing virtual disk

Documents library

domain

Dynamic Memory

Ease of Access Center

elevated permissions

File Explorer

Guest account

hibernate mode

host

hybrid mode

Hyper-V Manager

Hyper-V Virtual Machine 
Connection

hypervisor

Jump List

library

live preview

live tile

Microsoft Management Console 
(MMC)

Music library

Pictures library

pin

power plan

Recycle Bin

resolution

shortcut

sleep mode

sleep settings

Standard user account

startup RAM

user account

User Account Control (UAC)

user profile

user state

Videos library

virtual disk

workgroup

O B J E C T I V E  D O M A I N  M A T R I X

Skill/Concept Exam Objective Objective Number

Understanding User Accounts Configure user account control (UAC) 3.2

Configuring and Optimizing User 
Account Control (UAC)

Configure user account control (UAC) 3.2

Configuring Windows 10 Configure Control Panel options

Configure desktop settings

Understand libraries

1.1

1.2

4.4

Configuring Hyper-V None None
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■■ Understanding User Accounts

There are three types of user accounts in Windows 10:

•	 Administrator
•	 Standard user
•	 Guest

Each account has a different level of control over the computer.

The Guest account type is simply an account with few permissions and no password that 
allows a user to access a computer without requiring a unique user account. The Guest 
account is disabled by default and, when enabled, is intended for a user who needs temporary 
access to a computer.

The Standard user account type has fewer permissions than an Administrator account, but 
enough permissions to be productive. You should use a Standard user account for day-to-day 
work. When you’re logged on to a Standard user account, you can surf the web, read email, 
create documents, listen to music, and perform other basic tasks.

The Administrator account type provides the broadest permissions and, therefore, the most 
control over the computer. When you’re logged on as an administrator, you can change all 
settings, install programs, and modify the Windows registry. Use an Administrator account 
only when you need to make changes or perform maintenance that requires elevated per-
missions. Elevated permissions generally refer to administrative-level permissions. Using an 
Administrator account for ordinary (standard-level) computing tasks leaves the computer at a 
much greater risk of attack. For example, if you visit a malicious website by accident, the site 
can easily install and execute a Trojan horse program on the computer because of the broad 
permissions of the Administrator account.

A computer administrator can use a Standard user account for most tasks and use the Run as 
administrator command to start certain tasks or programs with full administrator-level per-
missions. For example, let’s say you want to run a program but get an Access denied error 
message. Depending on the program, you might be able to right-click the program’s menu 
item or icon and then choose Run as administrator from the shortcut menu. The program 
will run with full administrator rights. Before running any tasks or programs with elevated 
privileges, make sure the computer is protected by a firewall and an up-to-date antivirus 
program or that it’s disconnected from the internet.

CERTIFICATION READY
What are the differences 
between a Standard 
user account and an 
Administrator user 
account?
Objective 3.2

As an IT technician at a mid-market food service and vending company, you’re responsible 
for setting up new computers and helping users adjust their existing computer settings. 
Your duties include creating user accounts, optimizing display settings, and creating 
shortcuts. In addition, because your company uses a legacy program that doesn’t run in 
Windows 10, some of your employees need an alternative way to access the program. So, 
you plan to show those employees how to run older applications made for Windows XP.

THE BOTTOM LINE

A user account is a collection of information that defines the actions that can be taken on 
a computer and which files and folders can be accessed (rights, policies, and permissions). 
An account also keeps track of user preferences, such as the desktop background, window 
color, and screen saver. Several users can share a computer, but each user should have his 
own account. With separate accounts, each user can personalize her desktop, keep her files 
and settings protected from other users, and so on.
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Another special account type that you should be aware of is the default Administrator 
account. This is the default administrative-level account that’s created when you install 
Windows. Think of it as the ultimate master local (i.e., non-domain) account in Windows. 
Use this account only for troubleshooting or for specific activities that you can’t perform with 
any other account.

The default Administrator account is automatically hidden (disabled) in Windows 10, but you 
can enable it if necessary. You must first open a command prompt window in Administrator 
mode by clicking Start, typing cmd, right-clicking cmd.exe in the resulting list, and then 
choosing Run as administrator. In the command prompt window, type net user administrator  
/active:yes and press Enter. When you’re finished using the account and want to disable it, 
open a command prompt window as described and type net user administrator /active:no.

When you create a new user account or modify an existing account, you can choose Standard 
or you can choose Administrator. The Guest account type does not show up as an option in 
the Create a New Account window.

CREATE A USER ACCOUNT

GET READY. To create a new user account, perform the following steps.
1.  Click Start > Settings.
2.  On the Settings page, click Accounts.
3.  On the Accounts page (see Figure 2-1), click Family & other people.

4.  In the Other people section, click Add someone else to this PC.

5.  On the How will this person sign in? page, click I don’t have this person’s
sign-in information.

6.  On the Let’s create your account page, click Add a user without a Microsoft
account.

Figure 2-1

Managing user accounts
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7.  On the Create an account for this PC page, in the Who’s going to use this PC? text 
box, type a name for the account.

8.  In the Enter password text box and the Re-enter password text box, type 
Pa$$w0rd.

9.  In the Password hint text box, type default and click Next.
10.  On the Settings page, click the account and click Change account type.

11.  In the Change account type dialog box, in the Account type drop-down list, click 
Administrator (see Figure 2-2). Click OK.

12.  Close the Settings page.

■■ Configuring and Optimizing User Account Control (UAC)

With UAC, when a user logs on to Windows 10, the system issues a token, which indi-
cates the user’s access level. Standard users receive a standard user token and members of the 
Administrators group receive two tokens, a standard user token and an administrator token. 
Normally, both types of users use the standard user token. However, if you need to perform 
an administrative task, UAC prompts indicate that a change needs to be made. If you are an 
administrator, click Yes to continue. If you are not an administrator, you must log on with 
an Administrator account. If malicious code tries to access your system and make changes 
without your knowledge, the UAC prompts notify you, and you can stop the program from 
making those changes.

In Windows 10, the number of operating system applications and tasks that require ele-
vated permission is fewer when compared with older versions of Windows. The default 
UAC setting allows a standard user to perform the following tasks without receiving a UAC 
prompt:

•	 View Windows settings
•	 Pair Bluetooth devices with the computer
•	 Reset the network adapter and perform other network diagnostic and repair tasks
•	 Establish a local area network (LAN) connection or wireless connection

CERTIFICATION READY
Which security 
mechanism is used 
to notify you when a 
program makes changes 
to the system?
Objective 3.2

Figure 2-2

Specifying an account type

THE BOTTOM LINE

User Account Control (UAC) is a technology used with Windows Vista, 7, 8/8.1, and 10 
to enhance system security by detecting and preventing unauthorized changes to the 
system. Some applications might not run properly using a standard user credential if the 
application needs to access restricted files or registry locations.
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•	 Modify display settings
•	 Play and burn CD/DVD media
•	 Change the desktop background for the current user
•	 Open Date and Time in Control Panel and change the time zone
•	 Use Remote Desktop to connect to another computer
•	 Change the user’s own password
•	 Configure battery power options
•	 Configure accessibility options
•	 Restore a user’s backup files
•	 Set up computer synchronization

UAC will prompt you and require elevation to an Administrator account for the following 
tasks:

•	 Install and uninstall applications
•	 Install a driver for a device
•	 Install Windows updates
•	 Install an ActiveX control
•	 Open Windows Firewall in Control Panel
•	 Change a user’s account type
•	 Configure Remote Desktop access
•	 Add or remove a user account
•	 Copy or move files into the Program Files directory or the Windows directory
•	 Schedule automated tasks
•	 Restore system backup files
•	 Configure Automatic Updates
•	 Browse to another user’s directory

In Windows 10, four UAC settings are available through Control Panel:

•	 Always notify me: The user is always prompted when changes are made to the com-
puter and the desktop is dimmed.

•	 Notify me only when apps try to make changes to my computer (default): When a 
program makes a change, a prompt appears and the desktop dims. Otherwise, the user is 
not prompted.

•	 Notify me only when apps try to make changes to my computer (do not dim my 
desktop): When a program makes a change, a prompt appears and the desktop does not 
dim.

•	 Never notify me: UAC is off.

To configure UAC through Control Panel, use the following procedure.

REVIEW UAC SETTINGS

GET READY. To review UAC settings, log on to Windows 10 using an account with adminis-
trator privileges and then perform the following steps.

1.  Click Start. Type uac and then from the results list, click Change User Account 
Control settings. The User Account Control Settings dialog box opens, as shown in 
Figure 2-3.
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2.  Read the current setting and then drag the slider up and down to each setting to
review its description:

• Always notify me

• Notify me only when apps try to make changes to my computer (default)

• Notify me only when apps try to make changes to my computer (do not dim
my desktop)

• Never notify me

3.  In the User Account Control Settings dialog box, click Cancel.

■■ Configuring Windows 10

The desktop (as shown in Figure 2-4) is the main screen area that you see when you first start 
the computer and log on to Windows. Like the top of an actual desk, it is where you perform 
your work by opening and running one or more applications. The desktop also includes the 
Recycle Bin, which is used to recover files that have been previously deleted.

At the bottom of the desktop, the taskbar displays icons that indicate which programs are 
running and allows you to switch between those running programs. The Start button is 
located at the left end of the taskbar.

Figure 2-3

Reviewing UAC settings

THE BOTTOM LINE

Windows 10 is a robust and flexible operating system that is made to work on and support 
a wide range of hardware. For example, Windows 10 can work on a tablet, a laptop, or a 
desktop computer. Windows 10 also supports mobile devices so that you can take your 
computer or device with you while accessing your files and programs.
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When you click the Start button, the Windows 10 Start menu opens, as shown in Figure 2-5. 
The Windows 10 Start menu is a blend of the Windows 7 Start menu and the Windows 8 
Start screen.

Figure 2-4

Viewing the Windows 10 
desktop

Figure 2-5

Opening the Windows 10 Start 
menu
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The left side of the Windows 10 Start menu lists the most used programs, and provides access 
to File Explorer, Settings, and other applications. When you right-click an installed applica-
tion, you can choose Pin to Start, which will attach the application to the Start menu, or you 
can choose More > Pin to attach the application to the taskbar.

When you have multiple windows open, you may want to minimize the windows by clicking 
the Show desktop button (at the right end of the taskbar), or by right-clicking the taskbar 
and choosing Show the desktop. If you grab a window’s title bar (at the top of the window) 
and shake it around, all other windows will minimize.

The right side of the Windows 10 Start menu displays tiles, which are larger than the icons 
found on the Windows desktop. Unlike the static desktop icons, tiles can contain dynamic 
content provided by the software they represent. For example, the tile for a web browser can 
contain a thumbnail of the currently open website, while the Messaging tile can display part 
of your latest incoming email. Tiles in Windows 10 that contain this type of dynamic content 
are called live tiles.

The tiles on the Start menu are configurable in a number of ways. Users can move the tiles 
around, change their size, change their groupings, and control whether they display live 
content. It is also possible to remove seldom-used tiles and add new tiles for applications, 
files, and shortcuts on the computer.

Introducing Windows 10 Settings

Click the Settings option on the Start menu to open the Settings application and access 
common Windows settings. The Settings application is based on the Modern UI interface, as 
shown in Figure 2-6. These settings are divided into the following categories:

•	 System: Allows you to configure the display, notifications and actions, apps and features, 
multitasking, tablet mode, power and sleep options, and default apps.

•	 Devices: Provides quick access to hardware devices, such as printers, which you can use 
with the currently selected app.

•	 Network & Internet: Keeps track of Wi-Fi connections and allows you to configure 
VPN, dial-up connections, Ethernet connections, and proxy settings.

•	 Personalization: Provides settings for the background, colors, lock screen, themes, and 
the Start menu.

•	 Accounts: Allows you to change the profile picture and add accounts.
•	 Time & language: Allows you to configure date and time, region and language, and 

speech settings.
•	 Ease of Access: Provides settings for Narrator, Magnifier, high contrast, closed captions, 

keyboard, and mouse.
•	 Privacy: Allows you to configure camera, microphone, speech, account information, 

contacts, calendar, messaging, and application settings for Wi-Fi and Bluetooth 
connections.

•	 Update & security: Allows you to configure Windows Update, activate Windows, per-
form backups and recoveries, and configure Windows Defender.

In Windows 10, many of the Windows configurations are done within the Settings 
application. These settings can be accessed by clicking the Start button and clicking 
Settings.
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Cortana is Microsoft’s new personal assistant that helps you find things on your PC, manage 
your calendar, locate files, chat with users, and search the internet. To see the search results, 
just type the text you want to find in the Ask me anything text box, as shown in Figure 2-7.

Figure 2-6

Accessing Windows settings

Figure 2-7

Using Cortana
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Using Control Panel

Clicking a category link provides a list of utilities in that category. Each utility listed within 
a category includes a link to open the utility, and under this link are several of the most fre-
quently performed tasks for the utility.

As with current and previous versions of Windows, you can change from the default Category 
view to classic view (Large icons view or Small icons view). Icons view is an alternative view 
that provides the look and functionality of Control Panel in Windows 2000 and earlier ver-
sions of Windows, in which all options were displayed as icons.

The Microsoft Management Console (MMC) is one of the primary administrative tools used 
to manage Windows and many of the network services provided by Windows. It provides 
a standard method to create, save, and open the various administrative tools provided by 
Windows. When you open Administrative Tools, most of these programs are MMC.

CERTIFICATION READY
What is the traditional 
tool used to configure 
general Windows 
settings?
Objective 1.1

USING A TOUCH SCREEN

Windows 10 can be used with a pointing device such as a mouse, or by using a touch screen. Operating a touch 
screen requires a familiarity with certain finger gestures, such as the following:

Tap: Press a fingertip to the screen and release it. The function is identical to that of a mouse click.
Double-tap: Press a fingertip to the screen twice in quick succession on the same spot. The function is iden-
tical to that of a double mouse click.
Press and hold: Tap a point on the screen and press for approximately two seconds. The function is the 
same as that of mousing over a designated spot and hovering.
Slide: Press a point on the screen and drag your finger without pausing. The function is the same as clicking 
and dragging with a mouse.
Swipe: Drag your finger across the screen in the indicated direction.

Prior to Windows 10, Control Panel was the primary graphical utility to configure 
the Windows environment and hardware devices. In Windows 10, it can be accessed 
by right-clicking the Start button and choosing Control Panel (see Figure 2-8). Eight 
categories are listed in Control Panel; each category includes a top-level link, and 
under this link are several of the most frequently performed tasks for the category.

Figure 2-8

Opening Control Panel
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Administrative Tools is a folder in Control Panel that contains tools for system administrators 
and advanced users. To access the Administrative Tools, right-click Start and choose Control Panel. 
Click System and Security > Administrative Tools while in Category view or click Administrative 
Tools while in icons view. There are also quick links to the administrative tools that can be accessed 
by clicking the Start button and clicking Windows Administrative Tools.

Some common administrative tools in this folder (as shown in Figure 2-9) include:

• Component Services: Configures and administers Component Object Model (COM)
components. Component Services is designed for use by developers and administrators.

• Computer Management: Manages local or remote computers by using a single, consol
idated desktop tool. Using Computer Management, you can perform many tasks, such as
monitoring system events, configuring hard disks, and managing system performance.

• Event Viewer: Shows information about significant events, such as programs starting or
stopping, or security errors that are recorded in event logs.

• iSCSI Initiator: Configures advanced connections between storage devices on a network.
• Local Security Policy: Shows and enables you to edit Group Policy security settings.
• ODBC Data Sources: Uses Open Database Connectivity (ODBC) to move data from

one type of database (a data source) to another.
• Performance Monitor: Shows advanced system information about the processor,

memory, hard disk, and network performance.
• Print Management: Manages printers and print servers on a network and performs

other administrative tasks.
• Services: Manages the different services that run in the background on your computer.
• System Configuration: Identifies problems that might be preventing Windows from

running correctly.
• System Information: Shows details about your computer’s hardware configuration,

computer components, and software, including drivers.
• Task Scheduler: Schedules programs or other tasks to run automatically.
• Windows Memory Diagnostic: Checks your computer’s memory to see whether it is

functioning properly.

Figure 2-9

Opening the Administrative 
Tools folder
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When you use these tools, you might assume that they are used only to manage the local 
computer. However, many of these tools can be used to manage remote computers as well. 
For example, you can use the Computer Management console to connect to and manage 
other computers if you have administrative rights to those computers.

Configuring System Options

To access the system settings, you can do one of the following:

• In Control Panel, if you are in Category view, click System and Security, and then click
System or click View amount of RAM and processor speed.

• In Control Panel, if in classic view, click System.
• In File Explorer, right-click This PC and choose Properties.
• Right-click Start and choose System.

In Windows, there are often several ways to do the same thing.

At the top of the System window, you see the Windows edition you have and the system 
type. If Windows comes in 64-bit, it will show 64-bit Operating System in the middle of the 
window. Toward the bottom of the window, you will see the computer name and domain (if 
any) if Windows is activated and the Product ID. See Figure 2-10.

To help identify computers, you should assign a meaningful name to each computer. This 
can be done in the System settings within Control Panel. You can also add a computer to a 
domain or workgroup.

Some of the most important configuration settings for a user are the system settings 
within Control Panel. These include gathering generation information about your 
system, changing the computer name, adding the computer to a domain, accessing the 
Device Manager, configuring remote settings, configuring startup and recovery options, 
and configuring overall performance settings.

Figure 2-10

Displaying System settings
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Every computer assigned to a network must have a unique computer name. If two computers 
have the same name, one or both of the computers will have trouble communicating on the 
network. To change the computer name, open System from Control Panel, or open System 
by right-clicking Start and choosing System. Then click the Change settings option in the 
Computer name, domain, and workgroup settings area. In the System Properties dialog box, 
on the Computer Name tab, click the Change button. See Figure 2-11. Any changes to the 
computer name or workgroup/domain name will require a reboot.

By default, a computer is part of a workgroup. A workgroup is usually associated with a peer-to-
peer network in which user accounts are decentralized and stored on each individual computer. 
If several users need to access the computer (while requiring unique usernames and passwords), 
you will need to create a user account for each user. If you want those users to access another 
stand-alone computer, you will have to create the same computer accounts and passwords on 
that computer as well. As you can imagine, with several computers, this can become a lot of 
work as you keep creating and managing accounts on each individual computer.

A domain is a logical unit of computers that define a security boundary, and it is usually 
associated with Microsoft’s Active Directory Domain Services (AD DS). The security of the 
domain is generally centralized and controlled by Windows servers acting as domain con-
trollers. As a result, you can manage the security much easier for multiple computers while 
providing better security.

When a computer is added to a domain, a computer account is created to represent the 
computer. In addition, information stored on the computer is used to uniquely identify the 
computer. When these items match, it shows that a computer is correctly identified, which 
contributes to a more secure work environment.

To add the computer to the domain, open System Properties and click Change. Next, click 
the Domain option, type the name of the domain, and then click OK. Windows will prompt 
you to log on with a domain account that has the capability to add computers to the domain. 
This is typically a domain administrator or account administrator. After you enter the creden-
tials (username and password), a Welcome dialog box opens. Click OK to close the Welcome 
dialog box. When you close the System Properties dialog box, Windows will prompt you to 
reboot the computer.

Figure 2-11

Displaying System Properties



    Understanding Operating System Configurations  |  37

To remove a computer from a domain, join an existing workgroup, or create a new 
workgroup, click the Workgroup option, type the name of the workgroup, and then 
click OK. If you are removing yourself from the domain, Windows will prompt you for 
administrative credentials so that your account can be deleted from Active Directory. If you 
don’t specify administrative credentials, Windows will still remove the computer from the 
domain, but the computer account will remain within Active Directory.

Changing the Date and Time

To access the date and time settings, perform one of the following methods:

•	 Click Clock, Language, and Region in Control Panel while in Category view and click 
Set the time and date to open the Date and Time dialog box.

•	 Click Date and Time while in Large icons or Small icons view to open the date and 
Time dialog box.

•	 Open Settings and then click Time & language to open the Date and time page.
•	 Right-click the date or time on the taskbar and choose Adjust date/time to open the 

Date and time page.

To set the date or clock, follow these steps:

1.	 In the Date and Time dialog box, click the Date and Time tab and click Change 
date and time.

2.	 To change the clock, double-click the hour, minutes, or seconds, and click the arrows to 
increase or decrease the value.

3.	 To change the date, click the left or right arrows to change the month and then click the 
correct day of the month.

4.	 When you are finished changing the time settings, click OK.

To change the time zone, on the Date and Time tab, click Change time zone and then click 
your current time zone in the drop-down list. Click OK.

If you are part of a domain, the computer should be synchronized with the domain controllers. 
If you have a computer that is not part of a domain, you can synchronize with an internet 
time server by clicking the Internet Time tab, clicking Change settings, and then selecting the 
Synchronize with an Internet time server check box. Select a time server and then click OK.

Configuring the Desktop and Taskbar Settings

The Windows desktop is a flexible, configurable part of the Windows environment. You can 
grab the taskbar and move it to either side of the screen, to the top, or back to its default 
location at the bottom. The taskbar must be unlocked to move it—right-click the taskbar 
and, if Lock all taskbars is selected, click Lock all taskbars to clear the selection.

One of the easiest but most essential Windows tasks is making sure that the computer 
has the correct date and time, which is essential for logging purposes and for security. 
If a secure packet is sent with the wrong date or time, the packet may be automatically 
denied because the date and time are used to determine whether the packet is legitimate.

Windows desktop settings is a broad term that refers to many different settings you 
can configure to personalize Windows, such as the Windows theme, the desktop 
background, mouse clicks and pointer speeds, gadgets, shortcuts, and more. All settings 
are customizable—choosing the right mix will make your Windows experience more 
enjoyable and more productive.
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To modify it further, open Settings and then click Personalization > Taskbar to open the 
Taskbar page (see Figure 2-12). Options on this page include hiding the taskbar, using small 
taskbar buttons, and replacing Command Prompt with Windows PowerShell, among other 
selections. When you scroll down, you can modify the notification area (including selecting 
which icons appear on the taskbar) and you can turn system icons on or off.

The Toolbars tab allows you to specify which toolbars can be added to the taskbar. The 
default available toolbars include:

• Address: Allows you to type a Uniform Naming Convention (UNC) or Uniform
Resource Locator (URL). The UNC uses a \\servername\sharefolder format; a URL is a
website address.

• Links: Displays Microsoft Edge favorites.
• Desktop: Allows you to access all shortcuts on the desktop and File Explorer including

Libraries, This PC, Control Panel, and Recycle Bin.

With Windows 10, you can pin program shortcuts directly to the taskbar. When you pin 
a program, the icon for that program displays on the taskbar even when the program isn’t 
running. This provides you with quick access to your frequently used programs. Shortcuts for 
Task View, Microsoft Edge, File Explorer, and Store appear there by default. You can unpin 
programs from the taskbar as well. You’ll learn about shortcuts later in the lesson.

When you open a program in Windows 10, an icon for that program displays on the taskbar. 
To activate a program, just click its icon on the taskbar. If you have several programs open 
at once, Windows allows you to hover the mouse pointer over an icon in the taskbar to see a 
thumbnail preview of the window. This thumbnail preview is called a Jump List. You can also 
press and hold the Alt key and then press the Tab key repeatedly to switch between windows 
and see live previews of the window for each open program.

Many Windows 10 desktop settings are available when you right-click a blank area of the 
desktop and choose Personalize. The Personalization window is shown in Figure 2-13.  

Figure 2-12

Opening the Taskbar page
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The main part of the window displays various themes you can use. Just click the theme of 
your choice and see the changes take effect immediately.

You can also change the background of any theme. In the Personalization window, click 
Background. In the Background window, open the Picture drop-down list, and then select a 
picture, a solid color, or a slideshow.

When you click the Themes option and then click Advanced sound settings, the Sound 
dialog box opens (see Figure 2-14). From here you can choose different sounds to accompany 
Windows events, such as when you connect a device or when you close Windows. The com-
puter’s sound volume must be set at an appropriate level to actually hear the sound.

Figure 2-13

The Personalization window

Figure 2-14

The Sound dialog box
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In the Personalization window, click the Lock screen option and click the Screen saver settings 
option. The Screen Saver Settings dialog box opens (see Figure 2-15). In the Screen saver 
drop-down list, click a screen saver and click OK.

Configuring the Start Menu

To pin an item to the Start screen, find a program or file in the Start menu, by using Cortana 
or by using File Explorer. Then right-click the program, application, or folder and choose 
Pin to Start. Some tiles allow for additional actions. For example, if you pin This PC to the 
Start menu, you can quickly open Computer Management or System Properties, or connect/
disconnect network drives.

Configuring File Explorer Settings

To open File Explorer, click the File Explorer tile on the taskbar, or double-click any folder on 
the desktop. To configure File Explorer, open the Folder Options dialog box.

CONFIGURE FILE EXPLORER SETTINGS

GET READY. Log on to Windows 10 using an account with Administrator privileges.
1.  To open File Explorer, click the File Explorer icon on the taskbar.

2.  In the File Explorer window, click the View tab.

3.  At the end of the View tab, click Options. The Folder Options dialog box opens
with the General tab active (see Figure 2-16).

Figure 2-15

Configuring the screen saver

Windows 10 uses the Modern UI style that includes the Start menu. The Start menu 
contains a list of applications and desktop programs along with pinned tiles. The pinned 
tiles have different sizes and colors. In addition, you can pin folders to the new Start screen.

File Explorer, previously known as Windows Explorer, is the file manager that is included 
with Windows operating systems. It provides a graphical user interface to access and manage 
the file system, including opening files, moving and copying files, and deleting files.
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4.  To configure each folder to open in its own window, click the Open each folder in 
its own window option.

5.  Click the View tab.

6.  To show hidden files, folders, and drives, click the Show hidden files, folders, and 
drives option.

7.  To show the file extensions, clear the Hide extensions for known file types check 
box.

8.  To close the Folder Options dialog box, click OK.

Configuring User Profiles

The user state includes the following components:

•	 User registry: When a user logs on, the current settings are copied from HKEY_USERS 
to HKEY_CURRENT_USER. When a user logs off, those settings, including any set-
tings that were changed during the current session, are copied back to HKEY_USERS. 
On computers that run Windows 10, each user’s settings are stored in their own files, 
named Ntuser.dat and Usrclass.dat, located in the Users folder on the boot volume (usu-
ally the C:\Users folder).

•	 Application data: The AppData folder contains mostly application settings that 
are specific to a user. The AppData folder provides separation for user-related and 

Figure 2-16

Configuring folder options

When a user logs on to Windows, the user has a user state that is captured in the user’s 
profile. A user state is the collection of data and settings that pertain to each user. It 
describes settings and data that determine the user environment. The user state separates 
the user environment, files, and settings from the files and settings that are specific to the 
installed operating system and those that belong to installed applications. When a user 
logs on, the user state is kept separate from other users on the same computer. The user 
state includes users’ data and their application or operating system configuration settings.
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computer-related application settings. The AppData folder is located in the Users folder 
on the boot volume (usually the C:\Users folder).

• User data: User-specific data is stored in multiple folders, which include Documents,
Favorites, Pictures, and Music.

A user profile is a series of folders, associated with a specific user account that contains 
personal documents, user-specific registry settings, desktop theme, internet favorites, and 
other personalized information—everything that provides a user’s familiar working environ-
ment. On a Windows 10 computer, user profiles are stored in the Users folder, within sub-
folders named for the user accounts.

On computers running Windows 10, user profiles automatically create and maintain the desktop 
settings for each user’s work environment on the local computer in a folder beneath C:\Users. 
The system creates a new user profile for each user logging on at the computer for the first time.

Each user folder contains a separate user profile for that person. A typical user profile (as 
shown in Figure 2-17) consists of the following folders, some of which are hidden, plus a 
hidden registry file:

• AppData
• Contacts
• Desktop
• Documents
• Downloads
• Favorites
• Links
• Music
• Pictures
• Saved Games
• Searches
• Videos

Figure 2-17

Viewing a user’s profile in the 
Users folder
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When a user logs on at the workstation using a local or domain account, the system loads 
that individual’s profile and uses it throughout the session until the user logs off. During the 
session, the Documents folder in the user’s profile becomes the operative Documents folder 
for the system, as do all the other folders in the profile.

Configuring Folder Locations

When you redirect the folder by specifying a different folder location, you will still be able to 
access the folder the same way you did before. The following exercise shows you how to man-
ually change the folder location on the local system.

CONFIGURE A FOLDER LOCATION

GET READY. To configure a folder location in Windows 10, perform the following steps.
1.  Log on to LON-CL1 as adatum\administrator with the password of Pa$$w0rd.

2.  Click the File Explorer icon on the taskbar.

3.  Right-click the folder that you want to redirect (such as the Desktop, Documents,
Pictures, Music, or Videos folder) and choose Properties.

4.  Click the Location tab, as shown in Figure 2-18.

You can change the location of your personal folders, such as Documents, Music, or 
Pictures, by specifying a different folder location. Therefore, if one or more of these 
personal folders grow or the primary drive becomes filled up, you can move the location 
to another drive or a shared network folder.

Figure 2-18

Specifying folder locations
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5.  Click Move.

6.  In the Select a Destination dialog box, browse to and click the location. You can
also specify a local path or network path in the Folder text box and press Enter.
Next, click Select Folder.

7.  Click a folder in the new location where you want to store the files, click Select
Folder, and then click OK.

To restore the folder back to the default location, click the Restore Default button on the 
Location tab.

Configuring Libraries

In Windows 10, a library is a virtual folder that can display content from different loca-
tions (folders, for example) on your computer or an external drive. You access libraries in File 
Explorer, just like you do files and folders.

To show libraries in File Explorer, click the View tab, and then click Navigation pane > Show 
libraries. Windows 10 includes the following default libraries (see Figure 2-19):

• Documents library: Stores word-processing documents, spreadsheets, and similar files.
• Music library: Stores audio files, such as those you’ve downloaded from the web, trans-

ferred from a portable device (music player), or ripped from a CD.
• Pictures library: Stores digital image files.
• Videos library: Stores video files.

If multiple users share a Windows 10 system, each user will have his or her own separate 
libraries and folders, which are stored in the C:\Users\username folder.

CERTIFICATION READY
Which default libraries 
are included with 
Windows 10?
Objective 4.4

Libraries were introduced in Windows 7. A library looks like an ordinary folder, but is 
a virtual folder that simply points to files and folders in different locations on a hard 
drive, network drive, or external drive.

Figure 2-19

Default libraries in Windows 10
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When creating a new library, you must include at least one folder within the library for orga-
nizational purposes. You can then copy, move, or save files to the folder in the library. You 
can add a location such as a folder on your C: drive, a second hard drive in your computer, or 
an external drive to an existing library.

ADD A FOLDER TO A LIBRARY

GET READY. To add a folder to a library, perform the following steps.
1.  Click the File Explorer icon on the taskbar.

2.  When File Explorer opens, locate and click the folder you want to include in a 
library. The folder cannot already be included in another library.

3.  Right-click the folder, choose Include in library, and then click a library (such as 
Documents, Music, Pictures, or Videos).

You can also include external drives in a library, as long as the folder is indexed for search 
or available offline. Make sure the external hard drive is connected to your computer and 
that your computer recognizes the device. You can’t include content on removable media, 
such as a CD or DVD, in a library. Some USB flash drive devices don’t work with libraries 
either.

To remove a folder, navigate to the library in the File Explorer navigation pane, right-click the 
folder you want to remove and then choose Remove location from library.

You can also create your own library.

CREATE A LIBRARY

GET READY. To create a library, perform the following steps.
1.  Click the File Explorer icon on the taskbar.

2.  If the Libraries don’t appear in the navigation pane, click the View tab and then 
click Navigation pane > Show libraries.

3.  In the Navigation pane, right-click Libraries and choose New > Library.

4.  A Library node will appear with the default name New Library. Rename the Library 
to whatever you choose, such as Personal Library.

5.  Click the new library.

6.  Because the Library was just created, it is empty. Click the Include a folder button.

7.  In the Include Folder in New Library dialog box, navigate to the desired folder and 
click Include folder.

Configuring Display Settings

When you right-click the desktop and choose Display Settings, the Display page appears, 
allowing you to change the orientation and the size of the text (see Figure 2-20).

Windows 10 has several display settings. The settings you’ll most likely modify include 
the resolution, color depth, and font size. You can modify each setting to suit a 
particular application.
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To open the Windows 10 Advanced Display Settings page (as shown in Figure 2-21), click 
Advanced display settings. This is where you choose which monitor to use (if your computer 
is connected to two or more monitors) and whether to display content in a landscape orien-
tation or a portrait orientation. You can also configure settings to connect a projector to your 
computer. Three other important display settings you might want to adjust for specific pur-
poses are resolution, color depth, and font size.

Figure 2-20

Opening the Settings Display 
page

Figure 2-21

Opening the Advanced Display 
Settings page
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Resolution refers to the number of pixels that create the image, that is, everything you see 
on the screen. Resolution has a horizontal value and a vertical value, such as 1200 × 768 or 
1600 × 900. The Windows desktop expands itself to fit whatever resolution you select, so you 
always have a full background. Similarly, the taskbar stretches across the bottom of the screen, 
regardless of the resolution you choose.

You might need to change a computer’s screen resolution for a variety of reasons, such as 
when you’re accommodating a visually impaired user or when you’re using an external pro-
jector. Your computer’s monitor has a minimum and a maximum resolution it can display, so 
Windows 10 gives you a range of resolutions from which to choose.

Screen fonts are usually measured in dots per inch (dpi). You can enhance the appearance of 
your desktop by adjusting font size dpi to improve the readability of pixelated or illegible fonts.

Configuring Power Settings

Sleep mode is a low-power mode for computers that uses a minimum amount of power so 
that the system can be quickly restored back to the previous state without rebooting the com-
puter. Sleep mode is useful when you want to stop working for a short period of time and 
quickly pick up where you left off. For older versions of Windows and other operating sys-
tems, sleep mode is referred to as Stand By mode, Suspend mode, or Suspend to RAM.

Before continuing to the next section, you should understand the difference between sleep 
mode, hibernate mode, and hybrid sleep. Hibernate mode saves all computer operational 
data on the hard drive to a hibernation file (Hiberfil.sys) before turning the computer com-
pletely off. In other words, hibernate mode is a suspend to disk. When the computer is 
turned back on, the computer is restored to its previous state with all programs and files open 
and unsaved data intact. Hibernate mode will be discussed later in this lesson.

In Windows 10, simple power management settings can be accessed by opening Settings and 
clicking System > Power & Sleep, as shown in Figure 2-22. The screen settings allow you to 
specify how long the screen will remain on if you are not actively using your computer when 
the computer is using battery power or when it is using AC power (plugged in). The sleep 
settings will specify how long the computer will operate before going into sleep mode when 
the computer is using battery power or when it is using AC power.

Figure 2-22

Configuring Power settings
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Hybrid mode is a combination of sleep mode and hibernate mode. Hybrid mode writes 
information to the hibernation file when the computer enters a sleep state, which allows for a 
fast wake time. If the system loses power completely and suddenly, you can restore operations 
from the hibernation file.

Power management is balancing power consumption with performance. Windows 10 
includes extensive power management capabilities, including supporting the Advanced 
Configuration and Power Interface (ACPI), which can be configured using power plans. The 
power plans can be configured using Control Panel Power Options, using Group Policy, or 
via the command prompt.

Power Options is the primary interactive power configuration interface that can be used to 
select the power plan, modify the settings for the default power plans, and create new, custom 
power plans.

A power plan is a collection of hardware and system settings that manage how a computer 
uses power. Windows 10 includes three default power plans:

•	 Balanced (recommended): Balances performance with power-saving features.
•	 Power Saver: Saves power by reducing PC performance and screen performance so that 

you can maximize battery life.
•	 High Performance: Maximizes screen brightness and PC performance.

Table 2-1 shows the default power plan settings.

Table 2-1

Default Power Plan Settings

Power Setting Power Saver Balanced High Performance

Wireless adapter 
power-saving mode

Maximum Power Saving  
(battery) Maximum 
Performance (AC)

Medium Power Saving 
(battery) Maximum 
Performance (AC)

Maximum Performance  
(battery) Maximum 
Performance (AC)

Dim the display 1 minutes (battery)  
2 minutes (AC)

2 minutes (battery)  
5 minutes (AC)

5 minutes (battery)  
10 minutes (AC)

Turn off the display 2 minutes (battery)  
5 minutes (AC)

5 minutes (battery)  
10 minutes (AC)

10 minutes (battery)  
15 minutes (AC)

Put the computer to 
sleep

10 minutes (battery)  
15 minutes (AC)

45 minutes (battery) Never 
(AC)

Never (battery) Never (AC)

Adjust plan brightness 40% (battery) 100% (AC) 50% (battery) 100% (AC) 100% (battery) 100% (AC)

Turn off hard disk 5 minutes (battery)  
20 minutes (AC)

10 minutes (battery)  
20 minutes (AC)

20 minutes (battery)  
20 minutes (AC)

Minimum processor 
state

5% (battery) 5% (AC) 5% (battery) 5% (AC) 5% (battery) 100% (AC)

System cooling policy Passive (battery) Passive (AC) Passive (battery) Active (AC) Active (battery) Active (AC)

Maximum processor 
state

100% (battery) 100% (AC) 70% (battery) 100% (AC) 100% (battery) 100% (AC)
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To select one of the default power plans, you can use either of the following procedures:

• Open the Windows Mobility Center and, in the Battery Status tile, click one of the
plans from the drop-down list.

• Open Control Panel, click Hardware and Sound > Power Options, and then click the
radio button for the desired plan, as shown in Figure 2-23. To display the Power Saver
option, you must click the Show additional plans down arrow. If these options are
grayed out, click the Change settings that are currently unavailable option.

You can use Control Panel Power Options to modify a power plan or to create a new power 
plan. To create a custom power plan, use the following procedure.

CREATE A CUSTOM POWER PLAN

GET READY. Log on to Windows 10 using an account with Administrator privileges and per-
form the following steps.

1.  On LON-CL1, open Control Panel and then click Hardware and Sound > Power
Options.

2.  On the Power Options page, click Create a power plan.

3.  In the Create a Power Plan Wizard, click the radio button for the default power
plan that will be the basis for your new plan.

4.  In the Plan name text box, type a name for your power plan and click Next.
5.  On the Change Settings for the Plan page, modify the display and sleep settings

as desired for the On battery power state and the Plugged in power state and click
Create. The Choose or Customize a Power Plan page appears.

6.  For the new plan, click the Change plan settings option.

The Change Settings for the Plan page appears again.

Figure 2-23

Viewing the Power Options 
page
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7.  When the Change Settings for the Plan page opens, click Change advanced power
settings. The Power Options dialog box opens with the Advanced settings tab
shown (see Figure 2-24).

8.  Modify any of the settings as desired and click OK.

9.  Click Save changes to close the Change Settings for the Plan page.

The Advanced settings give you a high degree of control for the power plans. Some of the 
options include:

• Hard Disk: Turn Off Hard Disk After: Specifies the amount of time of inactive use
before a mechanical disk will stop spinning.

• Wireless Adapter Settings: Power Savings Mode: Allows you to control power by
selecting one of the following options: Maximum Performance, Low Power Saving,
Medium Power Saving, and Maximum Power Saving. If you need a fast internet connec-
tion, click the Maximum Performance or Low Power Saving option. If you don’t need
Wi-Fi, turn your Wi-Fi antenna off when you aren’t using it.

• Sleep after: Specifies how long a machine will sleep after inactive use.
• Allow Hybrid sleep: Enables Hybrid sleep mode.
• Hibernate: Specifies when a machine goes into hibernation.
• Allow wake timers: Allows a system to be woken up from sleep mode to perform tasks

at certain times, such as Windows updates.

Configuring Accessibility Options

Figure 2-24

Configuring advanced power 
settings

Microsoft has built many features into Windows 10 that work with assistive technologies 
or as stand-alone features that improve the user experience for people who are deaf or 
visually impaired. Most accessibility features can be configured in the Ease of Access Center.
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The Ease of Access Center (see Figure 2-25) provides many accessibility options, which help 
users who are deaf or visually impaired use Windows more easily and efficiently. The primary 
tools include Magnifier, Narrator, On-Screen Keyboard, and High Contrast.

Magnifier helps visually impaired users see a selected portion of the screen or the entire screen 
more clearly by increasing the size of text and graphics. The Magnifier application window 
is quite small and provides you with access to Magnifier settings. Here you can set a certain 
magnification level and choose how the magnification “lens” follows the mouse pointer and 
text cursor. The lens looks like a magnifying glass icon on the screen.

Narrator is a text-to-speech program that reads aloud the actions you take, such as clicking 
and typing. This feature can also narrate certain events, such as error messages.

On-Screen Keyboard (see Figure 2-26) presents a keyboard on your screen from which you 
can type and enter data (rather than using a keyboard). You can use a mouse, stylus, or 
another pointing device to “press” keys.

Another accessibility feature is the High Contrast theme (see Figure 2-27), a color scheme 
that makes some text easier to read and some images easier to identify on-screen.

CERTIFICATION READY
What is the primary 
purpose of Windows 10’s 
accessibility options?
Objective 1.1

Figure 2-25

The Ease of Access Center tools

Figure 2-26

The On-Screen Keyboard 
presents a fully functional 
keyboard
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The bottom portion of the Ease of Access Center window includes other accessibility options 
you can configure for users who are deaf or visually impaired, including:

•	 Using the computer without a display
•	 Making the computer easier to see
•	 Using the computer without a mouse or keyboard
•	 Making the mouse easier to use
•	 Making the keyboard easier to use
•	 Using text or visual alternatives for sounds
•	 Making it easier to focus on tasks

Speech Recognition is an accessibility feature that you access in the Ease of Access category 
in Control Panel. This tool allows a user to speak commands into a microphone, which 
Windows then processes. All speech recognition programs require a sometimes-lengthy 
training period in which the user “teaches” the computer to recognize the user’s voice. You 
can learn more about the Windows Speech Recognition feature in Help and Support (click 
Start, type speech recognition in the search box, and then press Enter).

USE ACCESSIBILITY FEATURES

GET READY. To enable accessibility features, open the Ease of Access Center in Control Panel 
and then perform the following steps.

1.  To use Magnifier, click Start Magnifier. When the application name displays, click it. 
A small application window displays a magnifier glass icon. Click the level of magni-
fication in the window and then move the magnifier glass icon around the screen.

2.  To use Narrator, click Start Narrator. The Narrator Settings dialog box opens (see 
Figure 2-28). Now when you type text or navigate text on the screen, Narrator reads 
it aloud. To turn Narrator off, click Exit in the Microsoft Narrator and then click OK.

Figure 2-27

The High Contrast settings
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The steps are similar for On-Screen Keyboard and High Contrast. Just click Start On-Screen 
Keyboard or Set up High Contrast and follow the prompts.

Creating and Managing Shortcuts

An icon is a small, visual symbol of a computer resource, such as a program, folder, file, or 
drive. To access an actual computer resource, click or double-click its icon. Some icons are 
located on the desktop, others are in the Start menu, and still others might appear in the list 
of files and folders in File Explorer.

A shortcut (see Figure 2-29) is an icon or link that gives you quick access to an original 
resource. The links you see in Control Panel are also considered shortcuts. Because a shortcut 
only points to a resource, deleting a shortcut does not delete the actual item. You can usually 
distinguish a shortcut icon from the original item it refers to because the shortcut has a small 
arrow in the shortcut icon’s lower-left corner.

If you regularly access a particular folder, for example, you can create a shortcut to that folder 
on the desktop. Whenever you want to open that folder, double-click the icon instead of 
launching File Explorer and navigating to the folder to open it.

CERTIFICATION READY
What is a shortcut?
Objective 1.2

Figure 2-28

Configuring Narrator settings

Shortcuts are icons you can click to start a program or go to a location without 
requiring any extra steps. Shortcuts save time because you don’t have to use several 
keystrokes or click several menus or commands.

Figure 2-29

An example of a shortcut icon
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CREATE AND DELETE A SHORTCUT

GET READY. To create a folder shortcut on the desktop, perform the following steps.
1.  In File Explorer, point to the folder for which you want to create a shortcut.

2.  Right-click the folder and choose Send to > Desktop (create shortcut) (see
Figure 2-30). The shortcut now displays on your desktop.

To delete a shortcut icon, follow these steps:
1.  Right-click the icon and choose Delete.

2.  Click OK. The shortcut is removed and sent to the Recycle Bin.

■■ Configuring Hyper-V

The Hyper-V is a hypervisor, sometimes called a virtual machine monitor (VMM), and is 
responsible for managing the computer’s physical hardware and creating multiple virtualized 
hardware environments, called virtual machines.

Client Hyper-V, a Microsoft replacement for Windows Virtual PC, provides the same vir-
tualization capabilities as Hyper-V in Windows Server 2012 R2 and Windows Server 2016. 
Although it does not include all the advanced features available on the server version, it does 
utilize the same interface and underlying technology. By default, the Hyper-V feature is not 
installed on Windows 10 machines.

Although Client Hyper-V runs only on Windows 10 (64-bit) machines running the 
Windows 10 Professional, Enterprise, or Education (64-bit) operating system, it enables you to 
run 32- and 64-bit VMs simultaneously, connect to a Hyper-V machine running on another 
computer, and move machines between Client Hyper-V and Hyper-V running on the server.

Figure 2-30

Creating a shortcut on the 
desktop

THE BOTTOM LINE

Client Hyper-V enables you to create and manage virtual machines (VMs) using a virtual 
switch. These VMs can be used to test your applications for compatibility with new 
operating systems, allow you to run applications written for older versions of Windows, or 
isolate an application. The physical machine that Hyper-V and the virtual machines run on 
is often referred to as the host.
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Using this feature, you can build a test lab that runs entirely on a single computer. For 
example, if you need to test an application’s compatibility with several different configurations 
of Windows 10, you can create a VM for each configuration. After your testing is complete, 
you can easily remove the VMs or export them to your production network.

To run Hyper-V, you need the following:

• Windows 10 Professional, Enterprise, or Education (64-bit) edition
• A 64-bit processor that incorporates second level address translation (SLAT) technology
• A minimum of 4 GB of memory (running more than one VM at a time requires more)

ENABLE THE HYPER-V FEATURE

GET READY. To enable the Hyper-V feature, log on to the computer running Windows 10 
Enterprise (64-bit) with Administrator privileges and perform the following steps.

1.  On LON-CL1, right-click Start and choose Control Panel.
2.  In the Search Control Panel text box, type Features. Then from the Results list,

click Turn Windows features on and off.
3.  Click the + next to the Hyper-V folder, as shown in Figure 2-31.

4.  Select the Hyper-V check box and click OK.

Windows searches for the required files and then applies the changes to the
computer.

5.  Click Close.

6.  Restart your computer to complete the installation.

A restart starts the Windows hypervisor and the Virtual Machine Management
service.

After installing Client Hyper-V, you see two new tiles after logging on with the administrative 
account:

• Hyper-V Manager (see Figure 2-32): This is the management console for creating and
managing your VMs and setting up your test network.

• Hyper-V Virtual Machine Connection: This is used when working with a single VM
that you have already created. It is very similar to the Remote Desktop Connection
utility.

Figure 2-31

Enabling the Hyper-V feature 
on Windows 10 Enterprise
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Creating and Configuring Virtual Machines

Within the Hyper-V Manager console, you can import VMs (Action > Import Virtual 
Machine) and create virtual hard disks (Action > New > Virtual Machine) to be used by VMs 
or by the host PC. You can also manage a VM’s configuration by modifying the startup order 
of devices (for example, CD, IDE, network adapter, floppy), allocate memory, determine the 
number of virtual processors to use, and add hard drives/CD drives to an IDE/SCSI controller.

When you create a virtual machine, you must define the virtual machine’s virtual hardware, 
including:

• The name of the virtual machine
• The location where the virtual machine will be stored
• The VM generation
• How much memory the virtual machine will use
• The virtual switch the virtual machine is connected to
• A virtual hard disk used by the operating system
• The operating system installation options

When you create virtual machines in Hyper-V, you have to choose one of the two virtual 
machine generations:

• Generation 1: Provides the same virtual hardware used in older versions of Hyper-V.
Generation 1 VMs support 32-bit and 64-bit guest operating systems.

Figure 2-32

Opening the Hyper-V Manager 
console

A virtual machine (VM) is a self-contained, isolated unit that can be easily moved 
from one physical computer to another, runs its own operating system, and includes its 
own virtual hardware configuration.
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• Generation 2: Provides new functionality on a virtual machine, including PXE boot by
using a standard network adapter, boot from a SCSI virtual hard disk or DVD, Secure Boot,
and UEFI firmware support. Generation 2 VMs only support 64-bit guest operating systems.

Once a virtual machine has been created, you cannot change its generation.

When creating and configuring a virtual machine, you can specify how much memory is 
assigned to a virtual machine. The startup RAM specifies the amount of memory that you 
want to allocate to the VM when it starts. When you are using Dynamic Memory, this value 
can be the minimum amount of memory needed to boot the system.

In Windows 10, Dynamic Memory is enabled by default. Dynamic Memory reallocates 
memory automatically to the VM from a shared memory pool as its demands change. If a 
virtualized server needs more memory, Hyper-V can increase the memory allocated to the 
system, and then reduce it when the traffic subsides.

CREATE A VIRTUAL MACHINE

GET READY. To create a virtual machine in Hyper-V running on Windows 10, perform the 
following steps.

1.  On LON-CL1, right-click Start and choose Control Panel.
2.  In the Search Control Panel text box, type Administrative Tools. Then from the

search results, click Administrative Tools.
3.  In the Administrative Tools window, double-click Hyper-V Manager. If you are

prompted to confirm if you want to allow this app to make changes to your PC,
click Yes.

4.  Right-click the host and choose New > Virtual Machine.

5.  In the New Virtual Machine Wizard, on the Before You Begin page, click Next.
6.  On the Specify Name and Location page (as shown in Figure 2-33), in the Name

text box, type the name of the virtual machine.

7.  The default location to store the VM is C:\ProgramData\Microsoft\Windows\Hyper-V\
folder. Click Next.

Figure 2-33

Creating a virtual machine
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8.  On the Specify Generation page, Generation 1 is already selected. Click Next.
9.  On the Assign Memory page, the default startup memory is 1024. In the Startup

memory box, type 2048. Click Next.
10.  Normally, you would select a virtual switch. However, because a virtual switch is

not configured yet, on the Configuring Networking page, click Next.
11.  On the Connect Virtual Hard Disk page (as shown in Figure 2-34), change the size

to 50 GB. Click Next.

12.  On the Installation Options page, click Install an operating system from a boot-
able CD/DVD-ROM, as shown in Figure 2-35.

Figure 2-34

Creating a virtual hard disk

Figure 2-35

Specifying Installation Options



    Understanding Operating System Configurations  |  59

13.  Click Image file (.iso) and click Browse. In the Open dialog box, browse to and 
double-click a Windows installation ISO file. Click Next.

14.  On the Summary page, click Finish.

After the virtual machine is installed, you have to install an operating system, just as you 
would have to install an operating system on a physical machine. Some of the operating 
systems that Hyper-V supports are:

•	 Windows 10
•	 Windows 8.1
•	 Windows 8
•	 Windows 7 with SP1
•	 Windows 7
•	 Windows Vista with SP2
•	 Windows Server 2012 R2
•	 Windows Server 2012
•	 Windows Server 2008 R2 with SP1
•	 Windows Server 2008 with SP2
•	 Windows Small Business Server 2011
•	 CentOS and Red Hat Enterprise Linux
•	 Debian virtual machines on Hyper-V
•	 SUSE
•	 Oracle Linux
•	 Ubuntu
•	 FreeBSD

In some cases, the Hyper-V guest operating system does not function properly using the 
default drivers that are installed. For these operating systems, you can install guest integration 
services, which includes drivers for Hyper-V. It also supports operating system shutdown, 
time synchronization, and backup support. However, Windows 10, Windows 8/8.1, 
Windows Server 2012, Windows Server 2012 R2, and Windows Server 2016 already include 
the guest integration services.

INSTALL GUEST INTEGRATION SERVICES

GET READY. To install guest integration services, perform the following steps.
1.  On LON-CL1, in the Server Manager window, click Tools and click Hyper-V 

Manager. The Hyper-V Manager console opens.

2.  In the left pane, click a Hyper-V server.

3.  In the Actions pane, start the virtual machine on which you want to install the guest 
integration services and click Connect. A Virtual Machine Connection window opens.

4.  In the Virtual Machine Connection window, click Action and click Insert 
Integration Services Setup Disk. Hyper-V mounts an image of the guest 
integration services disk to a virtual disk drive and displays an Autoplay window.

5.  Click Install Hyper-V Integration Services. A message box appears, prompting you 
to upgrade the existing installation.

6.  Click OK. The system installs the package and prompts you to restart the computer.

7.  Click Yes to restart the computer.
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Creating and Managing Virtual Switches

Hyper-V includes three types of virtual switches:

• External: Creates a virtual switch that binds to the physical network adapter. This
enables your VMs to access your physical network.

• Internal: Creates a virtual switch that is used only by the VMs that run on the physical
computer and between the VMs and the physical host computer.

• Private: Creates a VM that can only be used by the VMs running on the computer.

To create a virtual switch, in the Actions pane, click Virtual Switch Manager. In the Virtual 
Switch Manager dialog box, click the type of switch to use and click Create Virtual Switch. If 
you select the external switch type, you need to specify the physical network adapter (on the 
host) to connect the switch to.

CREATE A VIRTUAL SWITCH

GET READY. To create a virtual switch in Hyper-V running on Windows 10, perform the fol-
lowing steps.

1.  On LON-CL1, right-click Start and choose Control Panel.
2.  In the Search Control Panel text box, type Administrative Tools. Then from the

search results, click Administrative Tools.
3.  In the Administrative Tools window, double-click Hyper-V Manager. If you are prom

pted to confirm if you want to allow this app to make changes to your PC, click Yes.
4.  In the Actions pane, click Virtual Switch Manager. The Virtual Switch Manager

dialog box opens, as shown in Figure 2-36.

Figure 2-36

Selecting the type of virtual 
switch

To set up a test network that includes multiple systems, you need to configure a virtual 
switch using the Virtual Switch Manager. This enables your VMs to communicate with 
each other and access your physical network for internet access.
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5.  Click the type of switch that you want to create and click Create Virtual Switch.

6.  In the Virtual Switch Manager (as shown in Figure 2-37), in the Name text box,
type a descriptive name for the switch.

7.  Click OK to close the Virtual Switch Manager. When you are prompted to apply net-
working changes, click Yes.

SELECT A VIRTUAL SWITCH FOR A VM

GET READY. To select a virtual switch for a VM in Hyper-V running on Windows 10, per-
form the following steps.

1.  On LON-CL1, using Hyper-V Manager, right-click the VM and choose Settings.
2.  In the Settings dialog box, click Network Adapter, as shown in Figure 2-38.

Figure 2-37

Configuring a virtual switch
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3.  On the Network Adapters page, for the Virtual switch, click the new virtual switch.

4.  Click OK to close the Settings dialog box.

Creating and Managing Virtual Disks

The New Virtual Hard Disk Wizard provides you with a simple way to create a virtual 
hard disk. With the wizard, you have to specify the file format and the type of virtual disk. 
Besides fixed-size virtual hard disks and dynamically expanding virtual hard disks that were 
discussed in Lesson 2, you can also use the wizard to create a differencing virtual hard disk.

A differencing virtual disk is a virtual disk that is associated with another virtual hard disk 
in a parent-child relationship. In other words, you start with a parent disk and then create a 
differencing disk that points to the parent disk. As changes are made, the changes are written 
to the differencing disk, while the parent disk remains unchanged. The differencing virtual 
disk expands dynamically as needed. When you use a differencing disk, you do not specify 
the size of the disk. Instead, the differencing disk grows up to the size of the parent disk that 
it is associated with.

Figure 2-38

Configuring VM settings

A virtual disk is a file that represents a physical disk drive to a guest operating system 
running on a virtual machine. The user can install a new operating system onto the 
virtual disk without repartitioning the physical disk or rebooting the host machine.
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CREATE A VIRTUAL DISK

GET READY. To create a virtual disk in Hyper-V running on Windows 10, perform the fol-
lowing steps.

1.  On LON-CL1, right-click Start and choose Control Panel.
2.  In the Search Control Panel text box, type Administrative Tools. Then from the 

search results, click Administrative Tools.
3.  In the Administrative Tools window, double-click Hyper-V Manager. If you are 

prompted to confirm if you want to allow this app to make changes to your PC, 
click Yes.

4.  Right-click a virtual machine and choose Settings.
5.  In the Settings dialog box, click IDE Controller 0. As you can see, it already has 

one virtual disk that was created when the virtual machine was created.

6.  On the IDE Controller page, click Hard Drive and click Add. The Hard Drive page 
opens, as shown in Figure 2-39.

7.  With the Virtual hard disk option selected, click New.

8.  In the New Virtual Hard Disk Wizard, on the Before You Begin page, click Next.

Figure 2-39

Creating a virtual disk
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9.  On the Choose Disk Format page, VHDX is already selected. Click Next.
10.  On the Choose Disk Type page, click the disk type and click Next.
11.  On the Specify Name and Location page, in the Name text box, specify a descrip-

tive name for the disk. Click Next.
12.  On the Create a New Blank Virtual Hard Disk page, specify the size of the disk, 

such as 10 GB. Click Next.
13.  On the Summary page, click Finish.

14.  Click OK to close the Settings dialog box.

Creating and Managing Checkpoints

When you are testing an application and want to troubleshoot compatibility issues or test 
a new application update before rolling it out to production machines, you can use the 
Hyper-V snapshot feature (right-click the machine and choose Checkpoint, as shown in 
Figure 2-40). By creating a checkpoint, you can return to a known state on the VM (for 
example, the state before you installed the application).

Although checkpoints are a useful tool for you when implementing a test environment in 
Hyper-V, this tool is not recommended for heavy use in production environments. Apart 
from consuming disk space, the presence of snapshots can reduce the overall performance of a 
VM’s disk subsystem.

To revert to the previous state, right-click the checkpoint and choose Apply. When you no 
longer need the checkpoint, right-click the checkpoint and choose Delete Checkpoint.

In Hyper-V, a checkpoint is a captured image of the state, data, and hardware 
configuration of a VM at a particular moment in time.

Figure 2-40

Creating a checkpoint in 
Hyper-V Manager
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■■ Knowledge Assessment

Multiple Choice

Select the correct answer for each of the following questions.

	 1.	 Which of the following is not an account type in Windows 10?
a.	 Guest
b.	 Limited user
c.	 Standard user
d.	 Administrator

In this lesson you learned:

•	 The desktop is the main screen area that you see when you first start the computer and 
log on to Windows. Like the top of an actual desktop, it is where you perform your work 
by opening and running one or more applications. It also includes the Recycle Bin, which 
is used to recover files that have been previously deleted.

•	 In Windows 10, many of the Windows configuration is done within Settings. Settings can 
be accessed by clicking Start > Settings.

•	 With versions of Windows prior to Windows 10, Control Panel was the primary graphical 
utility to configure the Windows environment and hardware devices. In Windows 10, it can 
be accessed by right-clicking Start and choosing Control Panel.

•	 File Explorer, previously known as Windows Explorer, is the file manager that is included 
with Windows operating systems. It provides a graphical user interface to access and man-
age the file system including opening files, moving and copying files, and deleting files.

•	 In Windows 10, a library is a virtual folder that can display content from different loca-
tions (folders, for example) on your computer or from an external drive. A library looks like 
an ordinary folder but simply points to files and folders that are located elsewhere.

•	 In Windows 10, simple power management settings can be accessed by opening Settings 
and clicking System > Power & Sleep. The screen settings allow you to specify how long 
the screen will remain on if you are not actively using your computer when the computer 
is using battery power or when it is using AC power (plugged in). The sleep settings will 
specify how long the computer will operate before going into sleep mode when the com-
puter is using battery power or when it is using AC power.

•	 Microsoft has built many features into Windows 10 that work with assistive technologies 
or as stand-alone features that make the user experience better for people who are deaf or 
visually impaired. Most accessibility features can be configured in the Ease of Access Center.

•	 Client Hyper-V enables you to create and manage virtual machines (VMs) using a virtual 
switch. These VMs can be used to test your applications for compatibility with new 
operating systems, allow you to run applications written for older versions of Windows, or 
isolate an application. The physical machine that Hyper-V and the virtual machines run on 
is often referred to as the host.

S K I L L  S U M M A R Y
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	 2.	 Which power mode first goes into a low-power mode for computers, and then to 
Hibernate mode when the system is almost out of power?
a.	 Balanced mode
b.	 Power mode
c.	 Zip mode
d.	 Hybrid mode

	 3.	 Which of the following actions is most likely to trigger a User Account Control dialog 
box?
a.	 Uninstalling a program
b.	 Creating a shortcut
c.	 Changing resolution
d.	 Adding a gadget

	 4.	 Which of the following can be used to directly access Event Viewer?
a.	 Gadgets window
b.	 Programs in Control Panel
c.	 Administrative Tools
d.	 User Account Control dialog box

	 5.	 Which of the following is not a UAC notification level?
a.	 Always notify me
b.	 Notify me only when users try to access my files
c.	 Notify me only when programs try to make changes to my computer
d.	 Never notify me of installations or changes

	 6.	 Which feature allows you to quickly minimize all open windows except the active one?
a.	 Shake
b.	 Snap
c.	 Peek
d.	 Show Desktop

	 7.	 Which of the following settings is not configurable from the Screen Resolution window?
a.	 Orientation
b.	 Font size
c.	 Display
d.	 Windows theme

	 8.	 Which of the following allows you to manage programs that run when Windows starts 
or when you log on?
a.	 Task Scheduler
b.	 Performance Monitor
c.	 Programs in Control Panel
d.	 System Configuration

	 9.	 Which versions of Windows 10 support Windows XP Mode? (Choose all that apply.)
a.	 Mobile
b.	 Professional
c.	 Education
d.	 Enterprise

	10.	 Which of the following correctly explains the abbreviation VHD?
a.	 Variable Hex Determinant
b.	 Virtual Home Directory
c.	 Virtual Hard Disk
d.	 Virtual Hard Drive
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Fill in the Blank

Complete the following sentences by writing the correct word or words in the blanks provided.

	 1.	 A _____ is a collection of information that defines the actions you can take on a com-
puter and which files and folders you can access.

	 2.	 The _____ account type is best for everyday use.

	 3.	 _____  is used to prevent unauthorized changes to your system without your 
knowledge.

	 4.	 To configure accessibility options, open the _____.

	 5.	 To minimize all open windows at once, click the _____ button.

	 6.	 _____ includes several items, including System and Security, Programs, User Accounts 
and Ease of Access.

	 7.	 Use _____ to troubleshoot and resolve computer problems, and to keep your system 
running optimally.

	 8.	 The Windows 10 _____ window allows you to configure several display-related 
settings.

	 9.	 _____ can be used to run older applications made for Windows XP, for example, on a 
computer running Windows 10.

	10.	 _____ is used to manage files and folders on a drive.

True / False

Circle T if the statement is true or F if the statement is false.

T F 	1.	 A User Account Control dialog box opens when you open your data files.

T F 	2.	 You cannot change the desktop resolution setting because it’s a fixed value.

T F 	3.	 Deleting a shortcut does not delete the resource it represents.

T F 	4.	 A user account and a user profile are the same thing.

T F 	5.	 Windows 10 Settings replaced Windows Control Panel.

■■ Business Case Scenarios

Scenario 2-1: Getting Administrative-Level Privileges

As an IT technician, you need to perform some maintenance tasks on an employee’s com-
puter that will require elevated privileges. When you go to the Manage Accounts window 
in Control Panel on that employee’s computer, you see only the employee’s standard user 
account. Describe how to log on as a user with administrative-level privileges.

Scenario 2-2: Configuring Accessibility Features

Alexandra, an employee at your company, is visually impaired. Which features can be config-
ured in Windows 10 to help her perform her work more efficiently?
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Scenario 2-3: Running a Legacy Application

Oscar is the warehouse manager for an auto parts business. Although the business standard-
ized on Windows 10 Professional, Oscar needs to run a legacy parts lookup program that 
does not run in Windows 10. You provide technical support to the business. Describe your 
recommended solution.

Scenario 2-4: Creating a Better User Experience

Oscar would like to use his Windows 10 Professional computer more efficiently. He would 
also like to be able to quickly launch Microsoft Excel each time he logs on to his computer, 
and he does not want the Windows Media Player to be present on the taskbar. Describe your 
recommended solution.
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LESSON 3

O B J E C T I V E  D O M A I N  M A T R I X

Skill/Concept Exam Objective Objective Number

Configuring Internet Explorer Configure native applications and tools

Configure applications

1.3

3.1

Configuring Microsoft Edge Configure native applications and tools 1.3

Configuring Cortana Configure native applications and tools 1.3

Introducing Accessory Programs Configure native applications and tools 1.3

Supporting Mobile Access and Data 
Synchronization

Configure mobility settings

Understand offline files

1.4

4.4

Using Windows Mobility Center Configure mobility settings 1.4

Accessing a Computer Remotely Configure native applications and tools

Configure and use management tools

1.3

1.5

Understanding 
Native Applications, 
Tools, Mobility, and 
Remote Management 
and Assistance

K E Y  T E R M S

ActiveX control

ActiveX Filtering

add-on

cmdlet

Common Information Model 
(CIM)

Compatibility View

Component Object Model  
(COM)

Computer Management

cookie

dynamic security

favorite

InPrivate Browsing

Internet Explorer

Microsoft Edge

Network Address Translation 
(NAT)

one-way sync

phishing

Pop-up Blocker

PowerShell Remoting

proxy server

Remote Assistance

Remote Desktop Connection 
(RDC)

Remote Desktop Protocol (RDP)

Remote Desktop Services (RDS)

screenshot

Secure Sockets Layer (SSL)

security zone

SmartScreen Filter

snap-in

Snipping Tool

Sync Center

sync conflict
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■■ Configuring Internet Explorer

Internet Explorer has changed significantly over the years. As a result, it has a lot of features 
and functionality. Because you use the web browser to access information from throughout 
the world over the internet, your computer or private information might be at risk of being 
accessed by others. Thus, it’s important to manage the security features of Internet Explorer to 
ensure you’re defending yourself effectively.

Managing Cookies and Privacy Settings

A cookie is text stored by a user’s web browser. It can be used for a wide range of functions, 
including identifying you as a user, authenticating you as a user, and storing your site pref-
erences and shopping cart contents. Cookies can provide a website with a lot of helpful 
information that can make your browsing experience easier and faster, but they also can be 
used by spyware programs and websites to track your online behavior. Unfortunately, some 
websites will not operate without cookies.

CERTIFICATION READY
Can you identify and 
configure the various 
security features 
available in Internet 
Explorer?
Objective 1.3

Your IT manager has asked you to find ways to help computer users be more productive 
and provide support services to them without requiring you to purchase third-party 
tools and software. You decide to brush up on the native applications in Windows 10, 
such as Internet Explorer 11, Microsoft Edge, Snipping Tool, and Windows Media 
Player. To help remote users who run into problems with their software or who just 
need quick tutorials, you’ll begin using Windows Remote Assistance. Finally, you plan 
to show frequent travelers how to use Remote Desktop Connection to access files from 
their home or work computers.

Tracking Protection

two-way sync

Web Services for Management

Windows Management 
Instrumentation (WMI)

Windows Media Player 12

Windows Mobility Center

Windows PowerShell

Windows PowerShell Integrated 
Scripting Environment (ISE)

Windows Remote Management 
(WinRM)

WinRS.exe

THE BOTTOM LINE

Windows 10 includes two browsers, Internet Explorer and Microsoft Edge. Internet 
Explorer is the traditional Microsoft browser that offers a number of features to protect 
your security and privacy while you browse the web, including phishing filters, Protected 
Mode, Pop-up Blocker, Add-on Manager, download files or software notification, and 
the use of digital signatures and 128-bit secure (SSL) connections when using secure 
websites.

Your web browser can reveal plenty of information about your personality and interests. 
Therefore, you need to take steps to ensure that this information cannot be read or used 
without your knowledge.
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DELETE COOKIES AND TEMPORARY INTERNET FILES

GET READY. To delete cookies and temporary internet files, perform the following steps.

1.  Open Internet Explorer.
2.  Click the Tools (gear) button and then click Internet options.
3.  On the General tab, under Browsing history, click Delete. The Delete Browsing  

History dialog box opens (see Figure 3-1).

4.  Ensure that the Cookies and website data check box and the Temporary Internet 
files and website files check box are selected. Click Delete.

Being aware of how your private information is used when browsing the web is important to 
helping prevent targeted advertising, fraud, and identity theft.

VIEW PRIVACY SETTINGS

GET READY. To view privacy settings, perform the following steps.

1.  Open Internet Explorer.
2.  Click Tools > Internet options.
3.  Click the Privacy tab (see Figure 3-2).

Figure 3-1

Deleting cookies and 
temporary files
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When you click the Advanced button, you can change settings that affect how cookies are 
handled and when you click the Sites button, you can allow or block cookies from individual 
websites.

To prevent Internet Explorer from storing data about your browsing session, Internet Explorer 
11 includes InPrivate Browsing. This helps prevent anyone who might be using your com-
puter from seeing where you visited and what you looked at on the web.

When you start InPrivate Browsing, Internet Explorer opens a new window. The pro-
tection that InPrivate Browsing provides is only in effect during the time that you use 
that window. You can open as many tabs as you want in that window, and they will all 
be protected by InPrivate Browsing. However, if you open another browser window, that 
window will not be protected by InPrivate Browsing unless you configure that window 
to also use InPrivate Browsing. To end your InPrivate Browsing session, close the browser 
window.

Some websites can be used to gather information about which pages you visit on the internet. 
Tracking Protection blocks this content from websites that appear on Tracking Protection 
Lists. A Personalized Tracking Protection List included with Internet Explorer is generated 
automatically based on sites you visit. You can also download Tracking Protection Lists and 
then Internet Explorer will periodically check for updates to the lists.

Pop-up windows are very common. Although some pop-up windows are useful website con-
trols, most are simply annoying advertisements—with a few attempting to load spyware or 
other malicious programs. To help protect your computer, Internet Explorer’s Pop-up Blocker 
can suppress some or all pop-ups.

ActiveX controls are small applications that allow websites to provide content such as videos 
and games and to allow you to interact with content such as those used in toolbars and  
stock tickers. However, these applications can malfunction, deliver unwanted content, or can 

Figure 3-2

Configuring privacy settings
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contain malware. ActiveX Filtering in Internet Explorer prevents sites from installing and 
using ActiveX applications. Of course, when ActiveX Filtering is on, videos, games, and other 
interactive content might not work.

If you want to enable ActiveX controls for an individual website, visit the website, click 
the Filter button at the top of the browser window, and then click Turn off ActiveX 
Filtering.

TURN ON INPRIVATE BROWSING

GET READY. To turn on InPrivate Browsing, perform the following steps.

1.  Open Internet Explorer.
2.  Click Tools > Safety > InPrivate Browsing. A browser opens with an InPrivate 

button at the top of the window.

TURN ON TRACKING PROTECTION

GET READY. To turn on Tracking Protection, perform the following steps.

1.  Open Internet Explorer.
2.  Click Tools > Safety > Turn on Tracking Protection.

3.  In the Manage Add-ons dialog box, with Tracking Protection selected, double-click 
Your Personalized List.

4.  In the Personalized Tracking Protection List, click Automatically block (as shown 
in Figure 3-3) and then click OK.

5.  Click Close.

Figure 3-3

Turning on tracking protection
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To help manage Internet Explorer security when visiting websites, Internet Explorer 
divides your network connection into security zones based on four content types. For 
each zone, a security level is assigned.

CONFIGURE THE POP-UP BLOCKER

GET READY. To configure the Pop-up Blocker, perform the following steps.

1.  Open Internet Explorer.
2.  Click Tools > Internet options.
3.  Click the Privacy tab.

4.  Click Settings. The Pop-up Blocker Settings dialog box opens.

5.  To allow pop-ups from a specific website, in the Address of website to allow text 
box, type the URL of the site and click Add.

Repeat the process to add additional sites to the Allowed sites list.

6.  Adjust the Blocking level drop-down list to one of the following settings:

•	High: Blocks all pop-ups

•	Medium: Blocks most automatic pop-ups

•	Low: Allows pop-ups from secure sites

7.  Click Close to close the Pop-Up Blocker Settings dialog box.

8.  Click OK to close the Internet Properties dialog box.

CONFIGURE ACTIVEX FILTERING

GET READY. To configure ActiveX Filtering, perform the following steps.

1.  Open Internet Explorer.
2.  Click Tools > Safety > ActiveX Filtering.

There should now be a check mark next to ActiveX Filtering.

Configuring Security Zones

The security for each security zone is assigned based on dangers associated with that zone. 
For example, it is assumed that connecting to a server within your own corporation would be 
safer than connecting to a server on the internet.

The four default content types are:

•	 Internet zone: This zone includes anything that is not assigned to any other zone as well 
as anything that is not on your computer or your organization’s network (intranet). The 
default security level of the Internet zone is Medium-high.

•	 Local intranet zone: This zone applies to computers that are part of the organization’s 
network (intranet) that do not require a proxy server, as defined by the system adminis-
trator. These include sites specified on the Connections tab, network, paths (such as  
\\computername\foldername), and local intranet sites (such as http://internal). You can 
add sites to this zone. The default security level for the Local intranet zone is Medium-
low, which means Internet Explorer allows all cookies from websites in this zone to be 
saved on your computer and read by the website that created them. Lastly, if the website 
requires NT LAN Manager (NTLM) or integrated authentication, it automatically uses 
your user name and password.
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•	 Trusted sites zone: This zone includes trusted sites that you believe you can download 
or run files from without damaging your computer. This also includes sites from which 
you believe you can download data or sites that you don’t consider to be a security risk. 
You can assign sites to this zone. The default security level for the Trusted sites zone is 
Medium, which means Internet Explorer allows all cookies from websites in this zone to 
be saved on your computer and read by the website that created them.

•	 Restricted sites zone: This zone includes sites that you do not trust; downloading or 
running files from these sites might damage your computer. You can assign sites to 
this zone. The default security level for the Restricted sites zone is High, which means 
Internet Explorer blocks all cookies from websites in this zone.

To determine which zones the current web page falls into, press Alt to show the menu and 
click File > Properties.

MODIFY THE SECURITY LEVEL FOR A WEB CONTENT ZONE

GET READY. To modify the security level for a web content zone, perform the following steps.

1.  Open Internet Explorer.
2.  Click Tools > Internet options.
3.  In the Internet Options dialog box, click the Security tab.

4.  Click the zone on which you want to set the security level (as shown in Figure 3-
4). Drag the slider to set the security level to High, Medium-high, or Low. Internet 
Explorer describes each option to help you decide which level to choose. You are 
prompted to confirm any reduction in security level.

5.  To customize individual settings, click the Custom level button to open the 
Security Settings dialog box for the selected zone.

Figure 3-4

Configuring the security 
content zones
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Internet Explorer offers multiple security features to defend against malware and data 
theft, including dynamic security and protected mode. Dynamic security is a set of 
tools and technology that protects your computer as you browse the internet with 
Internet Explorer. It includes ActiveX opt-in, Security Status Bar, Phishing Filter, 
Address Bar Protection, and protected mode.

6.  Click radio buttons for the individual settings in each security category. The radio 
buttons typically make it possible to enable a setting, disable it, or prompt the 
user before enabling it.

7.  To close the Security Settings dialog box, click OK.

8.  To close the Internet Options dialog box, click OK.

For each web content zone, there is a default security level. The security levels available in 
Internet Explorer are:

•	 High: Excludes any content that can damage your computer by maximizing safeguards 
and disabling less secure features

•	 Medium-high: Appropriate for most websites; prompts before downloading potential 
unsafe content

•	 Medium: Warns you before running potentially damaging content
•	 Medium-low: Appropriate for local network\intranet websites; allows most content to 

be run without prompting
•	 Low: Does not warn you before running potentially damaging content
•	 Custom: Creates a security setting of your own design

The easiest way to modify the security settings that Internet Explorer imposes on a specific 
website is to manually add the site to a different security zone. The typical procedure is to add 
a site to the Trusted sites zone to increase its privileges, or add it to the Restricted sites zone to 
reduce its privileges.

ADD A SITE TO A SECURITY ZONE

GET READY. To add a site to a security zone, perform the following steps.

1.  Open Internet Explorer.
2.  Click Tools > Internet options.
3.  Click the Security tab.

4.  Click the zone—either Trusted sites or Restricted sites—to which you want to 
add a site.

5.  Click Sites. The Trusted sites dialog box or the Restricted sites dialog box opens.

6.  In the Add this website to the zone text box, type the URL of the website you 
want to add to the zone and click Add. The URL appears in the Websites list.

7.  Click Close to close the Trusted sites dialog box or the Restricted sites dialog box.

8.  To close the Internet Options dialog box, click OK.

Using Dynamic Security and Protected Mode

The Security Status Bar keeps you notified of the website security and privacy settings by 
using color-coded notifications next to the address bar. Some of these features include:

•	 The address bar turns green to indicate websites bearing new High Assurance certifi-
cates, indicating the site owner has completed extensive identity verification checks.
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•	 Phishing Filter notifications, certificate names, and the gold padlock icon are now also 
adjacent to the address bar for better visibility.

•	 Certificate and privacy detail information can easily be displayed with a single click on 
the Security Status Bar.

•	 The address bar is displayed to the user for every window, whether it’s a pop-up or 
whether it’s a standard window, which helps to block malicious sites from emulating 
trusted sites.

•	 To help protect you against phishing sites, Internet Explorer warns you when you’re 
visiting potential or known fraudulent sites and blocks the site if appropriate. The opt-
in filter is updated several times per hour with the latest security information from 
Microsoft and several industry partners.

•	 International Domain Name Anti-Spoofing notifies you when visually similar characters 
in the URL are not expressed in the same language.

If Internet Explorer is still using its original settings, you’ll see the Information bar in the fol-
lowing circumstances:

•	 When a website tries to install an ActiveX control on your computer or run an ActiveX 
control in an unsafe manner

•	 When a website tries to open a pop-up window
•	 When a website tries to download a file to your computer
•	 When a website tries to run active content on your computer
•	 When your security settings are below recommended levels
•	 When you access an intranet web page, but have not turned on intranet address 

checking
•	 When you start Internet Explorer with add-ons disabled
•	 When you need to install an updated ActiveX control or add-on program
•	 When the website address can be displayed with native language letters or symbols but 

you don’t have the language installed

To help protect your computer, Internet Explorer protected mode runs as a low-integrity 
procedure, which means that Internet Explorer writes to only low-integrity disk locations, 
such as the Temporary Internet Files folder and the standard Internet Explorer storage areas, 
including the History, Cookies, and Favorites folders. As a result, protected mode is a feature 
that makes it more difficult for malicious software to be installed on your computer.

ENABLE PROTECTED MODE

GET READY. Before protected mode can be enabled, you must ensure that UAC is enabled. 
To enable protected mode, perform the following steps.

1.  Open Internet Explorer.
2.  Click Tools > Internet options.
3.  Click the Security tab.

4.  Click to select the Enable Protected Mode.

5.  Close the Internet Options dialog box by clicking OK.

6.  Close Internet Explorer and then restart Internet Explorer.

Protected mode is not a complete defense against malware. Therefore, it is recommended to 
use an up-to-date antivirus package with antispyware capability and to keep your system up 
to date with Windows and Internet Explorer security updates and patches.

TAKE NOTE*
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Internet Explorer allows you to add add-ons to your browser, such as extra toolbars, 
animated mouse pointers, stock tickers, and pop-up blockers. Add-ons are downloaded 
from the internet and installed as an executable program.

Configuring the SmartScreen Filter and Phishing

To help protect against phishing, Internet Explorer 11 includes SmartScreen Filter, which 
examines traffic for evidence of phishing activity and displays a warning to the user if it finds 
any. It also sends the address back to the Microsoft SmartScreen service to be compared 
against lists of known phishing and malware sites. If SmartScreen Filter discovers that a web-
site you’re visiting is on the list of known malware or phishing sites, Internet Explorer displays 
a blocking web page and the address bar is shown in red. From the blocking page, you can 
choose to bypass the blocked website and go to your home page instead, or you can continue 
to the blocked website, though this is not recommended. If you continue to the blocked web-
site, the address bar continues to appear in red.

To protect your privacy, information that is submitted to the SmartScreen web service is 
transmitted in encrypted format over HTTPS. This information is not stored with your IP 
address or other personally identifiable information and will not be used to identify, contact, 
or provide advertising to you.

You can set up the browser by using express settings or by configuring settings individually. 
The express settings option enables the SmartScreen Filter, but you can disable it at any 
time by clicking the Safety button on the toolbar and clicking SmartScreen Filter > Turn off 
SmartScreen Filter (which opens the Microsoft SmartScreen Filter dialog box).

Even without SmartScreen Filter turned on, you can remain safe from phishing attempts as 
long as you obey the following unofficial rules of web surfing:

•	 Don’t trust hyperlinks.
•	 Never supply a password or any other confidential information to a website unless you 

type the URL yourself and you are sure that it is correct.

Managing Add-Ons

The four basic types of add-ons supported by Internet Explorer are as follows:

•	 Toolbars and Extensions: Enable the browser to open and manipulate websites or file 
types that Internet Explorer does not support natively. Some applications add their own 
toolbars to Internet Explorer, enabling you to work with their documents within an 
Internet Explorer session.

•	 Search Providers: Enable the user to perform searches directly from the Internet 
Explorer interface using search engines on the internet or the local network.

•	 Accelerators: Enable users to send text or other media they select in an Internet 
Explorer browser window to another application, such as an email client or an internet 
resource (such as a blog).

•	 Tracking Protection: Enables you to import and export XML files containing 
InPrivate filters.

CERTIFICATION READY
Which Windows 10 
browser technology is 
used to protect against 
phishing activity when 
visiting websites?
Objective 3.1

Phishing is a fraudulent technique based on social engineering. With phishing, users 
are enticed (usually through email or other websites) to go to illegitimate websites that 
look similar to legitimate websites in an effort to persuade users to supply personal 
information, such as passwords and account numbers.



    Understanding Native Applications, Tools, Mobility, and Remote Management and Assistance  |  79

VIEW YOUR CURRENT ADD-ONS

GET READY. To view your current add-ons, perform the following steps.

1.  Open Internet Explorer.
2.  Click Tools > Manage add-ons.
3.  Under Toolbars and Extensions (see Figure 3-5), under Show, you can select one of 

the following views of your add-ons:

•	To display a complete list of the add-ons that reside on your computer, click All 
add-ons.

•	To display only those add-ons that were needed for the current web page or a 
recently viewed web page, click Currently loaded add-ons.

•	To display add-ons that were preapproved by Microsoft, your computer manufac-
turer, or a service provider, click Run without permission.

•	To display only 32-bit ActiveX controls, click Downloaded controls.

4.  Click Close.

DELETE ACTIVEX CONTROLS

GET READY. To delete ActiveX controls you have installed, perform the following steps.

1.  Open Internet Explorer.
2.  Click Tools > Manage add-ons.
3.  Under Show, click Downloaded controls to display all downloaded ActiveX controls.

4.  Click the ActiveX control you want to delete and click More information.

5.  In the More Information dialog box, click Remove. If you are prompted for an 
administrator password or confirmation, type the password or provide confirmation.

Figure 3-5

Managing add-ons
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Through the years, web pages have changed quite a bit. Unfortunately, as newer 
technology is implemented on websites, sometimes websites don’t look like you expect 
them to. Images might not appear, menus might be out of place, and text could be 
jumbled together. In these situations, you can try to run the site in compatibility mode.

DISABLE ADD-ONS

GET READY. To permanently disable add-ons, perform the following steps.

1.  Open Internet Explorer.
2.  Click Tools > Manage add-ons.
3.  Under Show, click All add-ons.
4.  Click the add-on you want to disable and click Disable.

Configuring Compatibility Mode

Once you turn on Compatibility View, Internet Explorer automatically shows that site in 
Compatibility View each time you visit. You can turn it off by removing it from your com-
patibility list.

VIEW COMPATIBILITY VIEW

GET READY. To turn Compatibility View on or off, click the Compatibility View button, or 
perform the following steps.

1.  Open Internet Explorer.
2.  Click Tools > Compatibility View settings.
3.  In the Compatibility View Settings dialog box (as shown in Figure 3-6), you can 

perform the following tasks:

•	Display intranet sites in Compatibility View: To include all of your internal cor-
porate websites, make sure the Display intranet sites in Compatibility View check 
box is selected.

Figure 3-6

Managing Compatibility View 
settings
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•	Use Microsoft compatibility lists: Selecting this check box automatically puts 
sites into Compatibility View if they are on the list compiled by Microsoft.

•	Add this website: To run a website in Compatibility View, type the website into 
the Add this website text box, and click Add.

4.  Click Close to close the Compatibility View Settings dialog box.

Configuring Secure Sockets Layer (SSL) and Certificates

Secure Sockets Layer (SSL) uses a cryptographic system that uses two keys—one key 
to encrypt the data and another key to decrypt the data. The public key is known to 
everyone and a private or secret key is known only to the recipient of the message. The 
public key is published in a digital certificate, which also confirms the identity of the 
web server.

When you connect to a site that is secured using SSL, a lock icon appears in the address 
bar. Clicking the lock icon displays more information about the site, including the 
identity of the certificate authority (CA) that issued the certificate. For even more 
information, you can click the View certificates link to open the Certificate dialog box 
(see Figure 3-7).

When visiting certain websites, Internet Explorer might find problems with the digital cer-
tificate, such as the certificate has expired, it is corrupted, it has been revoked, or it does not 
match the name of the website. When this happens, Internet Explorer blocks access to the 
site and displays a warning stating that there is a problem with the certificate. You then have 
a chance to close the browser window or ignore the warning and continue on to the site. Of 
course, if you choose to ignore the warning, make sure you trust the website and you believe 
that you are communicating with the correct server.

You might need to transmit private data over the internet, such as credit card numbers, 
Social Security numbers, and so on. You should use HTTP over SSL (HTTPS) to 
encrypt the data sent over the internet. By convention, URLs that require an SSL 
connection start with https: (instead of http:).

Figure 3-7

Viewing certificate information
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Favorites allow you to keep track of websites that you visit frequently so that you can 
visit them quickly in the future. If you’re on a site that you want to make a favorite, 
click the Favorites (star) button and click Add to favorites. You can also save a favorite 
by pressing Ctrl+D. You will then be prompted to name the favorite and identify which 
folder the favorite will be stored in. The favorites are stored in the user’s profile folder 
(c:\Users\<Username>\Favorites).

Managing Favorites

Some of the popular tasks related to favorites are:

•	 To view your favorites, click the Favorites (star) button.
•	 To organize your favorites, click the Favorites (star) button, click the small down arrow 

next to the Add to favorites button, and then click Organize favorites.
•	 To export the favorites to an HTML file, which can be imported into another machine, 

click the small down arrow next to the Add to favorites button, click Import and export, 
and then click Export to a file.

•	 To import the favorites from an HTML file, click the small down arrow next to the Add 
to favorites button, click Import and export, and then click Import from a file.

Managing LAN Settings

NAT enables a local area network (LAN) to use one set of IP addresses for internal traffic and 
a second set of addresses for external traffic. The NAT computer or device is usually a router 
(including routers made for home and small-office internet connections) or a proxy server. As 
a result, you can:

•	 Provide a type of firewall by hiding internal IP addresses.
•	 Enable multiple internal computers to share a single external public IP address.

The private addresses are reserved addresses not allocated to any specific organization. 
Because these private addresses cannot be assigned to global addresses used on the internet 
and are not routable on the internet, you must use a NAT gateway or proxy server to con-
vert between private and public addresses. The private network addresses are expressed in 
RFC 1918 as:

•	 10.0.0.0–10.255.255.255
•	 172.16.0.0–172.31.255.255
•	 192.168.0.0–192.168.255.255

NAT obscures an internal network’s structure by making all traffic appear to origi-
nate from the NAT device or proxy server. A proxy server is a server that acts as an 
intermediary for clients seeking resources outside their networks. Medium and large orga-
nizations typically use a proxy server. In addition, these organizations require their clients 
to use the proxy server when accessing the internet. By using the proxy server, organi-
zations can monitor traffic and provide better security. For organizations that use proxy 

Although Classless Inter-Domain Routing (CIDR) helped use the IPv4 addresses more 
efficiently, additional steps were necessary to prevent the exhaustion of IPv4 addresses. 
Network Address Translation (NAT) is used with masquerading to hide an entire 
address space behind a single IP address. In other words, it allows multiple computers 
on a network to connect to the internet through a single IP address.
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servers, users need to use the proxy server to access Office 365, Microsoft Intune, and 
Microsoft Azure, because client traffic has to go through the proxy server to connect to 
the internet.

CONFIGURE A CLIENT TO USE A PROXY SERVER

GET READY. To configure a client to use a proxy server, perform the following steps.

1.  Open Internet Explorer.
2.  Click Tools > Internet options.
3.  Click the Connections tab.

4.  Click LAN settings.
5.  In the Local Area Network (LAN) Settings dialog box (see Figure 3-8), clear the 

Automatically detect settings check box.

6.  Select the Use a proxy server for your LAN check box.

7.  In the Address text box, type the host name or IP address of the proxy server. In 
the Port text box, type the port used by the proxy server, such as 80 or 8080.

8.  If you do not want to use proxy servers to access local resources, select the 
Bypass proxy server for local addresses check box.

9.  Alternatively, you can click the Advanced button. In the Proxy Settings dialog box, 
you can specify individual proxy settings for HTTP, Secure, FTP, and Socks. You  
can also specify exceptions for sites in which you do not want to use the proxy 
server. Click OK.

10.  Click OK to close the Local Area Network (LAN) Settings dialog box.

11.  Click OK to close the Internet Options dialog box.

Figure 3-8

Configuring proxy settings
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THE BOTTOM LINE

Microsoft Edge is a new Microsoft lightweight web browser with a layout engine built 
around web standards designed to replace Internet Explorer as the default web browser. It 
integrates with Cortana, annotation tools, Adobe Flash Player, a PDF reader, and a reading 
mode. Extension support was developed and added to the Windows 10 Anniversary 
Update in July 2016.

■■ Configuring Microsoft Edge

At the top of the Microsoft Edge window, you will find the following buttons:

•	 Reading view
•	 Add to Favorites or Reading List
•	 Hub (Favorites, reading list, history, and downloads)
•	 Make a Web Note
•	 Settings

To open Microsoft Edge Settings (as shown in Figure 3-9), click the More (. . .) button and 
click the Settings option.

Under Settings, you can:

•	 Enable or disable the favorites bar.
•	 Set Microsoft Edge to start with the Start page, a new tab page, previous pages, or a specified 

web page.
•	 Set whether new tabs will be top sites and suggested content, top sites, or a blank page.
•	 Set your search engine to Bing or any search engine of your choice by clicking the View 

advanced settings button.
•	 Clear browsing history and delete media licenses, pop-up exceptions, and location permissions.
•	 Set the Reading view style to Default, Light, Medium, or Dark, along with the Reading 

font size.

CERTIFICATION READY
Which browser included 
in Windows 10 is 
intended to replace 
Internet Explorer?
Objective 1.3

Figure 3-9

Configuring Microsoft Edge
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When you click the View advanced settings option, you can:

•	 Enable or disable Adobe Flash Player.
•	 Set privacy options.
•	 Manage saved passwords.
•	 Opt to save form entries.
•	 Choose to block pop-ups and cookies.
•	 Manage protected media licenses.
•	 Send Do Not Track requests.
•	 Enable or disable page prediction.
•	 Enable or disable SmartScreen Filter.
•	 Turn on or off Cortana integration.
•	 Set your search engine to Bing or a search engine of your choice.

■■ Configuring Cortana

When you first start Cortana, you must specify your name or nickname and specify your 
Microsoft account, which enables Cortana to give you suggestions, ideas, reminders, alerts, 
and more. You can then access the Cortana settings, as shown in Figure 3-10. You can then 
customize Cortana further by adding your home address and work address so that it can 
make decisions based on where you live and work.

CERTIFICATION READY
What Windows 10 
feature is used to search 
for and find installed 
applications?
Objective 1.3

THE BOTTOM LINE

Cortana is a search feature and personal assistant for Windows 10. It can help you find 
programs and files on your computer and manage your calendar events. It can also deliver 
sports scores, weather, news, navigation, reminders, and more. When you search, you can 
either type what you are looking for, or if you have a microphone, you can speak to Cortana.

Figure 3-10

Configuring Cortana
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When you click Cortana, you will see four small icons:

•	 Home: Displays news and personalized items that Cortana thinks you will be interested 
in at the moment.

•	 Notebook: Specifies what appears in the Home view and in search results as a whole. 
You can also add additional accounts (Connected Accounts).

•	 Reminders: Shows reminders that Cortana has gathered. For the Reminders option to 
be available, you must be signed into Cortana with a Microsoft account.

•	 Feedback: Sends feedback to Microsoft.

■■ Introducing Accessory Programs

To access these programs, click Start, navigate to and click the application or type the name 
of the program, and then press Enter.

Windows 10 comes bundled with many useful accessory programs (as shown in 
Table 3-1), such as Calculator, Notepad, Paint, Snipping Tool, Windows Media Player, 
WordPad, and many more. The programs allow you to be productive in Windows 
without purchasing third-party programs.

Program Description

Calculator Performs basic mathematical functions such as addition, subtraction, 
multiplication, and division. Also includes scientific, programmer, and 
statistics functions, along with unit conversions, date calculations, and 
worksheets to determine mortgage payments, vehicle lease payments, 
and fuel economy.

Command 
Prompt

Opens a window in which you run MS-DOS and other computer 
commands.

Math Input 
Panel

Allows you to write and correct freehand math equations using your 
mouse or other pointing device.

Notepad Serves as a simple text editor.

Paint Allows you to perform basic image editing.

Remote Desktop 
Connection

Connects two computers over a network or the internet, allowing one 
computer to see and use the other computer’s desktop. Remote Desktop 
Connection is covered later in this lesson.

Run Allows you to run commands from the Start menu. Some commands 
require elevated or administrative privileges; to run these commands, 
use the Run as administrator command.

Snipping Tool Allows you to capture, annotate, and save screenshots. Snipping Tool is 
covered later in this lesson.

Sound Recorder Allows you to record sound from different audio devices, such as a 
microphone that’s plugged into the sound card on your computer.

Table 3-1

Window 10 Accessory 
Programs

(continued )
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Using the Snipping Tool

A screenshot, also referred to as a snip or screen grab, is a snapshot of whatever is displayed 
on the computer screen. You might take a screenshot of an error message to help trouble-
shoot a computer problem, you might capture screenshots of a process in a program to create 
a how-to guide, or you might capture a screenshot to save as an image to use in a report or 
other document.

Snipping Tool (see Figure 3-11) is an accessory program that comes with Windows 10 
that allows you to take screenshots, annotate them, and save them. When using Snipping 
Tool, you can capture the entire screen, a window, a rectangular portion of the screen, or 
a free-form image. The free-form capture allows you to use your mouse pointer or other 
pointing device to draw around a non-rectangular object on the screen.

CERTIFICATION READY
What is the Snipping 
Tool used for?
Objective 1.3

Program Description

Sticky Notes Allows you to keep notes on the desktop to help you remember impor-
tant items. Available in different colors.

Sync Center Allows you to sync any folder in your computer with a folder on an 
external drive connected to your computer or a network drive.

File Explorer Allows you to access files and folders on your computer, copy and move 
items, search for items, and more. This graphical file management system 
is built in to many versions of Windows.

Windows 
Mobility Center

Allows you to control many different computer settings, such as screen 
brightness, volume, power/battery, Wi-Fi, Bluetooth, sound, and so on.

WordPad Serves as a word processor, with many more features than Notepad.

Ease of Access Allows you to open the Ease of Access Center to configure accessibility 
options and gives you access to the speech recognition feature. See 
Lesson 2.

Tablet PC Gives you access to tools to use a tablet PC’s input device.

Windows Media 
Player

Enables you to play audio and video and display images; rip music from 
and copy music to compact discs; and burn recordable discs in Audio CD 
format or as a data disc.

Windows 
PowerShell

Opens a command window useful for IT professionals. Windows 
PowerShell is covered later in this lesson.

Home and business users alike need to capture screenshots occasionally for many 
different reasons. Windows 10 includes the Snipping Tool, an easy-to-use screen capture 
program with a few editing features.

Figure 3-11

The Snipping Tool window

Table 3-1

Continued
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You can save images in GIF, JPG, PNG, or HTML format, then use Snipping Tool to add 
freehand annotations, highlight or erase part of the image, or send it to a recipient via e-mail. 
If you select the HTML format, Snipping Tool saves the screenshot as a web archive file in 
MHT format, which you can open in a web browser such as Internet Explorer.

USE THE SNIPPING TOOL TO CAPTURE A SCREENSHOT

GET READY. To capture a screenshot with the Snipping Tool and save it as a graphics file, per-
form the following steps.

1.  Open or display a file, program, window, web page, or anything that contains an 
object or picture you want to capture in a screenshot.

2.  Click Start > Windows Accessories > Snipping Tool.
3.  Click the New drop-down menu and click Free-form Snip, Rectangular Snip, 

Window Snip, or Full-screen Snip (see Figure 3-12). The default option is 
Rectangular Snip, which is used in this example.

4.  A white overlay appears on your screen. Click and drag the mouse pointer over the 
area you want to capture (see Figure 3-13). An editing window appears, displaying 
the captured image.

Figure 3-12

Selecting the type of screen-
shot to capture

Figure 3-13

The captured image
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5.  To save the image, click Save Snip on the toolbar, which looks like a floppy 
diskette.

6.  In the Save As dialog box, navigate to the location where you want to save the 
screenshot. In the File name text box, type a descriptive name for the file.

7.  Click the Save as type drop-down menu and click GIF, JPG, or PNG.

8.  Click Save. The screen capture is saved as a graphics file.

USE THE SNIPPING TOOL TO ANNOTATE AN IMAGE

GET READY. To annotate an image using Snipping Tool, perform the following steps.

1.  In the Snipping Tool editing window, click the down arrow to the right of the pen 
button on the toolbar. Click a pen color in the list.

2.  Write or draw on the image (see Figure 3-14).

3.  Click Save Snip to save the annotated image under the current file name or a new 
file name.

Remember, you can open an image saved with Snipping Tool in any graphics program 
(including Paint) to make detailed edits.

GIF files support 256 colors and are used primarily for websites. JPG is the most common 
picture file format, and it supports over 16 million colors. PNG files are an improvement to 
the GIF format and support “lossless compression,” which means you can enlarge a PNG 
file to a certain extent without losing clarity and crispness.

TAKE NOTE*

Figure 3-14

Annotating an image

You can turn off the Snipping Tool overlay. Click Options, clear the Show screen overlay 
when Snipping Tool is active check box, and then click OK.TAKE NOTE*
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Using Windows Media Player

Windows Media Player 12 is a program that allows you to play back music and video files 
and view photos. Files stored in your Music, Pictures, and Videos libraries appear in the 
Windows Media Player file list by default. If you’re connected to a network, you can stream 
digital media files—audio, video, or photos—for playback or viewing from another computer 
or a server that hosts Windows media files. The main window in Windows Media Player is 
called the Player Library (see Figure 3-15).

Whether playing digital files on your computer, or from a CD or DVD, Windows Media 
Player includes common playback controls, such as Play, Shuffle, Repeat, Stop, Next, 
Previous, and a volume slider. You can switch to a smaller window, referred to as Now 
Playing mode, by clicking the Switch to Now Playing button in the lower-right corner. The 
Now Playing mode window appears (see Figure 3-16). To return to your library, click Go to 
Library.

With Windows Media Player, you can do the following as well:

•	 Create playlists: Organize your music files into playlists, which are simply lists of music 
composed of songs from different albums, and may even be located on different areas of 
your computer or attached devices. Whatever appears in the library may be included in 
a playlist.

CERTIFICATION READY
What is the name of 
the main window of 
Windows Media Player?
Objective 1.3

If you need to simply play back almost any type of multimedia file, Windows Media 
Player should be the program you use. It’s built in to Windows 10 (so it’s free), and 
its media burning and ripping features, along with the ability to stream multimedia to 
other networked computers, makes it a great choice at home and work.

Figure 3-15

Windows Media Player main 
window—the Player Library

Windows Media Player 12 supports the 3GP, AAC, AVCHD, MPEG-4, WMV, and WMA 
audio and video formats. It also supports most AVI, DivX, MOV, and Xvid files.

TAKE NOTE*
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•	 Rip music from CDs to your computer: Insert a CD and, when a list of its tracks 
appears in the Windows Media Player window, click Rip CD. Windows Media Player 
rips the tracks on the CD to your Music library.

•	 Burn CDs: If you have a recordable optical drive on your computer, you can use 
Windows Media Player to burn a collection of your favorite songs to a CD.

•	 Create slide shows: Use Windows Media Player to create slide shows with playback 
controls in just a few clicks.

•	 Share media across a network: You can use the Play to command to share multimedia 
files across a network with a homegroup (a personal network, usually set up at home) or 
across the internet.

If you pin Windows Media Player 12 to the Windows 10 taskbar, you can take advantage of 
Jump Lists for previously accessed files. The Jump List also includes playback controls at the 
bottom of the Jump List window to play music, a video, or view photos without having to 
open Windows Media Player first.

PLAY BACK MEDIA FILES

GET READY. To listen to music files, watch videos, or view photos in Windows Media Player, 
perform the following steps.

To listen to music files in Windows Media Player:
1.  Open Windows Media Player by clicking Start, typing Media Player, and then select-

ing Windows Media Player.
2.  Click the Music library in the navigation pane, click the file you want to hear in 

the file list, and then click Play at the bottom of the window.

Figure 3-16

Windows Media Player—Now 
Playing mode



92  |  Lesson 3

Another option is to click the Play tab in the upper-right corner of the Windows 
Media Player window, drag the songs you want to hear to the Play tab, and then 
click the Play button.

3.  After the file has finished playing, Windows Media Player automatically plays the 
next file in the list.

To watch a video in Windows Media Player:
1.  Click the Videos library in the navigation pane and double-click the file you want 

to view in the file list. Windows Media Player launches a special viewing window 
and plays back the video.

2.  Place your mouse pointer over the window to display playback controls.

To view photos in Windows Media Player:
1.  Click the Pictures library in the navigation pane. Thumbnails of the photos in your 

Pictures library appear (see Figure 3-17).

2.  To view all of the photos as a slide show, click Play. Windows starts the slide 
show in its own window.

To stop any playback feature, click Stop in the playback controls and click Go to Library.

CREATE A PLAYLIST

GET READY. To create a playlist of music, perform the following steps.

1.  In Windows Media Player, in the Player Library, click Playlists.
2.  To create a playlist, click the Click here link.

3.  With the title in edit mode (as shown in Figure 3-18), type a name for the new 
playlist that appears in the Navigation pane.

4.  Drag and drop songs from the file list to the new playlist.

Figure 3-17

The Pictures library
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An auto playlist gives you more control and options. To create an auto playlist, click the down 
arrow on the Create playlist button, click Create auto playlist, and then follow the prompts.

BURN A MUSIC CD

GET READY. To burn a music CD, perform the following steps.

1.  Insert a blank CD or DVD into your computer’s recordable media drive.

2.  In Windows Media Player, in the Player Library, click the Music library to display 
the file list.

3.  Click the Burn tab.

4.  Drag individual songs, playlists, or entire albums to the burn list on the right.

5.  Click Start burn.

The CD ejects when the burning process completes. The burn process works similarly for 
other types of media files.

■■ Supporting Mobile Access and Data Synchronization

You can use Microsoft accounts, PC settings, and Sync Center to ensure a consistent experi-
ence for users who move between devices. Solutions include synchronizing PC settings across 
desktops, laptops, and smartphones using Microsoft accounts and configuring Sync Center to 
maintain access to files and folders stored on a network file share when you are offline.

Figure 3-18

Creating a playlist in Windows 
Media Player

THE BOTTOM LINE

Users who work across multiple devices want to be able to keep their address books, music, 
and document files in sync and accessible, regardless of the device they are using at the 
time. Windows 10 provides several ways to ensure that users have a consistent experience.
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Synchronizing Your PC Settings

Information that can be synchronized includes the following:

•	 Start screen layout, chosen colors, and themes
•	 Language preferences
•	 Browser history and favorites
•	 Windows Store app settings

You can also get to and share your photos, documents, and other files from OneDrive and 
other services on all your PCs without signing in to each one.

SYNC YOUR PC SETTINGS

GET READY. To sync your PC Settings, log on to a Windows 10 computer using your 
Microsoft account and perform the following steps.

1.  Click Start > Settings.
2.  In the Settings window, click Accounts.
3.  On the Accounts page, click Sync your settings.
4.  For Sync settings, drag the slider bar all the way to the right to turn on sync for each 

item that you want to synchronize between your devices, as shown in Figure 3-19.

5.  Close the Settings window.

When you sign on to a Windows 10 computer with your Microsoft account, the system 
automatically syncs most of the settings for you.

patrickpatrick@adatum.com.

Figure 3-19

Synchronizing via PC Settings
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USING SYNC CENTER

Sync Center offers two ways to sync your data:

•	 One-way sync: Data kept in a primary location is synchronized with data in another 
location. For example, if you have a portable MP3 device, you can configure a one-way 
sync so that you maintain the music files on your computer and the MP3 player holds 
only a copy of the files. When it comes time to sync, only data on the computer will be 
transferred to the MP3 player, not vice versa.

•	 Two-way sync: Data is transferred in both directions. This works well when you want to 
make sure key files you work with on the network and on your device are always in sync. 
As a result, you can still work with those files when you are not connected to the net-
work where the files are stored (offline files).

When working with mobile devices, Microsoft recommends using the software that comes 
with your device (mobile phone, music device, and so on) to perform synchronization. If 
your device is compatible with Sync Center, you can perform the next exercise to sync your 
device.

SYNC A DEVICE

GET READY. If your device is compatible with Sync Center, sync your device by performing 
the following steps.

1.  Right-click Start and choose Control Panel.
2.  In the Search Control Panel text box, type Sync Center. From the results, click 

Sync Center.
3.  Open Sync Center and click Set up new sync partnerships.
4.  Click Set Up.

5.  Configure the settings and schedule for how and when you want to sync with 
the device.

Configuring Offline Files

Changes you make to the files while offline will be made to the files in the network folder 
when you reconnect. Sync Center tracks the version number for a file. If the file has 
changed, it copies the updated version to the other location to keep both locations  
in sync. In case of conflicts, Sync Center notifies you and you can choose to address  
the conflict.

If offline files are enabled, when you click the Manage offline files link within Sync Center, 
the Offline Files dialog box opens (see Figure 3-20), displaying the following tabs:

•	 General: Configures how offline files are used and synced.
•	 Disable offline files: Enables and disables the Offline Files feature.

CERTIFICATION READY
What can you do to sync 
files from a shared folder 
so that you can access 
those files when you are 
not connected to your 
corporate network?
Objective 4.4

Sync Center enables you to sync certain mobile devices as well as files stored in folders 
on network servers (offline files).

Sync Center’s primary purpose is to synchronize files available on your network. When 
you set up an offline files sync partnership with a folder, any time you disconnect from 
the network, you can continue to work on the files.
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•	 Open Sync Center: Opens Sync Center and checks for conflicts.
•	 View your offline files: Provides access to your offline files.

•	 Disk Usage: Provides information on how much disk space is currently used and is 
available for storing offline files; enables you to change the maximum amount of space 
offline files and temporary files can use on your computer.

•	 Encryption: Enables you to encrypt and unencrypt your offline files.
•	 Network: Enables you to determine how often the computer will check for a slow con-

nection; by default, it is set to 5 minutes.

SCHEDULING FOR OFFLINE FILES

To set a schedule for the items you want to synchronize along with the date/time or the 
event that triggers the synchronization, simply right-click the Offline Files icon and choose 
Schedule for Offline Files. The options are as follows:

•	 At a scheduled time: This option enables you to set a start date and time, and deter-
mine the frequency you want to repeat the schedule (minutes, hours, days, weeks, 
or months).

•	 When an event occurs: This option configures synchronization to occur when one of 
the following events occurs:
•	 You log on to your computer.
•	 Your computer is idle for x minutes/hours.
•	 You lock Windows.
•	 You unlock Windows.

Additional start-and-stop scheduling options include the following:

•	 Start sync only if the computer is awake, has been idle for x minutes, and/or the com-
puter is running on external power.

•	 Stop sync if the computer wakes up from being idle or the computer is no longer 
running on external power.

Figure 3-20

Reviewing Offline Files 
property settings
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RESOLVING SYNC CONFLICTS

Although synchronizing can help keep your files in a consistent state, there will be times that 
you will experience a conflict that must be resolved to ensure you have the right file in the 
right place. Understanding what causes conflicts and your options to resolve them will help 
you protect your files.

A sync conflict occurs when you have two copies of a file stored in different locations (e.g., 
locally and in a network folder) that have both changed since the last sync. A conflict can 
also occur if someone deletes a file (located in a shared folder) while another person makes a 
change to the same file while she is offline. In either case, Sync Center prompts you to deter-
mine how you want to address the conflict. You typically will overwrite the older file, but if 
you choose to keep both, Sync Center renames one version and makes a copy of both files in 
both locations. At this point, the files are no longer synchronized.

SET UP OFFLINE FILES AND RESOLVE A CONFLICT

GET READY. To set up offline files and resolve conflicts, perform the following steps.

First, from your Windows server, create a folder, share it, and then create a file called MyFile.
txt in the folder.

1.  Log on to LON-DC1 as adatum\administrator with the password of Pa$$w0rd.

2.  On the taskbar, click File Explorer.
3.  Click the C: drive on your computer to open it.

4.  Right-click the C: drive, choose New > Folder, and then type Data.

5.  Right-click the Data folder and choose Properties.
6.  In the Properties dialog box, click the Sharing tab.

7.  Click the Advanced Sharing button.

8.  Select the Share this folder option.

9.  Click the Permissions button.

10.  In the Permissions dialog box, select the Allow Full Control check box.

11.  Click OK to close the Permissions dialog box.

12.  Click OK to close the Advanced Sharing dialog box.

13.  Click Close to close the Properties dialog box.

14.  Double-click the Data folder.

15.  Right-click the Data folder and choose New > Text Document.
16.  Type MyFile for the name and press Enter.

Now, from a Windows 10 client computer, connect to the shared folder on the domain 
controller.

1.  Log on to the Windows 10 client computer with a regular domain user account.

2.  On the taskbar, click File Explorer.
3.  In the Address text box, type \\rwdc01\data and then press Enter.
4.  Double-click MyFile.txt to open it and type Connected over network.

5.  Click File > Save and then close Notepad.

6.  Right-click the file and choose Always available offline. Notice the icon changes 
to show that the file is available offline.

7.  Right-click the Network icon on the taskbar and choose Open Network and 
Sharing Center.

8.  Click Change adapter settings.

TAKE NOTE*

This exercise requires a 
domain controller and a 
Windows 10 client com-
puter connected to the 
domain.
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9.  In the Network Connections window, right-click your Ethernet adapter and choose 
Disable. Your Ethernet adapter is now disabled, which simulates an offline environ-
ment for this computer.

From LON-DC1, delete the file while the Windows 10 client computer is disconnected from 
the network. This creates a conflict that you will need to resolve later.

1.  From LON-DC1, on the taskbar, click File Explorer.
2.  Click the C: drive on your computer.

3.  Double-click the Data folder on your computer.

4.  Right-click MyFile and choose Delete.

From the Windows 10 client computer, make a change to the file while you are still offline.
1.  From the Windows 10 client computer, with the \\rwdc01\data folder open,  

double-click MyFile.txt to open it and then type Changes made while offline.

2.  Click File > Save.

3.  Close Notepad.

From the Windows 10 client computer, enable your Ethernet adapter and reconnect to the 
network.

1.  From the Windows 10 machine, with the Network Connection window open, right-
click your Ethernet adapter and choose Enable.

2.  Once your Ethernet adapter has reconnected to the network, close the Network 
Connections dialog box.

3.  Right-click MyFile.txt and choose Sync > Sync selected offline files.
4.  In the Resolve Conflict dialog box, click Keep this version and copy it to the 

other location.

5.  Close the dialog box.

The file has now been restored on RWDC01.

■■ Using Windows Mobility Center

Windows Mobility Center is a control panel of sorts that gives you access to several 
laptop settings, from volume to screen brightness to power options to Wi-Fi  
and Bluetooth settings—all in one place. Although the settings can be accessed from 
various icons and commands within Windows, you can make adjustments from a  
single window in Windows Mobility Center. Figure 3-21 shows the Windows Mobility 
Center window.

Windows Mobility Center displays settings in boxes, or tiles. The tiles that are displayed 
depend on your hardware and laptop manufacturer. In addition, a setting that is turned off or 
disabled might not display, or it might display with a red X—such as when you turn off your 
Wi-Fi antenna by pressing a Fn key, such as F4 or F10.

Table 3-2 describes common Windows Mobility Center settings. Not all settings are available 
on all laptops, so a few settings described in the table are not displayed in Figure 3-21.

CERTIFICATION READY
What set of tools are 
only found on mobile 
computers that help 
manage mobile features?
Objective 1.4

TAKE NOTE*

Windows Mobility 
Center is only available 
on laptops.

THE BOTTOM LINE

Rather than using different tools to adjust your laptop’s screen brightness, wireless settings, 
and more, just open the Windows Mobility Center, which displays groups of settings all in 
one interface.
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Figure 3-21

The Windows Mobility Center 
window

Table 3-2

Typical Windows Mobility 
Center Settings

Setting Description

Brightness Allows you to adjust the brightness of your laptop display. Move the 
slider to the left to decrease brightness or to the right to increase bright-
ness. Display brightness is related to the power plan for your laptop; 
those settings are adjusted in the Battery Status tile.

Volume Allows you to increase or decrease speaker volume or select the Mute 
check box to temporarily disable audio.

Battery Status Allows you to see how much battery charge remains and adjust the power 
plan for your laptop. Power plans vary but offer two at a minimum: one for 
running on battery power and another for running on AC power.

Wireless 
Network

Allows you to turn your wireless network adapter on or off and see the 
status of your wireless network connection.

Screen Rotation For tablet PCs, this feature allows you to change the orientation of your 
screen (portrait or landscape).

External Display Allows you to connect an external monitor to your laptop.

Sync Center Allows you to access settings to sync files with a network location or 
with a mobile device. Sync Center is covered in more detail in this lesson.

Presentation 
Settings

Provides you with access to settings for connecting your laptop to a pro-
jector for presentations.

CHANGE MOBILITY CENTER SETTINGS

GET READY. To adjust settings in Windows Mobility Center, perform the following steps.

1.  Open Windows Mobility Center by clicking Start, typing windows mobility, and 
then clicking Windows Mobility Center in the results list.

2.  Adjust the screen brightness by dragging the Brightness slider left or right.

3.  Click the Battery Status drop-down list and click another power plan, such as 
Power saver. Notice how the screen brightness changes again.

4.  Click the Battery Status drop-down list again and click the original power plan.

CERTIFICATION READY
Which settings can 
be adjusted by using 
the Windows Mobility 
Center?
Objective 1.4
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Click the drop-down lists in other tiles of Windows Mobility Center to see which options are 
available.

■■ Accessing a Computer Remotely

These tools include the following:

•	 Remote Desktop Connection
•	 Remote Assistance
•	 Microsoft Management Console (MMC)
•	 Remote PowerShell

Configuring Remote Desktop

Remote Desktop Services (RDS) allows users to access a remote computer just as if they 
were sitting in front of the computer. Within a Window, the user has a Start button, desktop, 
applications, and folders as well as access to local resources such as the user’s local drive and 
mapped drives. Users could use Remote Desktop Services to run applications that they can’t 
run on their own machines. You could go one step further and use multiple servers to create 
an entire RDS infrastructure to provide a robust, resilient service for your users.

By default, Windows Server 2012 R2 and Windows Server 2016 can support up to two 
remote sessions at once, while Windows 10 only supports one remote connection. For 
servers, if you need additional users to access the server, you have to install a Remote Desktop 
Licensing server, and then add licenses based on either the number of devices that can con-
nect to the RDS server or the number of concurrent users.

When planning for remote access, you must deliver a consistent experience to your users 
whether they connect over the local network or across low-bandwidth networks when 
working from remote locations. For users to be productive while working remotely, they must 
have access to their remote resources at all times. As part of your remote access design, review 
your current topology and ensure that you have redundancy built in not only to your devices 
(routers and switches), but also to your network links.

You need to ensure that the firewalls do not block access to the remote servers when access 
is needed. You typically would not make the remote access available through the RDP from 
the internet unless the client is connected over a VPN tunnel or is using the Remote Desktop 
Services Gateway.

Although the RDP uses compression and caching mechanisms to limit the amount of traffic 
transmitted over network links, consider the different types of traffic that will traverse the  
network links. For example, if you are using virtualization for your operating systems and 

CERTIFICATION READY
Which Windows 10 tool 
allows you to remotely 
connect to Windows 
servers and provides 
a remote desktop and 
taskbar?
Objective 1.5

TAKE NOTE*

Remote Desktop is 
included with all edi-
tions of Windows 10; 
however, you can only 
connect to computers 
running the Professional, 
Enterprise, or Education 
editions.

THE BOTTOM LINE

These days, large organizations may be located throughout the country/region (or the world), 
have a mobile work force, and offer work-from-home capability. As an administrator, 
you need a way to access these systems remotely. Microsoft includes multiple tools within 
Windows that allow you to access clients and servers remotely.

The Remote Desktop Protocol (RDP) is a proprietary protocol that was developed by 
Microsoft to connect to another computer over a network connection using the same 
graphical interface that you would use if you were sitting in front of the physical server. 
RDP uses TCP port 3389. Typically, you would access computers remotely using the 
Remote Desktop Connection (RDC), which would allow you to connect to a Remote 
Desktop Session Host or to a Remote Application.
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applications to support your remote users, expect to see large bursts of data when the 
operating system and applications are sent to the remote client. Make sure your core infra-
structure is capable of providing the bandwidth needed by your users.

If you are concerned about protecting sensitive data sent between remote users and your 
servers, configure group policies to require the use of a specific security layer to secure commu-
nications during RDP connections. RDP connections can be configured to support 128-bit 
encryption (the maximum level of encryption supported by the client) or 52-bit encryption 
mechanisms. The option you choose for your design depends on the capabilities of your 
remote clients and the level of encryption needed to meet your specific data protection needs. 
In general, your design should use the strongest encryption supported by your remote clients.

RDP 10 is integrated with Windows Server 2016 and Windows 10. With RDP 10, you can 
deploy remote clients (laptops, desktops, and/or virtual machines hosted in a data center) as 
part of your remote access strategy.

To connect to a computer, use the Remote Desktop Connections (mstsc.exe) program, which 
is found in the Windows Accessories folder. In the Remote Desktop Connection dialog box 
(see Figure 3-22), specify a server name or IP address, and click Connect.

CONNECT TO A REMOTE COMPUTER USING REMOTE DESKTOP CONNECTION

GET READY. To connect to a remote computer using Remote Desktop Connection, perform 
the following steps.

1.  Log on to a Windows 10 computer.

2.  Click Start and type remote desktop. From the search results, click Remote 
Desktop Connection.

3.  In the Computer text box, type the computer name or IP address of the computer 
(such as LON-DC1 or 192.168.1.68) and click Connect.

4.  If you are prompted to confirm that you want to trust this remote connection, 
click Connect again.

On occasion, you might need to use the mstsc.exe /admin command to connect to a server 
with the administrative session. This becomes particularly useful when the terminal server or 
Remote Desktop Services has exceeded the maximum number of allowed connections or when 
you get a black screen after you RDP to a system, assuming the system has not crashed.

When you open Remote Desktop Connection, click Show Options to display additional 
options (as shown in Figure 3-23). These options are arranged in the following tabs:

•	 General: Allows you to specify the remote computer and user name to connect to. At 
the bottom of the tab, you can save the current connection settings to an RDP file or 
open a saved RDP file.

Figure 3-22

Opening the Remote Desktop 
Connection program
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•	 Display: Controls how the remote desktop appears on the client computer, including 
the size of the remote desktop in pixels (including the full screen option), use of all 
monitors for the remote session, and the number of colors.

•	 Local Resources: Allows you to control which client resources are available to the 
remote session.

•	 Experience: Specifies which display options are available for a remote connection. If you select 
LAN (10 Mbps or higher), all options are selected. However, if you select a faster option than 
what the network actually is, your remote session may be slow or have a choppy display.

•	 Advanced: Allows you to specify server authentication options and a Remote 
Desktop Gateway.

On the Display tab (see Figure 3-24), you can specify the size of the remote desktop as it 
appears on the client computer. By default, the Remote Desktop size slider is set to Full 
Screen, which causes the client to occupy the client computer’s entire display, using the  
computer’s configured display resolution.

Figure 3-23

Remote Desktop options

Figure 3-24

Remote Desktop Display tab
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To avoid confusion when displaying multiple desktops on a system (the local desktop and one 
or more multiple remote desktops), the Display the connection bar when I use the full screen 
check box is selected, which will display a title bar at the top of each remote desktop session.

In addition to the desktop size, you can use the Colors drop-down list to adjust the color 
depth of the RDC display. The settings available in this drop-down list depend on the capa-
bilities of the video display adapter installed on the client computer.

One of the new features implemented in RDP 6.x is support for 32-bit color, which enables 
clients to run graphic-intensive applications, such as image editors, with a full color palette. 
However, the trade-off for this capability is the increased network bandwidth required to 
transmit the display information from the terminal server to the client.

For example, when you configure RDC to use 32-bit color, the client and the terminal server 
open a special RDP channel just for that color information. This enables the client to assign a 
lower priority to the extra color information so that it does not interfere with the basic func-
tionality of the client. However, 32-bit color increases the overall bandwidth consumed by the 
connection substantially. As a general rule, you should set the Colors parameter to the High 
Color (16-bit) setting unless the client will be running terminal server applications that can 
benefit from the additional color information.

On the Local Resources tab, shown in Figure 3-25, you configure how the RDC client should 
reconcile the resources on the Remote Desktop server with those on the client computer. You 
can click the Settings button to specify whether audio playback is played on the local com-
puter or the remote computer and whether remote audio recordings are recorded from the 
local computer.

To make the remote connection more flexible, Remote Desktop allows you to redirect 
many of the local resources, such as local printers and disk drives (including local mapped 
drives). When you log on to the remote computer, you can open a document on the remote 

Figure 3-25

Remote Desktop Local 
Resources tab
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computer and print the document to your local printer. In addition, you can open a docu-
ment on your local hard drive on the remote computer.

By default, the Printers and Clipboard check boxes are already selected. By redirecting 
the Clipboard, you can cut and paste to and from the remote computer. If you click the 
More button, you can specify ports, drives, and other supported Plug and Play (PnP) 
devices.

With Windows 10, you can select USB devices for redirection and swap them between 
the remote computer and the local computer. To redirect USB devices, you must enable 
the RemoteFX USB redirection feature in a Group Policy Object (GPO). Navigate to the 
Computer Configuration\Policies\Administrative Templates\Windows Components\Remote 
Desktop Services\Remote Desktop Connection Client\RemoteFX USB Device Redirection\
Allow RDP redirection of other supported RemoteFX USB devices from this computer, 
enable the policy, and specify whether you want to allow all users or only administrators to 
redirect devices. When RemoteFX USB Redirection is enabled, click the new Devices icon on 
the connection bar to choose which devices you want to redirect.

Configuring Remote Assistance

Remote Desktop is used to open a session with a computer, whereas Remote Assistance 
is used to view and interact with a user session remotely. It can be used by technical 
support people, administrators, and trainers to interact with the user without traveling to 
the user.

To ensure that a support person does not jump into a user session without proper authoriza-
tion, you can send an invitation using one of three methods:

•	 Save this invitation as a file: Use this option to save the invitation as a file that you can 
send to a user via an attachment, copy to a disk, or send over the network.

•	 Use email to send an invitation: Use this option to send the invitation to the sender 
through email. Of course, you cannot use this option if you do not have a configured 
email program, such as Microsoft Outlook.

•	 Use Easy Connect: If the local network uses the Peer Name Resolution Protocol 
(PNRP), which requires IPv6, you can use Easy Connect. The Windows 10 system will 
start listening for incoming connections without an invitation. Instead, you only need to 
share the unique password.

CREATE AN INVITATION

GET READY. To create an invitation, perform the following steps.

1.  Log on to a Windows 10 computer.

2.  Right-click Start and choose Control Panel.
3.  In Control Panel, click System and Security. Under System, click Launch remote 

assistance.

4.  In the Windows Remote Assistance dialog box (as shown in Figure 3-26), click 
Invite someone you trust to help you.

CERTIFICATION READY
Which tool allows you 
to view a user session 
on a computer running 
Windows 10 so that 
you can assist the user 
through a problem?
Objective 1.5

Remote Assistance is a Windows 10 feature that enables an administrator, trainer, or 
support person to connect to a remote user’s computer, chat with the user, and either 
view all of the user’s activities or take complete control of the system. Similar to Remote 
Desktop, it also uses TCP port 3389.
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5.  The How do you want to invite your trusted helper? page appears, as shown in 
Figure 3-27. Click Save this invitation as a file.

6.  In the Save As dialog box, specify a name for the invitation file and the  
location of the folder in which the wizard should create the invitation.  
Click Save.

7.  The Windows Remote Assistance window opens, displaying the password you  
must supply to the support person.

Figure 3-26

The Windows Remote 
Assistance Do you want to ask 
for or offer help? page

Figure 3-27

The Windows Remote 
Assistance How do you want 
to invite your trusted helper? 
page
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If the support person’s system supports Remote Assistance, you just have to double-click the 
invitation. The support person is prompted to enter the password. The user is then prompted 
to confirm if the support person is allowed. When the user clicks Yes, the support person can 
see the session. Using the Windows Remote Assistance window, the support person and user 
can send messages back and forth, as shown in Figure 3-28. For the support person to take 
control, he or she has to click the Request control button.

In the following exercise, you will use Remote Assistance Easy Connect. However, if you do 
not have Peer Name Resolution Protocol (PNRP) and IPv6, the Easy Connect options will be 
greyed out.

USE EASY CONNECT

GET READY. To use Easy Connect to remotely connect to a computer, perform the following 
steps.

1.  Log on to a Windows 10 computer that needs help.

2.  Right-click Start and choose Control Panel.
3.  In Control Panel, click System and Security. Under System, click Launch remote 

assistance.

4.  In the Windows Remote Assistance dialog box, click Invite someone you trust to 
help you.

5.  The Windows Remote Assistance Wizard opens, displaying the How do you want to 
invite your trusted helper? page.

6.  Click Use Easy Connect. If you get a Can’t connect to global peer-to-peer network 
error message, you probably do not have PNRP installed on your network.

7.  In the Windows Remote Assistance window, record the unique password that you 
will provide to the user who is trying to help you.

8.  Log on to the remote Windows 10 computer.

9.  Right-click Start and choose Control Panel.
10.  In Control Panel, click System and Security. Under System, click Launch remote 

assistance.

11.  In the Windows Remote Assistance dialog box, click Help someone who has 
invited you.

12.  In the Windows Remote Assistance dialog box, click Use Easy Connect.
13.  In the Remote Assistance dialog box, type the Easy Connect 12-character password 

and click OK.

Configuring Remote Management Settings

As mentioned in the previous two sections, the two methods to connect to another 
computer are Remote Desktop and Remote Assistance. However, before you can use Remote 
Desktop or Remote Assistance, you have to use the System Properties to enable these two 
technologies. In addition, you have to make sure the Windows Firewall (or whatever firewall 
you are using) will allow Remote Desktop and/or Remote Assistance traffic.

Figure 3-28

Interacting with a user via 
Remote Assistance
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To enable either or both of these technologies, open the System Properties (open Control 
Panel, click System and Security > System, and then click Remote settings), as shown in 
Figure 3-29. By default, Remote Assistance is enabled and Remote Desktop is not.

Click the Advanced button in the Remote Assistance section to specify the maximum amount 
of time an invitation can remain open (the default is 6 hours) and whether the computer can 
be controlled remotely or not. You can also specify whether you can create invitations that 
can only be used from computers running Windows Vista or later, which will encrypt the IP 
address, which, in turn, cannot be read by Windows XP.

For Remote Desktop, the Allow connections only from computers running Remote Desktop 
with Network Level Authentication (recommended) option is used to require the user to be 
authenticated before the session is created, which helps protect the remote computer from 
malicious users and software. To use Network Level Authentication, the client computer must 
be using at least Remote Desktop Connection 6.0 and operating systems such as Windows 
XP with Service Pack 3, or Windows Vista and newer.

The Select Users button is used to specify which users can connect to the system using the RDP. 
These users are added to the local computer Remote Desktop Users group. The Administrators 
group already has access even though they are not listed in the Remote Desktop Users list.

CONFIGURE REMOTE MANAGEMENT SETTINGS

GET READY. To configure remote management settings, perform the following steps.

1.  Log on to LON-CL1 as adatum\administrator with the password of Pa$$w0rd.

2.  Right-click Start and choose System.

3.  In the Control Panel System window, click Remote settings.
4.  In the System Properties dialog box, the Remote tab is selected. To enable  

Remote Assistance, make sure the Allow Remote Assistance connections to this 
computer check box is selected.

5.  In the Remote Assistance section, click the Advanced button.

6.  In the Remote Assistance Settings dialog box, select the Create invitations that 
can only be used from computers running Windows Vista or later check box to 
tighten security.

Figure 3-29

Enabling Remote Desktop and 
Remote Assistance
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7.  To close the Remote Assistance Settings dialog box, click OK.

8.  In the System Properties dialog box, in the Remote Desktop section, click the 
Allow remote connection to this computer option to enable remote connections.

9.  Click the Select Users button.

10.  In the Remote Desktop Users dialog box, click Add to add a user or group.

11.  In the Select Users or Groups dialog box, in the Enter the object names to select 
text box, type the name of the user group and click OK.

12.  To close the Remote Desktop Users dialog box, click OK.

13.  To close the System Properties dialog box, click OK.

Using the Microsoft Management Console to Manage  
Systems Remotely

The Microsoft Management Console (MMC) is a collection of administrative tools called 
snap-ins. An MMC snap-in is a utility provided by Microsoft or a third party that’s accessible 
through a common interface. Administrators use MMC tools for managing hardware, soft-
ware, and network components on a computer. Administrative Tools is a popular collection of 
tools that use the MMC.

Computer Management, shown in Figure 3-30, is a popular snap-in that includes several 
tools such as Disk Management, which is used to configure hard drives and their partitions, 
and Event Viewer, which allows you to view computer event information, such as program 
starting and stopping (including program crashes) and security problems. You can manage 
system performance and resources using Performance Monitor, which is under Performance > 
Monitoring Tools.

CERTIFICATION READY
What are the Windows 
10 Administrative Tools 
built on?
Objective 1.3

When assisting users with computer problems or maintaining systems, a support person 
often needs to check computer events, look at computer resource usage, or examine 
a disk’s partition, among other tasks. You may use Microsoft Management Console 
(MMC) tools and utilities for this purpose.

Figure 3-30

The Computer Management 
window
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Some administrators and power users create custom MMCs that include only tools they use 
regularly—creating a toolkit of sorts.

CREATE A CUSTOM MMC AND MODIFY SETTINGS REMOTELY

GET READY. To create a custom MMC and then modify settings remotely, perform the fol-
lowing steps.

1.  Right-click Start, click Run, and then type mmc in the Run dialog box. Click Yes 
to open the MMC Console.

2.  In the MMC Console window, click File > Add/Remove Snap-in. The Add or 
Remove Snap-ins dialog box opens (as shown in Figure 3-31).

3.  In the Available snap-ins list on the left, click a snap-in of your choice, such as 
Computer Management. In the middle of the dialog box, click Add. In the dialog 
box that opens, leave Local computer selected (unless the computer you want to 
manage is one other than the current computer).

4.  Click Finish. The snap-in is added to the Selected snap-ins pane on the right.

5.  You can then repeat step Repeat Steps 3 and 4 for each snap-in you want to 
include in the custom MMC.

6.  When you have finished adding snap-ins, click OK.

7.  Click File > Save As. In the File name text box, type a name for the custom MMC 
and click Save.

8.  If you loaded the Computer Management MMC, expand System Tools > Event 
Viewer > Windows Logs and click System.

9.  View the logs on the remote computer.

Figure 3-31

Selecting snap-ins for a custom 
MMC
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10.  Expand the Services and Applications node and click Services.
11.  Right-click the Computer Browser service and choose Restart.
12.  Close the MMC console.

To avoid exposing a computer to malicious attacks, Microsoft recommends that you use 
MMC snap-ins when you are not logged on as Administrator.

Many of the snap-ins supplied with Windows 10 enable you to manage other Windows 
computers on the network as well. There are two ways to access a remote computer using a 
Microsoft Management Console (MMC) snap-in:

•	 Redirect an existing snap-in to another system
•	 Create a custom console with snap-ins directed to other systems

To connect to and manage another system using an MMC snap-in, you must launch the 
console with an account that has administrative credentials on the remote computer. You 
then click the snap-in, then right-click the snap-in, and choose Connect to another com-
puter. The Select Computer dialog box shown in Figure 3-32 opens. If your credentials do 
not provide the proper permissions on the target computer, you will be able to load the 
snap-in, but you will not be able to read information from or modify settings on the 
target computer.

Not every snap-in has the capability to connect to a remote computer because some 
do not need it. For example, the Active Directory Domain Services consoles automat-
ically locate a domain controller for the current domain and access the directory ser-
vice from there. There is no need to specify a computer name. However, you will find 
Change Domain and Change Domain Controller commands in the Action menu in these 
consoles, which enable you to manage a different domain or select a specific domain 
controller in the present domain.

The other factor that can affect the ability of an MMC snap-in to connect to a remote 
computer is the existence of Windows Firewall rules that block the necessary network 
traffic between the computers. The traffic that an individual snap-in requires and whether 
the default Windows Firewall rules restrict it depends on the functions that the snap-in 
performs.

Connecting to a remote computer by redirecting an existing console is convenient for 
impromptu management tasks, but it is limited by the fact that you can only access one com-
puter at a time. You also have to open the console and redirect it every time you want to 
access the remote system. A more permanent solution is to create a custom console with snap-
ins that are already directed at other computers.

Figure 3-32

The Select Computer dialog 
box in an MMC console
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When you add a snap-in to a custom console, you select the computer you want to manage 
with that snap-in. You can also add multiple copies of the same snap-in to a custom console, 
with each one pointed at a different computer. This adds a whole new dimension to MMC’s 
functionality. Not only can you create custom consoles containing a variety of tools, but you 
can also create consoles containing tools for a variety of computers. For example, you can cre-
ate a single console containing multiple instances of the Event Viewer snap-in, with each one 
pointing to a different computer. This enables you to monitor the event logs for computers all 
over the network from a single console.

Using Windows Remote Management

Windows Remote Management (WinRM) is a Windows 10 service that enables admin-
istrators to execute commands on remote computers using Windows PowerShell or the 
Windows Remote Shell (WinRS.exe) command-line program. However, Windows 10 does 
not start the service by default or configure the computer to allow remote management 
communications.

WinRM is responsible for routing the packets to the right location, while Web Services 
for Management structures the packets and requires a port to be made accessible via 
your firewall. To enable remote management for a target computer, you can do one of the 
following:

•	 Open a command prompt and execute the winrm quickconfig command.
•	 Open Windows PowerShell on the computer, and then type Enable-PSRemoting.

The following tasks are performed when you run winrm quickconfig or Enable-PSRemoting:

•	 Start or restart (if already started) the WinRM service.
•	 Set the WinRM service startup type to automatic.
•	 Create a listener to accept requests on any IP address.
•	 Enable Windows Firewall inbound rule exceptions for WS-Management traffic 

(for http only). This inbound rule is listed as Windows Remote Management via 
WS-Management (TCP port 5985) in the inbound rules of your Windows Firewall.

CONFIGURE REMOTE MANAGEMENT WITH THE WINRM COMMAND

GET READY. Log on to Windows 10 using an account with administrative privileges and then 
perform the following steps.

1.  Open a Command Prompt with Administrator privileges. If the User Account Control 
dialog box opens, click Yes.

2.  Execute the following command:

winrm quickconfig

3.  When the command responds, indicating that it will start the WinRM service and 
set the WinRM service to delayed auto start, type y and press Enter.

4.  When you are prompted to create a WinRM listener, enable the WinRM firewall 
exception, type y, and then press Enter.

5.  Close the Administrator: Command Prompt window.

Using Windows Remote Management, administrators can execute programs from the 
command line on remote computers without having to open a Remote Desktop session.
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WinRM can be enabled for all computers within a domain via a Group Policy Object. To 
help keep the use of WinRM secure, you can enable the Computer Configuration\Policies\
Administrative Templates\Windows Components\Windows Remote Management (WinRM)\
WinRM Service\Allow remote server management through WinRM setting, and specify the 
IP Address ranges that the service will accept connections from.

Using WinRS.exe

To use WinRS.exe, frame the command you want to execute on the remote computer as 
follows:

winrs –r:computer [-u:user] [-p:password] command

•	 –r:computer: Specifies the name of the computer on which you want to execute the 
command, using a NetBIOS name or a fully qualified domain name (FQDN).

•	 -u:user: Specifies the account on the remote computer that you want to use to execute 
the command.

•	 -p:password: Specifies the password associated with the account specified in the –u 
parameter. If you do not specify a password on the command line, WinRS.exe prompts 
you for one before executing the command.

•	 command: Specifies the command (with arguments) that you want to execute on the 
remote computer.

Introducing Windows PowerShell

The Windows PowerShell environment is built on the .NET Framework, which allows 
administrators to use many more tools and commands than the MS-DOS command 
window environment. PowerShell and the MS-DOS command environment are compat-
ible. For example, you can run Windows command-line programs in Windows PowerShell 
and also start Windows programs like Calculator and Notepad at the Windows PowerShell 
prompt. Windows PowerShell providers enable you to access other data stores, such as the 
registry and the digital signature certificate stores, as easily as you access the file system. 

After you have configured the Remote Management service, you can execute commands 
on other computers that have been similarly configured. To execute a command from 
the Windows 10 command prompt, you must use the WinRS.exe program.

Windows PowerShell is a command-line interface used mainly by IT professionals 
to run cmdlets (pronounced command-lets), complete background jobs (processes 
or programs that run in the background without a user interface), and run scripts to 
perform administrative tasks.

Alternatively, you can use the Windows PowerShell Set-WSManQuickConfig cmdlet to con-
figure the Remote Management.TAKE NOTE*

The WinRM.exe program will fail to configure the required firewall exception if the com-
puter’s network location is set to Public. The computer must use either the Private or 
Domain location settings for the remote management configuration process to succeed.

TAKE NOTE*
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PowerShell also provides full access to COM and WMI, which enables administrators to 
perform tasks on both local and remote Windows systems and with some remote Linux 
systems.

Component Object Model (COM) provides a platform-independent, distributed, object-
oriented system for creating software components. Software can call these components at 
will. For example, File Explorer is an empty shell that links to multiple COM interfaces 
that allow you to navigate and display the file structure, and related objects such as This 
PC/My Computer, drives, folders, and files. Other programs such as Microsoft Office 
can call up the same COM objects so that you can browse, store, and access documents 
on disks.

Windows Management Instrumentation (WMI) is the Microsoft implementation of  
Web-Based Enterprise Management (WBEM) that allows accessing management infor
mation in an enterprise environment. WMI uses the Common Information Model (CIM) 
industry standard to represent systems, applications, networks, devices, and other managed 
components. With WMI, you can retrieve the status of local and remote computers and 
their components. With WMI, you can configure security settings, configure system prop-
erties, change permissions of users and groups, manage processes, and view and configure 
error logging.

Cmdlets (pronounced command-lets) are native commands available in Windows PowerShell. 
Cmdlets follow a Verb-Noun naming pattern, such as get-process, get-service,  
get-help, set-date, or stop-process. Common verbs include:

•	 Add: Add a resource to a container, or attach an item to another item.
•	 Get: Retrieve data from a resource.
•	 New: Create a new resource.
•	 Remove: Delete a resource from a container.
•	 Set: Modify a resource, such as data or system parameters.
•	 Start: Begin an operation such as a process or program.

Knowing the legal verbs and remembering the singular noun rule is helpful when guessing 
cmdlet names.

Windows PowerShell includes more than 100 basic core cmdlets, and additional cmdlets will 
be added when you install additional software components such as Microsoft Exchange. You 
can even write your own cmdlets and share them with other users.

To get help on a cmdlet, you can use the get-help cmdlet. For example, to get help for the 
ps cmdlet, execute the following command:

Get-Help ps

To get more detailed help, add a –full at the end of the command.

RUN A CMDLET IN WINDOWS POWERSHELL

GET READY. To run a cmdlet in Windows PowerShell, perform the following steps.

1.  Click Start and type PowerShell. From the results, click Windows PowerShell.
2.  A commonly used command is ps (or get-process). The ps command lists 

the currently running processes and their details, such as the process ID, pro-
cess name, and percentage of processor usage (CPU). Type ps and press Enter, as 
shown in Figure 3-33.
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3.  To get help with the ps command, execute get-help ps.

4.  To view running services, execute get-service. A list of services displays along 
with their status (Running or Stopped).

5.  To exit the Windows PowerShell window, execute exit.

Because most cmdlets have multiple parameters, Windows PowerShell commands can get 
very complicated by combining cmdlets. A pipe (|) will use the output of one command as 
the input to another command. For example, Get-VM will list VMs on a Hyper-V host.  
Get-vmmemory server01 will display the memory settings of one VM called server01. 
However, if you combine the two with a pipe:

Get-vm | Get-vmmemory

you will get the memory settings for all of the servers in a list.

Windows 10 includes the Windows PowerShell Integrated Scripting Environment (ISE) 
that helps you create Windows PowerShell scripts. If you need the scripts to be executed on a 
regular basis, you can execute the scripts using Task Scheduler.

ISE provides command-completion functionality, and enables you to see all available com-
mands and the parameters that you can use with those commands. While you can use a 
text editor to create a PowerShell script, the Windows PowerShell ISE makes it easier, since 
you can view cmdlet parameters, and it can help you create syntactically correct Windows 
PowerShell commands.

After you open Windows PowerShell ISE (as shown in Figure 3-34), you can use the File 
menu to create a new script, open saved scripts, save scripts, and run scripts. Windows 
PowerShell ISE provides color‑coded cmdlets to assist with troubleshooting, and provides 
debugging tools that you can use to debug simple and complex Windows PowerShell scripts. 
You can use the Windows PowerShell ISE to view available cmdlets by module (such as 
DNSClient, Defender, WindowsSearch, or WindowsUpdate).

Figure 3-33

Running the ps command  
in Windows PowerShell
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If you need help running a script, such as sending an email to a group of users, use the fol-
lowing command structure:

Send-MailMessage -SmtpServer server hostname -From sender email address 
-To recipient email address --BodyAsHtml "message"

If you start typing Send-, you will see a list of commands that begin with Send-. If you click 
Send-MailMessage, you get the syntax of the command, as shown in Figure 3-35.

Figure 3-34

Opening Windows  
PowerShell ISE

Figure 3-35

Using Windows PowerShell 
ISE to get help on PowerShell 
cmdlets
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To create a script using the Windows PowerShell ISE, you would click View > Show Script 
Pane. Alternatively, you can click the little down arrow next to Script at the top of the main 
pane. You will then type your commands (as shown in Figure 3-36) and save the script with a 
.ps1 filename extension. You can execute the script to test it anytime by clicking the Execute 
button (the right green arrow button). After the script has been thoroughly tested, you can 
then use Task Scheduler to automatically execute the script.

Using Remote Windows PowerShell

The Windows PowerShell environment is built on the .NET Framework, which allows 
administrators to use many more tools and commands than the MS-DOS command window 
environment. PowerShell and the MS-DOS command environment are compatible, how-
ever. For example, you can run Windows command-line programs in Windows PowerShell 
and also start Windows programs like Calculator and Notepad at the Windows PowerShell 
prompt.

Another feature of Windows PowerShell is remoting. Administrators can use cmdlets to access 
remote computers or they can use the Windows PowerShell Remoting service to run com-
mands on a remote computer or on many remote machines. Windows PowerShell Remoting 
can require substantial setup, which is not within the scope of this book.

PowerShell Remoting is a server-client application that allows you to securely connect to 
a remote PowerShell host and run script interactively. It allows you to run commands on 
a remote system as though you were sitting physically at its console. PowerShell Remoting 
is built upon the Web Services for Management protocol and uses Windows Remote 
Management service to handle the authentication and communication elements.

Figure 3-36

Creating a script with Windows 
PowerShell ISE

Windows PowerShell is a command-line interface used mainly by IT professionals 
to run cmdlets, complete background jobs (processes or programs that run in the 
background without a user interface), and run scripts to perform administrative tasks.
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There are two types of remoting:

•	 One-to-one remoting: Allows you to bring up the PowerShell prompt on a remote 
computer. The credentials you use are delegated to the remote computer. Any com-
mands you run will run under those credentials.

•	 One-to-many remoting: Allows you to send one or more commands, in parallel, to 
multiple computers. Each of these computers runs the command, produces the results 
into an XML file, and then returns the results to your computer over the network. 
When the results are returned, they include the computer name.

In the next two exercises, you will use one machine to access another machine via Windows 
PowerShell. In the first exercise, you will enable PSRemoting on a computer. You will then 
use a second computer to access the first computer.

USE POWERSHELL (ONE-TO-ONE REMOTING)

GET READY. To connect to a target Windows 10 computer using PowerShell and use 
one-to-one remoting, perform the following steps.

To enable PSRemoting on a target computer:
1.  Log on with administrative privileges to a computer running Windows 10.

2.  Click Start and type PowerShell. From the results, click Windows PowerShell.
3.  In the Windows PowerShell window, execute Enable-PSRemoting (see Figure 3-

37).

4.  Read the tasks that will be performed, type A, and then press Enter.

GET READY. From the source Windows 10 computer, log on with administrative privileges to 
the domain and perform the following steps.

1.  Press Windows logo key+r, type PowerShell in the Run box, and then click OK.

2.  In the Windows PowerShell window, execute the following command:

enter-pssession –ComputerName <computername>

Replace <computername> with your domain controller’s name. Once connected, 
the PowerShell prompt should include the name of the computer you are currently 
connected to remotely.

3.  Execute get-service to see the services running on the domain controller.

4.  Execute get-process to see a list of all processes running on the domain 
controller.

5.  Execute get-acl c:\ to see the access control list applied via NTFS for the c: 
drive.

6.  Execute exit-pssession to exit PowerShell.

Figure 3-37

Enabling PS Remoting
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S K I L L  S U M M A R Y

In this lesson you learned:

•	 Internet Explorer is the traditional Microsoft browser that offers a number of features to pro-
tect your security and privacy while you browse the web, including phishing filters, Protected 
Mode, Pop-up Blocker, Add-on Manager, download files or software notification, and the use 
of digital signatures and 128-bit secure (SSL) connections when using secure websites.

•	 Microsoft Edge is the new Microsoft lightweight web browser with a layout engine built 
around web standards designed to replace Internet Explorer as the default web browser. It inte-
grates with Cortana, annotation tools, Adobe Flash Player, a PDF reader, and a reading mode.

•	 Windows Media Player 12 is a program that allows you to play back music and video files 
and view photos. Files stored in your Music, Pictures, and Videos libraries appear in the 
Windows Media Player file list by default.

•	 Users who work across multiple devices want to be able to keep their address books, 
music, and document files in sync and accessible, regardless of the device they are using 
at the time. Windows 10 provides several ways to ensure that users have a consistent 
experience.

•	 Windows Mobility Center is a control panel of sorts that gives you access to several 
laptop settings, from volume to screen brightness to power options to Wi-Fi and Bluetooth 
settings—all in one place.

•	 The Remote Desktop Protocol (RDP) is a proprietary protocol that was developed by 
Microsoft to connect to another computer over a network connection using the same 
graphical interface that you would use if you were sitting in front of the physical server. 
RDP uses TCP port 3389. Typically, you would access computers remotely using the 
Remote Desktop Connection (RDC), which would allow you to connect to a Remote 
Desktop Session Host or to a Remote Application.

•	 Remote Assistance is a Windows 10 feature that enables an administrator, trainer, or 
support person to connect to a remote user’s computer, chat with the user, and either 
view all of the user’s activities or take complete control of the system. Similar to Remote 
Desktop, it also uses TCP port 3389.

•	 Windows PowerShell is a command-line interface used mainly by IT professionals to 
run cmdlets (pronounced command-lets), complete background jobs (processes or pro-
grams that run in the background without a user interface), and run scripts to perform 
administrative tasks.

■■ Knowledge Assessment

Multiple Choice

Select the correct answer for each of the following questions.

	 1.	 Which of the following tools are available in Administrative Tools? (Choose all that 
apply.)
a.	 Print Management
b.	 System Information
c.	 Computer Management
d.	 Event Viewer
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	 2.	 Which of the following actions can be performed with the Snipping Tool?
a.	 Annotate an image with the pen tool
b.	 Change the color of a captured image
c.	 Add typed callouts
d.	 Save in PDF format

	 3.	 When you right-click a program you want to run that requires elevated or administrative 
privileges, which of the following commands can be chosen from the shortcut menu?
a.	 Run elevated
b.	 Run protected
c.	 Run with permission
d.	 Run as administrator

	 4.	 Which of the following actions can be performed with Windows Media Player 12? 
(Choose all that apply.)
a.	 Stream video files over the internet
b.	 Rip music from a CD
c.	 Play a slide show
d.	 Create playlists

	 5.	 Which of the following locations allows you to configure security zones in Internet 
Explorer 11?
a.	 Internet Options Security tab
b.	 Internet Options Privacy tab
c.	 Safety menu
d.	 Tracking Protection window

	 6.	 Which of the following utilities runs the ps cmdlet?
a.	 MS-DOS command window
b.	 Windows Remote Assistance
c.	 Windows PowerShell
d.	 Computer Management

	 7.	 Which of the following tools are accessible from the Computer Management window? 
(Choose all that apply.)
a.	 Event Viewer
b.	 Performance Monitor
c.	 Remote Desktop Connection
d.	 Disk Management

	 8.	 Which of the following tools can be used when you want to access your home computer 
from work to get a file you worked on last night?
a.	 Disk Management
b.	 Remote Desktop Connection
c.	 Windows Remote Assistance
d.	 Sync Center

	 9.	 Which Remote Assistance method uses Peer Name Resolution to allow for quick and 
easy connection?
a.	 Invitation via files
b.	 Invitations via email
c.	 Easy Connection
d.	 Auto Connect
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	10.	 Which programming environment can be used to create complicated PowerShell scripts?
a.	 PowerShell Dev Center
b.	 Windows PowerShell Integrated Scripting Environment
c.	 Remote PowerShell
d.	 Windows Management Instrumentation

Fill in the Blank

Complete the following sentences by writing the correct word or words in the blanks provided.

	 1.	 Microsoft’s newest browser is _____________.

	 2.	 Remote Desktop Connections and Remote Assistance use TCP port _____________.

	 3.	 _____________ helps prevent personal information and browsing history from being 
stored by Internet Explorer 11.

	 4.	 The _____________ detects threats on websites, such as phishing attacks and malware 
downloads, and prevents them from running.

	 5.	 _____________ is an accessory program included with Windows 10 that allows you to 
take screenshots, annotate them, and save them.

	 6.	 _____________ is a feature of Internet Explorer 11 that helps you control which web-
sites can track your online browsing activity.

	 7.	 After you synchronize files between your computer and a network location, the files you 
use on your computer are referred to as _____________.

	 8.	 _____________ allows you to set up a computer for remote access and then connect to 
that computer wherever you are located.

	 9.	 An MMC _____________ is a utility provided by Microsoft or a third party that’s 
accessible through a common interface, such as Administrative Tools.

	10.	 _____________ is a command-line interface used mainly by IT professionals to run 
cmdlets, background jobs, and scripts to perform administrative tasks.

True / False

Circle T if the statement is true or F if the statement is false.

T F 	 1.	 Windows Mobility Center is found on all editions of Windows 10 
Professional.

T F 	 2.	 Remote Desktop Connection and Windows Remote Assistance refer to the 
same program used in different ways.

T F 	 3.	 Windows Remote Assistance sessions are encrypted for safety.

T F 	 4.	 Remote Desktop comes with all editions of Windows 10; however, you 
can only connect to computers running the Professional, Enterprise, or 
Education editions.

T F 	 5.	 Windows Mobility Center includes access to power plans and screen 
brightness.
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■■ Business Case Scenarios

Scenario 3-1: Securing Internet Explorer 11

Your co-worker is finalizing a big project for a medical client and has many sensitive client 
files on her computer. She asks you to help her make her computer as safe as possible while 
accessing the internet. Describe your recommended solution.

Scenario 3-2: Offering Remote Assistance

The sales staff travels extensively and often needs technical assistance with configuration set-
tings on their Windows 10 laptops. Which feature or program is used to provide remote 
support for these employees?

Scenario 3-3: Viewing Logs Remotely

Joe has been having problems with his system and you have been assigned a ticket to investi-
gate those problems. However, Joe is a very busy person who always needs to use his machine. 
Therefore, you don’t have access to the machine to look through the system logs. Describe 
how you can look at the Event Viewer logs without interrupting Joe.

Scenario 3-4: Creating a Playlist

You provide technical support to a small dental practice. The office manager hands you several 
company-owned music CDs. She wants the music piped to the lobby area where patients wait 
to be seen for their appointments. The computer used at the receptionist’s desk is running 
Windows 10 and has wireless speakers that can be set up in the waiting area. Describe how 
you can provide the requested music without investing in further resources.
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LESSON4 Managing 
Applications, 
Services, and Disks

K E Y  T E R M S

Active Directory

app

basic disk

BitLocker Drive Encryption

compression

desktop app

dynamic disk

encryption

encryption key

Extended File Allocation Table 
(exFAT)

External Serial Advanced 
Technology Attachment 
(eSATA)

FAT

FAT32

file system

FireWire

Group Policy

Group Policy Object (GPO)

IEEE 1394

isochronous data transfer

Microsoft account

mirrored volume

multi-booting

NTFS

partition

process

Program Compatibility 
Troubleshooter

Resilient File System (ReFS)

service

software program

striped volume

System Configuration utility 
(MSConfig)

Task Manager

Universal Serial Bus (USB)

Universal Windows Platform 
(UWP)

volume

Windows Store

O B J E C T I V E  D O M A I N  M A T R I X

Skill/Concept Exam Objective Objective Number

Configuring Applications Configure applications 3.1

Managing Windows Store Apps Configure applications 3.1

Understanding Services Understand services 3.4

Using MSConfig (System Configuration 
Utility)

Configure native applications and tools 1.3

Managing Processes and Applications 
with Task Manager

Configure native applications and tools 1.3

Understanding Storage Understand file systems

Understand storage

4.1

5.2

Encrypting and Compressing Files  
and Folders

Understand encryption 4.3
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■■ Configuring Applications

Desktop apps are traditional apps, such as Microsoft Word or Excel. The applications are 
installed using an .exe or .msi installer file, which is obtained from a DVD, over a network 
from a shared folder, or over the internet.

Configuring Desktop Apps

Because those applications are running in the Windows 10 desktop environment, there are 
centralized settings that you can configure for each application. For example, you can specify 
which files are associated with an application, and you can configure how older applications 
interact with Windows 10.

To start a desktop application, you:

•	 Double-click an icon, which is usually a shortcut to the executable file.
•	 Double-click a data file that is tied to or associated with the application.
•	 Click the Start button, navigate to the application, and then click the application.

For example, when you install Microsoft Office, .doc and .docx files are associated with 
Microsoft Word. Therefore, anytime you double-click a .doc or .docx file on a system with 
Microsoft Office installed, Microsoft Word opens, which then opens the document.

CHANGE THE DEFAULT APPS

GET READY. To change the default apps in Windows 10, perform the following steps.
1.  Click Start > Settings.
2.  In the Settings window, click System.

3.  On the System page, click the Default apps vertical tab. To change the primary 
web browser from Microsoft Edge to Microsoft Internet Explorer, scroll down (as 
shown in Figure 4-1) and under Web browser, click Microsoft Edge, and then click 
Internet Explorer.

Your company’s management wants to maximize the return on their investment in 
Windows 10. The IT group has requested that you prepare user training materials to 
teach employees how to make best use of Windows 10 files, applications, libraries, 
and file encryption. You need to learn as much as possible about these technologies to 
provide accurate materials and in-depth training.

THE BOTTOM LINE

A software program (also known as an app) is a sequence of instructions written to 
perform a specified task for a computer. Today, most of these programs are installed as 
desktop apps or Windows Store apps.

One of the advantages of any modern operating system is that you can use it to run a 
wide range of applications. Because each application is unique, each program has its 
own settings. To determine the settings for a desktop application, you will have to refer 
to the documentation that is included with the desktop application.
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4.  To reset to the Microsoft recommended default apps, click the Reset button. After 
the applications have been reset, a checkmark appears next to the Reset button.

5.  Click Choose default apps by file type.

6.  On the Choose default apps by file type page, scroll down to .gif. The current 
program to open a .gif file is Photos. To change the default program for .gif files, 
click Photos and click Paint.

7.  Close the Settings window.

Configuring Windows Features

In Windows 10, you can use Control Panel’s Programs and Features to uninstall programs or 
to change a program’s configuration by adding or removing certain options. If the program 
you want to uninstall isn’t listed, it might not have been certified for or registered with 
Windows. You should check the documentation for the software.

UNINSTALL OR CHANGE A PROGRAM

GET READY. To uninstall a program or change a program in Windows 10, perform the fol-
lowing steps.

1.  Right-click Start and choose Programs and Features. Alternatively, open  
Control Panel and if you are in Category view, click Programs > Programs and 
Features. If you are in Large icons view or Small icons view, click Programs  
and Features.

2.  Click a program such as Microsoft SQL Server 2012 Native Client (see Figure 4-2) 
and click Uninstall. Click No to not uninstall the app.

Figure 4-1

Managing default apps

You can also use the Programs and Features to uninstall and change an installed 
program. Most Windows programs allow you to uninstall a program from your 
computer if you no longer use it or if you want to free up space on your hard drive.
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3.  Close the Control Panel.

Some programs include the option to repair the program or to change the installed options, 
but many simply offer the option to uninstall the program. To change the program, click 
Change or Repair. If you are prompted for an administrator password or confirmation, type 
the password or provide confirmation.

Supporting Desktop Application Coexistence

Before you deploy Windows 10 in an organization, you must thoroughly test each application 
to make sure that it runs as expected. If it does not, either you need to take additional  
steps to make the application run on Windows 10, or you need to contact the vendor to  
get an upgraded version of the application.

Of course, as with any problem, when dealing with application compatibility issues, don’t 
forget to follow basic troubleshooting. First, record any error messages that are displayed. 
Then, use Event Viewer to look for additional warnings or errors. If applications seem to be 

Figure 4-2

Managing programs with 
Programs and Features

Because Windows 10 follows the same architecture used in Windows Vista, Windows 7, 
and Windows 8/8.1, most applications written for Windows Vista, Windows 7, and 
Windows 8/8.1 will run on Windows 10. The few applications that do not run on 
Windows 10 are usually primarily security-class applications or applications that 
bypass the Windows application programming interface (API) to communicate with 
system hardware by performing low-level kernel calls. If an application does not run in 
Windows 10, not even under the application compatibility mode, you can try to run 
the application under a Hyper-V virtual machine, a RemoteApp, or App-V.
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slow, you can use Task Manager and other performance monitoring tools such as Performance 
Monitor. Lastly, be sure to perform research on the internet and to check vendor websites.

There are several ways in which you can have users run the same application but with dif-
ferent versions. First, you can run Hyper-V on a client machine, so that you create virtual 
machines that will run other versions of an application. You can also have users connect to 
remote desktop sessions, which include other versions of the application. You can also access 
RemoteApps, which are applications hosted on a server running Remote Desktop Services, 
but appear as applications that are running locally.

Application Virtualization (App-V), which is part of the Microsoft Desktop Optimization 
Pack (MDOP), is used to mitigate application-to-application incompatibilities or conflicts. To 
run virtual applications, you use the App-V 5.1 Sequencer, which converts an application into 
a virtual package. You then deploy the App-V 5.1 client, which runs the virtualized appli-
cation on the computer. When you run the virtualized application on a local computer, the 
virtualized application runs in an isolated environment. Therefore, you could run different 
versions of the same application at the same time by using App-V.

Troubleshooting Program Compatibility

The Program Compatibility Troubleshooter is a wizard-based solution that users or admin-
istrators can use to automatically configure an executable file to use an appropriate Windows 
10 compatibility mechanism. Thus, the troubleshooter is not a compatibility mechanism in 
itself; it is simply a method for applying other mechanisms.

To run the Program Compatibility Troubleshooter, right-click an executable file or a shortcut 
to an executable file and choose Troubleshoot Compatibility from the shortcut menu. When 
the troubleshooter launches, it attempts to determine what is preventing the program from 
running properly. The troubleshooter then gives you two options:

•	 Try Recommended Settings: Implements the compatibility settings that the trouble-
shooter has determined will resolve the problem and configures the executable to use 
those settings whenever you run it.

•	 Troubleshoot Program: Displays a What Problems Do You Notice? page, shown in 
Figure 4-3, on which you can select the problems you have experienced. The trouble-
shooter then leads you through a series of pages that further identify the problem and 
configure the executable with specific compatibility settings.

Figure 4-3

The What Problems Do You 
Notice? page in the Program 
Compatibility Troubleshooter

The simplest method of coping with an application compatibility issue in Windows 10 
is to run the Program Compatibility Troubleshooter.
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Another tool to overcome compatibility issues is to manually configure the compatibility 
settings for an executable file. To access these settings, right-click an executable file, choose 
Properties, and then click the Compatibility tab (as shown in Figure 4-4). You can then 
define the compatibility mode for the application, such as Windows 95, Windows XP 
(Service Pack 3), Windows 7, or Windows 8. You can also reduce the color mode, run the 
application in a 640 × 480 screen resolution, or run the program as an administrator.

Configuring Startup Options

Task Manager is one of the handiest programs you can use to take a quick glance at 
performance to see which programs are using the most system resources on your computer. 
You can see the status of running programs and programs that have stopped responding,  
and you can stop a program running in memory. For this lesson, you can also use Task 
Manager to manage your startup programs and services.

The Startup tab shows the programs that are configured to automatically start when you 
start Windows, as shown in Figure 4-5. You can disable a startup program by right-clicking 
an item and choosing Disable. You can also access the properties of the program file for the 
application, and the location of the program file.

Figure 4-4

Manually configuring program 
compatibility settings

Some programs start or have a component (program and service) that starts during 
the Windows boot process. Also, some of these programs allow the program to run 
faster, while others are required for the program to function properly. In some of these 
situations, you may not want these programs to start during boot up or continually 
consume resources at all times. Therefore, you need to know how to turn off or disable 
the startup programs.



128  |  Lesson 4

DISABLE A STARTUP PROGRAM

GET READY. To disable a startup program in Windows 10, perform the following steps.
1.  Right-click the taskbar and click Task Manager.
2.  In the Task Manager window, click More details.
3.  To view the startup programs, click the Startup tab.

4.  To disable a startup program, right-click the program and choose Disable.

5.  Close the Task Manager.

■■ Managing Windows Store Apps

Universal Windows Platform (UWP) apps are a special type of Windows Store apps that 
can be installed on multiple hardware platforms, such as a tablet that is running Windows 10 
Pro, an Xbox One, or a Windows 10 Phone. The Windows Store apps differ from traditional 
applications in that they are designed to run in a single, full window display across multiple 
form factor devices (e.g., desktops, laptops, and tablets). These devices can be touch-based or 
use a standard mouse and keyboard.

Configuring the Windows Store

Figure 4-5

Managing startup programs

THE BOTTOM LINE

Windows Store apps refers to a class of applications for Microsoft Windows devices 
including PCs, tablets, phones, Xbox One, Microsoft HoloLens, and the Internet of 
Things. They are typically distributed and updated through the Windows Store.

The Windows Store provides a central location for you to purchase and download 
Windows apps that run on Windows 8 and later operating systems. Windows Store 
apps do not run on Windows 7 or earlier versions of Windows. Windows Store apps 
tend to be smaller and faster than desktop apps.
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Windows 10 includes the Windows Store app, which can be accessed directly from the task-
bar. In Windows 10, the Windows Store enables users to deploy both Windows Store apps 
and desktop apps. To browse the Windows Store, you do not have to sign in with a Microsoft 
account. However, if you want to download and install apps from the Windows Store, you do 
have to sign in with a Microsoft account.

A Microsoft account, previously called Windows Live ID, is a unique account that is 
the combination of an email address and a password that you use to sign in to services 
like Outlook.com, MSN.com, Hotmail.com, OneDrive, Windows Phone, or Xbox 
Live. When you set up a computer running Windows 10 for the first time, you have 
the option of creating a Microsoft account using an email address that you provide. The 
email address you use can come from any provider. After the account is set up, Microsoft 
will use it, along with your password, to help manage your settings across all of your 
PCs that run Windows 10. Microsoft accounts enable you to synchronize your desktop 
across multiple Windows 10 devices and provide a consistent experience when working 
with Windows Store apps. Purchased apps will be available from each device, feeds you 
add will be synced across all devices, and state information will be maintained, so you 
can start a game or read a book and pick it up later on another device. You can create 
a Microsoft account during the initial installation of the operating system or after the 
system is running.

When you open the Windows Store, you can click the Sign in icon (the icon next to the 
Search text box). Also, if you click the Sign up button, you can configure the following:

•	 Downloads and updates: Allows you to view the current downloads and allows you to 
check for updates for the Windows Store apps.

•	 Settings: Allows you to enable automatic updates, show products on the Live Tile, 
streamline purchases, and manage your devices that are connected to the Microsoft 
account. Figure 4-6 shows the Windows Store Settings page.

Figure 4-6

Managing Windows Store 
settings
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CONFIGURE THE WINDOWS STORE

GET READY. To configure the Windows Store, perform the following steps.
1.  On the taskbar, click the Windows Store button.

2.  To sign in to the Windows Store, click the Sign in button and then click  
Sign in.

3.  When you are asked to choose an account, click Microsoft account.
4.  Specify the proper credentials in the Email or phone dialog box and click  

Sign in.

5.  Click the user icon and click Settings.
6.  To update apps automatically, ensure that the Update apps automatically option is 

set to On.

7.  To streamline your purchases so that you will not be asked for a password, ensure 
that the Streamline my purchase experience is set to On.

8.  To view your downloads and updates, click the user icon again and click  
Downloads and updates.

9.  Close the Store window.

Implementing Windows Store Apps

The applications available through the Windows Store must be certified by Microsoft for 
compatibility and content. The certified apps cannot contain adult content and cannot 
advocate discrimination, illegal activity, alcohol, tobacco products, drugs, weapons, profanity, 
or extreme violence.

Although the Windows Store can provide a wide variety of apps and tools to enhance 
Windows 10, you might decide to restrict access to it for your users. This restriction might be 
necessary if you want to make sure your users are working with only authorized applications 
within your organization.

To deny access to Windows Store apps, set up a policy for a single computer/user or for mul-
tiple computers and users. The tool you use depends on where you want to use the policy. For 
example, if you want to configure the policy and test it, use the Local Group Policy Editor on 
a Windows 10 client machine. If you want to deploy the policy settings across your domain, 
use the Group Policy Management Console. In either case, the settings are located under the 
Administrative Templates\Windows Components\Store under the Computer Configuration 
and User Configuration nodes.

When configuring the policy using the Local Group Policy Editor for a user (User 
Configuration\Administrative Templates\Windows Components\Store), there is only one 
option to set within the policy:

•	 Turn off the Store application:
•	 Not Configured (default): If you select this option, access to the Store is allowed.
•	 Enabled: If you select this option, access to the Store is denied.
•	 Disabled: If you select this option, access to the Store application is allowed.

TAKE NOTE*

If you create the policy 
using the Local Group 
Policy Editor, you can 
export and import 
it into a GPO at the 
domain level. It does not 
have to be created again.

Searching for a Windows Store app is quite easy. You just type what you are searching 
for (the specific name or desired category), and Microsoft provides a list of available 
apps. Apps then install in the background. When the installation is done, the app 
appears in a tile on the Start menu.
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If you set the policy for a computer (Computer Configuration\Administrative Templates\
Windows Components\Store), the following options are available:

•	 Turn off Automatic Download of updates:
•	 Not Configured (default): Download of updates is allowed.
•	 Enabled: Automatic downloads are turned off.
•	 Disabled: Automatic downloads of updates are allowed.

•	 Allow Store to install apps on Windows To Go workspaces:
•	 Not Configured (default): Access to the Store is not allowed.
•	 Enabled: Access to the Store is allowed on the Windows To Go Workspace. Use this 

option only when the device is used with a single PC.
•	 Disabled: Access to the Store is denied.

•	 Turn off the Store application:
•	 Not Configured (default): If you select this option, access to the Store is allowed.
•	 Enabled: If you select this option, access to the Store is denied.
•	 Disabled: If you select this option, access to the Store application is allowed.

RESTRICT ACCESS TO THE WINDOWS STORE USING A LOCAL GROUP POLICY

GET READY. Log on to a Windows 10 computer with administrative credentials. In this 
activity, you will review the policy settings that control the Windows Store access for both 
computers and users by performing the following steps:

1.  Click Start. Type gpedit.msc and press Enter. The Local Group Policy Editor opens.

2.  Expand Computer Configuration > Administrative Templates > Windows 
Components and click Store.

3.  Double-click the Turn off the Store application setting. The Turn off the Store 
application dialog box opens. Click Enabled.

4.  Attempt to access the Windows Store. Click the Store tile located on the Windows 
10 Start menu. The message Windows Store isn’t available on this PC appears.

5.  Return to the group policy setting you enabled in Step 3 and click Not Configured 
to regain access to the Windows Store.

In some situations, you might have a computer in a public area (such as a library or kiosk) 
that needs to run just a single Windows app. In these situations, you can configure Windows 
10 settings to restrict access to a single application.

When you assign access to a single Windows Store app, you restrict the application to a user 
account. When the user signs into the computer, that user can only access the assigned app.

RESTRICT A USER ACCOUNT TO RUN A SINGLE WINDOWS STORE APP

GET READY. To restrict a user account to run a single Windows Store app, perform the following 
steps.

1.  Click Start > Settings.
2.  Click Accounts and click Family & other people.

3.  In the right pane, click Set up assigned access.
4.  Click Choose an account and select the account that you want to restrict.

5.  Click Choose an app and select the installed app to which you want to restrict 
the account.

6.  Sign out of the computer to make the changes effective.
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Understanding Group Policy and Network Application Installation

Group Policy is a collection of settings (policies) stored in Active Directory on a Windows net-
work. Active Directory is an infrastructure (directory) that stores information and objects. An 
object can be a file, a printer, a computer, a user account, or other entities. Objects in Active 
Directory are linked to Group Policy Objects (GPOs), which are used by administrators to 
control users and computers on a network and to deploy applications, software updates, and 
security. Group Policy affects users and computers contained in sites, domains, and organiza-
tional units.

Group Policy works well in small to large environments whether an organization is located in a 
single area or has multiple offices spread around a state or several states, for example. It’s easiest 
to manage in mostly “heterogeneous environments,” in which many of the client computers 
use the same hardware and users use much of the same software with the same configurations.

If your organization already deployed Active Directory, such as Microsoft Windows 2016 
Active Directory Domain Services (AD DS), using Group Policy to push applications to users 
or computers is efficient. Using Group Policy, you can assign or publish an application to 
all users or computers in a designated site, domain, organizational unit (OU), or to a local, 
individual user or computer.

For example, let’s say you’re deploying Microsoft Office for more than 20 users. If you set up 
Group Policy to assign the software on each computer, the software is installed the next time 
the computer starts and any users with the correct permissions who log on to the computer 
may run the software. If you use Group Policy to assign the software to users, the next time an 
authorized user clicks the Microsoft Office shortcut or menu item, the software installs on the 
user’s computer and Office opens. If you publish an application to users, the next time a user 
logs on, he can choose to install the software from a dialog box that opens.

With Group Policy, you can control which users can use the software. If a user logs on who 
isn’t authorized to run the software (considered “out of scope”), the software can be unin-
stalled automatically.

Once software is installed, you can push updates to the software and even upgrade programs 
using Group Policy.

INSTALL AN APPLICATION FROM A NETWORK LOCATION

GET READY. Configuring Group Policy in Windows Server is beyond the scope of this 
book, but this exercise shows you how to install an application from a network location in a 
domain, from the user’s perspective. Perform the following steps.

1.  Right-click Start and choose Control Panel. Click Programs > Programs and 
Features. In the left pane, click Install a program from the network.

2.  Browse the list of programs, click a program you want to install, and then 
click Install.

Follow the prompts to move through the installation. You might be prompted for an admin-
istrator password or confirmation during the installation.

CERTIFICATION READY
How are network 
applications installed 
using Group Policy?
Objective 3.1

TAKE NOTE*

Group Policy is sup-
ported in Windows 
10 Professional and 
Enterprise editions.

TAKE NOTE*

These steps work if you 
set the GPO to install 
an application to a user 
versus a computer.

In a Windows network in a domain environment, administrators can use Group Policy 
to ease the burden of administering and managing many users and client computers. 
Group Policy lets you control who can install software and on which computers; it also 
helps you push software updates and security configurations across the network. Group 
Policies also exist in Windows 10 and other Windows operating systems. They are 
referred to as Local Group Policies and affect only the users who log on to a particular 
computer. This section focuses on Group Policy at the network domain level.
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■■ Understanding Services

Windows uses services to handle requests for print spooling, file indexing, task scheduling, 
the Windows Firewall, and much more. Services run in the background, essentially helping 
the operating system work with other programs. Although services do not usually have user 
interfaces, you can manage services through the Microsoft Management Console (MMC) 
Services snap-in (see Figure 4-7).

A Windows 10 system can have more than 100 services running at any one time. Each com-
puter can have different services running, depending on the version of Windows in use, the 
computer manufacturer, and the applications installed, but Windows 10 generally uses many 
of the same services across its editions.

To use the Services snap-in and configure services, you must be a member of the Account 
Operators group, the Domain Admins group, or the Enterprise Admins group, or you must 
have received the appropriate authority. Using the Run as command to open the Services 
console ensures you have the proper level of authority.

You can access Windows services in many different ways:

•	 Click Start, type services in the Ask me anything search box, and then click Services or 
services.msc in the resulting list. (Or right-click Services or services.msc and choose Run 
as administrator. You must provide an administrative password or confirm to continue.) 
The Services console opens.

•	 In Computer Management, expand the Services and Applications node and click Services.
•	 In Administrative Tools, double-click Services or double-click Component Services and 

then click Services.
•	 Open Task Manager and click the Services tab.
•	 Open MSConfig and click the Services tab. (MSConfig is covered in the next section in 

this lesson.)

MORE INFORMATION

For more information 
about MMC, see  
Lesson 3.

THE BOTTOM LINE

Services run in the background on a Windows system to help the operating system run other 
programs. The Services console is the central management point of services in Windows 10.

Figure 4-7

The Services console in 
Windows 10
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The Extended and Standard tabs (at the bottom of the Services console) both display all of 
the services in the system; however, the Extended tab provides descriptive information for a 
selected service in the space to the left of the details pane. Sometimes a link is displayed for 
you to get more information about a particular service.

The Services console enables you to view all services and their status; add, start, stop, or dis-
able services; select user accounts that might run the service (for security purposes); define 
how a service recovers from failures; or view a list of service, program, and driver depen-
dencies. To use any of these options, double-click the service to open its Properties dialog 
box.

Understanding Service Startup Types

The General tab in the service’s Properties dialog box (see Figure 4-8) provides options for 
setting a service’s startup type:

•	 Automatic (Delayed Start): The service starts approximately two minutes after the 
system has completed starting the operating system.

•	 Automatic: The service starts as the operating system starts.
•	 Manual: The service must be started manually, by a user, a dependent service, or a 

program.
•	 Disabled: The service is disabled and will not start.

TAKE NOTE*

You can export service 
information to a .txt or 
.csv file.

CERTIFICATION READY
What are the four service 
startup types?
Objective 3.4

Be careful when disabling any services. Some services, such as Security Center and Windows 
Firewall, should not be disabled unless the computer is behind a hardware firewall. Many 
computer users disable unnecessary services to optimize the speed of their computers. You 
should create a system restore point (covered in Lesson 8) before disabling services. And 
although it’s time consuming, disable one service at a time, reboot your computer, and 
check for side effects of disabling that service before disabling any other services.

TAKE NOTE*

Figure 4-8

The General tab
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You can also start, stop, pause, or resume a service using the buttons in the Service status 
section. For example, let’s say a printer has several duplicate (unnecessary) print jobs and the 
queue is not responding. You’ve restarted the printer a few times but that didn’t work. To fix 
the problem, just restart the Print Spooler service in the Services console to clear the print 
queues.

The Log On tab (see Figure 4-9) allows you to specify the user account the service can use, 
which might be different from the logged-on user or the default computer account. Your 
options are:

•	 Local Service account: Click This account and type NT AUTHORITY\LocalService. 
The Local Service account is a built-in account (it’s already created in the operating 
system). It can run services in the background but has limited access to resources and 
objects, which helps protect the system if individual services are compromised. No pass-
word is required.

•	 Network Service account: Click This account and type NT AUTHORITY\
NetworkService. The Network Service is similar to the Local Service account but is 
geared for networking services. Like the Local Service account, the Network Service 
account can run services in the background but it helps to protect the computer from 
compromise.

•	 Local System account: Click Local System account. The Local System account is a 
built-in account that has full control of the operating system.

•	 Another account: Click This account, click Browse, browse for a different user account, 
select it, and then click OK. Type the password for the user account you selected and 
then click OK.

The service will run in the security context of the account you choose.

CERTIFICATION READY
Which service or user 
accounts can you specify 
a service to use?
Objective 3.4

While troubleshooting a service, try pausing the service (if it’s an option) and then unpaus-
ing the service before stopping and restarting the service. By pausing and then continuing, 
you might be able to resolve the problem without having to reset connections or cancel jobs.

TAKE NOTE*

Figure 4-9

The Log On tab
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The Recovery tab (see Figure 4-10) lets you choose recovery actions the computer will take 
if a service fails. For example, if a service fails, the computer might first try restarting the ser-
vice. If that doesn’t work, you can instruct the computer to restart the service again or you 
can restart the computer to clear memory and refresh connections.

The Dependencies tab (see Figure 4-11) shows you which services depend on other services 
to run. A dependent service starts after the service upon which it depends starts. Stopping a 
service also stops any other service that depends on it. There are no options available on this 
tab—it’s informational only. However, before you stop or disable a service on the General tab, 
you should view the information on the Dependences tab to know which other services might 
be affected by your change.

CERTIFICATION READY
What is a service 
dependency?
Objective 3.4

Figure 4-10

The Recovery tab

Figure 4-11

The Dependencies tab
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CONFIGURE A SERVICE

GET READY. To configure a service in the Services console, perform the following steps.
1.  Click Start and in the Ask me Anything search box, type services. Right-click  

services.msc in the resulting list, choose Run as administrator, and then  
click Yes to continue (or type a password). Press Enter.

2.  In the details pane, double-click the service that you want to configure, such as 
Print Spooler (see Figure 4-12). The service’s Properties dialog box opens.

3.  On the General tab, click the Startup type drop-down list (see Figure 4-13). Click 
Automatic (Delayed Start), Automatic, Manual, or Disabled.

Figure 4-12

The Print Spooler service in the 
Services console

Figure 4-13

Selecting a startup type
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4.  Click the Log On tab. To specify the user account that the service can use to log 
on, perform one of the following steps:

•	To use the Local System account, click Local System account.
•	To use the Local Service account, click This account and then type NT AUTHORITY\

LocalService.

•	To use the Network Service account, click This account and then type  
NT AUTHORITY\NetworkService.

•	To specify another account, click This account, click the Browse button, and then 
specify a user account in the Select User dialog box. Click OK to save your changes 
and close the dialog box.

5.  Type the password for the user account in the Password text box and the  
Confirm password text box and click OK. You do not have to type a password if 
you selected the Local Service account or the Network Service account.

■■ Using MSConfig (System Configuration Utility)

MSConfig, also known as the System Configuration utility, lets you enable or disable startup ser-
vices, set boot options such as booting into Safe Mode, access tools like Action Center and Event 
Viewer, and more. You’ll use this utility mainly to troubleshoot startup problems with Windows.

To open System Configuration, click Start, type msconfig in the Ask me anything search box, 
and then click msconfig.exe in the resulting list. The System Configuration dialog box opens, 
showing the General tab (see Figure 4-14). Normal startup is selected by default (unless 
you’ve previously changed the startup settings). A normal startup runs all device drivers and 
services. Other options include the following:

•	 Diagnostic startup: Runs basic devices and services only; equivalent to starting the 
computer in Safe Mode.

•	 Selective startup: Starts the system with some or all system services and startup 
items disabled.

The options on the Boot tab (see Figure 4-15) enable you to adjust boot options, usually  
for diagnostic purposes. The Boot tab options match the options in the Advanced boot 

CERTIFICATION READY
What is the purpose of 
MSConfig?
Objective 1.3

THE BOTTOM LINE

Use MSConfig, also known as the System Configuration utility, to troubleshoot and 
diagnose Windows startup problems.

Figure 4-14

The General tab
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You use the Services tab (see Figure 4-16) to enable or disable Microsoft and third-party services. 
These are the same services that display in the Services console covered earlier in this lesson.

configuration menu that displays when you press F8 at startup. To boot the system into Safe 
Mode, select the Safe boot check box. When you do this, the Minimal option is selected by 
default. The other safe boot options are:

•	 Alternate shell: Boots to the command prompt without network support.
•	 Active Directory repair: Boots to the Windows GUI and runs critical system services 

and Active Directory.
•	 Network: Boots into Safe Mode with network services enabled.

The options in the right column are as follows:

•	 No GUI boot: Disables the Windows Welcome screen.
•	 Boot log: Creates a boot log of startup activity in a file named ntbtlog.txt.
•	 Base video: Starts the Windows graphical user interface using standard VGA drivers.
•	 OS boot information: Displays driver names as drivers are installed during the 

startup process.

Figure 4-15

The Boot tab

You can make boot options permanent by selecting the Make all boot settings permanent 
check box, clicking Apply, and then clicking OK. Administrators often do this on test com-
puters that they use to test new programs and updates before rolling them out to ordinary users.

TAKE NOTE*

Figure 4-16

The Services tab
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Finally, the Tools tab (see Figure 4-17) lists many programs you can start for reporting and 
diagnostic purposes. Some of the tools are Change UAC Settings, Event Viewer, Performance 
Monitor, and Task Manager.

CHANGE SYSTEM CONFIGURATION SETTINGS

GET READY. To configure settings in the System Configuration utility, perform the following 
steps.

1.  Open the System Configuration utility by clicking Start, typing msconfig  
in the Ask me anything search box, and then clicking msconfig.exe in the 
resulting list. When prompted, provide an administrative password or confirm  
to continue.

2.  Click the Boot tab, select the Safe boot check box (see Figure 4-18), and then 
click OK.

Figure 4-17

The Tools tab

Figure 4-18

Selecting the Safe boot option 
on the Boot tab
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3.  Restart your computer. The computer starts in Safe Mode.

4.  Open the System Configuration utility, click the Boot tab, clear the Safe boot 
check box, and then click OK. Restart your computer and return to the System 
Configuration utility.

5.  Click the Services tab. Browse the list of services and select a service that is 
not needed on your PC. Clear the check box to the left of the service name. Click 
Apply.

6.  Click the Startup tab, and then click Open Task Manager. Browse the list of 
startup items and select an item that you don’t want to start when your computer 
starts. Click Disable. Then close Task Manager.

7.  In the System Configuration window, click the General tab and notice that 
Selective startup is now selected (instead of the Normal startup setting).

8.  Click OK to close the System Configuration utility.

If you have any problems with your system after disabling a service or startup item, return to 
the System Configuration utility and enable the service or startup item.

■■ Managing Processes and Applications with Task Manager

Task Manager is one of the handiest programs you can use to take a quick glance at performance 
to see which programs are using the most system resources on your computer. You can see the 
status of running programs and programs that have stopped responding, and you can stop a 
program running in memory.

To start Task Manager, right-click the empty space on the taskbar and choose Task Manager (or 
you can open the Security menu by pressing the Ctrl+Alt+Del keys and choosing Task Manager). 
When Task Manager starts, it displays only the running applications (see Figure 4-19).

TAKE NOTE*

Clicking a column head-
ing arranges the entries 
in alphabetical order.

CERTIFICATION READY
Can you describe how 
to remedy a situation 
in which a process is 
consuming 100% of the 
processor utilization for 
the past 10 minutes?
Objective 1.3

THE BOTTOM LINE

Task Manager gives you a quick glance at performance and provides information about 
programs and processes running on your computer. A process is an instance of a program 
that is being executed.

Figure 4-19

Using Task Manager
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Click the More Details down-arrow to show all the available tabs (see Figure 4-20). When 
you first start Task Manager on a computer running Windows 10, seven tabs are opened for 
Task Manager:

•	 Processes
•	 Performance
•	 App history
•	 Startup
•	 Users
•	 Details
•	 Services

The Processes tab shows all processes running in memory and how much processing and memory 
each process uses. The processes will display applications (as designated by Apps), Background 
processes, and Windows processes. On the Processes tab, you can perform the following tasks:

•	 To see the processes that use the highest percentage of CPU utilization, click the CPU 
column header.

•	 To stop a process, right-click the process and choose End task.
•	 To jump to the Details tab for a particular process, right-click the process and choose 

Go to details.
•	 If you want to see the executable that is running the processes, right-click the process 

and choose Open file location.

To add additional columns, right-click a column header, and select the column you want to 
display, such as Process Identification (PID) or Process name.

The Performance tab (as shown in Figure 4-21) displays the amount of CPU usage, physical 
Memory usage, and Ethernet throughput. For CPU usage, a high percentage indicates the 
programs or processes are requiring a lot of CPU resources, which can slow your computer. If 
the percentage seems frozen at or near 100%, a program might not be responding.

Figure 4-20

Viewing the Task Manager tabs
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Click Memory to display how much of the paging file is being used (In use and Available), the 
amount of Committed and Cached memory, Paged pool, and Non-paged pool. It also shows 
you the total amount of RAM, the Speed of the RAM, and the number of Slots used for 
memory on the motherboard.

The App history tab displays how much resources (including CPU time and network) an 
application has been using over a period of time. The Startup tab shows the programs that are 
configured to automatically start when you start Windows. You can disable the startup pro-
grams by right-clicking an item and choosing Disable.

The Users tab displays the users who are currently logged on, the amount of CPU and 
memory usage that each user is using, and the processes the user is running. It also gives you 
the ability to disconnect them.

The Details tab displays a more detailed look at the processes running on the computer, 
including the Process Identification (PID). The PID is composed of unique numbers that 
identify a process while it is running. Similarly, you can stop the process and you can increase 
or decrease the process priority.

If you are an advanced user, you might want to view other advanced memory values on the 
Details tab. To do so, right-click the column heading, choose Select columns, and then select 
or cancel the selection of values to be displayed or not displayed. While there are nearly 40 
columns to display, some of the more useful values include the following:

•	 Working set (memory): Shows the amount of memory in the private working set plus 
the amount of memory the process is using that can be shared by other processes.

•	 Peak working set (memory): Shows the maximum amount of working set memory 
used by the process.

•	 Working set delta (memory): Shows the amount of change in working set memory 
used by the process.

Figure 4-21

Viewing CPU usage
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•	 Commit size: Shows the amount of virtual memory that is reserved for use by a process.
•	 Paged pool: Shows the amount of committed virtual memory for a process that can be 

written to another storage medium, such as the hard drive.
•	 NP pool: Shows the amount of committed virtual memory for a process that can’t be 

written to another storage medium. (NP is an abbreviation for Non-Paged.)

The Services tab displays all services on the computer that are running and not running. 
Similar to the Services console, you can start, stop, or restart services.

■■ Understanding Storage

When it comes to Windows storage, there’s more to it than just saving data on a disk. There 
are different types of disks (basic and dynamic) you need to know about, along with choices 
of partition styles such as master boot record (MBR) and GUID partition table (GPT), which 
determine the number of partitions you are allowed to create along with the size limitations 
of those partitions.

Understanding Storage Device Types

There are many different types of storage devices supported in Windows 10. This section 
explains eSATA, USB, IEEE 1394 (FireWire), and iSCSI.

EXTERNAL SERIAL ADVANCED TECHNOLOGY ATTACHMENT (eSATA)

External Serial Advanced Technology Attachment (eSATA) is an external interface for SATA 
technologies. eSATA competes with IEEE 1394 (also called FireWire 400) and Universal 
Serial Bus (USB) 2.0. eSATA is very fast, with read access times of 12.7 milliseconds (ms), 
read throughput of 93.5 MB/s, and a write throughput of 94 MB/s. In a nutshell, eSATA 
has a maximum speed of 300 MB/s for 3 Gb/s SATA connections, which is three times faster 
than either USB 2.0 or FireWire 400. eSATA cables can be up to 6.56 feet or 2 meters in 
length and are narrow. An eSATA cable is shown in Figure 4-22.

However, there is one negative aspect—eSATA requires its own power connector (USB 2.0 
and FireWire 400 do not). The reason eSATA can transfer data so quickly is because eSATA 
requires no translation between the interface and computer. This also helps save computer 
processing resources.

CERTIFICATION READY
Which types of storage 
devices are supported by 
Windows 10?
Objective 5.2

THE BOTTOM LINE

Storage in Windows 10 refers to storing data as well as an operating system on disks. There 
are a number of different types of storage: internal, external, network, and cloud.

Windows 10 supports many different types of storage devices in addition to ordinary hard 
drives. Other storage device types include eSATA, USB, IEEE 1394 (FireWire), and iSCSI.

Figure 4-22

An eSATA cable
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UNIVERSAL SERIAL BUS (USB)

Universal Serial Bus (USB) (see Figure 4-23) is a standard developed in the mid-1990s that 
defines cable connectors and protocols used to connect external devices to a computer. The 
devices include keyboards, digital cameras, portable media players, and external hard drives, 
to name a few.

USB version 1.0 had data transfer rates of 1.5 megabits per second (Mbps) at low speed and 
12 Mbps at full speed.

USB 2.0 increased this speed to 480 Mpbs, which is 40 times faster. USB 2.0 has a read 
access time of 13.3 milliseconds (ms), a read throughput time of 40.1 megabytes per second 
(MBps), and a write throughput of 30.9 MBps. USB cables can be up to 16.4 feet (5 meters) 
in length.

USB 3.0 is the newest version and boasts transfer speeds up to 5 gigabits per second (Gbps). 
For this reason it has acquired the nickname SuperSpeed. USB 3.0 ports don’t need as much 
power and are backward compatible with USB 2.0 ports.

IEEE 1394 (ALSO KNOWN AS FIREWIRE)

IEEE 1394, also known as FireWire and i.link, has been around for many years and 
has undergone several revisions. One of the original reasons behind the creation of IEEE 
1394 was to serve as an interface between the computer and a digital video camera so that 
video could be imported for editing. Today, IEEE 1394 is used for many different types of 
high-speed data transfers, including video, and serves the same purpose as USB. Several types 
of IEEE 1394 cables are shown in Figure 4-24.

Figure 4-23

A USB cable

Figure 4-24

IEEE 1394 cables
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IEEE 1394 supports plug-and-play technology, hot swapping, multiple speeds on the same 
bus, isochronous data transfer (which means a constant data rate), and it provides power to 
peripheral devices.

The original standard, FireWire 400 (1394a), provides 400 Mbps throughput and isochro-
nous transfer with read access times of 13.3 ms, read throughput of 40.1 Mbps, and a write 
throughput of 30.9 Mbps. FireWire 800 (1394b) doubled the throughput to 800 Mbps. 
IEEE 1394 supports cable lengths up to 14.76 feet (4.5m).

INTERNET SMALL COMPUTER SYSTEM INTERFACE (iSCSI)

While all other storage devices covered in this lesson are mainly for consumer products to 
connect peripheral devices to laptops and desktop computers, internet Small Computer 
System Interface (iSCSI) connects enterprise network storage devices such as a storage area 
network (SAN). iSCSI is used to transfer data over local area networks (LANs), wide area net-
works (WANs), and even the internet.

Understanding Disk and Drive Types

In Windows 10, a physical hard drive can be designated as a basic disk or a dynamic disk. 
Basic disks contain only simple volumes. Dynamic disks can contain simple, spanned, 
striped, and mirrored volumes.

Traditionally, basic disks use partitions and logical drives. The master boot record (MBR) par-
tition style has been around for quite a while and all Windows operating systems support MBR 
partitions. But as with most legacy technologies, MBR partitions have their limitations. MBR 
partitions are limited to four basic partitions and each partition is limited to 2 terabytes (TB) in 
size. The four basic partitions can be either four primary partitions or three primary partitions 
with one extended partition, which can be further divided into multiple logical partitions.

A GPT partition style allows for more partitions and larger volume sizes. A disk initialized as 
a GPT partition style may contain up to 128 primary partitions and each can be larger than 2 
TB, in fact, they can be as large as 9.4 zettabytes (ZB).

With dynamic disks, free space on a hard drive is divided into volumes instead of parti-
tions. Dynamic disks are not limited by partition styles as are basic disks. You can configure 
dynamic disk volumes as simple, spanned, mirrored, striped, or RAID-5:

•	 Simple volume: This type of volume uses free space available on a single disk.
•	 Spanned volume: This type of volume extends a simple volume across multiple disks, 

up to a maximum of 32.
•	 Mirrored volume: This type of volume duplicates data from one disk to a second disk 

for redundancy and fault tolerance; if one disk fails, data can be accessed from the 
second disk. You cannot span a mirrored volume; a mirrored volume must reside on a 
single disk. Mirroring is also referred to as RAID-1.

•	 Striped volume: This type of volume stores data across two or more physical disks. Data 
on a striped volume is written evenly to each of the physical disks in the volume. You 
cannot mirror or span a striped volume. Striping is often referred to as RAID-0.

•	 RAID-5 volume: This type of volume is a type of striped volume that also provides fault 
tolerance. Data is written to three or more disks; if one disk fails, the remaining drives 
re-create the data.

CERTIFICATION READY
What are common types 
of drives supported by 
Windows 10?
Objective 5.2

TAKE NOTE*

One zettabyte is equal to 
one billion terabytes.

Windows 10 supports two primary types of disks: basic and dynamic. In addition, 
the operating system supports simple, spanned, striped, and mirrored volumes. Use 
the Disk Management tool in the Computer Management snap-in to manage disks, 
partitions, and volumes.
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You can typically convert a basic disk to a dynamic disk without losing any data, but it’s a 
best practice to back up all data before attempting the conversion. You might need to con-
vert a hard disk from dynamic to basic at some point. For example, a user’s computer runs 
Windows 7 and the single hard disk is configured as a dynamic disk.

Understanding File Systems

A file system is the overall structure your computer uses to name, store, and organize files and 
folders on a hard drive or partition. The file system provides a map of the clusters (the basic 
units of logical storage on a hard drive) that a file has been stored in. When you install a hard 
drive in a computer, you must format it with a file system. Today, the primary file system 
choices for a computer that will run Windows are NTFS, FAT32, and FAT. In Windows 10, 
you can view file systems in use on your computer from the Disk Management MMC snap-in.

FAT32 and FAT (which is seldom used today) were popular in earlier versions of Windows 
(such as Windows 95, Windows 98, Windows Millennium Edition, Windows NT, and 
Windows 2000). The limitations of FAT32 make it less desirable than NTFS:

•	 A FAT32 partition is limited to a maximum size of 32 gigabytes (GB).
•	 The maximum size of a file that can be stored on a FAT32 volume is 4 GB.

So why use FAT32? Many Universal Serial Bus (USB) flash drives come formatted as FAT32 
to be compatible with a large variety of operating systems. If you plan to configure your com-
puter for multi-booting, where you choose at startup which operating system you want to 
load, you might need to format a partition with FAT32 if that partition will run Windows 
95, Windows 98, or Windows Millennium Edition.

NTFS is the preferred file system that supports much larger hard drives and a higher level of 
reliability than FAT-based file systems. In addition, NTFS offers better security through per-
missions and encryption.

Resilient File System (ReFS) was introduced as an enhanced NTFS file system by offering 
larger volume sizes and files. ReFS also offers greater resiliency, meaning better data veri-
fication, error correction, and scalability. It is recommended that you should use ReFS for 
very large volumes and file shares. However, you cannot use ReFS for the boot volume. For 
maximum file name length, NTFS only supports 256 characters, while ReFS supports up to 
32,000 characters.

Because ReFS uses a subset of NTFS features, it maintains backward compatibility with 
NTFS that can be accessed directly by Windows Server 2012 or higher, or Windows 8.1 or 
higher. Different from NTFS, ReFS has a fixed allocation unit size of 64 KB, and ReFS does 
not support Encrypted File System (EFS) for files.

When deciding on which file system to use, you should always consider NTFS or ReFS. It is 
recommended to use ReFS for the following situations:

•	 Microsoft Hyper-V workloads: ReFS has performance advantages when using both 
.vhd and .vhdx files.

•	 Storage Spaces Direct when using shared direct attached Storage: ReFS supports 
larger volumes, and improved throughput.

•	 Data archival that you want to retain for long periods: Archive data can benefit from 
ReFS resiliency.

Table 4-1 compares attributes of the available Windows 10 file systems.

CERTIFICATION READY
What are the differences 
between FAT, FAT32, and 
NTFS?
Objective 4.1

TAKE NOTE*

You can view all avail-
able disks or volumes 
that have been format-
ted with a file system in 
the This PC folder in the 
Devices and drives sec-
tion of File Explorer.

The three primary types of file systems for Windows are FAT, FAT32, and NTFS. It’s 
best to use NTFS-formatted drives for Windows Vista through Windows 10 because 
NTFS handles small to very large hard drives, provides better security, and is the most 
reliable.
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Another file system worth mentioning is the Extended File Allocation Table (exFAT), which 
is a Microsoft file system optimized for flash drives. It is typically used where the NTFS file 
system is not ideal because of the data structure overhead. exFAT supports a larger volume 
than FAT or FAT32 supports. exFAT has been adopted by the SD Card Association as the 
default file system for SDXC cards larger than 32 GB.

Using Disk Management to Configure Disks, Volumes, and File Systems

To open Computer Management, click Start, type computer, and then click Computer 
Management in the resulting list. Alternatively, you can right-click Start and choose 
Computer Management. Figure 4-25 shows the tools in the Computer Management snap-in, 
with the Disk Management tool selected.

Table 4-1

Comparing File Systems

When you add a new hard drive to a computer, there are a few steps you need to take to 
introduce a new drive to the operating system. You need to initialize the disk and then 
choose a drive type and a partition style (for basic disks). You can perform all of these steps 
in the Disk Management tool, which is part of the Computer Management MMC snap-in.

Figure 4-25

The Disk Management snap-in

File System Maximum Partition Size Maximum File Size

FAT 2 GB 2 GB

FAT32 32 GB 4 GB

NTFS 256 TB* Limited by the size of the volume on which it resides

ReFS 1 Yobibyte (280 bytes) 16 exbibytes (264 bytes)

exFAT 128 Pebibtye (250 bytes) Limited by the size of the volume on which it resides

*with 64 KB clusters
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If you just installed a new hard disk and the disk is not initialized, in Disk Management, 
right-click the disk (such as Disk 1 or Disk 2) and choose Initialize Disk. In the Initialize 
Disk window, you are prompted to select a partition style, as shown in Figure 4-26.

The first choice you need to make is to choose the partition style of the disk. Be sure you 
select the correct partition style because this is not something you can easily change later. The 
two partition styles are MBR and GPT.

You can change your partition style as long as you have not created any partitions. If you have 
created partitions that contain data and you want to change the partition style, you need to 
back up your data, delete all partitions, and then right-click the disk number and choose to 
convert to the new partition style.

Next, you need to choose the type of disk: basic or dynamic. Basic disks contain only simple 
volumes. The partition style you choose dictates the number of partitions you can create and 
their sizes. Dynamic disks can contain simple, spanned, striped, and mirrored volumes.

CONVERT A DISK FROM BASIC TO DYNAMIC

GET READY. To convert a disk from basic to dynamic, perform the following steps.
1.  Back up all data on the disk you want to convert.

2.  In the Computer Management console, open Disk Management: Right-click Start and 
choose Computer Management > Disk Management.

3.  Right-click the disk (such as Disk 1 or Disk 2) you want to convert and choose 
Convert to Dynamic Disk.

4.  If the disk is currently MBR, the Convert to GPT Disk option appears. If the disk is 
GPT, the Convert to MBR Disk option appears. Click the appropriate option.

After you convert the partition style, you can create partitions again and restore the data that 
you previously backed up.

In the next example, a second disk is added to the computer, so two disks have been initial-
ized as MBR. However, you will create a simple volume on only one of the dynamic disks. 
Spanning, striping, and mirroring, which you will do in subsequent step-by-step exercises, 
involve two or more disks.

Figure 4-26

The Initialize Disk dialog box

The conversion from basic to dynamic can occur automatically based on the type of volume you 
create. You’ll see this in action in the step-by-step exercise named “Create a Spanned Volume.”

TAKE NOTE*
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CREATE A SIMPLE VOLUME

GET READY. To create a simple volume, perform the following steps.
1.  In the Computer Management console, open Disk Management: Right-click Start and 

choose Computer Management > Disk Management.
2.  Right-click an empty area (unallocated space) of a dynamic disk. In the New 

Volume menu, choose New Simple Volume (see Figure 4-27).

3.  The New Simple Volume Wizard starts. Click Next on the welcome screen. Click 
Next to accept the default volume size.

4.  On the Assign Drive Letter or Path screen, assign a drive letter or path, click Next 
and then on the Format Partition screen (as shown in Figure 4-28), click a file 
system such as FAT, FAT32, or NTFS.

5.  On the Format Partition screen, you can also choose an allocation unit size and a 
name for the volume label. (If you’re not familiar with allocation unit sizes, accept 
the default.) There are two other options you can set: Perform a quick format 
(selected by default, which is a good idea) and Enable file and folder compression, 
which is not selected by default. Click Next.

6.  In the Completing the New Simple Volume Wizard, click Finish.

Figure 4-27

The New Volume menu

Figure 4-28

Formatting a partition
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You now have a new partition on the dynamic disk on which you can store data. All the other 
volume types—spanned, striped, and mirrored—require two or more disks. Therefore, if you 
have only one disk, the options to create spanned volumes, striped volumes, or mirrored vol-
umes are grayed out and cannot be selected.

CREATE A SPANNED VOLUME

GET READY. To create a spanned volume, perform the following steps.
1.  In the Computer Management console, open Disk Management: Right-click Start and 

choose Computer Management > Disk Management.
2.  Right-click an empty area of a dynamic disk and choose New Spanned Volume.

3.  Click Next on the Welcome to the New Spanned Volume Wizard screen.

4.  Click the desired disk in the Available box and click Add (see Figure 4-29). You 
can also double-click the Available disk to add it to the Selected box.

5.  When you add disks to the Selected box, the Total volume size in megabytes 
(MB) box displays the combined sizes of all disks, yet when you click one of 
the disks in the Selected box, the Maximum available space in MB box and 
the Select the amount of space in MB box show what you have selected from 
that specific disk. You can select a different amount of space from each disk you 
add. You can continue to add as many disks as you would like to include in your 
spanned volume. After you have selected the disks, click Next.

6.  On the Assign Drive Letter or Path screen, click a drive letter and click Next.
7.  The Format Volume screen is the same as the screen for creating a simple volume. 

Set your format volume options and click Next.
8.  On the Completing the New Spanned Volume Wizard page, click Finish.

9.  A warning message appears, letting you know that in order to create a spanned 
volume, the basic disk will be converted to a dynamic disk. If you convert the 
disk to dynamic, you will not be able to start installed operating systems from any 
volume on the disk. Click Yes to continue or No to cancel the operation.

Do not plan to use spanned volumes for fault tolerance. If one disk in the spanned volume 
fails, all data in the spanned volume is lost unless you have a backup.

Figure 4-29

The Select Disks page
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STRIPED VOLUMES

Creating a striped volume is similar to creating a spanned volume in that almost all the steps 
are the same. However, the way data is stored on a striped volume is different than a spanned 
volume. As with a spanned volume, striped volumes must contain at least two disks and can 
contain up to 32. But when the data is stored, it is separated into 64-kilobyte (KB) chunks. 
The first 64 KB is stored on Disk 1 in the striped volume, the second 64 KB chunk is stored 
on Disk 2, and so on. See Figure 4-30. The data is literally striped across multiple drives.

Accessing data on a striped volume is faster than accessing data on a spanned volume because 
a striped volume has multiple sets of read/write heads working simultaneously when reading 
and writing data. In this regard, spanned volumes are good for high capacity, whereas striped 
volumes are better for performance.

CREATE A STRIPED VOLUME

GET READY. To create a striped volume, perform the following steps.
1.  In Disk Management, right-click an empty disk and choose New Striped Volume. 

On the Welcome to the New Striped Volume Wizard screen, click Next.
2.  Click the second disk in the Available box (refer to Figure 4-29) and click Add.

When you add disks to the Selected box, the Total volume size in megabytes (MB) 
box displays the combined sizes of all disks. This is where one of the big differences 
between spanned volumes and striped volumes takes place. On spanned volumes, 
you could take different amounts of hard drive space from each disk—you cannot do 
this with striped volumes. Striped volumes must use the same amount of disk space 
from each disk you take to the striped volume. So after you add two or more disks 
to the Selected box, if you change the Select the amount of space in MB setting 
(regardless of which disk is highlighted in the Selected box), the size difference will 
be reflected on both (or all) disks that you had added. Both disks have 40957 MB 
of space but we have changed the Select the amount of space in MB to 39975.

3.  After you have selected the disks, click Next.
4.  On the Assign Drive Letter or Path screen, select your drive letter and click Next. 

The Format Volume screen appears. Set your format volume options and click Next. 
Click Finish.

5.  A warning appears, indicating that to create a striped volume, the basic disk will 
be converted to a dynamic disk. If you convert the disk to dynamic, you will not 
be able to start installed operating systems from any volume on the disk. Click Yes 
to continue or No to cancel.

Striped volumes do not offer fault tolerance. Just as with spanned volumes, if one disk in the 
striped volume fails, all data from the entire striped volume is lost. You’ll have to retrieve the 
data from a previous backup.

A1

An
...
A4
A3
A2

B1

Striped Volume (RAID-0)

Bn
...
B4
B3
B2

Figure 4-30

A striped volume
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MIRRORED VOLUMES

Mirrored volumes require only two disks. You cannot mirror to a third or fourth disk. 
Mirrored volumes store an exact copy of data from the first member of the mirrored volume 
to the second member. Because the data is written across both drives, you do get fault toler-
ance with mirrored volumes. Figure 4-31 shows an example of a mirrored volume.

CREATE A MIRRORED VOLUME

GET READY. To create a mirrored volume, perform the following steps.
1.  In Disk Management, right-click an empty disk and choose New Mirrored Volume. 

On the Welcome to the New Mirrored Volume Wizard screen, click Next.
2.  Click the second disk in the Available box. Mirrored volumes require the same 

amount of disk space from each disk. When you add a disk to the Selected box, 
the Total volume size in megabytes (MB) box displays the most available free 
space from the disk with the smallest amount.

You can reduce the amount of space, but it will be reduced on both disks. This 
makes sense because you’re creating an exact copy of data stored on the source 
disk, so you don’t need the destination disk to have additional free space that will 
never be used. After you have selected the disks, click Next.

3.  On the Assign Drive Letter or Path screen, select a drive letter and click Next. 
The Format Volume screen is the same as the previous Format Volume screens. Set 
your format volume options and click Next. Click Finish.

4.  A warning message appears, informing you that the basic disk will be converted to 
a dynamic disk. If you convert the disk to dynamic, you will not be able to start 
installed operating systems from any volume on the disk. Click Yes.

After you create a few different types of volumes, it’s easy to figure out which volume is 
which—they’re identified by a strip of color at the top of the volume. Here are the default 
legend colors for the different types of volumes:

•	 Simple volumes are identified by their dark blue strips.
•	 Spanned volumes display purple strips.
•	 Striped volumes display aquamarine strips.
•	 Mirrored volumes display burgundy strips.

In the real world, you wouldn’t carve up disks like on client computers—there would be 
no point. But you may have client computers with two, three, four, or even six disks. On a 
computer with six disks, for example, you might want to create a spanned volume on disks 
2, 3, and 4 so they appear in File Explorer as a single drive (such as drive E). It can be less 
confusing for end users. Then you could mirror disks 5 and 6 to create a mirrored volume for 
sensitive data that requires fault tolerance.
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Figure 4-31

A mirrored volume
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■■ Encrypting and Compressing Files and Folders

Encryption protects the contents of files and folders from unauthorized access. Windows uses 
Encrypting File System (EFS) to allow users to encrypt information on hard drives, external 
flash drives, CDs, DVDs, backup tapes, and other types of physical media. Files and folders 
are not encrypted in Windows 10 by default; however, users can enforce encryption on data 
files, folders, and entire drives.

Understanding Encrypting File System (EFS)

The data in an encrypted file is “scrambled” but still readable and usable by the user who 
encrypted the file. That user—and any other authorized users—can open and change the file 
as necessary. However, an unauthorized user who tries to open or copy the file receives an 
“Access Denied” message. Only the original owner and the computer’s designated recovery 
agent can access encrypted files. The designated recovery agent is the Administrator account, 
by default, on a local computer or in a domain.

A file created in or moved to an encrypted folder is automatically encrypted. The folder itself 
isn’t encrypted; a user with appropriate file access permissions can see the names of the files in 
the folder.

When you mark a file for encryption, Windows generates a large, random number—a unique 
encryption key. The key is used to scramble the contents of the file. This encryption key is 
also encrypted with a personal file encryption certificate, which is stored in the Windows 
Certificate database. The file’s encryption key is stored along with the file.

When you’re logged on to Windows and attempt to open an encrypted file, Windows 
retrieves your personal EFS certificate, decodes the file’s unique encryption key, and uses that 
key to decode the contents of the file.

If you lose an encryption key or your EFS certificate, or one of them becomes damaged, you 
could lose your data. It’s important to back up your encryption key(s) and certificate and 
keep them in a safe place. You should also consider creating a file recovery certificate.

ENCRYPT A FILE OR FOLDER

GET READY. To encrypt and decrypt a file or folder, perform the following steps.
1.  In File Explorer, right-click the file or folder you want to encrypt and choose  

Properties. The Properties dialog box opens.

2.  On the General tab, click Advanced. The Advanced Attributes dialog box opens (see 
Figure 4-32).

3.  Select the Encrypt contents to secure data check box and click OK.

4.  Click OK to accept your settings and close the Properties dialog box.

5.  The Confirm Attribute Changes dialog box opens (see Figure 4-33). Click either Apply 
changes to this folder only or Apply changes to this folder, subfolders and files.

6.  Click OK.

TAKE NOTE*

Windows 10 Home does 
not fully support EFS.

CERTIFICATION READY
How are files and 
folders encrypted using 
Encrypting File System 
(EFS)?
Objective 4.3

TAKE NOTE*

It’s more efficient to 
encrypt at the folder 
level rather than the file 
level. New files added 
to the folder will also be 
encrypted.

THE BOTTOM LINE

Encrypting files and folders protects them from unwanted access. Microsoft uses the 
Encrypting File System (EFS) to encrypt individual files and folders in Windows Vista 
through Windows 10.

Encrypted files can be significantly larger than unencrypted files, and the encryption/
decryption process can add significant processing overhead.

TAKE NOTE*
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As Windows encrypts the folder, you are reminded to back up your encryption key. Microsoft 
recommends that you back up the encryption key immediately. Click the balloon reminder 
and follow the prompts. The encrypted folder and files will be displayed with a small golden 
lock, so you can see at a glance that it’s encrypted.

DECRYPT A FILE OR FOLDER

GET READY. To decrypt a file or folder, perform the following steps.
1.  Right-click the file or folder you want to decrypt and choose Properties.
2.  Click the General tab and click Advanced.

3.  Clear the Encrypt contents to secure data check box and click OK.

BACK UP YOUR EFS CERTIFICATE

GET READY. To back up your EFS certificate, perform the following steps.
1.  Click Start, type mmc.exe, and then press Enter. If you are asked to allow  

this app to make changes to your device, click Yes.
2.  Click File > Add/Remove snap-in.

3.  In the Add or Remove Snap-ins dialog box, click Certificates and  
click Add.

Figure 4-32

The Advanced Attributes dialog 
box

Figure 4-33

The Confirm Attribute Changes 
dialog box
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4.  In the Certificates snap-in dialog box, My user account is already selected. Click 
Finish.

5.  In the Add or Remove Snap-ins dialog box, click OK.

6.  Expand the Personal folder by clicking its arrow.

7.  Click Certificates. The user’s personal certificates are listed (see Figure 4-34).

8.  Click the certificate that lists Encrypting File System in the Intended Purposes 
column. If there is more than one EFS certificate, select all of them.

9.  Click Action > All Tasks > Export. The Export wizard starts.

10.  Click Next.
11.  On the Export Private Key page (see Figure 4-35), select the Yes, export the 

private key option and click Next.

Figure 4-34

Personal certificates in 
Certificate Manager

Figure 4-35

Using the Certificate Export 
Wizard
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12.  Click Personal Information Exchange and click Next.
13.  Type the password you want to use, confirm it, and then click Next.
14.  The wizard creates a file to store the certificate. Click Browse, navigate to the loca-

tion where you want to save the file, and then type a name for the file. Click Save.

15.  In the next screen, click Next.
16.  Click Finish and click OK.

Be sure to back up the certificate file to a location that is different than where it’s saved. For 
example, if you saved the file on your computer’s hard drive, copy the file to removable media 
or a network location.

Understanding Compression

Compression is the process of decreasing the size of files or folders without affecting the files’ 
contents. The purpose of compression is to decrease large files that would otherwise use a lot 
of storage space. Because files often include a lot of redundant, repeated data, compressing 
them replaces repeated data with pointers to the data. The pointers take up much less space 
than the repeated data, so the size of the file is reduced.

COMPRESS A FILE OR FOLDER

GET READY. To compress a file or folder, perform the following steps.
1.  In File Explorer, right-click the file or folder you want to compress and choose 

Properties. The Properties dialog box opens.

2.  On the General tab, click Advanced. The Advanced Attributes dialog box opens.

3.  Select the Compress contents to save disk space check box and click OK.

The compressed file or folder will display two small arrows pointing toward each other.  
To uncompress the file or folder, select it, return to the Advanced Attributes dialog box, and 
clear the Compress contents to save disk space check box.

Understanding BitLocker

BitLocker Drive Encryption is another method of protecting data stored on a fixed drive in 
a Windows computer. BitLocker encrypts the entire drive, rather than individual files and 
folders. The complementary BitLocker To Go protects data on removable data drives, such as 
an external flash drive.

CERTIFICATION READY
How are files or folders 
compressed?
Objective 4.3

CERTIFICATION READY
What is the purpose of 
BitLocker?
Objective 4.3

Compression allows you to save disk space by reducing the size of files and folders 
without affecting their content.

BitLocker Drive Encryption encrypts an entire fixed disk to prevent access by 
unauthorized users. BitLocker To Go protects removable drives, such as external flash 
drives. You can encrypt drives with BitLocker in Windows Professional, Enterprise, and 
Education editions only.

CERTIFICATION READY
How does BitLocker 
encrypt and protect a 
hard drive?
Objective 5.2

You cannot encrypt files or folders that are compressed. If you want to encrypt a compressed 
file or folder, you must decompress it first.

TAKE NOTE*
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When you add new files to a BitLocker-encrypted disk, the files are encrypted automatically. 
If you copy the files to another drive, BitLocker automatically decrypts the files, which means 
they’re no longer protected.

Anytime you start a computer on which the operating system disk is BitLocker-encrypted, 
BitLocker scans the drive for security risks. If BitLocker detects a potential security risk such 
as a change to the startup files, it locks Windows (prevents it from running) and requires the 
user to provide the BitLocker recovery key to unlock Windows. This ensures that unautho-
rized users cannot access the system to steal files or somehow damage the system or data.

Some computers have a Trusted Platform Module (TPM) chip on the motherboard. If the 
chip is present, BitLocker uses the TPM chip to protect the BitLocker keys. When a user 
starts a computer with a TPM chip and with BitLocker enabled, BitLocker requests the keys 
from the TPM and unlocks the system.

You can turn off BitLocker at any time by suspending it temporarily or decrypting the drive.

TURN ON BITLOCKER DRIVE ENCRYPTION

GET READY. To turn on BitLocker Drive Encryption, perform the following steps.
1.  Right-click Start and choose Control Panel.
2.  Click System and Security > BitLocker Drive Encryption.
3.  In the BitLocker Drive Encryption window (see Figure 4-36), click Turn On Bit-

Locker for the operating system drive. When prompted, provide an administrative 
password or confirm to continue.

BitLocker scans your computer to ensure that it meets the BitLocker system 
requirements.

4.  In the BitLocker Setup Wizard, follow the prompts to choose how to store the 
recovery key.

5.  When prompted, confirm that the Run BitLocker system check check box is 
selected and click Continue to encrypt the drive.

6.  Restart the computer by clicking Restart now.

TAKE NOTE*

BitLocker encryp-
tion is available only 
in Windows 10 
Professional, Enterprise, 
and Education editions.

TAKE NOTE*

BitLocker Drive 
Encryption encrypts an 
entire drive. EFS pro-
tects individual files and 
folders on any drive on a 
per-user basis.

Figure 4-36

Turning on BitLocker
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■■ Knowledge Assessment

Multiple Choice

Select the correct answer for each of the following questions.

	 1.	 Which of the following actions can be performed in Programs and Features in Control 
Panel?
a.	 Install an application
b.	 Uninstall an application
c.	 Encrypt an application’s files
d.	 Compress an application’s files

The encryption process might take several minutes to more than an hour. A completion 
message appears when the encryption process is finished.

In this lesson you learned:

•	 A software program (also known as an app) is a sequence of instructions written to 
perform a specified task for a computer. Today, most of these programs are installed as 
desktop apps or Windows Store apps. Desktop apps are traditional apps, such as Microsoft 
Word or Excel.

•	 The Program Compatibility Troubleshooter is a wizard-based solution that users or admin-
istrators can use to automatically configure an executable file to use an appropriate 
Windows 10 compatibility mechanism. Thus, the troubleshooter is not a compatibility 
mechanism in itself; it is simply a method for applying other mechanisms.

•	 The Windows Store provides a central location for you to purchase and download 
Windows apps that run on Windows 8 and later operating systems. Windows Store apps 
do not run on Windows 7 or earlier versions of Windows. Windows Store apps tend to be 
smaller and faster than desktop apps.

•	 Services run in the background on a Windows system to help the operating system run 
other programs. The Services console is the central management point of services in 
Windows 10.

•	 When it comes to Windows storage, there’s more to it than just saving data on a disk. 
There are different types of disks (basic and dynamic) you need to know about, along with 
choices of partition styles such as the master boot record (MBR) and GUID partition table 
(GPT), which determine the number of partitions you are allowed to create along with the 
size limitations of those partitions.

•	 Encryption protects the contents of files and folders from unauthorized access. Windows 
uses Encrypting File System (EFS) to allow users to encrypt information on hard drives, 
external flash drives, CDs, DVDs, backup tapes, and other types of physical media. 
BitLocker Drive Encryption is another method of protecting data stored on a fixed drive in 
a Windows computer.

S K I L L  S U M M A R Y
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	 2.	 Which of the following actions can be performed using Group Policy? (Choose all that 
apply.)
a.	 Restrict user access to an application
b.	 Encrypt a user’s files
c.	 Update an application
d.	 Install applications from a network location

	 3.	 Which of the following locations is accessed to enter Safe Mode the next time the com-
puter starts?
a.	 The General tab
b.	 The Boot tab
c.	 The Startup tab
d.	 Services console

	 4.	 In the System Configuration utility, which of the following tabs is accessed to start 
Performance Monitor?
a.	 General
b.	 Startup
c.	 Services
d.	 Tools

	 5.	 Which of the following represents the maximum disk size that NTFS can handle?
a.	 32 GB
b.	 256 GB
c.	 32 TB
d.	 256 TB

	 6.	 Which built-in account type used to run services has full access to a system?
a.	 Local Service account
b.	 Network Service account
c.	 Local System account
d.	 Root System account

	 7.	 Which of the following partitions or volumes can be created on a dynamic drive? 
(Choose all that apply.)
a.	 Striped partition
b.	 Striped volume
c.	 Simple volume
d.	 Spanned volume
e.	 Mirrored partitions
f.	 Striped partitions

	 8.	 In which of the following locations are EFS certificates stored?
a.	 EFS Certificate database
b.	 Windows Certificate database
c.	 Certificate library
d.	 Documents library

	 9.	 Which of the following is used to indicate that a folder is compressed?
a.	 Two small arrows pointing toward each other
b.	 A golden lock
c.	 0s and 1s
d.	 A series of question marks
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	10.	 Which of the following is the name of the chip that BitLocker can use on some com-
puters to protect BitLocker encryption keys?
a.	 Trusted Platform Module
b.	 Trusted Protection Module
c.	 Encryption Platform Module
d.	 Trusted Hard Drive Module

Fill in the Blank

Complete the following sentences by writing the correct word or words in the blanks provided.

	 1.	 An _____ is a program that runs within the operating system and helps a user perform a 
specific task, such as word processing, appointment scheduling, or accounting.

	 2.	 _____ is a collection of settings (policies) stored in Active Directory on a Windows 
network.

	 3.	 Windows uses _____to handle requests for print spooling, file indexing, task scheduling, 
the Windows Firewall, and much more.

	 4.	 _____ is used to enable or disable startup services, set boot options such as booting into 
Safe Mode, access tools like Action Center and Event Viewer, and more.

	 5.	 Most Windows Vista through Windows 10 users use the _____ file system because it 
supports larger disks than FAT32 or FAT.

	 6.	 Group Policy can be used to _____ (or publish) an application to all users or computers 
in a designated group.

	 7.	 A _____ is a unique account that is the combination of an email address and a pass-
word that is used to sign in to services like Outlook.com, MSN.com, Hotmail.com, 
OneDrive, Windows Phone, or Xbox Live.

	 8.	 Windows uses _____ to allow users to encrypt information on hard drives, external flash 
drives, CDs, DVDs, backup tapes, and other types of physical media.

	 9.	 _____ is the process of decreasing the size of files or folders without affecting the files’ 
contents.

	10.	 _____ encrypts an entire drive, rather than individual files and folders on a disk.

True / False

Circle T if the statement is true or F if the statement is false.

T F 	1.	 Use Programs and Features to install applications in Windows 10.

T F 	2.	 Objects in Active Directory are linked to Group Policy Objects (GPOs).

T F 	3.	 A Windows 10 system can have more than 100 services running at any one 
time.

T F 	4.	 In System Configuration, the Tools tab enables you to enable or disable services.

T F 	5.	 EFS and BitLocker Drive Encryption refer to the same thing.
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■■ Business Case Scenarios

Scenario 4-1: Providing Redundancy on a Client Computer

You provide support for a commercial bioengineering lab. Mizuki is a chemist at the lab, and 
she recently inherited a computer from the IT department that has two large hard disks and 
runs Windows 10 Enterprise. One hard disk provides ample disk space for her programs and 
data files, but she would like to use the other disk for redundancy to better protect her system 
and files. Describe your recommended solution.

Scenario 4-2: Protecting Laptop Computers

Henry, a traveling salesperson at your company, left his laptop at the airport on his last trip 
and the laptop was never recovered. His new laptop arrived yesterday; you installed Windows 
10 Enterprise and productivity applications and you also restored data from a backup. What 
should you do to the laptop to protect all programs and data on the computer in the event of 
loss or theft?

Scenario 4-3: Uninstalling Local Software

Henry, a traveling salesperson at your company, left on an extended business trip to  
Asia. He has called to request that the voice transcription software be deleted from his 
computer. He doesn’t use the application and doesn’t want it taking up space. Describe  
how to help him remove the software on his own.

Scenario 4-4: Running a Windows 7 Application on Windows 10

You use an inventory application that ran on your Windows 7 computer but it doesn’t run on 
your new Windows 10 computer. Describe the various solutions available to you for getting 
this application to run on your Windows 10 computer.
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LESSON 5

O B J E C T I V E  D O M A I N  M A T R I X

Skill/Concept Exam Objective Objective Number

Understanding Cloud Storage Understand storage

Understand backup and recovery methods

5.2

6.1

Understanding Printing Devices Understand printing devices

Connect devices

Understand file and print sharing

5.3

5.1

4.2

Understanding System Devices and 
Device Drivers

Understand system devices

Connect devices

5.4

5.1

Managing Devices

K E Y  T E R M S

audio device

cloud storage

Device Manager

Devices and Printers folder

driver

fetching

input device

local printer

network printer

OneDrive

OneDrive for Business

OneDrive Recycle Bin

plug-and-play (PnP) technology

print device

print job

print queue

print spooler

video device
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■■ Understanding Cloud Storage

If you’ve been in the IT industry for any length of time, you’ve probably seen outsourcing 
of data storage. Generally, when a company outsources the storage of its data, another 
company assumes the burden of maintaining all the storage devices and data backups. 
Cloud storage is remote data storage with backups but can also include application host-
ing. You can use applications like Microsoft Word and Outlook, along with many other 
applications, over the internet. Client machines can run applications from the cloud and 
access data; in fact, they can maintain complete control of their data and security.

Using OneDrive to Manage Files and Folders

OneDrive is a free (up to 1 GB), secure, file-hosting service that enables your users to  
store, sync, and share files across devices using the cloud. Office 365 comes with 1 GB 
of OneDrive storage for each user. Additional storage can be purchased. You can also use 
OneDrive to synchronize files and folders that you select across multiple devices. If you  
forget to include a file within your sync folder, you can use OneDrive to connect to your 
remote computer, locate the file, and then upload it to your OneDrive space. This process is 
called fetching.

The public offering of OneDrive is intended for personal use and is easily comparable to 
Dropbox. You store files in your OneDrive and access them from anywhere. OneDrive for 
Business is different from the public version of OneDrive because OneDrive for Business  
is based on SharePoint. By using SharePoint, OneDrive for Business can be used by team 
members to store and work on documents with others and it helps ensure that business files 
for your users are stored in a central location.

ACCESSING ONEDRIVE FROM A BROWSER

You can access OneDrive from a browser using your Microsoft user account from anywhere 
you have an internet connection. While OneDrive can be accessed from a browser on the 
OneDrive website at https://onedrive.live.com (as shown in Figure 5-1), OneDrive for Business 
is accessed from the Office 365 Portal (https://portal.office.com). After you are logged on 
to Office 365, you can click the OneDrive button to open the OneDrive Admin Console, 
on which you can upload, download, create, and share folders and files. If your computer is 
configured to support fetching, you can also connect to it remotely from the OneDrive for 
Business Console.

CERTIFICATION READY
What is the purpose of 
cloud storage, such as 
Microsoft OneDrive?
Objective 5.2

Some of the computers you support have two or more disks. To make the most of 
the storage space, you plan to span, stripe, or mirror the volumes, depending on the 
needs of each user. However, you are tired of always adding more disks or upgrading 
computers because the system runs out of disk space. Therefore, you also plan to run a 
pilot project using cloud storage and services such as Microsoft OneDrive.

THE BOTTOM LINE

Cloud services are becoming highly popular, and they provide convenient storage and 
application hosting for consumers and businesses alike.

OneDrive is a file hosting service that allows you to store and create files and folders 
and share them with other users and groups.
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UPLOADING FILES TO ONEDRIVE

If you have existing files on your computer that you want to upload to OneDrive, you can 
use either of the following options:

•	 From the OneDrive Dashboard, navigate to the folder in which you want to store the 
file. On the menu, click Upload, browse to the file you want from your computer, and 
then click Open.

•	 From the OneDrive app installed on your local computer, you can drag and drop 
the files you want to upload into the OneDrive folder. This automatically syncs with 
OneDrive. You can also configure OneDrive for the desktop to allow you to fetch files 
on your PC from other devices.

RECOVERING FILES FROM ONEDRIVE

Similar to deleting local files in Windows 10, if you accidentally delete a file, you have  
30 days to recover it from the OneDrive Recycle Bin, a temporary storage place of  
deleted items.

By default, OneDrive stores your deleted files for at least 3 days and a maximum of 30 days. 
Unless you exceed 10% of your storage to deleted files, the deleted files will be held for  
30 days. However, if you exceed 10% of your total OneDrive storage, the duration of the 
file will be reduced. Once the file is deleted from OneDrive, the file will be deleted from all 
drives that are synced with OneDrive.

To restore a deleted file, go to the OneDrive website (https://onedrive.live.com) and click 
Recycle bin in the left pane. To restore all items, click Restore all items (as shown in Figure 5-
2). To restore or permanently delete individual items, select them by clicking  
their check boxes and click Restore all items. To permanently delete all items, click Empty 
recycle bin.

CERTIFICATION READY
What is the primary tool 
to recover deleted files 
in OneDrive?
Objective 5.2

TAKE NOTE*

Deleted files do not 
count toward your 
OneDrive storage limit.

Figure 5-1

The OneDrive Console
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■■ Understanding Printing Devices

Microsoft has historically used the term “print device” to refer to the actual hardware but 
is now using the term “printer” in most consumer-level documentation. You will see both 
“printer” and “print device” in Microsoft documentation and in this lesson.

Understanding Local Printers

If you do not have a CD from the manufacturer, you can use the built-in printer drivers in 
Windows 10. However, it is almost always preferable to use the printer setup program on the 
CD or download the latest print driver setup installation file from the manufacturer’s Web 
site than to use the built-in Windows 10 driver. The built-in driver typically provides access 
to a minimal subset of the printer’s features.

ADD A LOCAL PRINTER

GET READY. To add a local printer, perform the following steps.

1.  Physically connect the printer to a computer with the appropriate cable.

2.  Right-click Start and choose Control Panel.

CERTIFICATION READY
What is a local printer?
Objective 5.3

CERTIFICATION READY
How can you add or 
remove a printer?
Objective 5.1

Figure 5-2

Accessing the OneDrive 
Recycle Bin

THE BOTTOM LINE

Printing devices can be local or networked; they can even be available over the internet. 
You can perform most printer support from Devices and Printers.

A local printer is connected directly to your computer via a cable, using a serial, 
parallel, USB, infrared, or other port type. Most printers come with a manufacturer’s 
CD containing the printer software that must be installed for your operating system to 
talk to the printer. A good rule of thumb is if your printer ships with a manufacturer’s 
CD, use the setup program on the CD to install the driver. A driver is a small program 
that enables hardware to interact with the operating system. If the correct print driver 
is not loaded, you may not be able to print documents, or the documents print strange 
characters, strange text, or looks distorted.
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3.  In the Control Panel under Hardware and Sound, click View devices and printers. 
The Devices and Printers window displays (see Figure 5-3).

4.  Select Add a printer from the menu bar. The Add Printer Wizard starts.

5.  On the Choose a device or printer to add to this PC page, click the The Printer 
that I want isn’t listed option.

6.  On the Find a printer by other options page (see Figure 5-4), click Add a local 
printer or network printer with manual settings and click Next.

Figure 5-3

The Devices and Printers 
window

Figure 5-4

Find a printer by other options 
screen
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7.  On the Choose a printer port page, click the port that your printer is currently 
connected to: Use an existing port or Create a new port. Figure 5-5 shows  
the default existing port. Your choices for creating a new port are Local Port or 
TCP/IP Port (whereby you enter the IP address or name of a printer). After you 
select a port, click Next.

8.  The Install the printer driver page asks for a printer driver and displays a list of 
manufacturers and printers. Click the manufacturer of the printer and click the 
printer (see Figure 5-6). If you do not see your printer, click the Windows Update 
button to get a more extensive list of printers to choose from.

Figure 5-5

The Choose a printer port 
screen

Figure 5-6

Selecting your printer
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9.  When you’ve found your printer, click the Have Disk button to open the Install 
From Disk dialog box. Ensure the CD is in the CD/DVD drive, browse to the 
appropriate printer model, and then click OK.

10.  Type a name for your printer and click Next.
11.  The Printer Sharing page (see Figure 5-7) allows you to share the printer so other 

people can connect to and use the printer across the network. The printer is local 
for you, but for all others connecting across the network, it’s a networked printer. 
If you would like to share the printer, type the respective information for the 
Share name, Location, and Comment text boxes. If you do not want to share  
the printer, click the Do not share this printer option.

12.  Click Next.

13.  The message You’ve successfully added printername appears. To ensure that your 
computer and printer are communicating properly, click Print a test page.

14.  If the test page prints properly, click Finish.

Your newly added printer should display in the Devices and Printers window with a green 
circle and a white check mark, indicating that it is your default printer. From this point 
forward, whenever you tell the computer to print, it automatically prints to your default 
printer. You can always choose to print to a different printer by selecting a different printer 
from the list of printers when you print a document.

REMOVE A LOCAL PRINTER

GET READY. To remove a local printer, perform the following steps.

1.  Open Devices and Printers.
2.  Right-click the printer that you want to remove and choose Remove device.

3.  Close the Devices and Printers window.

You can’t remove a printer that has print jobs in the queue.

Figure 5-7

Sharing your printer (or not 
sharing your printer)
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Understanding Network Printers

A true network printer is most commonly connected to and shared from a network server. 
While you can use the Add a local printer or network printer with manual settings option  
in the Add Printer Wizard, you can also use the Select a shared printer by name option  
and specify a UNC to the printer. Alternatively, you can open a UNC to a server, such as  
\\LON-SVR1, right-click the shared printer, and choose Connect.

Some network printers on the market today use proprietary connectivity methods and can 
only be accessed by installing a driver that is supplied by the manufacturer.

Printing a Document

CERTIFICATION READY
What is a network 
printer?
Objective 5.3

CERTIFICATION READY
How do you access a 
network printer to print 
a document?
Objective 4.2

A network printer generally has a network adapter and is connected to a network. The 
printer receives an IP address and is a node on the network much like a networked 
computer. You can share a local (directly connected) printer with others on a network; 
in this case, the printer is considered to be both local (to the computer to which it is 
connected) and networked.

Figure 5-8 shows a document that is ready to be printed in Word 2016. You can access 
this page by clicking the File menu within the Word document, and then clicking Print. 
Alternatively, press Ctrl+P.

Figure 5-8

Printing a Word 2016 
document

The first option at the top of the page is the number of copies; the default is to print 1 copy 
but you can change this by typing a number or clicking the up and down arrows to increase 
or decrease the number.
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The print device displays directly under the Printer heading. A status message indicates 
whether or not the printer is ready to print. If the printer is not ready to print, because it’s 
out of paper or offline, the status message indicates the problem so you can fix the issue 
before attempting to print. You can click the arrow to the right of the printer name and select 
a different printer if others are available.

The Settings section of the Print page includes many print options:

•	 Print All Pages: The default setting prints the entire document; however, you can click 
this button and specify to print the current page or a custom page range. You can also 
use the Pages text box to print a range of pages. For example, if you have a 100-page 
document but want to print only pages 5 through 10, type 5–10 in the Pages text box.

•	 Print One Sided: The default is to print on one side of the paper. You can change the 
setting to manually print on both sides of the paper. Printers with built-in duplexers can 
print on both sides of the paper automatically.

•	 Collated: This setting applies to multiple copies of a document. It affects whether 
multiple copies are printed in order (one complete set, and then another, and so on) 
or all copies of page 1 first, and then all copies of page 2, and so on.

•	 Orientation: Select to print the document in portrait (upright) or landscape (length-
wise) format.

•	 Size: This option enables you to select the paper size. Letter size (8.5” x 11”) is the 
default paper size for most printers.

•	 Margins: This setting enables you to change the document margins.
•	 Pages Per Sheet: This setting enables you to select the number of pages you want to 

print on one sheet of paper. You can typically choose from 1 to 16. The larger the 
number, the smaller the text will be on the printed page.

After making your selections, click the large Print button above the printer name to send the 
print job to the printer.

You can also choose to print a document to a file rather than to a print device. Why? Let’s 
say you need to send a Word file to a coworker but he doesn’t have Word installed on his 
computer. He doesn’t need to modify the file you send to him, he just needs to view the file’s 
contents. You can print the Word document to a file, which adds a .prn extension. When he 
receives the file, he can print the file to a printer.

PRINT TO A FILE

GET READY. To print to a file from Word, perform the following steps.

1.  Launch Word.

2.  Open the document you want to print to a .prn file.

3.  Select File > Print.
4.  On the Print page, click the arrow to the right of the printer name and select 

Print to File at the bottom of the list.

5.  Click Print at the top of the page. In the Print to file dialog box, navigate to the 
location on your computer where you want to save the file, type a file name in 
the File name text box, and then click OK.

PRINT A .PRN FILE

GET READY. To print a .prn file to a local printer, perform the following steps.

1.  Open a command prompt window by clicking Start, typing cmd in the Ask me 
anything search box, and then clicking cmd.exe in the resulting list.

CERTIFICATION READY
How do you print to  
a file?
Objective 5.3
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2.  Use the cd command to navigate to the location of the file. For example, if the 
file is named doc.prn and you saved it to the root of drive C, type cd c:\ and 
press Enter to execute the command.

3.  Execute the following command to send the file to the directly connected printer: 
copy/B doc.prn \\computername\printer_sharename
This command sends a binary (/B) copy of doc.prn to the device PRN, which is the 
system name for the default printer. A binary copy prevents anything in the file 
from changing during the process.

Understanding Print Queues

A print job is a file or set of files that have been sent to a printer. The printer processes the 
file or files in the print job and produces the document. The print job specifies which printer 
it is supposed to print to, the media size, the number of copies, and the priority.

Some printers can accept multiple pages of data at one time, but larger documents can 
take a while to print. You can think of a print queue as a holding area until the printer 
is finished printing the entire document. If you have a large document that cannot be 
entirely stored in a printer, the print job is sent to a print queue, which stores it until the 
printer can accept it. The printer then prints page by page until the entire document has 
been printed.

On occasion, a print job might have been sent that was not intended, or you might decide 
it is not necessary to print a job. In that situation, you need to delete the print job from the 
print queue.

By default, all users can pause, resume, restart, and cancel their own documents. To manage 
documents that are printed by other users, however, you must have the Allow manage  
documents permissions.

When the print device is available, the spooler retrieves the next print job and sends it to the 
print device. By default, the spool folder is located at C:\Windows\System32\Spool\Printers. 
If you have a server that handles a large number of print jobs or several large print jobs, make 
sure the drive where the spool folder is located has sufficient disk space.

EXPLORE A PRINT QUEUE

GET READY. To explore a print queue, perform the following steps.

1.  Right-click Start and choose Control Panel.
2.  In the Control Panel, under Hardware and Sound, click View devices and printers. 

The Devices and Printers window displays.

3.  Double-click your printer. A window similar to Figure 5-9 displays. The printer 
information displayed in this window includes:

•	The printer name

•	The printer’s status (in this example the Error - printing)

•	The number of documents in the queue

•	The owner of each document

CERTIFICATION READY
What is the purpose of a 
print queue?
Objective 5.3

The print spooler is an executable file that manages the printing process, which includes 
retrieving the location of the correct print driver, loading the driver, creating the 
individual print jobs, and scheduling the print jobs for printing.
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In this example, the first document in the print queue is in an error status and nothing else 
can print until either the error is resolved so the job can print or the job is cancelled and 
the next job will be allowed to print. If you have checked that your printer is turned on, 
has paper, and the ready lamp is lit, chances are you can get that job to print and then the 
subsequent jobs will print in turn.

The print queue window has three menus at the top: Printer, Document, and View:

•	 Printer: From this menu, you can choose a default printer, set printing preferences 
(default orientation), print on both sides of the paper, select the page order, add a 
watermark to pages, and set up color profiles so you can ensure that the colors you 
see on your screen are the colors that will be printed. Most printers today come with 
color profiles you can download from the manufacturer of the printer. You can also 
pause printing, cancel all documents (deletes all documents from the queue), share a 
printer (or stop sharing if it was previously shared), use the printer offline, and open the 
properties of the printer to make changes.

•	 Document: This menu is grayed out and thus cannot be accessed unless a document  
is selected. In the previous example, where the first print job has an error status, you 
could select that document and from the Document menu choose to restart the printing 
of the document or cancel the printing of the document. If you cancel the printing of 
the document, the next document in the queue (if any) begins printing. Other options 
from the Document menu allow you to pause, resume, or view document properties.

•	 View: This menu has two selections. Status Bar shows the number of documents in the 
queue on the status bar and Refresh refreshes the screen to show the most current view 
of the print queue.

On occasion, the print spooler might freeze or become unresponsive. You can restart the print 
spooler by following these steps:

1.	 Open the Services console located in Administrative Tools.
2.	 Right-click Print Spooler and choose Restart.

You can also stop and start the service.

Understanding Internet Printing

If you run Windows Server 2016, you can create a website hosted by Internet Information 
Services (IIS) using the Internet Printing role service. Clients can then use a web browser to 
connect and print to shared printers on the server using the Internet Printing Protocol (IPP). 
By default, Windows 10 has the Print and Document Services > Internet Printing Client 

Figure 5-9

Viewing printer information
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Windows feature installed; it is located under the Turn Windows features on or off option in 
the Control Panel.

You should restart the print queue at this point to ensure that print jobs reach the printer. 
Restart the Print Spooler service in the Services console to clear the print queue. (You learned 
about services in Lesson 4.)

■■ Understanding System Devices and Device Drivers

The main video device on a computer is the video adapter or card. This is an internal circuit 
board that’s either in the form of a physical card inserted into a slot on the motherboard or 
is manufactured as part of the motherboard. Other types of video devices include webcams, 
video capture cards, and TV tuners, to name a few.

The main audio device in a computer is a sound card. Like a video card or adapter, it is 
either in the form of a circuit board that’s inserted into a motherboard slot or hard-wired 
into the motherboard. Additional audio devices include microphones, headsets, and speakers. 
Headsets are always external devices, but microphones and speakers can be either internal or 
external.

Input devices are items such as keyboards, mice, trackballs, touchpads, digital pens,  
and joysticks (for gaming). On desktop computers, input devices are almost always 
external devices that plug into different ports on the computer. On a laptop computer, 
keyboards and touchpads are built in, although you can connect external input devices  
as well.

Many external devices, such as headsets and input devices, connect to a computer using 
wireless technology. A wireless keyboard or mouse, for example, comes with a small 
Bluetooth receiver that you plug into a USB port on the computer. The mouse contains 
a Bluetooth transmitter that communicates with the receiver. As you move the mouse 
around, it transmits signals using Bluetooth radio signals rather than a wire. If your 
computer already has Bluetooth technology built in, you may be able to set up Bluetooth  
to communicate directly with the external Bluetooth device without the need for the 
USB receiver.

Many wireless mice use infrared technology and are referred to as optical mice. These mice 
have an infrared light-emitting diode (LED) inside the mouse that detects the surface over 
which it is moved. This technology lets you use the mouse on a wider variety of surfaces 
compared to legacy trackball mice that required a mouse pad to operate.

Nearly all modern devices that you attach to a computer port are automatically detected 
by the operating system. This is part of plug-and-play (PnP) technology. As long as a PnP 
device is plugged into your computer and powered on (if the device requires power, like a 
printer), Windows detects the device and automatically installs the drivers.

The first time you connect a device, you should see a bubble message on the status bar 
that states Installing device driver software. When it installs the device driver successfully, 
you’ll see Your device is ready to use. The device has now been added to Device Manager. 
You can unplug the device and plug it in again, but the device driver installs only  
one time.

CERTIFICATION READY
How do you set up 
internet printing?
Objective 5.3

CERTIFICATION READY
Which types of video 
devices are supported  
by Windows 10?
Objective 5.4

CERTIFICATION READY
Which types of audio 
devices are supported  
by Windows 10?
Objective 5.4

CERTIFICATION READY
Which types of  
infrared input devices  
are supported by 
Windows 10?
Objective 5.4

CERTIFICATION READY
Do you need to install 
drivers for plug-and-play 
devices?
Objective 5.1

THE BOTTOM LINE

A computer is a collection of hardware devices, each of which requires a piece of software 
called a device driver in order to function. Windows 10 includes a large library of device 
drivers, but it is still sometimes necessary to obtain them yourself.
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Managing Devices

In addition to providing information about a device, drivers also permit the operating system 
to modify the hardware configuration settings of the device. For example, when you configure 
a printer to print a document in landscape mode instead of portrait mode, the printer device 
driver generates the appropriate command and sends it to the hardware.

The process of installing a hardware device consists primarily of identifying the device and 
installing a device driver for it. This process can occur during the operating system installa-
tion or at a later time, but the steps are fundamentally the same.

A major part of the Windows 10 installation process consists of identifying the devices in 
the computer and installing the appropriate drivers for them. The Windows 10 installation 
package includes hundreds of drivers for many different devices, which is why many  
installations finish without any user involvement. Sometimes, however, you might have to 
supply device drivers yourself.

In most cases, the information the device driver provides is integrated into the 
Windows interface. For example, the Properties dialog box for a printer includes 
generic system information, such as which port the printer is connected to and who 
is permitted to use it. Other tabs, and particularly the Device Settings tab, as shown 
in Figures 5-10 and 5-11, are based on hardware-specific information provided by 
the device driver.

Figure 5-10

The General tab of a printer’s 
Properties dialog box
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Using the Devices and Printers Folder

The Devices and Printers folder gives you a quick view of devices connected to your com-
puter that you can connect or disconnect from your computer through a port or network 
connection. This includes mobile devices such as music players and digital cameras, USB 
(Universal Serial Bus) devices, and network devices. See Figure 5-12. It does not include  
items installed inside your computer such as internal disk drives, expansion cards, or RAM, 
and it will not display legacy devices such as keyboards and mice connected through a PS/2 
or serial port.

To open the Devices and Printers folder, open the Control Panel and, under Hardware and 
Sound, click View devices and printers while in Category view or double-click Devices and 
Printers in Large icons or Small icons view.

When you right-click a device icon in the Devices and Printers folder, you can choose from 
a list of tasks that vary depending on the capabilities of the device. For example, you might 
be able to see what’s printing on a network printer, view files stored on a USB flash drive, 
or open a program from the device manufacturer. For mobile devices that support the new 
Device Stage feature in Windows, you can also open advanced, device-specific features in 
Windows from the shortcut (right-click) menu, such as the ability to sync with a mobile 
phone or change ringtones.

Figure 5-11

The Device Settings tab of a 
printer’s Properties dialog box

Windows 10 includes the Devices and Printers folder to quickly allow users to see all 
the devices connected to the computer and to configure and troubleshoot these devices. 
It will also allow you to view information about the make, model, and manufacturer 
and give you detailed information about the sync capabilities of a mobile phone or 
other mobile devices.
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Most PCs use USB connections for peripheral devices and plug and play is an integral part of 
the USB standard. When you connect a printer, camera, scanner, or another type of device to 
a computer running Windows 10 using a USB port, the system usually detects it, adds it to 
the Devices and Printers folder, and installs the appropriate device driver for it.

You can also manually install a device by selecting Add a device, which displays the Choose a 
device or a printer to add to this PC page.

Using Device Manager

Although it is not immediately apparent, Device Manager is a snap-in for the Microsoft 
Management Console (MMC). This means that there are many ways that you can access 
Device Manager, including the following:

•	 Open Hardware and Sound in the Control Panel and click the Device Manager link.
•	 Open the Computer Management console from the Administrative Tools program group in 

the System and Security section of Control Panel and click Device Manager in the left pane.
•	 Run the Microsoft Management Console shell application (Mmc.exe), click File >  

Add/Remove Snap-in, and click Device Manager in the list of snap-ins provided.
•	 Click Start, type Device Manager or the file name of the Device Manager snap-in 

(Devmgmt.msc), and then execute the resulting file.
•	 Search for Device Manager using Cortana and execute the resulting file.

Each of these procedures launches the Device Manager and displays a window with an inter-
face like that shown in Figure 5-13.

The Windows 10 tool for managing devices and their drivers is called Device Manager. 
You can use Device Manager to get information about the devices installed in the 
computer, as well as install, update, and troubleshoot device drivers.

Figure 5-12

Devices and Printers
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Device Manager is capable of displaying information in the following four modes, which can 
be selected from the View menu:

•	 Devices by type: Displays a list of device categories, which you can expand to show the 
devices in each category. This is the default Device Manager view.

•	 Devices by connection: Displays a list of the interfaces that hardware devices use to 
communicate with the computer. Expanding a connection shows the devices using that 
connection.

•	 Resources by type: Displays a list of resource types, including Direct Memory Access 
(DMA), Input/Output (I/O), Interrupt Request (IRQ), and Memory, which you can 
expand to show the resources of each type and the devices that are using them.

•	 Resources by connection: Displays a list of resource types, including Direct Memory 
Access (DMA), Input/Output (I/O), Interrupt Request (IRQ), and Memory, which you 
can expand to show the connection associated with each individual resource and the 
device using each connection.

To examine the properties of a device, simply locate it in the tree display and double-click it 
to open its Properties dialog box.

The tabs on the Properties dialog box vary depending on the nature of the device you select, 
but virtually all devices have the following four tabs:

•	 General: Displays the name of the device, its type, manufacturer, and location in the 
system. The Device Status box indicates whether the device is functioning and, if not, 
provides troubleshooting help.

•	 Driver: Displays the device driver’s provider, date, version, and digital signer. The tab 
also provides buttons you can use to display driver details, update, roll back (used when 
an upgrade of a device driver fails or causes problems with a system), or uninstall the 
driver, and enable or disable the device.

Figure 5-13

The Windows 10 Device 
Manager
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•	 Detail: Displays extensive information about the driver and its properties.
•	 Resources: Displays the hardware resources being used by the device and indicates 

whether there are any conflicts with other devices in the computer.

With Device Manager, you can disable any device in the computer, using any of the following 
procedures:

•	 Select the device and choose Disable from the Action menu.
•	 Right-click the device and choose Disable from the shortcut menu.
•	 Open the device’s Properties dialog box and on the Driver tab, click the Disable button.

Disabling a device does not affect the hardware in any way or uninstall the device driver; it 
simply renders the device inoperative until you enable it again. Obviously, you cannot disable 
devices that are necessary for the system to function, such as the processor, and some devices 
that are in use require you to restart the system before they can be disabled.

When you update a driver using Device Manager, you can point to a location on your com-
puter where you have already saved the new driver, or you can run a search of your computer 
and the internet. To update a device driver, use the following procedure.

UPDATE A DEVICE DRIVER

GET READY. Log on to Windows 10 using an account with Administrator privileges, and 
perform the following steps.

1.  Open Device Manager and locate the device that you want to update.

2.  Double-click the device you want to update, so that its Properties dialog box 
appears.

3.  Click the Driver tab, as shown in Figure 5-14.

Disabling a device releases the hardware resources it was using back to the operating 
system. If you restart the computer with the device disabled, Windows might reassign those 
hardware resources to other devices. If you re-enable the device, the computer might  
allocate different hardware resources to it than it had originally.

TAKE NOTE*

Figure 5-14

Viewing driver information
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4.  Click the Update Driver button. The How do you want to search for driver software? 
page appears, as shown in Figure 5-15.

5.  Click Browse my computer for driver software to specify a location for the 
driver or to select from a list of installed drivers. Click Search automatically for 
updated driver software to initiate a search for a driver.

6.  Click Next when you locate the driver you want to install. The Windows Has 
Successfully Updated Your Driver Software page appears.

7.  Click Close.

8.  Close the Device Manager window.

When you update a device driver in Windows 10, the operating system does not discard the 
old driver completely. It is not uncommon for new drivers to cause more problems than they 
solve, and many users find that they would prefer to go back to the old version. Windows 10 
makes this possible with the Roll Back feature, which you initiate by clicking the Roll  
Back Driver button on the Driver tab of the device’s Properties dialog box. This procedure 
uninstalls the current driver and reinstalls the previous version, returning the device to its 
state before you performed the most recent driver update.

Installing a new hardware device or a new device driver is a risky undertaking. There is 
always the possibility of a problem that, depending on the devices involved, could be trivial 
or catastrophic. For a peripheral device, such as a printer, a hardware misconfiguration or 
faulty driver would probably just cause the new device to malfunction. However, if the device 
involved is a graphics adapter, a bad driver could prevent the system from functioning.

Troubleshooting Problem Devices

TAKE NOTE*

Before installing new 
drivers, you should make 
sure you have a good 
backup. Backups are 
discussed in Lesson 8.

Figure 5-15

The How do you want to 
search for driver software? 
page

The Action Center (see Figure 5-16) shows important notifications related to the 
security and maintenance of your computer. When problems occur, you will be alerted 
to investigate them further.
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To configure how messages are displayed in the Action Center, open Windows 10 Settings 
and then click Settings > Notifications & actions. Then under the Notifications section, you 
can enable or disable the following options:

•	 Get notifications from apps and other senders
•	 Show notifications on the lock screen
•	 Show alarms, reminders, and incoming VoIP calls on the lock screen
•	 Hide notifications when I’m duplicating my screen
•	 Get tips, tricks, and suggestions as you use Windows

To troubleshoot hardware or driver problems, consider some of the following techniques:

•	 Open the Properties dialog box for the device and check the Device Status box on 
the General tab. If the device is malfunctioning, this tab informs you of its status and 
enables you to launch a troubleshooter.

•	 Open the Device Manager and delete the device entirely. Then restart the system 
and allow Windows 10 to detect and install the device again. This process will cause 
Windows to re-allocate hardware resources to the device, which could resolve the 
problem if it was caused by a hardware resource conflict.

Figure 5-16

Viewing the Action Center
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•	 If the device or driver malfunction prevents the system from running properly, 
as in the case of a bad graphics driver that prevents an image from appearing on 
the screen, you can start the computer in Safe Mode by pressing the F8 key as the 
system starts. Safe Mode loads the operating system with a minimal set of generic 
device drivers, bypassing the troublesome ones, so you can uninstall or trouble-
shoot them.

Device Manager also displays all of the devices installed on your computer. When a device 
is experiencing problems, Device Manager uses symbols to provide information about the 
particular error condition.

When there is an issue with a device, you will see one of the following symbols (each symbol 
represents a specific type of problem):

•	 Blue question mark inside white circle: The driver is installed, but may not provide 
full functionality.

•	 Red “X”: The device is installed in the computer and is consuming resources, the 
protected mode driver is not loaded, or the device was installed improperly.

•	 Yellow warning symbol with black exclamation point: The device is in a problem 
state; the device might be functioning. A problem code will be displayed with  
the device.

•	 Blue “I” on white field: Use automatic settings was not selected for the device  
or the resource was manually selected; does not indicate a problem or  
disabled state.

•	 Problem code: This is the code that explains the problem with the device.
•	 White circle with down arrow: The device was disabled by an administrator  

or user.

Windows 10 uses built-in hardware diagnostics to detect hardware problems on  
your computer. When problems are identified, a message appears that lets you know 
about the problem. If you select the message, you will be taken to the Action  
Center, which provides a central location to view any problems with your hardware  
or software.

When there is a problem, you will see two types of messages in the notification area  
(the bottom-right corner of your desktop):

•	 Red items (white flag, red circle with white x): These are important messages that 
indicate a significant problem that needs to be addressed. For example, your firewall  
is turned off, or spyware or antivirus applications need to be updated.

•	 Yellow items: These are messages that suggest tasks that can make your computer 
run better. For example, updating an application or configuring Windows Update 
to automatically download and install updates rather than checking with you 
beforehand.

How you troubleshoot a device depends upon the type of problem you encounter. For 
example, when you notice a device with the black exclamation point in a yellow triangle, 
you can double-click the device to investigate the problem further. Figure 5-17 shows 
that the device cannot start and the specified request is not a valid operation for the 
target device.

Another item of interest when troubleshooting device problems is to look for an Other 
Devices folder. This folder contains devices that are detected by Windows but lack a driver  
for the device.
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Figure 5-17

Looking at problem devices 
in Device Manager

S K I L L  S U M M A R Y

In this lesson, you learned:

•	 Cloud storage is remote data storage with backups, but can also include application 
hosting. You can use applications like Microsoft Word and Outlook, along with many other 
applications, over the internet. Client machines can run applications from the cloud and 
access data; in fact, they can maintain complete control of their data and security.

•	 OneDrive is a file hosting service that allows you to store and create files and folders and 
share them with other users and groups.

•	 OneDrive for Business is different from the public version of OneDrive because OneDrive 
for Business is based on SharePoint. By using SharePoint, OneDrive for Business can be 
used by team members to store and work on documents with others and it helps ensure 
that business files for your users are stored in a central location.

•	 Printing devices can be local or networked; they can even be available over the internet. 
You can perform most printer support from Devices and Printers.

•	 Some printers can accept multiple pages of data at one time but larger documents can 
take a while to print. You can think of a print queue as a holding area until the printer is 
finished printing the entire document.

•	 A computer is a collection of hardware devices, each of which requires a piece of software 
called a device driver in order to function. Windows 10 includes a large library of device 
drivers, but it is still sometimes necessary to obtain them directly from the vendor.
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■■ Knowledge Assessment

Multiple Choice

Select the correct answer for each of the following questions.

	 1.	 Which of the following actions can be used to recover a file that was accidently deleted 
in Microsoft OneDrive?
a.	 Using the Windows Recycle Bin
b.	 Using the OneDrive Recycle Bin
c.	 Using the Sync utility
d.	 Using the OneDrive Recovery utility

	 2.	 In OneDrive, by default, how long will a deleted file be available in the OneDrive 
Recycle Bin?
a.	 3 days
b.	 5 days
c.	 30 days
d.	 90 days

	 3.	 Which of the following actions is the easiest way to let someone know that a new 
document is available on OneDrive?
a.	 Call them on the phone; leave a message if they are not there
b.	 Send them a document with the link embedded
c.	 Send a notification after sharing the document or folder
d.	 Sync your computer with their computer

	 4.	 Which of the following is a holding area for print jobs?
a.	 Print trap
b.	 Print cache
c.	 Print drive
d.	 Print queue

	 5.	 Which of the following services allows you to print to a printer via a website?
a.	 Internet Printing
b.	 Web Printing
c.	 Cache Printing
d.	 HTTP Printing

	 6.	 Which of the following tools can be used to quickly determine if a device has a bad 
device driver?
a.	 Disk Manager
b.	 Device Manager
c.	 Driver Manager
d.	 Control Panel

•	 Windows 10 includes the Devices and Printers folder to quickly allow users to see all  
the devices connected to the computer and to configure and troubleshoot these devices. 
It will also allow you to view information about the make, model, and manufacturer and 
give you detailed information about the sync capabilities of a mobile phone or other 
mobile devices.

•	 The Windows 10 tool for managing devices and their drivers is called Device Manager. You 
can use Device Manager to get information about the devices installed in the computer, as 
well as install, update, and troubleshoot device drivers.
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	 7.	 Which of the following tools is usually used to manage printers on a Windows 10 
machine?
a.	 Device Manager
b.	 Devices and Printers folder
c.	 USB Manager
d.	 Print Queue Manager

	 8.	 Which of the following tasks can be completed with Device Manager? (Choose all that 
apply.)
a.	 Update a driver’s software
b.	 Disable a driver
c.	 Uninstall a driver
d.	 Change a device’s hardware ID
e.	 Scan for hardware changes

	 9.	 Which of the following refers to the set of files sent to the printer that specifies what the 
printer is supposed to print?
a.	 Print queue
b.	 Print job
c.	 Print spooler
d.	 Print driver

	10.	 In Device Manager, a white circle with a down arrow indicates which of the following?
a.	 The device is disabled.
b.	 The device driver is not loaded.
c.	 There is a problem with the device.
d.	 The wrong driver is loaded.

Fill in the Blank

Complete the following sentences by writing the correct word or words in the blanks provided.

	 1.	 _____________ can be used to view device IRQ and DMA settings.

	 2.	 A _____________ is a file or set of files that have been sent to a printer, which are used 
to produce the document.

	 3.	 A _____________ is a small program that enables hardware to interact with the 
operating system.

	 4.	 A Windows _____________ can be used to pause printing, cancel all documents, and 
resume, or restart a document.

	 5.	 _____________ can be used to determine the version of files that a device driver installs 
and their complete paths.

	 6.	 _____________ technology automatically detects a device and installs the drivers.

	 7.	 Microsoft cloud storage is called _____________.

	 8.	 OneDrive for Business is stored in _____________.

	 9.	 A _____________ is a printer that has a network adapter that is connected to a 
printer.

	10.	 The _____________ is an executable file that manages the printing process and creates 
the individual print jobs.
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True / False

Circle T if the statement is true or F if the statement is false.

T F 	1.	 OneDrive and OneDrive for Business are the same.

T F 	2.	 Print jobs can be viewed in the print queue.

T F 	3.	 Device Manager can be used to update print drivers.

T F 	4.	 In Device Manager, a red X indicates that the driver has not been installed.

T F 	5.	 Device Manager is found in the Computer Management console.

■■ Business Case Scenarios

Scenario 5-1: Troubleshooting Print Jobs

John is trying to print a large document, but nothing is printing from the printer. You receive 
several complaints that when others try to print to the same printer, it is not working. What 
should you do to troubleshoot the printer problem?

Scenario 5-2: Troubleshooting a Printer Driver

Axel runs the warehouse for a beverage distributor. He called you to report that the new 
wireless laser printer he recently purchased does not work. He connected it to the USB port 
on his computer running Windows 10 Professional and turned on the printer, but the printer 
does not appear in the Devices and Printers window. How should you advise Axel to help 
troubleshoot the problem?

Scenario 5-3: Changing Print Drivers

You have a new printer. Unfortunately, it did not come with any drivers. So, you visit the 
manufacturer’s website and download the driver. You then print the document, but the 
printed page contains what looks like programming code. When other users try to print, their 
documents do not print. Describe your recommended solution.

Scenario 5-4: Using Cloud Services

The sales and marketing department at your company consists of two salespeople, a graphic 
designer, a copywriter, and a layout person.

Tonya and Aaron are the salespeople. Tonya is responsible for the western United States 
and Aaron covers the eastern United States. They tend to use the same files for all sales 
presentations, client follow-ups, and so on. When one modifies a template, it’s important  
that the other gets the updated file as soon as possible.

The marketing employees share several Word documents and PowerPoint presentations, in 
addition to a large folder of graphical images. It’s important for them to have shared access to 
a Marketing folder that contains the shared files.

What should you do to help the sales and marketing employees work more efficiently?
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LESSON 6Understanding File 
and Print Sharing

K E Y  T E R M S

advanced sharing

basic sharing

effective permissions

explicit permissions

homegroup

inherited permissions

mapping a drive

network discovery

network location

NTFS permissions

printer permissions

Public folder

shared folder

O B J E C T I V E  D O M A I N  M A T R I X

Skill/Concept Exam Objective Objective Number

Understanding File and Printer Sharing 
Basics

Understand file and printer sharing 4.2

Configuring HomeGroup Connections Understand file and printer sharing 4.2

Creating Public, Basic, and Advanced Shares Understand file and printer sharing 4.2

Configuring Printer Sharing Understand file and printer sharing 4.2
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■■ Understanding File and Printer Sharing Basics

Microsoft offers several ways for Windows 10 users to share resources such as files and 
printers, either on the same computer (between accounts) or on a network, without the need 
for a server. For example, you can share files from any folder on your computer by setting up 
basic or advanced sharing, or by moving files to the Public folder. Another method is by using 
a HomeGroup, the networking feature that’s built in to Windows 10.

To share files and printers with users on other computers, you need to have a wired or wireless 
network set up. In a typical wired environment, each computer has a network adapter that is 
connected to other computers and a hub, switch, or router with Ethernet cables. Wireless net-
works are easier to set up and maintain. Each computer’s wireless network adapter connects 
“over the air” to a router or wireless access point within range.

A network location is a collection of security settings that’s appropriate for the type of network 
to which you want to connect. Windows 10 offers three broad categories of network locations:

•	 Public network: This network location type is assigned to any new networks when they 
are first connected and is considered to be shared with the world, with no protection 
between the local computer and any other computer. Therefore, the Windows Firewall 
rules are configured to be the most restrictive including blocking file sharing, network 
discovery, and automatic setup of network printers, TVs, and other devices.

•	 Private network: This network location type is for home or small office networks, or 
where you know and trust the people and devices on the network. This setting allows 
your PC to connect to a homegroup and devices on the network, such as printers.

•	 Domain network: This network location type is detected when the local computer is a 
member of an Active Directory domain, and the local computer can authenticate to a 
domain controller for that domain through one of its network connections.

Whether wired or wireless, you must turn on file and printer sharing on each computer that 
will share files and/or printers. To do so, right-click the network icon in the notification area 
of the taskbar and choose Open Network and Sharing Center. In the task pane on the left, 
click the Change advanced sharing settings link. Click the down arrow to the right of Private, 
Guest or Public, or All Networks. The advanced sharing settings are shown in Figure 6-1.

Notice that network discovery and file and printer sharing are turned on. These settings allow 
you maximum flexibility for sharing files in a small office or home office environment.

TAKE NOTE*

This lesson assumes 
you are working on a 
peer-to-peer network in 
a small office or home 
office setting. The net-
work does not have a 
server and does not use  
a domain.

TAKE NOTE*

Network discovery is a 
Windows feature that 
enables your computer 
to find other computers 
and devices (such as 
printers) on a connected 
network. It also lets you 
control whether other 
computers can see your 
computer on the same 
network.

THE BOTTOM LINE

Windows 10 provides many ways to share files or printers on a network. The first step 
is to ensure that file and printer sharing is turned on in the advanced sharing settings 
in Network and Sharing Center. Some networking methods, such as HomeGroup, also 
require that your network location be set to Home network.

As the IT technician at a mid-market food service and vending company, you’ve been 
asked to set up file and printer sharing for all of the computers at a remote warehouse. 
The employees there do not need constant access to the network at the company’s 
main facility. All of the computers at the remote location are running Windows 10 
Professional. There are two printers in the warehouse. One printer is attached to the 
supervisor’s computer and the other printer is attached to a computer in the middle of 
the warehouse that all employees use to print pallet labels for outgoing shipments. Some 
folders on the supervisor’s computer contain confidential files that need to be protected 
from access by other employees.
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Finally, if your network includes a mix of computers running Windows XP and higher, and 
you want to share files between the computers, you should use a workgroup. A workgroup 
is a logical grouping of networked computers that can “see” each other on a network. You’re 
prompted to set up a workgroup when installing Windows, and many computers are set up 
to be a part of a workgroup named WORKGROUP by default. To see if your computer is 
part of a workgroup, right-click the Start button and choose System.

■■ Configuring HomeGroup Connections

HomeGroup is available with Windows 7, Windows 8/8.1 (including Windows RT 8.0/8.1), 
and Windows 10. Windows RT, Starter, and Home Basic editions can join a homegroup, but 
you cannot create a homegroup from them. For the system to use homegroups, the system 
cannot use a public network. If a system is part of a domain, you cannot create your own 
homegroup, but you can join one that is created by someone on your network.

If the system does not detect a homegroup, the Network and Sharing Center in the Control 
Panel contains a link that provides access to the Create a Homegroup Wizard.

Figure 6-1

Advanced sharing settings in 
Windows 10

THE BOTTOM LINE

When you run Windows 10 within a domain, Windows servers and clients have several 
tools and mechanisms available to share files and printers. Today, many households have 
multiple computers. A homegroup is a group of computers on a home network that can 
share files and printers. To protect your homegroup, you use a password. Similar to share 
permissions, other people cannot change the files that you share unless you give them 
permission to do so. Homegroups are relatively limited, when compared to folder sharing, 
because you can only share the contents of the libraries in the user’s profile.
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CREATE A HOMEGROUP

GET READY. Log on to Windows 10 using an account with Administrator privileges. Make sure 
that the system is configured to use the Private network location. Perform the following steps.

1.  Right-click Start and choose Control Panel.
2.  In the search box, type homegroup. In the search results, click HomeGroup. The 

HomeGroup page appears as shown in Figure 6-2.

3.  Click Create a homegroup.

4.  In the Create a Homegroup Wizard, click Next.
5.  On the Share with other homegroup members page (as shown in Figure 6-3), select 

the libraries that you want to share and click Next.

6.  The wizard creates the homegroup and assigns it a password. Be sure to record 
this password and store it in a safe place.

7.  Click Finish.

Figure 6-2

Opening the Control Panel 
HomeGroup

Figure 6-3

Sharing libraries and folders 
with homegroup members
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JOIN A HOMEGROUP

GET READY. Log on to Windows 10 using an account with Administrator privileges. Make 
sure that the system is configured to use the Private network location. To join an existing 
homegroup, perform the following steps.

1.  Right-click Start and choose Control Panel.
2.  In the search box, type homegroup. In the search results, click HomeGroup.

3.  On the HomeGroup page, click Join now.

4.  In the Join a Homegroup Wizard, click Next.
5.  On the Share with other homegroup members page, select the libraries that you 

want to share and click Next.
6.  On the Type the homegroup password page, in the Type the password text box, 

type the password supplied by the Create a Homegroup Wizard and click Next.
7.  On the You have joined the homegroup page, click Finish.

After you have created and joined a homegroup, you can manage the homegroup settings 
using the HomeGroup page, as shown in Figure 6-4. The HomeGroup options include:

•	 Change what you’re sharing with the homegroup: Select the libraries and printers you 
want to share in their entirety with your homegroup.

•	 Allow all devices on this network such as TVs and game consoles to play my shared 
content: Share media with all devices on your network. For example, you can share 
pictures with an electronic picture frame or share music with a network media player. 
Unfortunately, shared media is not secure. Anyone connected to your network can 
receive your shared media.

•	 View or print the homegroup password: View or print the password for your homegroup.
•	 Change the password: Change the password for your homegroup.
•	 Leave the homegroup: Leave your homegroup.
•	 Change advanced sharing settings: Change the settings for network discovery, file 

sharing, Public folder sharing, password-protected sharing, homegroup connections, and 
file sharing connections.

•	 Start the HomeGroup troubleshooter: Troubleshoot homegroup problems.

Figure 6-4

Managing a homegroup
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REMOVE A COMPUTER FROM A HOMEGROUP

GET READY. To remove a computer from a homegroup, follow these steps on the computer 
you want to remove.

1.  Right-click Start and choose Control Panel.
2.  In the search box, type homegroup. In the search results, click HomeGroup.

3.  Click Leave the homegroup.

4.  Click Leave the homegroup and click Finish.

To modify the default homegroup sharing configuration, you can select one of your shared 
libraries in File Explorer and click Share in the toolbar. Using the controls that appear in the 
ribbon, you can change other homegroup users’ access to the library from Homegroup (view) 
to Homegroup (view and edit). You can also limit access to specific homegroup users, or pre-
vent anyone on the network from accessing that library.

SPECIFY SHARED FILES AND FOLDERS IN A HOMEGROUP

GET READY. To specify shared files and folders in a homegroup, perform the following steps.

1.  On the taskbar, click File Explorer.
2.  Navigate to the file or folder (such as Desktop, Downloads, Documents, Pictures, 

Music, or Videos) you want to exclude from sharing and click it.

3.  Do one of the following:

a.  To prevent the file or folder from being shared with anyone, in the toolbar, 
click the Share tab and click Stop sharing.

b.  To share the file or folder with some people but not others, in the toolbar, 
click the Share tab, click Specific people, select each person you want to 
share with, and then click Add. Click Share when you are finished.

c.  To change the level of access to a file or folder, in the toolbar, click the Share 
tab and click either Homegroup (view) or Homegroup (view and edit).

■■ Creating Public, Basic, and Advanced Shares

HomeGroup isn’t the only way to share files and folders in Windows 10. You can also use tra-
ditional Windows file sharing to share individual files or folders, or move files or folders to a 
Public folder.

Traditional Windows file sharing offers greater control over sharing with Public folders. In 
traditional file sharing, depending on whom you choose to share files or folders with, you can 
generally apply permissions to restrict users to simply viewing (reading) files as well as allow 
them to modify and/or delete files.

Let’s look at Public folders first, because this method is the more convenient of the two 
methods.

CERTIFICATION READY
What are the primary 
differences between 
Public, basic, and 
advanced shares?
Objective 4.2

THE BOTTOM LINE

Windows 10 provides Public folders and traditional file sharing capabilities to meet your 
networking needs. Public folders are a quick-and-easy way to share files with network users 
and with other users on your computer. Basic and advanced sharing allows you to control 
who may access specific files and folders located in your libraries. Advanced sharing offers 
the most options and is therefore the best choice for protecting confidential information.
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Configuring Public Folders

The folders that make up the Public library are stored in the C:\Users\Public folder. The Public 
folder contains subfolders (Public Documents, Public Music, Public Pictures, Public Videos, 
and more) that help you get organized; however, those folders do not have any files in them 
until you or other people use your computer to add files to them.

By default, Public folder sharing is turned off, except when the system is part of a homegroup. 
To enable or disable public folders, open the Network and Sharing Center and click Change 
advanced sharing settings. When Public folder sharing is turned on, anyone on your computer 
or network can access these folders. When Public folder sharing is turned off, only people with 
a user account and password on your computer can access the public folders.

CONFIGURE PUBLIC FOLDERS

GET READY. To configure Public folders, perform the following steps.

1.  Log on to LON-CL1 as adatum\administrator with the password of Pa$$w0rd.

2.  On the taskbar, right-click the network status icon and choose Open Network and 
Sharing Center.

3.  In the Network and Sharing Center window, click Change advanced sharing 
settings.

4.  Under All Networks, select the Turn on sharing so anyone with network access 
can read and write files in the Public folders option.

5.  Click Save changes and close the Network and Sharing Center.

After you turn on Public folder sharing, local users can navigate to C:\Users\Public to open 
the public folders. If you want the Public folders to be available over the network, you can 
share the Public folder so that it can be easily accessed using a UNC.

Configuring File Sharing

Traditional Windows file sharing allows you to restrict access to specific shared files and 
folders, and choose which users have access. Basic sharing allows you to share a file or folder 
with a specific user and restrict the user to Read or Read/Write actions.

CERTIFICATION READY
For what purpose would 
you use Public folders?
Objective 4.2

CERTIFICATION READY
What are the two methods 
for sharing a folder?
Objective 4.2

The Public folder is an easy and convenient way to share files on your computer. You 
can share files in your Public folders with other people using the same computer and 
with people using other computers on your network. Any file or folder you put in a 
Public folder is automatically shared with the people who have access to your Public 
folders.

Most users are not going to log on to a server directly to access their data files. Instead, 
a drive or folder will be shared (known as a shared folder), and they will access the data 
files over the network. To help protect against unauthorized drive or folder access, you 
should use share permissions along with NTFS permissions (if the shared folder is on an 
NTFS volume). When a user needs to access a network share, she will use the universal 
naming convention (UNC), which is \\servername\sharename.
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Advanced sharing offers the greatest amount of control; for example, you can:

•	 Share files, folders, or an entire drive.
•	 Choose users or groups with which to share files and folders.
•	 Limit the number of users who can use a file or folder at the same time, mainly for secu-

rity purposes.
•	 Set permissions on shared files and folders, such as allowing users Read, Change, or Full 

Control permissions.
•	 Choose which files are available to users offline.

To set up basic or advanced shares, you must make sure that file sharing and network dis-
covery are turned on. You should also turn on password-protected sharing for security pur-
poses. File sharing, network discovery, and password-protected sharing options are enabled by 
default in the Network and Sharing Center (Advanced sharing settings page).

SET UP A BASIC SHARE

GET READY. To set up a basic share for a specific user, perform the following steps.

1.  In File Explorer, navigate to the file or folder you want to share.

2.  Right-click the file or folder and choose Properties. Click the Sharing tab in the 
Properties dialog box and click Share. The File Sharing dialog box opens (see 
Figure 6-5). You can also right-click the file or folder and choose Share with > 
Specific people.

3.  Click the arrow next to the text box, click a name from the list, and then click 
Add. Alternatively, if you know the user name of the person you want to add, type 
it in the text box and click Add.

4.  In the Permission Level column, click the down arrow for the new user and select 
Read or Read/Write. Read allows the user to open and view items but not make 
changes or delete them. Read/Write allows users to open, modify, and delete 
items. You can also click Remove to remove the user.

CERTIFICATION READY
Which permissions are 
available for Windows 10 
file sharing?
Objective 4.2

TAKE NOTE*

You’ll learn about per-
missions later in this 
lesson.

Figure 6-5

Windows 10 basic sharing
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5.  When you’re finished, click Share. If you’re prompted for an administrator password 
or confirmation, type the password or provide confirmation.

6.  After you set up a basic share for a user, Windows lets you send a confirmation to 
that user via email, or you can copy and paste a link to the shared item and send 
it to the user via email or instant message, for example.

7.  When you’re finished, click Done.

SET UP AN ADVANCED SHARE

GET READY. To set up an advanced share, perform the following steps.

1.  In File Explorer, navigate to the folder or drive you want to share. This exercise 
assumes you are not working with Public folders.

2.  Right-click the item to be shared and choose Properties. Click the Sharing tab 
in the Properties dialog box and click the Advanced Sharing button. If you’re 
prompted for an administrator password or confirmation, type the password or 
provide confirmation.

3.  In the Advanced Sharing dialog box, select the Share this folder check box 
(as  shown in Figure 6-6).

4.  Use the Limit the number of simultaneous users to spin box to select the 
number of users who may access the item simultaneously.

5.  In the Comments text box, type a description of the shared item (optional).

6.  To specify users or groups, or change permissions, click the Permissions button. 
The Permissions dialog box opens (see Figure 6-7).

Figure 6-6

The Advanced Sharing dialog 
box
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7.  Click Add to add a user or group. (You can also click Remove to remove a user or 
group from the share.) The Select Users or Groups dialog box opens.

8.  Type a user or group name in the text box or click Locations to find a user or 
group to add. When you’re finished, click OK.

9.  In the Permissions dialog box, select a user or group, select the check boxes for 
the permissions you want to assign, and then click OK.

10.  When you’re finished, click OK to close the Advanced Sharing dialog box. Close the 
Properties dialog box.

Share permissions are set for folders when they are shared in workgroups and domain-based 
networks and are only associated with the folders. These permissions determine the type of 
access that others will have to the folders when they connect to them over the network.

Share permissions only apply when you are accessing a shared folder via the UNC. If you 
log on locally and access the files directly without using the UNC, these permissions will not 
apply. Share permissions are not granular; therefore, the permission you assign to the share 
will automatically apply to the files and subfolders within the share itself.

In Windows 10, you will create and manage shares and share permissions from the folder 
properties Sharing tab. To see the permissions, click Advanced Sharing, select the Share this 
folder check box, and click the Permissions button. Table 6-1 shows the available permissions.

Figure 6-7

The Permissions dialog box

Table 6-1

Understanding Share 
Permissions

Permission Description

Read Enables user/group to view file and subfolder names, view data in files, and 
run programs

Change Enables user/group to add files and subfolders to the shared folder, change 
data in files, delete subfolders and files, and change any permission associated 
with Read

Full 
Control

Enables user/group to change file permissions (NTFS only), take ownership  
of files (NTFS only), and perform tasks associated with Change/Read
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Configuring File System Permissions

In addition to the permissions you set when sharing a folder, Windows offers a more compre-
hensive set of permissions called NTFS permissions. These permissions are available on vol-
umes formatted with the NTFS file system.

NTFS permissions differ from share permissions in two ways:

•	 They apply to files and folders on NTFS volumes.
•	 They apply whether the user attempts to access them over the network or locally.

Figure 6-8 shows the Security tab in the Properties dialog box. This tab is present because the 
folder is located on an NTFS volume. As you can see, there are a number of different permis-
sions available for selected users and groups (see Table 6-2).

CERTIFICATION READY
How do NTFS 
permissions differ from 
share permissions?
Objective 4.2

Figure 6-8

Managing NTFS permissions

The NTFS file permission tool is powerful and enables you to control access to your 
files and folders whether they are accessed across the network or by someone logging on 
to the computer locally.

Table 6-2

NTFS Permissions Permission Description

Read Folder: Enables user/group to read the contents of the folder.

File: Enables user/group to read the contents of the file.

Read & Execute Folder: Enables user/group to read the contents of the folder and  
execute programs in the folder.

File: Enables user/group to read the contents of the file and execute the 
program.

(continued )
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Groups or users that are granted Full Control permission on a folder can delete any files in 
that folder regardless of the permissions protecting the file. In addition, the permissions for 
List folder contents are inherited by folders but not files, and it should only appear when 
you view folder permissions. In Windows 10, the Everyone group does not include the 
Anonymous Logon group by default, so permissions applied to the Everyone group do not 
affect the Anonymous Logon group.

Each of the standard permissions consists of a logical group of advanced permissions. 
The available advanced permissions are as follows:

•	 Traverse folder/Execute file: When applied to a folder, this permission allows or pre-
vents a user or group to move through folders to reach other files or folders, even if the 
user has no permission for the parent folder. When applied to a file, this permission 
allows the user or group to run program files. By default, the Everyone group is granted 
the Bypass traverse checking user right, which is applied to folders only. Setting the 
Traverse folder permission on a folder does not automatically set the Execute file permis-
sion on all files within that folder.

•	 List folder/Read data: When applied to a folder, this permission allows or prevents the 
user or group to see a list of files and subfolders in the folder. When this permission is 
applied to a file, you can open and read the file.

•	 Read attributes: When applied to files and folders, this permission allows or prevents 
the viewing of file or folder attributes, such as read-only and hidden.

•	 Read extended attributes: When applied to files and folders, this permission allows or 
prevents the viewing of extended attributes of a file or folder. Extended attributes are 
defined by programs and may vary by program.

•	 Create files/Write data: When applied to a folder, this permission allows or prevents a 
user or group to create new files within the folders. When applied to a file, this permis-
sion allows the user or group to add to or modify the file, including overwriting existing 
content.

•	 Create folders/Append data: When applied to a folder, this permission allows you to 
create subfolders within the folder. When applied to a file, this permission allows the 

Permission Description

Write Folder: Enables user/group to create files and folders.

File: Enables user/group to create a file.

Modify Folder: Enables user/group to read and write permissions. User can 
delete files within the folder and view the contents of subfolders.

File: Enables user/group to read and write permissions. User can modify 
the contents of the file.

List Folder 
Contents

Folder: Enables user/group to view a list of files in the selected folder; 
user is not allowed to read the contents of a file or execute a file.

File: There is no equivalent permission for files.

Full Control Folder: Enables user/group to add, change, move, and delete items. User 
can also add and remove permissions on the folder and its subfolders.

File: Enables user/group to change, move, delete, and manage permis-
sions. User can also add, change, and remove permissions on the file.

Table 6-2

(Continued)
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user or group to add data to the end of a file, but not to change, delete, or overwrite 
existing data.

•	 Write attributes: When applied to files or folders, this permission allows or prevents 
changing the attributes of files or folders, such as read-only or hidden.

•	 Write extended attributes: When applied to files or folders, this permission allows or 
prevents changing the extended attributes of a file or folder.

•	 Delete subfolders and files: When applied to files or folders, this permission allows the 
user or groups to delete subfolders and files.

•	 Delete: When applied to files and folders, this permission allows or prevents deleting the 
file or folder.

•	 Read permissions: When applied to a file or folder, this permission allows or prevents 
viewing the permissions of the file or folder.

•	 Change permissions: When applied to a file or folder, this permission allows or pre-
vents the user or group changing the permissions of a file or folder.

•	 Take ownership: When applied to a file or folder, this permission allows or pre-
vents taking ownership of the file or folder. As an owner, you can change permissions 
regardless of permissions that you are explicitly granted to the file or folder.

To simplify administration, you can use groups to grant permissions. By assigning NTFS 
permissions to a group, you are granting permissions to one or more people simultaneously, 
reducing the number of entries in each access list, as well as the amount of effort required to 
grant multiple people access to certain files or folders.

Understanding Effective NTFS Permissions

There are two types of permissions used in NTFS:

•	 Explicit permissions: Permissions granted directly to a file or folder
•	 Inherited permissions: Permissions that are granted to a folder (parent object or con-

tainer) that flow into child objects (subfolders or files inside the parent folder)

In a file system, a folder with subfolders is considered the parent folder. The subfolders are 
considered child folders. After you set permissions on a parent folder, new files and subfolders 
that are created in the folder inherit these permissions.

To stop permissions from being inherited, select the “Replace all existing inheritable per-
missions on all descendants with inheritable permissions from this object” check box in the 
Advanced Security Settings dialog box. You are then prompted to confirm if you are sure you 
want to proceed. You can also clear the “Allow inheritable permissions from parent to prop-
agate to this object” check box. When you clear this check box, Windows responds with a 
Security dialog box. In the Security dialog box, when you click the Copy button, the explicit 
permission is copied from the parent folder to the subfolder or file. You can then change 
the subfolder’s or file’s explicit permissions. If you click the Remove button, you remove the 
inherited permission altogether.

By default, any objects within a folder inherit the permissions from that folder when they are 
created, as shown in Table 6-3. However, explicit permissions take precedence over inherited 
permissions, as shown in Table 6-4. So, if you grant different permissions at a lower level, the 
lower-level permissions take precedence.

The folder and file structure on an NTFS drive can be complicated, with many folders 
and nested folders. In addition, because you can assign permissions to groups and 
at different levels on an NTFS volume, figuring out the effective permissions of a 
particular folder or file for a particular user can be tricky.
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For example, say you have a folder called Data. Within the Data folder, you have Folder1, 
and within Folder1, you have Folder2. Folder2 has File1. If you grant Allow full control to 
a user account, the Allow full control permission will flow down to the subfolders and files 
within the Data folder.

Object NTFS Permissions

Data Grant Allow full control (explicit)

Folder1 Allow read (explicit)

Folder2 Allow read (inherited)

File1 Allow read (inherited)

Table 6-4

Explicit Permissions Overwrite 
Inherited Permissions

Table 6-3

Inherited Permissions Object NTFS Permissions

Data Grant Allow full control (explicit)

Folder1 Allow full control (inherited)

Folder2 Allow full control (inherited)

File1 Allow full control (inherited)

In comparison, if you grant Allow full control on the Data folder to a user account and you 
grant Allow read permission to Folder1, the Allow read permission will overwrite the inher-
ited permissions and will then flow down to Folder2 and File1.

If a user has access to a file, he can still gain access to the file even if he does not have access 
to the folder containing the file. Of course, because the user doesn’t have access to the folder, 
the user cannot navigate or browse through the folder to get to the file. Therefore, the user 
will have to use the universal naming convention (UNC) or local path to open the file.

When you view permissions of a file or folder, they will appear in one of the following ways:

•	 Checked: Permissions are explicitly assigned.
•	 Cleared (unchecked): No permissions are assigned.
•	 Shaded: Permissions are granted through inheritance from a parent folder.

Besides granting the Allow permission, you can also grant the Deny permission. The Deny 
permission always overrides other permissions that have been granted, including when a user 
or group has been given Full control. For example, if a group is granted Read and Write per-
mission and one person within the group is denied the Write permission, the user’s effective 
right is the Read permission.

When you combine applying Deny versus Allowed with explicit versus inherited permissions, 
the hierarchy of precedence of permission is as follows:

1.	 Explicit Deny
2.	 Explicit Allow
3.	 Inherited Deny
4.	 Inherited Allow

Because users can be members of several groups, it is possible for them to have several sets 
of explicit permissions for a particular folder or file. When this occurs, the permissions are 
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combined to form the effective permissions, which are the actual permissions when logging in 
and accessing a file or folder. These consist of explicit permissions plus any inherited permissions.

When you calculate effective permissions, you must first calculate the explicit and inherited 
permissions for an individual or group and then combine them. When combining user and 
group permissions for NTFS security, the effective permission is the cumulative permission. 
The only exception is that Deny permissions always apply.

For example, you have a folder called Data. Within the Data folder, you have Folder1, and 
within Folder1, you have Folder2. If User 1 is a member of Group 1 and Group 2 and you 
assign the following:

•	 The Allow write permission to the Data folder to User 1
•	 The Allow read permission to Folder1 to Group 1
•	 The Allow modify permission to Folder2 to Group 2

User 1’s effective permissions would be as shown in Table 6-5.

Table 6-5

Calculating Effective 
Permissions

Object User 1 NTFS Permissions Group 1 Permissions Group 2 Permissions Effective Permissions

Data Allow write (explicit) Allow write

Folder1 Allow write (inherited) Allow read (explicit) Allow read and write

Folder2 Allow write (inherited) Allow read (inherited) Allow modify* (explicit) Allow modify*

File1 Allow write (inherited) Allow read (inherited) Allow modify* (inherited) Allow modify*

*The Modify permission includes the Read and Write permissions.

As another example, say you have a folder called Data. Within the Data folder, you have 
Folder1, and within Folder1, you have Folder2. If User 1 is a member of Group 1 and  
Group 2 and you assign the following permissions:

•	 The Allow write permission to the Data folder to User 1
•	 The Allow read permission to Folder1 to Group 1
•	 The Deny modify permission to Folder2 to Group 2

User 1’s effective permissions would be as shown in Table 6-6.

Table 6-6

Effective Permissions Affected 
by Deny Permissions

Object User 1 NTFS Permissions Group 1 Permissions Group 2 Permissions Effective Permissions

Data Allow write (explicit) Allow write

Folder1 Allow write (inherited) Allow read (explicit) Allow read and write

Folder2 Allow write (inherited) Allow read (inherited) Deny modify (explicit) Deny modify

File1 Allow write (inherited) Allow read (inherited) Deny modify (inherited) Deny modify
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The concept of inheritance is important to keep in mind when setting NTFS permissions. 
Remember the following:

•	 When users copy files and folders, the files and folders inherit the permissions of the 
destination folder.

•	 When users move files and folders within the same volume, they retain their permissions.
•	 When users move files and folders to a different volume, they inherit the permissions of 

the destination folder.

Effective permissions for an object, such as a folder, are permissions granted to a user or group 
based on the permissions granted through group membership and any permissions inherited from 
the parent object. Windows does not include share permissions as part of the effective permissions.

NTFS permissions are cumulative. For example, if you give a user in the sales group Read 
permissions to a folder and its contents, and the user is also a member of the marketing 
group, which has been given the Write permission to the same folder, the user will have Read/
Write permissions. In this type of situation, if you do not want the user to be able to write to 
the folder, you can use the Deny permission and select the specific user account. The Deny 
permission always overrides the Allow permission.

Viewing Effective Permissions on a Resource

For example, let’s say you create a folder called Data and then share the folder, allowing the 
Sales group full control. You also configure the NTFS permissions for JSmith, a member 
of the group, with the following settings: Read & Execute, List Folder Contents, and Read. 
What would JSmith’s effective permissions be?

To determine JSmith’s effective permissions, right-click the Data folder and choose Properties. 
Click the Security tab and click Advanced. Once you are in the Advanced Security Settings for 
Data dialog box, click Select a user and then search for JSmith’s account. Once you find his 
account, select it and then click View effective access to see the permissions he has for the folder.

As shown in Figure 6-9, even though JSmith has Full Control to the share due to his mem-
bership in the Sales group, NTFS permissions restrict him to only reading, listing folder 
contents, and executing files within the folder. He cannot create files, folders, or make any 
changes to the documents.

In Windows 10, the Effective Access tab enables you to view the effective NTFS 
permissions for a user, group, or device account on a resource. To access this tab, right-
click the file or folder, choose Properties, click the Security tab, and then click Advanced.

Figure 6-9

Viewing a user’s effective 
permissions
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REVIEW PERMISSIONS USING THE EFFECTIVE ACCESS TAB

GET READY. To view the effective permissions for the local Administrator account, log on to 
your computer with administrative credentials and perform the following steps.

1.  Click the File Explorer icon on the taskbar.

2.  Click Local Disk (C:).

3.  Right-click the Windows folder and choose Properties.
4.  Click the Security tab and click Advanced.

5.  Click the Effective Access tab.

6.  Click Select a user.
7.  In the Enter the object name to select field, type Administrator and click OK.

8.  Click View effective access.
9.  Review the current permissions for the local Administrator account on C:\Windows 

and click OK.

10.  Click OK and then close the Windows Properties dialog box.

When planning your NTFS/Share permissions on storage spaces or any volumes in which 
files and folders are shared, the best approach is to set the Share permissions to provide Full 
Control to the appropriate user group and then use NTFS permissions to further lock down 
access to the resource. This process ensures that resources are secured regardless of how they 
are accessed (remotely or locally).

Combining NTFS and Share Permissions

For example, let’s say you create and share a folder with the following settings:

•	 Share permission (Share tab): Sales group, Read
•	 NTFS permission (Security tab): Sales group, Full Control

When users connect to the share over the network, both the share and NTFS permissions 
combine, and the most restrictive set is applied. In the preceding example, the share permis-
sion of Read is more restrictive than the NTFS permission, so users can read the folder and 
its contents. If the same users were to log on locally to the computer in which this share is 
located, they would bypass the share permissions and their level of access would be based on 
the NTFS permission. In this example, they would have Full Control.

Mapping Drives

It is very common to combine share and NTFS permissions when providing access to 
resources on NTFS volumes. When this happens, you must have a good understanding 
of the cumulative effects to ensure that your resources remain protected. Now that you 
have a better understanding of NTFS permissions and share permissions, you need 
to understand what happens when you combine the two permissions on the same 
resource.

Drive mapping allows you to create a shortcut to a shared folder across a network. 
Instead of finding and connecting to the shared drive each time you log on, you can 
create a mapped drive that is available at all times. Just double-click the mapped drive 
to access the shared folder.
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Once you share a folder or drive on your computer with other users, an easy way for them to 
get to the shared item is by mapping a drive. A mapped drive is a shortcut to a shared folder 
or drive on another computer across a network. File Explorer makes this process easy and 
straightforward.

By default in Windows 10, network drive letters start from the back of the alphabet (Z: is the 
first default drive letter that displays) and work down, so as not to interfere with local drives 
(which start with A: and work up). When mapping a drive, you can select any drive letter 
that’s not already in use.

A mapped network drive is displayed in File Explorer under This PC in the navigation pane.

MAP A DRIVE

GET READY. To assign a drive letter to a shared folder on the network, perform the following 
steps.

1.  Open File Explorer.
2.  On the Home tab, click Easy access (as shown in Figure 6-10) and click Map as 

drive.

3.  In the Map Network Drive window, in the drop-down menu, click a drive letter of 
your choice (see Figure 6-11).

4.  Click Browse and navigate to the shared folder you want to map to. Alternatively, 
type the universal naming convention (UNC) path of the folder. A UNC is a naming 
format that specifies the location of a resource on a local area network. The UNC 
format is \\computername\sharename\ filepath. The computername and sharename 
variables refer to the computer or server on which the folder resides. The filepath 
variable is the name of the folder you’re mapping.

5.  Select the shared folder and click OK.

6.  By default, the Reconnect at sign-in check box is selected. This means the 
drive mapping will persist until you manually disconnect it (using the Discon-
nect network drive entry in the Tools menu in File Explorer). When you’re done, 
click Finish.

CERTIFICATION READY
What is a mapped drive?
Objective 4.2

Figure 6-10

Selecting the Map network 
drive command
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The mapped drive displays in the File Explorer navigation pane (see Figure 6-12). Click it to 
access the shared folder.

Figure 6-12

A shared folder with a drive 
mapping

THE BOTTOM LINE

Printers are considered objects. Therefore, as with NTFS files and folders, you can assign 
permissions to a printer so that you can specify who can use the printer, who can manage 
the printer, and who can manage the print jobs.

■■ Configuring Printer Sharing

When you open the printer’s Properties dialog box, you can configure sharing using the 
Sharing tab. You can change the share name and specify whether you want to render the print 
jobs on the client computer or not.

Figure 6-11

Selecting a drive letter from 
the drop-down list
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To configure the print sharing permissions, click the Security tab, as shown in Figure 6-13. 
Windows 10 provides three levels of printer permissions:

•	 Print: Allows users to send documents to the printer.
•	 Manage this printer: Allows users to modify printer settings and configurations, 

including the access control list (ACL) itself.
•	 Manage documents: Provides the ability to cancel, pause, resume, or restart a print job.

By default, the Print permission is assigned to the Everyone group. If you need to restrict who 
can print to the printer, you remove the Everyone group and add another group or user and 
assign the Allow print permission to the group or user. Of course, it is still recommended that 
you use groups instead of users. As with file permissions, you can also deny print permissions.

SHARE A PRINTER

GET READY. To share a printer in Windows 10, perform the following steps.

1.  Right-click Start and choose Control Panel.
2.  Under Hardware and Sound, click View devices and printers.
3.  Right-click the printer and choose Printer properties.
4.  To share a printer, click the Sharing tab.

5.  If you need to share the printer, select the Share this printer check box, and in 
the Share name text box, specify the share name of the printer.

6.  Click the Security tab.

7.  To add a group or user, click the Add button.

8.  In the Select Users or Groups dialog box, in the Enter the object names to select 
text box, type the name of the user or group. Click OK.

9.  On the Security tab, select the user or group.

10.  Specify the print permissions for the user or group and click OK.

Figure 6-13

Printer permissions
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■■ Knowledge Assessment

Multiple Choice

Select the correct answer for each of the following questions.

	 1.	 Which of the following is not a network location in Windows 10?
a.	 Private
b.	 Office
c.	 Domain
d.	 Public

	 2.	 Which of the following should be used for file sharing when a peer-to-peer network has 
a mix of Windows 10, Windows 8/8.1, and Windows 7 computers?
a.	 Public folders
b.	 HomeGroup
c.	 A workgroup
d.	 A domain

S K I L L  S U M M A R Y

In this lesson you learned:

•	 A network location is a collection of security settings that’s appropriate for the type of 
network to which you want to connect.

•	 Network discovery is a Windows feature that enables your computer to find other com-
puters and devices (such as printers) on a connected network. It also lets you control 
whether other computers can see your computer on the same network.

•	 A homegroup is a group of computers on a home network that can share files and 
printers. To protect your homegroup, you use a password. Similar to share permissions, 
other people cannot change the files that you share unless you give them permission to 
do so. Homegroups are relatively limited, when compared to folder sharing, because you 
can only share the contents of the libraries in the user’s profile.

•	 Windows 10 provides Public folders and traditional file sharing capabilities to meet your 
networking needs. Public folders are a quick-and-easy way to share files with network 
users and with other users on your computer. Basic and advanced sharing allow you 
to control who may access specific files and folders located in your libraries. Advanced 
sharing offers the most options and is therefore the best choice for protecting confidential 
information.

•	 To provide access to a drive or folder, you can share the drive or folder, and users will 
access the data files over the network. To help protect against unauthorized drive or folder 
access, you should use share permissions along with NTFS permissions (if the shared 
folder is on an NTFS volume). When a user needs to access a network share, she will use 
the universal naming convention (UNC), which is \\servername\sharename.

•	 Printers are considered objects. Therefore, as with NTFS files and folders, you can assign 
permissions to a printer so that you can specify who can use the printer, who can manage 
the printer, and who can manage the print jobs.
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	 3.	 Which of the following actions can be performed with a homegroup? (Choose all that 
apply.)
a.	 Share libraries
b.	 Share attached printers
c.	 Allow users to view but not modify or copy shared files
d.	 Choose which folders users may access

	 4.	 After sharing a folder on a Windows 10 computer with other users, which of the follow-
ing can be done to make it easy for those users to access the shared folder?
a.	 Create a workgroup.
b.	 Create effective permissions.
c.	 Create NTFS permissions.
d.	 Map a drive.

	 5.	 Which of the following statements is not true regarding NTFS permissions?
a.	 Copied files and folders inherit permissions of the destination folder.
b.	 Copied files and folders retain permissions of the source folder.
c.	 Files and folders moved within the same partition retain their permissions.
d.	 Files and folders moved to a different partition inherit the permissions of the destina-

tion folder.

	 6.	 Which of the following Windows 10 permissions allows users to view and change files 
and folders, create new files and folders, and run programs in a folder?
a.	 Write
b.	 Modify
c.	 Read and execute
d.	 Full control

	 7.	 Which of the following Public folders is not created by default?
a.	 Public Documents
b.	 Public Music
c.	 Public Pictures
d.	 Public Projects

	 8.	 Which Windows 10 feature is used to turn Public folders on or off?
a.	 Advanced sharing settings
b.	 The This PC window
c.	 Network and Sharing Center window
d.	 Devices and Printers window

	 9.	 Which Windows 10 feature is used to add a printer?
a.	 Devices and Printers
b.	 Device Manager
c.	 Printer troubleshooter
d.	 Programs and Features

	10.	 When sharing a folder, which share permission should be configured?
a.	 Deny Full Control
b.	 Allow Full Control
c.	 Allow Read
d.	 Allow Modify
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Fill in the Blank

Complete the following sentences by writing the correct word or words in the blanks provided.

	 1.	 A _____ is a collection of security settings that’s appropriate for the type of network to 
which a user wants to connect.

	 2.	 Each default library in Windows 10 has _____, created to easily share documents, 
music, and so on with network users.

	 3.	 _____ allows a user to share a file or folder with another user and restrict that user to 
Read or Read/Write actions.

	 4.	 After setting permissions on a parent folder, new files and subfolders that are created in 
the folder _____ these permissions.

	 5.	 _____ permissions apply to users who log on locally or remotely.

	 6.	 The _____ is a network location that has the most restrictive firewall rules, including 
blocking file sharing and network discovery.

	 7.	 _____ allows users to share files, folders, or an entire drive, and set permissions on 
shared files and folders (Read, Change, or Full Control).

	 8.	 _____ is the built-in file and printer sharing feature in Windows 10 that’s designed for 
small office or home office networks.

	 9.	 When users connect to the share over the network, both the share and NTFS permis-
sions combine, and the most _____ set is applied.

	10.	 _____ permissions for an object, such as a folder, are permissions granted to a user or 
group based on the permissions granted through group membership and any permissions 
inherited from the parent object.

True / False

Circle T if the statement is true or F if the statement is false.

T F 	 1.	 Network users can join two or more homegroups at a time.

T F 	 2.	 When creating a homegroup, a user can share libraries but not printers.

T F 	 3.	 Public folder sharing in Windows 10 is turned off by default, except on a 
homegroup.

T F 	 4.	 Share permissions apply to users who connect to a shared folder over a network.

T F 	 5.	 A user has full permissions over his own print jobs.

■■ Business Case Scenarios 

Scenario 6-1: Selecting an Appropriate File-Sharing Method

Arnie, a supervisor in a small content translation company, wants to share a status spreadsheet 
with seven co-workers on a regular basis. His computer runs Windows 10. The peer com-
puters all run Windows 10 and are connected through a wireless network. Which method of 
file sharing should be set up for the supervisor?
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Scenario 6-2: Creating and Configuring a Homegroup

A local pet shop has three computers in the back office, all running Windows 10. For all three 
computers, The owner wants to share all files in their Documents and Pictures libraries and 
share a printer attached to one of the computers. Describe your recommended solution.

Scenario 6-3: Restricting Permissions

You are setting permissions on a network share named Marketing. Currently, the accounts for 
Bob and Aileen have Full Control over the Marketing folder. However, you want to restrict 
both users so that they can revise files within the Marketing folder and create new ones, but 
they cannot execute programs. Which permissions should be applied?

Scenario 6-4: Mapping a Network Drive

Samuel needs to be able to access the \Projects\Documents\98-349\ folder on the network 
often and quickly. He doesn’t want to click through several folders to get to the one he needs. 
Describe your recommended solution.
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LESSON 7Maintaining, Updating, 
and Protecting 
Windows 10

O B J E C T I V E  D O M A I N  M A T R I X

Skill/Concept Exam Objective Objective Number

Exploring Built-In Maintenance Tools Configure desktop settings

Understand storage

Understand maintenance tools

1.2

5.2

6.2

Configuring and Managing Updates Configure updates 6.3

Defending Your System From Malicious 
Software

Configure antivirus settings 3.3

K E Y  T E R M S

action

Action Center

critical update

cumulative patch

Current Branch (CB) servicing

Disk Cleanup

Disk Defragmenter

firewall

fragmented

hotfix

Long-Term Servicing Branch 
(LTSB) servicing

malicious software

Microsoft Windows Malicious 
Software Removal Tool

out-of-band patch

Patch Tuesday

security update

service pack

signature

spyware

Task Scheduler

trigger

Trojan horse

virus

Windows 10 Anniversary Update

Windows 10 Enterprise Long-
Term Servicing Branch (LTSB)

Windows Defender

Windows Firewall

Windows Insider program

Windows registry

Windows Update

worm



212  |  Lesson 7

■■ Exploring Built-in Maintenance Tools

Microsoft began bundling computer maintenance utilities in its early versions of Windows 
and has improved and expanded on them ever since. The latest utilities provide nearly any 
type of maintenance you might need, such as defragmenting disks, removing unnecessary 
files, scheduling tasks, troubleshooting problems, backing up files, and more.

In the following sections, you learn about some of the most popular Windows built-in 
utilities: Disk Defragmenter, Disk Cleanup, Task Scheduler, and the Maintenance section of 
Action Center.

Using Disk Defragmenter

A hard disk is divided into many sectors, each of which can hold a small amount of data 
for a file. The hard disk’s arm moves across a disk to “read” each sector in order to display 
a file or run a program. As more and more files are added to the disk, the information 
becomes fragmented, which means it is spread across sectors on different parts of the 
disk.

Disk Defragmenter is a utility that helps improve your computer’s performance by moving 
sectors of data on the hard disk, so that files are stored sequentially. This minimizes the 
movement a hard disk’s arm must make to read all of the sectors that make up a file or 
program.

Disk Defragmenter first analyzes your hard disk to determine the level of fragmentation, and 
then it defragments the disk if necessary.

In Windows 10, Disk Defragmenter is scheduled to run once a week by default. Although 
you may continue to use your computer while your hard disk is being defragmented,  
you might notice a performance hit if you’re working on large files or running several 
programs at once. If you’re often working on your computer when the hard disk is being 

CERTIFICATION READY
What is Disk 
Defragmenter?
Objective 6.2

CERTIFICATION READY
What is the smallest 
addressable unit on a 
hard disk that is used to 
store files?
Objective 5.2

TAKE NOTE*

Solid state drives (SSDs) 
differ from hard disks. 
An SSD uses solid state 
memory to store data 
rather than writing data 
to sectors. Therefore, an 
SSD does not need to be 
defragmented.

A primary part of your IT technician position at Interstate Snacks involves 
maintaining company computers. To keep support costs down, you use free tools 
that are built in to Windows or downloadable from the Microsoft website. The 
tools include Disk Defragmenter, Disk Cleanup, Windows Update, and Windows 
Defender. With the exception of Disk Cleanup, these tools have built-in scheduling 
features. You plan to use Task Scheduler to automate Disk Cleanup to run once a 
week and to start the accounting software every day at 8:30 a.m. for all accounting 
employees.

THE BOTTOM LINE

Windows 10 comes with many built-in maintenance tools that help to keep computers 
running at top performance. These tools include Disk Defragmenter, Disk Cleanup, Task 
Scheduler, and the Action Center Maintenance feature.

Disk Defragmenter can speed up your computer’s performance by defragmenting 
data on your hard disk. In Windows 10, the utility is set to automatically run once  
a week.
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analyzed and defragmented, you can change the schedule for when Disk Defragmenter  
runs automatically.

RUN DISK DEFRAGMENTER

GET READY. To run Disk Defragmenter, perform the following steps.

1.  Click Start and type Disk Defragmenter. From the results, click Defragment and 
Optimize Drives.

2.  In the Optimize Drives window (as shown in Figure 7-1), click to select a drive 
and click Optimize.

3.  After the disk is optimized, click the Close button.

The defragmentation process can take several minutes to well over an hour to complete, 
depending on the size and level of fragmentation of the hard disk.

IT technicians and other advanced users may want to use the command-line version of Disk 
Defragmenter, in order to run reports and use advanced commands. To use the command-
line version of the utility, click Start, type cmd in the Ask me anything search box, select 
cmd.exe from the resulting list, and then in the command window, type defrag/? and press 
Enter. Re-issue the command using any of the command-line parameters that display.

CHANGE THE DISK DEFRAGMENTER SCHEDULE

GET READY. To change the Disk Defragmenter schedule, perform the following steps.

1.  In the Optimize Drives window (refer to Figure 7-1 if necessary), click Change  
settings. The Optimize Drives: Optimization schedule dialog box opens (see 
Figure 7-2).

Figure 7-1

The Optimize Drives window
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2.  To change how often Disk Defragmenter runs, click the Frequency drop-down arrow 
and click Daily, Weekly, or Monthly.

3.  To change the time of day when Disk Defragmenter runs, click the Time drop-down 
arrow and click a time.

4.  To change the volumes that are scheduled to be defragmented, click the Choose 
button. Clear the check boxes of any volumes you don’t want scanned and click OK.

5.  Click OK and click Close.

Using Disk Cleanup

Another handy maintenance tool in Windows 10, and many previous versions of Windows, 
is Disk Cleanup. This utility removes many different kinds of unnecessary files from your 
computer:

•	 Downloaded program files
•	 Temporary internet files
•	 Offline web pages
•	 Files in the Recycle Bin
•	 Setup log files
•	 Temporary files left by programs, often in a TEMP folder
•	 Thumbnails for photos, videos, and documents used by the Windows interface (if you 

delete them, Windows re-creates them when needed)
•	 Windows error reporting files

You choose which files Disk Cleanup deletes by selecting the check boxes for each type of file.

RUN DISK CLEANUP

GET READY. To run Disk Cleanup, perform the following steps.

1.  Click Start. Type Disk Cleanup and press Enter.
2.  After a brief delay during which Disk Cleanup is analyzing your files, the Disk 

Cleanup dialog box opens (see Figure 7-3), showing how much disk space you 
will gain by running the program. You can select the types of files you want the 
utility to delete; those that are not selected will not be deleted. For many of the 
file types, you can click View Files to see a list of files that will be deleted.

CERTIFICATION READY
How does Disk Cleanup 
help you maintain a 
Windows 10 computer?
Objective 6.2

Figure 7-2

Optimize Drives: Optimization 
schedule dialog box

Disk Cleanup helps you remove unnecessary files from your computer, such as 
downloaded program files, temporary internet files, files that are left after running 
software, and much more.
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3.  When you’re ready, click Clean up system files.

Using Task Scheduler

Task Scheduler enables you to schedule and automate a variety of actions, such as starting 
programs, displaying messages, and even sending emails. You create a scheduled task by speci-
fying a trigger, which is an event that causes a task to run, and an action, which is the action 
taken when the task runs.

The main Task Scheduler window with the Task Scheduler Library selected is shown in 
Figure 7-4. The left pane lists the Task Scheduler Library, which contains several tasks by 
Microsoft and other vendors.

When you select Task Scheduler (Local), as shown in Figure 7-5, the middle pane shows three 
panes. The Overview pane provides you with an overview of Task Scheduler, the Task Status 
pane displays a summary of tasks that started in a certain time period (for example, within 
the last 24 hours), and the Active Tasks pane displays scheduled tasks. The information dis-
played in the middle pane can vary greatly from computer to computer.

On the right of the screen, the Actions pane provides commands for connecting to another 
computer and scheduling tasks for that computer, creating basic and more advanced tasks, 
and viewing tasks and their histories.

CERTIFICATION READY
When you schedule 
a task using Task 
Scheduler, what is used 
to specify when the 
schedule is executed?
Objective 6.2

Figure 7-3

The Disk Cleanup dialog box

Many, but not all, Windows utilities have their own scheduling feature. For those 
utilities that you want to automate, you can use Task Scheduler. You can also use Task 
Scheduler to open programs on specific days and times, or at Windows startup.
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Notice in Figure 7-5 that there are two commands in the Actions pane for creating tasks: 
Create Basic Task and Create Task. When you use the Create Basic Task command, the 
Create Basic Task Wizard walks you through the essentials of creating a task. The Create Task 
command displays the Create Task dialog box (see Figure 7-6), which is the manual way of 
creating tasks that gives you more control and options.

Figure 7-4

The main Task Scheduler 
window with the built-in 
libraries expanded

Figure 7-5

The Task Scheduler (Local)
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To schedule tasks for all users on your computer, you must be logged on as the Administrator. 
If you’re logged on as a Standard user, you can schedule tasks only for your user account.

CREATE A TASK USING THE CREATE BASIC TASK WIZARD

GET READY. To create a task using the Create Basic Task Wizard, perform the following steps.

1.  Click Start. Type Task Scheduler and press Enter.
2.  In the Actions pane on the right, click Create Basic Task. The Create Basic Task 

Wizard opens.

3.  On the initial screen (see Figure 7-7), type a name for the task and its description 
(optional). Click Next.

Figure 7-6

The Create Task dialog box

Figure 7-7

Entering information for a 
basic task in the initial wizard 
screen
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4.  The Task Trigger screen enables you to select the frequency in which the task 
should occur or an event that triggers the task (see Figure 7-8). The default selec-
tion is Daily. For our example, because this task will run weekly, click the Weekly 
option and click Next.

5.  On the Weekly screen, select a starting date as well as the time and day of the 
week the task should run (see Figure 7-9). Click Next.

Figure 7-8

You can create a task to run 
daily, weekly, monthly, one 
time, and more

Figure 7-9

Selecting frequency and 
recurrence of the task
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6.  On the Action screen, click Start a program and click Next.
7.  On the Start a Program screen, click Browse to find the Disk Cleanup program. 

Navigate to and click C:\Windows\system32\cleanmgr.exe and click Open. On the 
Start a Program screen, which now indicates the path to the Disk Cleanup program 
executable (as shown in Figure 7-10), click Next.

8.  The Summary screen summarizes the task, indicating when it will run. If everything 
is correct, click Finish. If you need to make any changes, click the Back button, 
make the appropriate changes, and then click Finish.

The task is added to Task Scheduler and will run on the trigger date.

CREATE A TASK MANUALLY

GET READY. To create a task manually, such as scheduling a program to start when Windows 
starts, perform the following steps.

1.  Click Start. Type Task Scheduler and press Enter.
2.  In the Actions pane on the right, click Create Task. The Create Task Wizard  

opens.

3.  In the Create Task dialog box, on the General tab, type a Name for the task and a 
Description (optional). In the Security options section, you can click Change User 
or Group to change the account or group the task runs under, and select whether 
the task should run when the user is logged on or not. Be sure to select the 
appropriate operating system in the Configure for drop-down list.

4.  Click the Triggers tab and click New. In the New Trigger dialog box, click the 
Begin the task drop-down arrow (see Figure 7-11) and click one of the options, 
such as At startup.

With this option selected, the New Trigger dialog box changes. Configure advanced 
settings, if needed, and click OK.

Figure 7-10

Selecting the program to run
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5.  In the Create Task dialog box, click the Actions tab and click New. In the New 
Action dialog box, click Browse, navigate to the program’s executable file (in this 
example, navigate to C:\Program Files\Internet Explorer\ and locate the Internet 
Explorer 11 executable named iexplore.exe), select it, and then click Open.

6.  Click OK.

7.  In the Create Task dialog box, click the Conditions tab. In addition to the trigger, 
you can specify conditions under which the task should run (see Figure 7-12). For 
example, the power conditions are selected in an effort to avoid running a laptop’s 
battery down unnecessarily. Make selections as appropriate.

Figure 7-11

The New Trigger dialog box

Figure 7-12

Selecting conditions for the 
new task
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8.  Click the Settings tab. Here you can control task behavior (such as whether 
the user should be able to run the task on demand), how often the task should 
attempt to restart if it fails, and so on. Make selections as appropriate.

9.  When you’re finished configuring settings, click OK.

The task is added to Task Scheduler. You can see the task listed in the Active Tasks pane at the 
bottom of the main Task Scheduler window.

Using Action Center

Action Center provides a single interface in which you can view the status of security and 
maintenance features (see Figure 7-13). Action Center alerts you to problems you need to 
correct and usually provides a way to fix it.

The quickest way to open Action Center is from the desktop. Click the comment icon in the 
notification area of the taskbar. If no issues are pending, the Security and Maintenance section 

TAKE NOTE*

To delete a task from 
Task Scheduler, double-
click it in the Active 
Tasks pane and click 
Delete in the Actions 
pane.

CERTIFICATION READY
How can Action Center 
help you maintain a 
computer?
Objective 1.2

Windows 10 Action Center is an improvement upon Security Center in previous versions 
of Windows. Within Action Center, you can view notifications for security features 
(firewall, antivirus software, and so on) and maintenance (backups, updates, and so on).

security@contoso.com
Home system: disarmed at 05:24 PM
10:45p - Outlook

Figure 7-13

Action Center
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are collapsed. When an issue needs your attention, errors are indicated by a red circle with a 
white X and warnings are indicated by a yellow triangle with a black exclamation point.

Using System Information

System Information is a utility that displays details about your computer’s hardware 
components, software, and drivers. You can use System Information to simply gather 
information about your computer or to diagnose issues. To open System Information, click 
Start, type system info, and press Enter. The main System Information window is shown in 
Figure 7-14.

The left pane includes the following categories:

•	 System Summary: This category displays general information about your computer. You 
can view the name of the operating system, the name of the computer (system), the type 
of processor, and much more.

•	 Hardware Resources: This category displays details about your computer’s hardware, 
such as whether any conflicts exist and the status of input/output (I/O) devices.

•	 Components: This category displays information about hardware devices and their 
drivers, such as disk drives, network adapters, and computer ports.

•	 Software Environment: This category displays details about system drivers, current 
print jobs and network connections, services, startup programs, and other system-
related items.

CERTIFICATION READY
What is the purpose of 
System Information?
Objective 6.2

System Information displays a wealth of information about your computer’s hardware, 
drivers, and system software. If you’re having any type of system-related issues, you 
should check System Information for possible clues as to the source of the problem.

Figure 7-14

The System Information 
window
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System Information provides a search feature that enables you to quickly find specific 
information about your system. Just type the information you’re looking for in the Find what 
box at the bottom of the window. For example, to see which programs launch at startup, type 
startup in the Find what box and click Find. You can narrow your search by selecting either 
the Search selected category only or Search category names only check boxes at the bottom of 
the System Information window.

When attempting to diagnose a system problem, it can be useful to export information in 
System Information to a text file to send to a fellow support technician or post on a trouble-
shooting forum on a website. System Information enables you to save information to an .nfo 
file format, which you can open from System Information, or export information to a stan-
dard text file with a .txt file extension.

SAVE SYSTEM INFORMATION TO A TEXT FILE

GET READY. To save System Information to a text file, perform the following steps.

1.  Click Start. Type system info and press Enter.
2.  In the System Information window, click File > Save.

3.  Type a name for the file and click Save. The resulting file is very long and 
contains all of the information collected by System Information.

4.  To export specific information from System Information to a text file, such as the 
list of currently running tasks, expand the Software Environment category in the 
left pane and click Running Tasks.

5.  Click File > Export, type a name for the file, and then click Save.

You can open the text files in Notepad, WordPad, or any word processing program.

■■ Maintaining the Windows Registry

The Windows registry is a database in Windows that stores user preferences, file loca-
tions, program configuration settings, startup information, hardware settings, and more. In 
addition, the registry stores the associations between file types and the applications that use 
them. For example, the registry holds the information that tells Windows to open the default 
media player program (usually Windows Media Player) when you double-click a music or 
movie file.

The registry is made up of keys, subkeys, and values, as shown in Figure 7-15. Registry 
keys are similar to folders in File Explorer in that the keys can have subkeys (like subfold-
ers). Subkeys have values that make up the preferences, configuration settings, and so on 
of the operating system. Whenever you change a preference, install software or hardware, 
or essentially make any changes to the system, the changes are reflected in the Windows 
registry.

THE BOTTOM LINE

The Windows registry is a database of configuration settings for your computer. It’s often 
referred to as the “brains” of a Windows operating system. The registry is self-sufficient and 
rarely requires maintenance, but you can use a reputable registry cleaner occasionally to 
remove settings that are no longer used.
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The registry is organized according to several logical sections, often referred to as hives, 
which are generally named by their Windows API definitions. The hives begin with HKEY 
and are often abbreviated to a three- or four-letter short name starting with “HK.” For 
example, HKCU is HKEY_CURRENT_USER and HKLM is HKEY_LOCAL_MACHINE. 
Windows Server 2016 has five Root Keys/HKEYs:

•	 HKEY_CLASSES_ROOT: Stores information about registered applications, such as the 
file association that tells which default program opens a file with a certain extension.

•	 HKEY_CURRENT_USER: Stores settings that are specific to the currently 
logged-on user. When a user logs off, the HKEY_CURRENT_USER is saved to 
HKEY_USERS.

•	 HKEY_LOCAL_MACHINE: Stores settings that are specific to the local computer.
•	 HKEY_USERS: Contains subkeys corresponding to the HKEY_CURRENT_USER 

keys for each user profile actively loaded on the machine.
•	 HKEY_CURRENT_CONFIG: Contains information gathered at run time. 

Information stored in this key is not permanently stored on disk, but rather regenerated 
at boot time.

Registry keys are similar to folders, which can contain values or subkeys. The keys within the 
registry follow a syntax similar to a Windows folder or file path, using backslashes to separate 
each level. For example:

HKEY_LOCAL_MACHINE\Software\Microsoft\Windows

refers to the subkey “Windows” of the subkey “Microsoft” of the subkey “Software” of the 
HKEY_LOCAL_MACHINE key.

Over time, some settings in the registry are no longer needed. Registry settings take up a 
relatively small amount of disk space, and the settings can remain in the registry without 
affecting the performance of the computer. However, a registry setting can also become cor-
rupt. Microsoft doesn’t provide tools to repair the registry directly, but registry cleaners are 
available that remove unnecessary settings (for programs that are no longer installed, for 
example) and can repair many problems.

You should back up your registry before running any maintenance program on it. Microsoft 
provides the Registry Editor utility to make changes to the registry and back it up. To open 

TAKE NOTE*

Some registry cleaners 
can actually harm your 
computer. Be sure to 
get a reputable program 
to avoid contaminating 
your PC with spyware 
and viruses.

Figure 7-15

A portion of the Windows 
registry
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Registry Editor, click Start and type regedit. Only users with advanced computer skills and 
IT professionals should edit the registry. Changing or deleting a critical setting can prevent 
your computer from operating upon reboot. However, nearly anyone can safely back up the 
registry.

BROWSE AND BACK UP THE WINDOWS REGISTRY

GET READY. To back up the Windows registry, perform the following steps.

1.  Open Registry Editor by clicking Start, typing regedit, and pressing Enter.
2.  Expand keys in the left pane to view the associated subkeys. To view Microsoft-

related subkeys, for example, click the gray arrow (>) to the left of the HKEY_
CURRENT_USER key, click the SOFTWARE subkey, and then click the Microsoft 
subkey. Browse the list of Microsoft subkeys.

3.  Similarly, expand the HKEY_LOCAL_MACHINE key, expand the SOFTWARE subkey, 
and then expand the Microsoft subkey. Another set of Microsoft-related subkeys 
appears.

4.  Collapse (close up) all keys by clicking the down arrows to the left of each 
expanded entry in the left pane.

5.  Click File > Export, navigate to the location where you want to save the registry 
backup file, type a name for the backup in the File name text box, and then 
click Save.

A best practice is to save registry backups to an external location, such as a USB flash drive, a 
CD/DVD, or a network drive.

■■ Configuring and Managing Updates

Microsoft routinely releases security updates on the second Tuesday of each month, com-
monly known as Patch Tuesday. Although most updates are released on Patch Tuesday, there 
might be occasional patches (known as out-of-band patches) released at other times when the 
patches are deemed critical or time-sensitive.

Because computers are often used as production systems, you should test any updates to make 
sure they do not cause problems for you. Although Microsoft performs intensive testing, 
occasionally problems do occur, either as a bug or as a compatibility issue with third-party 
software. Therefore, always be sure you have a good backup of your system and data files 
before you install patches so that you have a back-out plan, if necessary.

Microsoft classifies updates as Important, Recommended, or Optional:

•	 Important updates: These updates offer significant benefits, such as improved security, 
privacy, and reliability. They should be installed as they become available and can be 
installed automatically with Windows Update.

CERTIFICATION READY
Why is it important 
to keep your system 
updated with the newest 
Windows updates?
Objective 6.3

THE BOTTOM LINE

Intruders and some viruses, worms, rootkits, spyware, and adware gain access to a system 
by exploiting security holes in Windows, Internet Explorer, Microsoft Office, or other 
software applications. Therefore, the first step you should take to protect yourself against 
malware is to keep your system up to date with the latest service packs, security patches, 
and other critical fixes.
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•	 Recommended updates: These updates address noncritical problems or help enhance 
your computing experience. Although these updates do not address fundamental issues 
with your computer or Windows software, they can offer meaningful improvements.

•	 Optional updates: These updates include updates, drivers, or new software from 
Microsoft to enhance your computing experience. You need to install these manually.

Depending on the type of update, Windows Update can deliver the following:

•	 Security updates: A security update is a broadly released fix for a product-specific, security-
related vulnerability. Security vulnerabilities are rated based on their severity, which is indi-
cated in the Microsoft security bulletin as critical, important, moderate, or low.

•	 Critical updates: A critical update is a broadly released fix for a specific problem 
addressing a critical, non-security-related bug.

•	 Service packs: A service pack is a tested, cumulative set of hotfixes, security updates, 
critical updates, and updates, as well as additional fixes for problems found internally 
since the release of the product. Service packs might also contain a limited number of 
customer-requested design changes or features. After an operating system is released, 
many corporations consider the first service pack release as the time when the operating 
system has matured enough to be used throughout the organization.

Not all updates can be retrieved through Windows Update. Sometimes, Microsoft might 
offer the fix for a specific problem in the form of a hotfix or cumulative patch that you can 
install. A hotfix is a single, cumulative package that includes one or more files that are used 
to address a problem in a software product, such as a software bug. Typically, hotfixes are 
made to address a specific customer situation, and they often have not gone through the same 
extensive testing as patches retrieved through Windows Update. A cumulative patch is mul-
tiple hotfixes combined into a single package.

Upgraded builds of Windows 10 will occasionally be made available, and will be identified 
by a version number based on year and month. The original version was 1507, because it was 
released in July of 2015. Microsoft’s first major update was version 1511, which consisted of 
general bug fixes and improvements, streamlined activation, restored colored window title 
bars, integrated Skype, and improvements to the Microsoft Edge browser. You can also use 
the Find My Device option under Settings > Update & security to use built-in tracking, so 
you can track your laptop or tablet—via GPS and location services—if you lose it.

In August of 2016, Microsoft released the Windows 10 Anniversary Update. It introduced 
a number of new features and enhancements over the previous November Update release, 
including new extension support for Microsoft Edge, biometric authentication support with 
Windows Hello, improvements to Cortana, and Windows Inking.

Configuring Windows Update Options

When you first install Windows 10, you can choose how you want Windows Update to 
function. On a Windows 10 computer, you can open Settings and click Update & security to 
open the Windows Update page (see Figure 7-16).

Windows Update provides your Windows 10 users with a way to keep their computers 
current by checking a designated server. The server provides software that patches 
security issues, installs updates that make Windows and your applications more stable, 
fixes issues with existing Windows programs, and provides new features. The server 
can be hosted by Microsoft or it can be set up and managed in your organization by 
running the Windows Server Update Services (WSUS) or System Center 2012 R2/2016 
Configuration Manager.
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By clicking Advanced options, you can configure for Automatic Updates, get updates for 
other Microsoft products when Windows is updated, defer upgrades, and view update history 
(as shown in Figure 7-17).

Figure 7-16

The Windows Update page

Figure 7-17

The Windows Update Advanced 
Options page
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For corporations, you can also use Windows Server Update Services (WSUS) or System 
Center 2012 R2/2016 Configuration Manager to keep your systems updated. Smaller orga-
nizations might use WSUS or cloud-based services such as Microsoft Intune to keep systems 
up to date. The advantage of using one of these systems is that it allows you to test the patch, 
schedule the updates, and prioritize client updates. Once you determine a patch is safe, you 
can enable it for deployment.

When you click the Choose how updates are delivered option, the Updates from more than 
one place page appears (see Figure 7-18). Unless you are part of a corporation that is using 
WSUS or System Center 2012 R2/2016 Configuration Manager, you must use your internet 
connection to retrieve updates from Microsoft. Starting with Windows 10, you can enable the 
Updates from more than one place option, which also allows you to get updates from other 
computers on the same network as your local computer and from computers on the internet.

When you click Change active hours, you can configure when your system can be upgraded. 
The Restart options specifies when your machine can be rebooted, so that it can finish 
installing updates. In March 2017, Microsoft added a snooze option that prompts you when 
Windows 10 updates are available. Instead of automatically installing the update, Windows 10  
will wait up to three days before requiring the update to be installed. The snooze feature is 
designed to give you ample time to finish and save any crucial work.

Under Advanced options, you can select the Give me updates for other Microsoft products 
when I update Windows option. Some Windows 10 editions let you defer feature upgrades 
to your PC. By selecting the Defer upgrades option, new Windows features won’t be down-
loaded or installed for several months. This option is usually used to help avoid problems 
with an update that might cause problems within your organization. You can also select the 
Use my sign in info to automatically finish setting up my devices after an update option.

Figure 7-18

The Updates from more than 
one place page
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Managing Update History and Rolling Back Updates

At the top of the Update history page, you can click Uninstall updates to open the Installed 
Updates page, as shown in Figure 7-19. To uninstall or roll back an update, right-click the 
desired update and choose Uninstall. You are then prompted to uninstall the update. When 
you click Yes, the update will be uninstalled.

Implementing Insider Preview

If you decide to use the Insider Preview, you need to keep in mind that you will often be 
receiving updates to Windows that might not be fully tested. There are risks that might take 
your system down and possibly corrupt data. So, you want to make sure that you only imple-
ment Insider Preview on test machines and make sure you have backups of all important data 
and programs.

Deferring upgrades does not affect security updates, but it does prevent you from getting 
the latest Windows features as soon as they are available.Warning!

Figure 7-19

The Installed Updates page

You can view your update history by clicking the Update history option. On the Update 
history page, each update, includes the KB article number and the date installed. If you  
click Successfully installed on <date> for a specific update, it provides a short description  
of the update.

In the past, the Windows Insider program (which was previously accessible to 
developers only) allowed users to sign up for early builds of the Windows operating 
system. Today, the Windows Insider program has been expanded to include enterprise 
testers and advanced users. This enables Microsoft to get feedback before a new feature 
or update is released to the general public and is a way to test upcoming Windows 
features before they are released to the general public.
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ENABLE THE INSIDER PREVIEW BUILD

GET READY. To enable the Insider Preview Build Updates, perform the following steps.

1.  Log on to a computer running a genuine, activated copy of Windows 10 with an 
active internet connection.

2.  Click Start > Settings.
3.  In the Settings window, click Update & security > Windows Insider Program.

4.  In the Get Insider Preview builds section, click Get started.

5.  Sign in with a Microsoft account.

6.  When you are warned that the prerelease software and services may not be fully 
tested, click Next.

7.  On the Before You Confirm page, click Confirm.

8.  On the One More Step to Go page, click Restart now.

Implementing Current Branch (CB), Current Branch for Business (CBB), 
and Long-Term Servicing Branch (LTSB) Scenarios

The Windows 10 servicing options or scenarios are shown in Table 7-1.

For systems that are configured for the Current Branch (CB) servicing, you will deploy the 
new features within four months after they are publicly released. This gives a corporation four 
months to deploy the new or updated features.

Enterprise companies are usually not willing to upgrade to the newest version of 
Windows, and most responsible corporations would deploy the monthly updates that 
Microsoft publishes every month. However, these corporations are not usually willing 
to deploy new or updated features because they can cause a wide range of problems. So 
rather than force the new and updated features to corporations, Microsoft has developed 
Windows 10 servicing options, which allow you to configure devices into one of three 
tiers based on how often you want these features deployed.

Table 7-1

The Windows 10 Servicing 
Options

Servicing Option Availability of New or Upgraded 
Features

Minimum Length of 
Servicing Lifetime

Supported Editions

Current Branch (CB) 
servicing

Receives upgrades immediately 
after Microsoft makes them publicly 
available

Approximately  
4 months

Home, Pro, Education, 
Enterprise, IoT Core, 
Windows 10 IoT Core 
Pro (IoT Core Pro)

Current Branch for 
Business (CBB) servicing

Defers receiving feature upgrades for 
4 months after Microsoft makes them 
publicly available

Approximately  
8 months

Pro, Education, 
Enterprise, IoT Core Pro

Long-Term Servicing 
Branch (LTSB)

Are available immediately after being 
published by Microsoft, but allows 
for long-term deployment of selected 
Windows 10 releases in low-change 
configuration (up to 10 years)

10 years Enterprise LTSB
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The Current Branch for Business (CBB) servicing is a slower track, which gives you four 
months to test and evaluate the new or updated features, and then four months to test and 
deploy the new or updated features. Unless you are controlling your updates with Windows 
Server Update Services (WSUS), System Center Configuration Manager (SCCM), or some 
similar technology, you can use the Defer upgrades option to move a computer into CBB 
servicing.

Windows 10 Enterprise Long-Term Servicing Branch (LTSB) is similar to Windows 10 
Enterprise, but will be a stripped-down version. It does include Internet Explorer 11, and 
is compatible with the Windows 32-bit version of Microsoft Office. It does not include 
Microsoft Edge, Windows Store Client, Cortana, Outlook Mail, Outlook Calendar, 
OneNote, Weather, News, Sports, Money, Photos, Camera, Music, and Clock. Long-Term 
Servicing Branch (LTSB) servicing is intended for scenarios during which changes to soft-
ware running on devices is limited to only essential updates (vulnerabilities and other impor-
tant issues). Only Windows 10 Enterprise LTSB supports LTSB.

■■ Defending Your System from Malicious Software

Malicious software, sometimes called malware, is software designed to infiltrate or affect a 
computer system without the owner’s informed consent. It is usually associated with viruses, 
worms, Trojan horses, spyware, rootkits, and dishonest adware. As a network administrator or 
computer technician, you will need to know how to identify malware, how to remove mal-
ware, and how to protect a computer from malware.

Because it is quite common for a computer to be connected to the internet, there are more 
opportunities than ever for your computer to be infected by malware. In addition, over the 
last couple of years, the amount of malware that has been produced is staggering. You also 
have to make sure that if a computer gets infected on a network, it does not spread to other 
computers.

Many early forms of malware were written as experiments or practical jokes (known as 
pranks). Most of the time, these were intended to be harmless or merely annoying. However, 
as time went by, malware turned into a type of vandalism or a tool to compromise private 
information. In addition, malware can be used as a denial-of-service (DoS) tool, to attack 
other systems, networks or websites, causing those systems to have performance problems or 
to become inaccessible.

Malware can be grouped into these categories:

•	 Viruses
•	 Worms
•	 Trojan horses
•	 Spyware and dishonest adware

A computer virus is a program that can copy itself and infect a computer without the user’s 
consent or knowledge. Early viruses were usually some form of executable code that was 
hidden in the boot sector of a disk or as an executable file (a file name with an .exe or .com 
extension).

THE BOTTOM LINE

One of the most challenging problems for computer users and administrators is to prevent 
viruses, worms, and other types of malware from infecting your computer. To protect 
against malicious software, make sure your system is updated, you are using a firewall to 
limit exposure to malware, and you are using an up-to-date anti-malware software package.
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Later, as macro languages were used in software applications such as word processors and 
spreadsheets to enhance the power and flexibility of these programs, macros could be 
embedded within the documents. Unfortunately, these documents can infect other docu-
ments and can cause a wide range of problems on a computer system as the macro code is 
executed when you open the document.

Today’s websites can be written in various programming and scripting languages and can 
include executable programs. Therefore, as you access the internet, your system is under 
constant threat.

A worm is a self-replicating program that replicates itself to other computers over the net-
work without any user intervention. Different from a virus, a worm does not corrupt or 
modify files on a target computer. Instead, it consumes bandwidth as well as processor and 
memory resources, slowing your system down or causing your system to be unusable. Worms 
usually spread by using security holes found within the operating system or TCP/IP software 
implementations.

A Trojan horse is a program named after the Trojan horse story in Greek mythology. A Trojan 
horse is an executable program that appears as a desirable or useful program. Since it appears 
to be a desirable or useful program, users are tricked into loading and executing the program 
on their system. After the program is loaded, it can cause your computer to become unusable 
or it can bypass your system’s security, allowing your private information (including passwords, 
credit card numbers, and social security numbers) to be read. Also, a Trojan horse may  
execute adware.

Spyware is a type of malware that is installed on computers and collects personal information 
or browsing habits often without the user’s knowledge. Spyware can also install additional 
software, and redirect your web browser to other sites or change your home page.

One type of spyware is the keylogger, which records every key a user presses. Therefore, when 
you type in credit card numbers, social security numbers, and passwords, that information 
gets recorded and is eventually sent to or read by someone without the user’s knowledge. It 
should be noted that not all keyloggers are bad since some corporations used the to monitor 
their corporate users.

Adware is any software package that automatically plays, displays, or downloads advertise-
ments to a computer after the software is installed on it or while the application is being used. 
While adware may not necessarily be bad, it is often used with ill intent.

Many protection companies sell stand-alone antivirus, antispyware, and firewall programs 
that are bundled into internet security products that usually provide additional features 
(such as antispam and anti-phishing filters, parental controls, and password vaults). At a 
minimum, every computer should have antivirus and antispyware software installed along 
with a firewall. Every computer should also use the security settings found in the latest web 
browsers.

Understanding Windows Firewall

A firewall is a software program or device that monitors traffic entering and leaving a com-
puter. This term comes from the building trades where it refers to a special barrier designed 
to delay the advance of fire from one area to another. In the computer world, threats and 

TAKE NOTE*

Networks have firewalls, 
too—they are similar to 
computer firewalls, but 
are usually much more 
robust.

Windows Firewall comes with Windows 10 and other Windows versions to protect 
your computer from traffic entering through communications ports.
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attacks from malicious insiders are the “fire” advancing on computers connected to the 
internet.

Microsoft provides Windows Firewall with Windows 10. The firewall is turned on automat-
ically in new installations. To access Windows Firewall, click Start, type firewall, and press 
Enter. The Windows Firewall page indicates whether or not the program is enabled (see 
Figure 7-20) and what it’s protecting.

Sometimes a firewall works too well, blocking communications that you want to allow! For 
example, a newly installed program that needs to communicate with the internet might 
not work because it’s blocked by the firewall. In this case, click the Allow an app or feature 
through Windows Firewall command in the task pane of the Windows Firewall page. The 
Allowed Apps page appears (see Figure 7-21). To change settings, click the Change settings 
button. Click the Allow another program button. Scroll the list to locate the program, select 
it, click Add, and then click OK.

It’s best to have only one firewall running on a computer. If you install an internet 
security product, the new software should automatically turn off Windows Firewall. 
If you check Action Center and see that two firewalls are running, open the Windows 
Firewall page, click Turn Windows Firewall on or off in the task pane, click the Turn off 
Windows Firewall option (as shown in Figure 7-22), and then click OK. Reboot your 
computer and immediately check Action Center again to verify that only one firewall is 
enabled.

Figure 7-20

The Windows Firewall page
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Figure 7-21

The Allowed Apps page

Figure 7-22

The Customize Settings page
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Managing Client Security Using Windows Defender

At the heart of Windows Defender are its definition files, which are downloaded from 
Windows Update. The definition files, which contain information about potential threats, are 
used by Windows Defender to notify you of potential threats to your system.

To access Windows Defender from the Windows 10 menu, click Start, type Windows 
Defender, and click Windows Defender in the results. Figure 7-23 shows the Windows 
Defender Home tab.

The Home tab allows you to check the status of Windows Defender, including whether 
Windows Defender is up to date and whether Windows Defender is protecting your system. 
It also gives you the option to initiate a scan.

On the Home tab, you should always watch for a green message indicating Your PC is being 
monitored and protected and you should also make sure your system is up to date. Other 
components include:

•	 Real-time protection: Real-time protection uses signature detection methodology and 
heuristics to monitor and catch malware behavior. Signature detection uses a vendor’s 
definition files to detect malicious programs, which look for known patterns in files 
and processes. If the program contains code that matches the signature, the program 
most likely contains the virus. This works well when the threat has already been identi-
fied, but what happens in between the time the virus is released and the definition file 
is made available? That’s where heuristics can help. It is used to monitor for suspicious 
activity by a program. Suspicious activity includes a program trying to copy itself into 

CERTIFICATION READY
How does Windows 
Defender help protect 
your system?
Objective 3.3

TAKE NOTE*

Windows Defender 
automatically disables 
itself if you install 
another antivirus 
product.

Windows Defender is designed to protect your computer against viruses, spyware, 
and other types of malware. It protects against these threats by providing real-time 
protection in which it notifies you if malware attempts to install itself on your computer 
or when an application tries to change critical settings.

Figure 7-23

Viewing the Windows Defender 
Home tab
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another program, a program trying to write to the disk directly, or a program trying to 
manipulate critical system files required by the operating system. These are indicators of 
possible malware activity that heuristics can detect.

•	 Virus and spyware definitions: When a new virus is discovered, Microsoft creates a 
new virus signature/definition update. Each definition file contains a piece of the actual 
virus code that is used to detect a specific virus or malware. During scans, the content 
on the computer is compared with information in the definition files. Because new 
viruses are created every day and existing viruses are modified regularly, it’s important to 
keep your definitions updated.

•	 Scan options (Quick, Full, and Custom): A Quick scan checks the areas that malicious 
software, including viruses, spyware, and unwanted software, are most likely to infect.  
A Full scan checks all the files on your disk, including running programs. A Custom 
scan is designed to check only locations and files you specify.

•	 Scan Details: This area of the Home tab provides information on when the last scan 
was performed on the computer.

The Update tab provides you with information about your virus and spyware definitions. It 
is important to keep these definitions current to ensure that your computer is protected at all 
times.

The Update tab provides information about when the definition files were created and the 
last time you updated them. It also lists the current version numbers for the virus and spy-
ware definitions. Windows Defender updates the definition files automatically, but you can 
manually check for updates by clicking Update definitions on this tab.

The History tab provides information about items that have been detected in the past and the 
actions that were taken with them.

The categories of items are as follows:

•	 Quarantined Items: These items were not allowed to run but were not removed from 
your computer.

•	 Allowed Items: These items were allowed to run on your computer.
•	 All Detected Items: These items include all items detected on your computer.

REMOVE A QUARANTINED ITEM

GET READY. To remove an item that has been quarantined, perform the following steps.

1.  Open Windows Defender.
2.  Click the History tab.

3.  Click Quarantined Items.
4.  Click View Details.
5.  Select the detected item and read the description.

6.  Click Remove.

If you click Windows Defender Settings, you will open the Windows 10 Settings, Update & 
security > Windows Defender page, as shown in Figure 7-24. The Settings page is where you 
can fine-tune how Windows Defender works.

On the Settings page, you can:

•	 Enable or disable real-time protection.
•	 Select if you want to use cloud-based protection.



    Maintaining, Updating, and Protecting Windows 10  |  237

•	 Select the files and locations you want to exclude from the scanning process.
•	 Select the file types you want to exclude from the scan.
•	 Select the processes you want to exclude.
•	 Display the Windows 10 version information.
•	 Open Windows Defender.

To keep your system more secure, you should schedule a Windows Defender scan.

SCHEDULE A WINDOWS DEFENDER SCAN

GET READY. To schedule a Windows Defender scan, log on with administrative privileges and 
then perform the following steps.

1.  Click Start and type taskschd.msc. From the results, click Task Scheduler.
2.  In the left pane, expand Task Scheduler Library > Microsoft > Windows > 

Windows Defender.
3.  Double-click Windows Defender Scheduled Scan.

4.  In the Windows Defender Scheduled Scan Properties (Local Computer) dialog box, 
click the Triggers tab and click New.

5.  In the Begin the task field, choose On a schedule.

6.  Under Settings, select One time and in the Start field, change the time to  
5 minutes from your current time.

7.  Make sure the Enabled check box is selected and click OK.

Figure 7-24

The Windows Defender 
Settings page
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8.  To close the Windows Defender Scheduled Scan Properties (Local Computer) dialog 
box, click OK.

9.  Open Windows Defender to see the status of the scan on the Home tab.

USING THE MALICIOUS SOFTWARE REMOVAL TOOL

If your anti-malware software cannot remove a virus or worm from a computer, try the 
Microsoft Windows Malicious Software Removal Tool.

Computers can become infected even with the best protection software running in the 
background. If you know your computer is infected with malware, such as Blaster, Mydoom, 
EyeStyle, or Poison, download and run the Microsoft Windows Malicious Software 
Removal Tool. This utility scans your computer for dangerous malware and attempts to 
remove it immediately.

Microsoft releases an updated version of the Malicious Software Removal Tool on Patch 
Tuesday each month, or more often if security threats are detected before the next Patch 
Tuesday updates. Microsoft recommends that you run the tool regularly, such as every week 
or two, as a supplement to your real-time antivirus software.

CERTIFICATION READY
How is the Microsoft 
Windows Malicious 
Software Removal Tool 
used to remove malware 
from a computer?
Objective 3.3

In this lesson you learned:

•	 Windows 10 comes with many built-in maintenance tools that can help to keep computers 
running at top performance. These tools include Disk Defragmenter, Disk Cleanup, Task 
Scheduler, and the Action Center Maintenance feature.

•	 Disk Defragmenter is a utility that helps improve your computer’s performance by moving 
sectors of data on the hard disk, so that files are stored sequentially. This minimizes the 
movement a hard disk’s arm must make to read all the sectors that make up a file or 
program.

•	 Task Scheduler enables you to schedule and automate a variety of actions, such as starting 
programs, displaying messages, and even sending emails. You create a scheduled task by 
specifying a trigger, which is an event that causes a task to run, and an action to be taken 
when the task runs.

•	 Intruders and some viruses, worms, rootkits, spyware, and adware gain access to a system 
by exploiting security holes in Windows, Internet Explorer, Microsoft Office, or other soft-
ware applications. Therefore, the first step you should take to protect yourself against 
malware is to keep your system up to date with the latest service packs, security patches, 
and other critical fixes.

•	 One of the most challenging problems for computer users and administrators is to pre-
vent viruses, worms, and other types of malware from infecting your computer. To protect 
against malicious software, make sure your system is updated, you are using a firewall 
to limit exposure to malware, and you are using an up-to-date anti-malware software 
package.

S K I L L  S U M M A R Y
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■■ Knowledge Assessment

Multiple Choice

Select the correct answer for each of the following questions.

	 1.	 Which of the following Windows built-in utilities helps delete unnecessary files from a 
computer?
a.	 Disk Defragmenter
b.	 Disk Cleanup
c.	 Task Scheduler
d.	 Registry Editor

	 2.	 Which of the following Windows built-in utilities helps improve a computer’s 
performance by moving sectors of data on the hard disk?
a.	 Disk Defragmenter
b.	 Disk Cleanup
c.	 Task Scheduler
d.	 Registry Editor

	 3.	 In Task Scheduler, which of the following commands creates a task using a wizard?
a.	 Create Task
b.	 Create Scheduled Task
c.	 Create Task Automatically
d.	 Create Basic Task

	 4.	 In Windows Defender, which of the following scans is not an available option?
a.	 Quick
b.	 Full
c.	 Partial
d.	 Custom

	 5.	 Which of the following is not part of the Maintenance section in Action Center?
a.	 Check for solutions to problem reports
b.	 Virus protection
c.	 Backup
d.	 Check for updates

	 6.	 If Action Center detects a maintenance or security issue that needs attention, which of 
the following indicate errors that require immediate attention?
a.	 A red circle with a white X
b.	 A yellow triangle with a black exclamation point
c.	 An orange flashing triangle
d.	 A green box

	 7.	 By default, the Windows 10 Disk Defragmenter utility is set to run how often?
a.	 Every day
b.	 Once a week
c.	 Biweekly
d.	 Once a month

	 8.	 Which of the following programs are always updated on Patch Tuesday?
a.	 Windows Defender
b.	 The Microsoft website
c.	 The Malicious Software Removal Tool
d.	 The Windows Firewall
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	 9.	 Which of the following tools should be used to remove malware such as Mydoom from 
an infected computer?
a.	 Malicious Software Removal Tool
b.	 Windows Firewall
c.	 Windows Defender
d.	 Task Scheduler

	10.	 Which of the following Windows 10 Servicing options receives updates immediately 
after Microsoft makes them publicly available?
a.	 CB
b.	 CBB
c.	 LTSB
d.	 CTSB

Fill in the Blank

Complete the following sentences by writing the correct word or words in the blanks provided.

	 1.	 A hard disk that is _____ has file data spread across many different sectors.

	 2.	 _____ is a utility that removes many kinds of unnecessary files from a computer.

	 3.	 In Task Scheduler, a _____ is an event that causes a task to run.

	 4.	 The _____ is a database in Windows that stores user preferences, file locations, program 
configuration settings, startup information, hardware settings, and more.

	 5.	 Microsoft provides regularly scheduled updates to the Windows operating system via the 
_____ feature.

	 6.	 _____ delivers updates for Microsoft software in addition to the Windows operating 
system.

	 7.	 _____ describes a wide variety of malicious software, such as viruses and worms that 
attack computers.

	 8.	 A _____ is a collection of updates issued from Microsoft after the last version of 
Windows or another Microsoft product was released.

	 9.	 _____ is Microsoft’s free antimalware program.

	10.	 _____ is used to view the computer’s hardware, drivers, and system software.

True / False

Circle T if the statement is true or F if the statement is false.

T F 	1.�	 �Microsoft includes Windows built-in maintenance tools in the Maintenance 
Tools folder in Accessories.

T F 	2.	 �Disk Cleanup can be run on demand, but the utility does not have its own 
scheduling feature.

T F 	3.	 Windows Update provides hotfixes and service packs for Windows computers.

T F 	4.	 Windows Defender protects only against spyware.

T F 	5.	 Windows Firewall is enabled automatically in new installations of Windows 10.
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■■ Business Case Scenarios
Scenario 7-1: Automating Computer Maintenance and Program 
Launching

Maria is a busy freelance writer who uses her computer several hours a day to research and 
write articles for several national magazines and newspapers. Her computer, which runs 
Windows 10 Professional, must be running at peak performance with little downtime. Maria 
has little time to devote to computer maintenance tasks. She also uses Internet Explorer 11  
and Microsoft Word 2016 every day and would like them to start automatically when 
Windows starts. Maria asks you for insight on how to maintain her computer with relatively 
little effort, and how to configure her computer to start programs automatically. Describe 
your recommended solution.

Scenario 7-2: Removing Viruses Safely

You are a support person for a computer consulting company. Rajeem is an independent tax 
consultant who calls you to report that he believes he infected his computer with a virus after 
downloading and installing a tax-related utility from the web. Describe your recommended 
solution.

Scenario 7-3: Gathering System Information

In an effort to troubleshoot an issue on a client computer, you posted a message on an online 
PC support forum. The forum moderator posts a message asking you to list all of the pro-
grams that launch at startup on the affected computer. Describe the easiest way to provide 
this information.

Scenario 7-4: Distributing Windows Updates Across a Network

You support a brokerage firm that employs 20 brokers. Each broker has his own client com-
puter, and the firm has a server running Windows Server. All the client computers are config-
ured identically.

Over the past six months, some Windows updates have caused the computers to stop respond-
ing, leaving the brokers without computers to conduct business. Describe how to ensure that 
the Windows updates that install on client computers will not cause usability issues.
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LESSON8 Understanding 
Backup and Recovery 
Methods

K E Y  T E R M S

backup

File History

restore

restore point

safe mode

Windows 7 File Recovery

Windows 10 File Recovery drive

Windows 10 System Restore

Windows Recovery Environment 
(Windows RE or WinRE)

O B J E C T I V E  D O M A I N  M A T R I X

Skill/Concept Exam Objective Objective Number

Understanding Local, Network, and 
Automated Backup Methods

Understand backup and recovery methods 6.1

Restoring Previous Versions of Files 
and Folders

Understand backup and recovery methods 6.1

Configuring System Recovery Understand backup and recovery methods 6.1

The company management wants to ensure that their users’ data is backed up. The IT 
group has requested that you prepare user training materials to teach employees how 
to back up and restore their data. You need to learn as much as possible about these 
technologies to provide accurate materials and in-depth training.
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■■ Understanding Local, Network, and Automated Backup Methods

A backup is a properly secured copy of files and folders—and sometimes settings—usually 
saved in a compressed format. A backup is created so you can restore the files and settings in 
the event of data loss from a hard disk failure, accidental erasure or disk formatting, or natural 
events. Most users hope they never need backups. When they do need backups, however, they 
need them now! And if they don’t have backups, it’s often too late—their files might be gone 
forever. You must be logged on as an administrator or a member of the Backup Operators 
group to back up a computer or data.

■■ Restoring Previous Versions of Files and Folders

Windows 7 File Recovery, previously named Windows Backup and Restore, is available in 
Windows 10. However, because this feature has been superseded in favor of the new File 
History feature (discussed later), Microsoft does not recommend using both features at 
the same time. File History has been designed to check for an existing Windows Backup 
schedule. If one exists, it disables itself. To use the File History feature, delete the Windows 
Backup schedule if one has been enabled.

File History is designed to only back up personal files. To back up applications and system 
files, consider using Windows 7 backups or System Restore. If these tools do not meet your 
needs for managing your system and application files, the Windows 7 File Recovery tool can 
be used in Windows 10 as an alternative to a third-party backup program.

The following exercise details how to use the Windows 7 File Recovery feature to make a full 
system backup, including a system image.

SCHEDULE A WINDOWS 10 BACKUP TO INCLUDE A SYSTEM IMAGE

GET READY. To schedule a full Windows 10 backup to an external drive, log on with local 
administrative privileges and perform the following steps.

1.  Connect an external drive. This drive must have enough capacity to store the data 
files and a system image.

2.  Right-click Start and choose Control Panel.

CERTIFICATION READY
How are local, network, 
and automated backups 
created?
Objective 6.1

TAKE NOTE*

The best method to 
recover data is backup.

CERTIFICATION READY
Which tool allows you 
to perform a traditional 
Windows backup of a 
drive?
Objective 6.1

THE BOTTOM LINE

With Windows 10, backups are better than ever. In this section, you’ll learn about local, 
manual, and network backups and how to automate them.

THE BOTTOM LINE

Windows 7 File Recovery was designed to protect a computer in the event of a system 
failure by storing data on another medium (hard drive, network folder, or CD/DVD). 
It can also back up a system image of a computer, including applications.
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3.  In the Search Control Panel text box, type File Recovery. From the results, click 
Backup and Restore (Windows 7).

4.  In the Backup and Restore (Windows 7) window (see Figure 8-1), click Set up 
backup.

Figure 8-1

Opening the Control Panel 
Backup and Restore  
(Windows 7)

5.  On the Select where you want to save your backup screen, click the external drive, 
as shown in Figure 8-2.

6.  Click Next.
7.  Click Let Windows choose (recommended) and click Next.

Windows backs up data files saved in libraries, on the desktop, and in default 
Windows folders. It also creates a system image (only one per computer can be 
kept in the backup location), which can be used to restore a computer in case of 
failure.

Another option is to select the Let me choose to select specific libraries and 
folders option and specify whether you want to include a system image as part of 
the backup.

8.  Review the Backup Summary and click Change schedule.

9.  Click Run backup on a schedule (recommended) and click OK to accept the 
default settings.

The backup is now scheduled to run every Sunday at 7:00 p.m.

10.  Click the Save settings and run backup button.
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Create a system repair disk to restore a system image if you do not have your Windows 10 
installation media. Create this disk from within the Windows 7 File Recovery control panel 
by clicking Create a system image.

RESTORE A FILE FROM A WINDOWS 10 BACKUP

GET READY. To restore files from a full Windows 10 backup, log on with local administrative 
privileges and perform the following steps.

1.  Connect the external drive that contains the backed-up files.

2.  On LON-CL1, using Windows 7 File Recovery, in the Restore section, click Restore 
my files.

3.  On the Browse or search your backup for files and folders to restore screen (see 
Figure 8-3), click Browse for folders.

4.  In the Browse the backup for folders or drives dialog box, click Administrator’s 
backup and click Add folder.

5.  Back on the Browse or search your backup for files and folders to restore screen, 
click Next.

6.  When you are prompted to identify where to restore the files, confirm that the In 
the original location option is selected. Click Restore.

7.  In the Copy File dialog box, select the Do this for all conflicts check box and 
click Copy and Replace.

8.  Click Finish.

9.  Close Windows 7 File Recovery.

Figure 8-2

Setting a location for the 
backup
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■■ Configuring System Recovery

A backup or the process of backing up refers to duplicating data so that these duplications 
can be accessed if you need to restore the original files after a data loss event. Backups can be 
used to restore entire systems following a disaster or to restore a small set of files that were 
accidentally deleted or corrupted.

When planning backups, decide where backup files will be stored. If files are stored at var-
ious locations throughout a corporation—including users keeping their files on their local 
computers—it is very difficult to back up all of these files. Therefore, you will most likely 
need to use some form of technology that will store files in a limited number of locations. 
For example, configure the user profiles for file redirection for the desktop and for My 
Documents so that files can be stored on a file server.

Configuring a System Restore

Windows 10 System Restore saves information about drivers, registry settings, programs, 
and system files in the form of restore points for drives with system protection turned on. 
A restore point is a representation of the state of a computer’s system files and settings.

CERTIFICATION READY
What is the simplest 
method to roll back 
settings when an 
application installation 
causes Windows 
instability?
Objective 6.1

THE BOTTOM LINE

There is no good time for a system to fail. But when it happens, you need to be ready. And 
the best way to be ready is to know the available recovery options and what steps to take 
before the problem occurs. However, the best method for system and data recovery is back 
up, back up, and back up some more.

Figure 8-3

Restoring files

Windows 10 System Restore is a computer recovery option that backs up the settings 
and registry, but does not back up personal data.



    Understanding Backup and Recovery Methods  |  247

Use the restore points to return these items to an earlier state without affecting personal 
files. Create restore points prior to performing any major system event, such as installing a 
program or a new device driver.

By default, Windows 10 automatically creates restore points every seven days if no restore 
points have been created during that time period. Windows 10 also allows you to create 
restore points manually at any time.

CONFIGURE A SYSTEM RESTORE

GET READY. To configure a System Restore, log on with local administrative privileges and 
perform the following steps.

1.  Click Start and type System Restore. From the results, click Create a restore 
point.

2.  Click the C: drive, click Configure, and then make sure Turn on system protection 
is selected, as shown in Figure 8-4.

3.  Drag the Max Usage slider to 10%. This adjusts the disk space for system 
protection. When the space fills up, older restore points are deleted to make room 
for new ones.

4.  Click Apply and click OK.

5.  Click Create to create a new restore point.

6.  In the Description text box, type text that describes the name of the restore 
point.

7.  Click Create.

8.  When notified that the restore point was created successfully, click Close.

9.  Click OK to accept the settings and close the System Properties dialog box.

TAKE NOTE*

Another way to access 
System Restore is via 
Control Panel > System 
and Security > System > 
System Protection.

Figure 8-4

Confirming system protection 
is enabled
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In most cases, the most recent restore point should be used, but you can choose from a list 
of restore points if more are available. The best approach is to use the restore point that was 
created just before you started experiencing problems with the computer.

In the following exercise, assume that an application was installed and the system is not func-
tioning normally. To return the computer to a functioning state, use the restore point you just 
created.

PERFORM A SYSTEM RESTORE USING A RESTORE POINT

GET READY. To perform a System Restore using a restore point, log on with local 
administrative privileges and perform the following steps.

1.  Click Start and type System Restore. From the results, click Create a restore 
point.

2.  Click System Restore.

3.  Click Next to start the System Restore Wizard. A System Restore does not affect 
documents, pictures, or other personal data. Recently installed programs and drivers 
may be uninstalled.

4.  Select the desired restore point (see Figure 8-5) and click Scan for affected 
programs. After the scan is complete, Windows 10 lists any programs and drivers 
that will be deleted, as well as programs and drivers that might be restored.

Figure 8-5

Selecting a restore point

5.  Click Close and click Next.
6.  Click Finish.

7.  If you changed your Windows password recently, create a password reset disk by 
clicking Start and then searching for Create a password reset disk.
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8.  Click Yes to begin the System Restore process. Windows restarts the computer, 
restores the files and settings, restores the registry, and then removes temp files 
as part of the restore process.

9.  After the restore process is complete, log back on to the system.

Configuring a Windows 10 File Recovery Drive

With improvements in operating system design, system crashes have been reduced over the 
years. The key word in that last sentence is reduced, not eliminated; therefore, it’s important 
to have the right tools in place to recover from a system failure even when you can’t start the 
Windows 10 system.

A Windows 10 File Recovery drive can help by providing enough of a boot environment 
to get back into the system to begin the troubleshooting process. It can be used to refresh or 
reset a computer, restore a computer to a previously created System Restore point, recover a 
Windows installation from a specific system image file, automatically fix startup problems, 
and perform advanced troubleshooting from the command prompt.

If you create a Windows 10 File Recovery drive on a Windows 10 32-bit system, you cannot 
use it to repair a 64-bit system, and vice versa.

After creating the recovery drive, you need to enable the system to boot from a USB device 
in the basic input/output system (BIOS). When booting into the drive, the Windows logo is 
displayed on a black screen and Windows prompts you to choose your keyboard layout. Next, 
the Choose an Option screen appears, on which you can access the troubleshooting tools and 
start troubleshooting the computer.

CREATE A WINDOWS 10 RECOVERY DRIVE

GET READY. To create a recovery drive, log on with local administrative privileges and 
perform the following steps.

1.  Connect a USB drive to the computer. The drive must hold at least 256 MB and all 
data on the drive must be deleted.

2.  Click Start and type Create recovery drive. From the results, click Create a 
recovery drive.

3.  If you’re prompted to Allow the Recovery Media Creator to make changes to the 
computer, click Yes.

4.  Click Next. Windows 10 searches and displays the available drives.

5.  Click Next to use the drive you inserted.

6.  After reviewing the Everything on the drive will be deleted message, click Create.

7.  Click Finish.

Configuring File History

If a system fails to boot and Windows 10 installation media is not available, create a 
recovery drive that includes a Windows 10 boot environment and troubleshooting tools 
to regain access to the computer.

The File History feature provides options for backing up and recovering access to 
personal files in case of a system problem.
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File History is a feature in Windows 10 that is designed to keep personal files safe. It enables 
users who are not administrators to select an external drive or a folder on the network, and it 
automatically backs up and restores their personal files.

In Windows 10, File History simplifies the process of protecting personal files. It eliminates 
the need to use a more complicated backup process included with previous releases of the 
operating system and introduces a process that is automatic and transparent to the user. It is 
disabled by default, so enable it to take advantage of its features.

File History scans for changes to your personal files. When a change is detected, the file is 
moved to an external location you specify, so you can recover previous versions of files if 
necessary. To optimize performance, File History consults the NTFS change journal to deter-
mine whether a file has changed instead of scanning, opening, and reading directories on the 
volume. By default, File History backs up everything in your libraries, desktop, and favorites. 
The libraries contain items such as My Documents, My Music, My Pictures, and Public doc-
ument folders. File History does not back up your system and application files.

File History does not require administrative privileges to set up and run. The user can decide when 
to turn it on and off, select the external drive to use, and restore files without having to contact an 
administrator. Although File History does not back up files to the cloud as OneDrive does, it can 
be used to back up the OneDrive folder if you are using the OneDrive desktop app for Windows.

The following exercise describes the process to turn on File History, which automatically 
begins scanning and copying all your files to an external USB drive.

ENABLE FILE HISTORY

GET READY. To enable File History, log on with a domain user account and perform the fol-
lowing steps.

1.  Connect an external drive.

2.  Click Start and type File History. From the results, choose Restore your files with 
File History.

3.  Click Turn on (see Figure 8-6).

This option creates a folder named FileHistory on the selected drive and automati-
cally begins copying the files to the drive.

Figure 8-6

Turning on File History
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4.  Close the File History window.

5.  Right-click the desktop and choose New > Text Document.
6.  Type FileHistoryTest for the name and press Enter.

This file will be used in the next exercise.

The File History window also includes the following two settings:

•	 Exclude folders: If you don’t want to save copies of specific folders or libraries, specify 
them here.

•	 Advanced settings: You can identify the folders to exclude, the frequency in which they 
are backed up, and the amount of cache space to set aside for them.

When you click the Advanced settings link, the Advanced Settings window opens (see 
Figure 8-7).

The Versions section includes the following settings:

•	 Save copies of files: The default is set to copy files every hour. Options include every 
10, 15, 20, or 30 minutes; every 3, 6, or 12 hours; or daily.

•	 Keep saved versions: The default is Forever, but you can also set it to keep until space is 
needed; 1, 3, 6, or 9 months; or 1 or 2 years.

•	 Clean up versions: Settings here are used to configure when files and folders older than 
a certain age are deleted. Files and folders/versions that were excluded or removed from 
your libraries are also deleted. Options here include: All but the latest one; Older than 1, 
3, 6, or 9 months; Older than 1 year (default); and Older than 2 years.

If you have a HomeGroup, use the HomeGroup section to recommend the drive to other 
HomeGroup members. Each HomeGroup member can decide whether to accept the recom-
mendation. If they do, their information is automatically backed up to the network share you 
set up.

Figure 8-7

Configuring advanced settings
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Windows 10 enables you to restore files through a familiar File Explorer interface after File 
History has copied all files to an external location.

As files are created and deleted over time, File History keeps track of each version. If you acci-
dentally delete a file that you need, the recovery process is very simple. File History provides 
a new recovery interface that enables you to browse through a virtual view of your files, select 
the file you want, and quickly get back to work.

When restoring files, you can browse your personal libraries, files, and folders; search for a file 
using keywords, file names, and dates; and preview versions of the files.

RESTORE A FILE USING FILE HISTORY

GET READY. To restore a file using File History, log on with the same domain account in 
which you enabled File History in the previous exercise and perform the following steps.

1.  Delete the FileHistoryTest document created in the previous exercise. You will now 
use File History to restore it.

2.  Click Start and type File History. From the results, click Restore your file with 
File History.

3.  From the left pane, click Restore personal files.
4.  Double-click the Desktop icon (see Figure 8-8).

TAKE NOTE*

File History must 
complete its backup of 
your personal files before 
you start this exercise.

Figure 8-8

Browsing for a deleted file

5.  Double-click the FileHistoryTest document.

You can now view its contents. If there are multiple versions of the same file, use 
the left and right buttons to see each version before choosing the file to restore.

6.  Click the Restore to Original Location button (see Figure 8-9).

7.  Confirm that the FileHistoryTest.txt document has been restored and then close the 
Desktop window.
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Performing Recovery Operations Using Windows Recovery

To access WinRE, boot the computer with the Windows 10 installation disk. When the 
Windows setup program starts, click Next. Then, click the Repair your computer option. 
Alternatively, if you are logged into Windows, run the Shutdown /r /o command. To reset the 
PC or access advanced options, click Troubleshoot. If you click Advanced options, the follow-
ing options are available, as shown in Figure 8-10.

Figure 8-9

Clicking the Restore to Original 
Location button

The Windows Recovery Environment (Windows RE or WinRE) can be used to 
repair common causes of unbootable operating systems. It is based on the Windows 
Preinstallation Environment (Windows PE).

Figure 8-10

Accessing Advanced options
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•	 System Restore: Can restore your system to a chosen restore point.
•	 System Image Recovery: Can use a system image file that you create with the recimg.

exe command.
•	 Startup Repair: Reboots into a specific Windows Recovery Environment program 

known as Start Repair and runs a diagnosis and repair routine that seeks to make the PC 
bootable again.

•	 Command Prompt: Allows you to access a command prompt while in safe mode.
•	 Startup Settings: Reboots Windows and provides a list of advanced boot options (see 

Figure 8-11), such as safe mode, change video resolution, start debugging mode or boot 
logging, run in safe mode, disable driver signature checks, disable early launch anti-
malware scans, and disable automatic restart after failure.

•	 Enable debugging: Starts Windows in an advanced troubleshooting mode intended 
for IT professionals and system administrators.

•	 Enable boot logging: Creates the file ntbtlog.txt that lists all the drivers that are 
installed during startup and that might be useful for advanced troubleshooting.

•	 Enable low-resolution video: Starts Windows using the current video driver and 
using low resolution (640 x 480) and refresh rate settings. Use this mode to reset the 
display settings.

•	 Enable Safe Mode: Starts Windows with a minimal set of drivers and services. If you 
make a change to the system and Windows no longer boots, try safe mode.

•	 Enable Safe Mode with Networking: Starts Windows in safe mode and includes the 
network drivers and services needed to access the internet or other computers on the 
network. It should not be used if you suspect malware.

•	 Enable Safe Mode with Command Prompt: Starts Windows in safe mode with a 
command prompt window instead of the usual Windows interface.

•	 Disable driver signature enforcement: Allows drivers containing improper signatures 
to be loaded.

Figure 8-11

Accessing Startup Settings
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•	 Disable early launch anti-malware protection: If problems are caused by an anti-
virus program, stop the early launch anti-malware protection, which allows you to 
update your virus definitions and perform further scans.

•	 Disable automatic restart after failure: Prevents Windows from automatically restart-
ing if an error causes Windows to fail. Choose this option only if Windows is stuck in 
a loop where Windows fails, attempts to restart, and fails again repeatedly.

Safe mode is useful for troubleshooting problems with programs and drivers that might not 
start correctly or that might prevent Windows from starting correctly. If a problem doesn’t 
reappear when you start in safe mode, eliminate the default settings and basic device drivers 
as possible causes. If a recently installed program, device, or driver prevents Windows from 
running correctly, start the computer in safe mode and then remove the program that’s caus-
ing the problem. See Figure 8-12.

While in safe mode, use the Control Panel to access the Device Manager, Event Viewer, 
System Information, command prompt, or Registry Editor.

Devices and drivers that start in safe mode include the following:

•	 Floppy disk drives (internal and USB)
•	 Internal CD-ROM drives (ATA, SCSI)
•	 External CD-ROM drives (USB)
•	 Internal DVD-ROM drives (ATA, SCSI)
•	 External DVD-ROM drives (USB)
•	 Internal hard disk drives (ATA, SATA, SCSI)
•	 External hard disk drives (USB)
•	 Keyboards (USB, PS/2, serial)
•	 Mice (USB, PS/2, serial)
•	 VGA video cards (PCI, AGP)

Figure 8-12

Windows 10 safe mode
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Windows services that start in safe mode include the following:

•	 Windows event log
•	 Plug and Play
•	 Remote procedure call (RPC)
•	 Cryptographic Services
•	 Windows Management Instrumentation (WMI)

Devices and services that start in safe mode with networking include the following:

•	 Network adapters (wired Ethernet and wireless 802.11x)
•	 Dynamic Host Configuration Protocol (DHCP)
•	 DNS
•	 Network connections
•	 TCP/IP NetBIOS Helper
•	 Windows Firewall

S K I L L  S U M M A R Y

In this lesson you learned:

•	 A backup is a properly secured copy of files and folders—and sometimes settings—
usually saved in a compressed format. A backup is created so you can restore the files and 
settings in the event of data loss from a hard disk failure, accidental erasure or disk for-
matting, or natural events.

•	 Windows 7 File Recovery was designed to protect a computer in the event of a system 
failure by storing data on another medium (hard drive, network folder, or CD/DVD). It can 
also back up a system image of a computer, including applications.

•	 Windows 10 System Restore saves information about drivers, registry settings, programs, 
and system files in the form of restore points for drives with system protection turned on. 
A restore point is a representation of the state of a computer’s system files and settings.

•	 A Windows 10 File Recovery drive can help by providing enough of a boot environment to 
get back into the system to begin the troubleshooting process. It can be used to refresh or 
reset a computer, restore a computer to a previously created System Restore point, recover 
a Windows installation from a specific system image file, automatically fix startup prob-
lems, and perform advanced troubleshooting from the command prompt.

•	 File History is a feature in Windows 10 that is designed to keep personal files safe. It 
enables users who are not administrators to select an external drive or a folder on the 
network, and it automatically backs up and restores their personal files.

•	 The Windows Recovery Environment (Windows RE or WinRE) can be used to repair 
common causes of unbootable operating systems. It is based on the Windows 
Preinstallation Environment (Windows PE).
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■■ Knowledge Assessment

Multiple Choice

Select the correct answer for each of the following questions.

	 1.	 Backups of data can be stored on which of the following devices or media? (Choose all 
that apply.)
a.	 CD/DVD
b.	 The same drive on which you are storing the backup
c.	 USB
d.	 Hard drives
e.	 Network

	 2.	 Which program allows you to perform a standard backup of Windows including the 
System image?
a.	 File History
b.	 Windows 10 Restore
c.	 Windows 7 File Recovery
d.	 Windows 10 File Recovery drive

	 3.	 Which of the following is a representation of the state of a computer’s system files and 
settings?
a.	 Restore point
b.	 File History backup
c.	 Windows 10 File Recovery drive
d.	 Windows Recovery Environment

	 4.	 Which of the following options are likely to restore a system in which a System Restore 
was performed from a restore point, but the issue was not resolved and now the com-
puter doesn’t boot? (Choose all that apply.)
a.	 Roll back to another restore point
b.	 Manually delete all files that changed
c.	 Undo the System Restore
d.	 Restart the machine

	 5.	 What can be used to repair common causes of unbootable operating systems?
a.	 Device Manager
b.	 File History
c.	 Windows 7 File Recovery
d.	 Windows Recovery Environment

	 6.	 Which of the following is the Windows Recovery Environment based on?
a.	 Windows 7 Backup
b.	 DOS boot disk
c.	 Windows PE
d.	 Windows installation ISO
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	 7.	 Which of the following recovery boot options should be avoided when the affected 
computer has been infected by a virus?
a.	 Safe Mode
b.	 Safe Mode with Networking
c.	 Repair Your Computer
d.	 Safe Mode with Command Prompt

	 8.	 Which of the following indicates how often Windows 10 automatically creates restore 
points by default?
a.	 Every day
b.	 Once every 3 days
c.	 Once every 7 days
d.	 Once every 30 days

	 9.	 Which Windows 10 feature is used to protect personal files by automatically backing up 
those files?
a.	 File History
b.	 File Recovery
c.	 System Restore
d.	 Windows 7 backup

	10.	 Before installing some new inventory software, which of the following precautions can be 
taken to protect a system so that if something goes wrong, the changes can be undone?
a.	 Install the application in safe mode
b.	 Create an image with the recovery disk
c.	 Perform a Windows 7 backup
d.	 Create a restore point

Fill in the Blank

Complete the following sentences by writing the correct word or words in the blanks provided.

	 1.	 The best method for recovering data is performing regular _____.

	 2.	 When you change your Windows password, you should create a _____ disk.

	 3.	 A _____ is a properly secured copy of files and folders—and sometimes settings—
usually saved in a compressed format.

	 4.	 A user must be logged on as an administrator or a member of the _____ to back up a 
computer or data.

	 5.	 Use _____ to restore an earlier version of a file.

	 6.	 To back up a drive in Windows 10, open the Control Panel and click _____.

	 7.	 If a new device driver has been added and the system is not responding, boot to the 
Advanced Options menu and choose _____.

	 8.	 To find the text file that contains your driver information after enabling boot logging, 
look in the _____ folder for a file named ntbtlog.txt.

	 9.	 A Windows 10 _____ can provide enough of a boot environment to get back into the 
system to begin the troubleshooting process.

	10.	 Use a _____ to roll back a computer system to an earlier point in time.
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True / False

Circle T if the statement is true or F if the statement is false.

T F 	1.	 Windows 10 enables users to choose exactly what to back up to a folder.

T F 	2.	 The traditional backup program that comes with Windows 10 is called 
Windows 10 File Recovery.

T F 	3.	 Windows 10 allows users to control how much hard drive space backups  
can use.

T F 	4.	 File History can be configured to back up the registry files.

T F 	5.	 Users can restore individual data files from a system image backup.

■■ Business Case Scenarios
Scenario 8-1: Scheduling File Backups

You provide technical support for a small environmental consulting firm. Dina, the graphic 
artist, creates a lot of maps for client reports. Her Windows 10 Professional computer auto-
matically backs up files every Sunday starting at 7:00 p.m. Dina reported recently that her 
computer was still backing up files when she arrived for work the last two Monday mornings. 
What can you do to help ensure that Dina’s files are backed up by Monday morning?

Scenario 8-2: Installing from an Image

The owner of the consulting firm approved funds to purchase a new computer for Dina 
because an upgrade to her main mapping software requires more memory than her current 
computer’s motherboard can handle. The new computer will be the same make and model 
but will have more memory and will have a much larger hard disk. You also ordered a 1 TB 
external USB drive for backups. When the new computer arrives, describe how to quickly get 
it up and running for Dina.

Scenario 8-3: Creating a System Repair Disc

Stanley works for your organization from his home office on a company-owned computer. He 
called your cell phone while you were at a restaurant having lunch. He said his computer has 
been having all kinds of problems lately and that it takes a long time for Windows to start. 
You suspect his Windows system files have become corrupted. Describe how to recover his 
system.

Scenario 8-4: Resolving a Driver Problem Using Recovery Boot Options

You recently installed a new video adapter in Jeffrey’s desktop computer using the driver sup-
plied on the CD in the adapter packaging. When Windows starts, the words on the screen are 
unreadable. Describe your recommended solution.
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Exam Objective Objective Number Lesson Number

Understanding Operating System Configurations

Configure Control Panel options 1.1 2

Configure desktop settings 1.2 2, 7

Configure native applications and tools 1.3 3, 4

Configure mobility settings 1.4 3

Configure and use management tools 1.5 3

Installing and Upgrading Client Systems

Identify Windows operating system editions 2.1 1

Identify upgrade paths 2.2 1

Understand installation types 2.3 1

Understand operating system architecture 2.4 1

Managing Applications

Configure applications 3.1 3, 4

Configure User Account Control (UAC) 3.2 2

Configure antivirus settings 3.3 7

Understand services 3.4 4

Managing Files and Folders

Understand file systems 4.1 4

Understand file and print sharing 4.2 5, 6

Understand encryption 4.3 4

Understand libraries 4.4 2, 3

Managing Devices

Connect devices 5.1 5

Understand storage 5.2 4, 5, 7

Understand printing devices 5.3 5

Understand system devices 5.4 5

Understanding Operating System Maintenance

Understand backup and recovery methods 6.1 5, 8

Understand maintenance tools 6.2 7

Configure updates 6.3 7
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32-bit Windows, 8–9
64-bit Windows, 8–9
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Accelerators add-on, 78
access (remote access). See remote access
accessibility options, configuring, 50–53
accessing

OneDrive, 164–165
System Restore, 247
Windows services, 133

accessory programs, 86
Snipping tool, 87–89
Windows Media Player, 90–93

Accounts settings, 31
Action Center, 221–222
actions (Task Scheduler), 215
activating Windows 10, 14
Active Directory, 132
ActiveX controls, 72
ActiveX Filtering, 73
Add cmdlets, 113
add-ons (Internet Explorer), 78–80
Address toolbar, 38
Administrative Tools folder, 34
administrative-level permissions, 25
Administrator accounts, 25
advanced permissions, 198–199
advanced shares, 192

advanced sharing, 194
combining NTFS and share permissions, 203
configuring, 193–196
effective NTFS permissions, 199–202
file system permissions, 197–199
mapping drives, 203–205
Public folders, 193
viewing effective permissions, 202–203

Allowed Apps page, 234
annotating images, Snipping Tool, 89
application data, 41
applications

business case scenarios, 162
configuring

desktop application coexistence, 125–126
desktop apps, 123–124
Program Compatibility Troubleshooter, 126–127
Programs and Features, 124–125
Startup options, 127–128

knowledge assessment, 159–161
managing with Task Manager, 141–144

skill summary, 159
Windows Store Apps

configuring Windows Store, 128–130
Group Policy, 132
implementing, 130–131

AppLocker, 5–6
apps. See applications
Assigned Access 8.1, 5–6
audio devices, 174
automated backups, 243
Automatic (Delayed Start) startup (Services), 134
Automatic startup (Services), 134

B
backup methods, 243

business case scenarios, 259
configuring system recovery

File History, 249–253
System Restore, 246–249
Windows 10 File Recovery drive, 249
Windows Recovery Environment (WinRE), 253–256

knowledge assessment, 257–259
skill summary, 256
Windows 7 File Recovery, 243–246

Balanced power plans, 48
basic disks, 146
basic shares, 192

advanced sharing, 194
basic sharing, 193
combining NTFS and share permissions, 203
configuring, 193–196
effective NTFS permissions, 199–202
file system permissions, 197–199
mapping drives, 203–205
Public folders, 193
viewing effective permissions, 202–203

BitLocker, 5–6, 157–159
BranchCache, 5–6
burning music CDs, 93
business case scenarios

applications, 162
backup methods, 259
configuring Hyper-V, 67–68
configuring Windows 10, 67–68
device management, 186
encryption, files and folders, 162
file sharing, 209–210
printer sharing, 209–210
remote access, 121
restoring files, 259

Index



262  |  Index

business case scenarios (Continued )
storage, 162
Windows 10, 23, 241
Windows Store Apps, 162

Business Store, 5–6

C
Calculator, 86
CB (Current Branch) servicing, 230
CBB (Current Branch for Business) servicing, 230–231
certificates, configuring, 81
checkpoints, 64
CIM (Common Information Model), 113
clean installation, 10, 12–14
CLI (command-line interface), 3
Client Hyper-V, 5–6
cloud, 11
cloud storage, 164–166
cmdlets, 113
COM (Component Object Model), 113
Command Prompt, 86
command-line interface (CLI), 3
command-line options (USMT), 17–18
Common Information Model (CIM), 113
compatibility mode, configuring, 80–81
Compatibility View, 80–81
Component Object Model (COM), 113
Component Services administrative tool, 34
compression, files and folders, 154–159
Computer Management administrative tool, 34
Computer Management window, 108
Computer Management window (MMC), 108
configuring

applications
desktop application coexistence, 125–126
desktop apps, 123–124
Program Compatibility Troubleshooter, 126–127
Programs and Features, 124–125
Startup options, 127–128

Cortana, 85–86
file sharing, 193–196
file system permissions, 197–199
homegroups, 189–192
Hyper-V, 54–55

business case scenarios, 67–68
checkpoints, 64
knowledge assessment, 65–67
skill summary, 65
virtual disks, 62–64
virtual machines, 56–59
virtual switches, 60–62

Internet Explorer
add-ons, 78–80
compatibility mode, 80–81
cookies and privacy settings, 70–74
dynamic security and protected mode, 76–77
Favorites, 82
LAN settings, 82–83
security zones, 74–76
SmartScreen Filter and phishing, 78

SSL and certificates, 81
Microsoft Edge, 84–85
offline files, 95–96
printer sharing, 205–206
Public folders, 193
remote access

Remote Assistance, 104–106
Remote Desktop, 100–104
Remote Management settings, 106–108

Services, 137–138
system recovery, 246–256

File History, 249–253
System Restore, 246–249
Windows 10 File Recovery drive, 249
Windows Recovery Environment (WinRE), 253–256

updates, 225
Insider Preview, 229–230
servicing options, 230–231
update history and rolling back updates, 229
Windows Update options, 226–229

Windows 10
accessibility options, 50–53
business case scenarios, 67–68
Control Panel, 33–35
Date and Time, 37
Desktop and Taskbar settings, 37–40
display settings, 45–47
File Explorer, 40–41
folder locations, 43–44
knowledge assessment, 65–67
libraries, 44–45
power settings, 47–50
Settings, 31–33
shortcuts, 53–54
skill summary, 65
Start menu, 40
system settings, 35–37
user profiles, 41–43

Windows Store, 128–130
Continuum, 5–6
Control Panel, configuring Windows 10, 33–35
cookies, 70–74
Cortana, 5–6, 32, 85–86
Create Basic Task Wizard, 216
Create Task command, 216
Create Task dialog box, 217
Credential Guard, 5–6
critical updates, 226
cumulative patch, 226
Current Branch (CB) servicing, 230
Current Branch for Business, 5–6
Current Branch for Business (CBB) servicing, 230–231
Custom scans, 236
Customize Settings page, 234

D
data synchronization, 93

offline files, 95–96
resolving sync conflicts, 97–98
scheduling for offline files, 96
synchronizing PC settings, 94
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Date and Time, configuring Windows 10, 37
deleting

ActiveX controls, 79
cookies, 71

Dependencies tab (Services, Properties dialog box), 136
desktop, 29
desktop application coexistence, 125–126
desktop apps, configuring, 123–124
desktop PCs, 4
Desktop settings, configuring Windows 10, 37–40
Desktop toolbar, 38
Detail tab, devices, 179
device drivers, 10, 174–183

Device Manager, 177–180
Devices and Printers folder, 176–177
troubleshooting problems, 180–183

Device Guard, 5–6
device management, 163

business case scenarios, 186
cloud storage, 164–166
knowledge assessment, 184–186
printing devices, 166–174

internet printing, 173–174
local printers, 166–169
network printers, 170
print queues, 172–173
printing documents, 170–172

skills summary, 183–184
system devices and device drivers, 174

Device Manager, 177–180
Devices and Printers folder, 176–177
troubleshooting problems, 180–183

Device settings, 31
Device Settings tab, Properties dialog boxes (printers), 175
Devices and Printers window, 167
Devices by connection mode (Device Manager), 178
Devices by type mode (Device Manager), 178
differencing virtual disks, 62
DirectAccess, 5–6
Disabled startup (Services), 134
disabling add-ons, 80
Disk Cleanup, 214–215
Disk Defragmenter, 212–214
Disk Management snap-in, 148
disks, storage, 146–147
display settings, configuring, 45–47
Document menu (print queue window), 173
documents, printing, 170–172
Documents library, 44
domain networks, 188
domains, 36
drive mapping, 203–205
Driver tab, devices, 178
drivers, 9–10
drives, storage, 146–147
dynamic disks, 146
Dynamic Memory, 57
dynamic security, 76–77

E
Ease of Access, 87

Ease of Access Center, 51
Ease of Access settings, 31
editions, Windows 10, 3–7
effective NTFS permissions, 199–202
EFS (Encrypting File System), 5, 7, 154–157
elevated permissions, 25
EMIE (Enterprise Mode Internet Explorer), 5, 7
enabling

File History, 250–251
protected mode, 77

Encrypting File System (EFS), 5, 7, 154–157
encryption key, 154
encryption, files and folders, 154

business case scenarios, 162
knowledge assessments, 159–161
skill summary, 159

Enterprise Mode Internet Explorer (EMIE), 5, 7
eSATA (External Serial Advanced Technology 

Attachment), 144
Event Viewer administrative tool, 34
exFAT (Extended File Allocation Table), 148
explicit permissions, 199
Extended File Allocation Table (exFAT), 148
external devices, 174
External Serial Advanced Technology Attachment 

(eSATA), 144
external virtual switches, 60

F
FAT, 147
FAT32, 147
Favorites, 82
features, Windows 10, 4–7
fetching, 164
File Explorer, 40–41, 87
File History, configuring, 249–253
file sharing, 188

business case scenarios, 209–210
homegroups, 189–192
knowledge assessment, 207–209
public, basic, and advanced shares, 192–205

combining NTFS and share permissions, 203
configuring, 193–196
effective NTFS permissions, 199–202
file system permissions, 197–199
mapping drives, 203–205
Public folders, 193
viewing effective permissions, 202–203

skill summary, 207
file system permissions, 197–199
file systems, 147–148
files

compression, 154-159
encryption, 159-161
file sharing. See file sharing
printing to, 171
recovering from OneDrive, 165
restoring, 243–246
uploading to OneDrive, 165
Windows 7 File Recovery, 243–246

Firewire (IEEE 1394), 145–146
folder locations, configuring, 43–44
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folders
compression, 154-159
encryption, 159-161

form factors, 4
fragmented information, 212
Full Control permission, 198
Full scans, 236

G
General tab

devices, 178
printers, 175
Services, Properties dialog box, 134

Generation 1 virtual machines, 56
Generation 2 virtual machines, 57
Get cmdlets, 113
GPOs (Group Policy Objects), 132
graphical user interface (GUI), 3
Group Policy, 132
Group Policy management, 5, 7
Group Policy Objects (GPOs), 132
Guest accounts, 25
GUI (graphical user interface), 3

H
hardware interrupts (IRQ), 10
hibernate mode, 47
High Performance power plans, 48
High Touch Installation (HTI), 11
hives (Windows registry), 224
HomeGroup, 189
homegroups, 189–192

creating, 190
joining, 191
removing a computer from, 192
specifying shared files and folders, 192

hosts, 54
hotfix, 226
HTI (High Touch Installation), 11
hybrid computers, 4
hybrid mode, 48
Hyper-V, configuring, 54-55

business case scenarios, 67–68
checkpoints, 64
knowledge assessment, 65–67
skill summary, 65
virtual disks, 62–64
virtual machines, 56–59
virtual switches, 60–62

Hyper-V Manager, 55
Hyper-V Virtual Machine Connection, 55
hypervisor, 54

I
IA-32 platform, 8
IEEE 1394 (Firewire), 145–146
implementing Windows Store Apps, 130–131
inherited permissions, 199
Initialize Disk dialog box, 149

InPrivate Browsing, 72
input devices, 174
Insider Preview, 229–230
installation

network applications, 132
Windows 10, 11

clean installation, 12–14
migrating to, 16–20
upgrading to, 15–16

Installed Updates page, 229
Integrated Scripting Environment (ISE), 114
internal virtual switches, 60
Internet Explorer, configuring, 70

add-ons, 78–80
compatibility mode, 80–81
cookies and privacy settings, 70–74
dynamic security and protected mode, 76–77
Favorites, 82
LAN settings, 82–83
security zones, 74–76
SmartScreen Filter and phishing, 78
SSL and certificates, 81

internet printing, 173–174
internet Small Computer System Interface (iSCSI), 146
Internet zone, 74
iSCSI (internet Small Computer System Interface), 146
iSCSI Initiator administrative tool, 34
ISE (Integrated Scripting Environment), 114
isochronous data transfer, 146

J
joining

domains, 5, 7
homegroups, 191

Jump list, 38

K
kernel mode, 7–8
knowledge assessments

applications, 159–161
backup methods, 257–259
configuring Hyper-V, 65–67
configuring Windows 10, 65–67
device management, 184–186
encryption, files and folders, 159–161
file sharing, 207–209
printer sharing, 207–209
remote access, 118–120
storage, 159–161
system recovery, 257–259
Windows 10, 21–23, 239–240
Windows Store Apps, 159–161

L
LAN settings, 82–83
laptops, 4
libraries, configuring, 44–45
Links toolbar, 38
List Folder Contents permission, 198
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Lite Touch Installation (LTI), 12
live previews, 38
live tiles, 31
LoadState.exe command-line tool, 17
local backups, 243
Local intranet zone, 74
local printers, 166–169
Local Security Policy administrative tool, 34
Local Service accounts, 135
Local System accounts, 135
Log On tab (Services, Properties dialog box), 135
Long-Term Servicing Branch, 5, 7
Long-Term Servicing Branch (LTSB) servicing, 230–231
LTI (Lite Touch Installation), 12
LTSB (Long-Term Servicing Branch) servicing, 230–231

M
maintenance tools

Action Center, 221–222
Disk Cleanup, 214–215
Disk Defragmenter, 212–214
System Information, 222–223
Task Scheduler, 215–221

malicious software, 231
Malicious Software Removal Tool, 238
malware, 231
management

devices, 163
business case scenarios, 186
cloud storage, 164–166
knowledge assessment, 184–186
printing devices, 166–174
skills summary, 183–184
system devices and device drivers, 174–183

updates, 225–231
Manual startup (Services), 134
mapping drives, 203–205
Math Input Panel, 86
media files, play back, 91
memory architecture, 7–9
Microsoft accounts, 129
Microsoft Edge, configuring, 84–85
Microsoft Management Console (MMC), 33, 108–111
migrating to Windows 10, 16–20
mirrored volume (dynamic disks), 146, 153
MMC (Microsoft Management Console), 33, 108–111
mobile access, data synchronization, 93

offline files, 95–96
resolving sync conflicts, 97–98
scheduling for offline files, 96
synchronizing PC settings, 94

Modify permission, 198
MSConfig (System Configuration utility), 138–141
multi-booting, 147
music CDs, burning, 93
Music library, 44

N
NAT (Network Address Translation), 82–83

Network & Internet settings, 31
Network Address Translation (NAT), 82–83
network applications, 132
network backups, 243
Network discovery, 188
network location, 188
network printers, 170
Network Service accounts, 135
New cmdlets, 113
New Trigger dialog box, 220
Notepad, 86
NTFS permissions, 197–199, 203

O
ODBC Data Sources administrative tool, 34
offline files

configuring, 95–96
scheduling, 96

one-to-one remoting, 117
one-way sync, 95
OneDrive

managing files and folders, 164–166
recovering files, 165–166
uploading files to, 165

OneDrive console, 165
OneDrive for Business, 164
OneDrive for Recycle Bin, 165
optional updates, 226
out-of-band patches, 225

P
Paint, 86
partitions, disks, 146
Patch Tuesday, 225
PC settings, synchronizing, 94
Performance Monitor administrative tool, 34
permissions

effective NTFS permissions, 199–202
elevated, 25
NTFS, 197–199

Permissions dialog box, 196
Personalization settings, 31
Personalization window, 39
phishing, 78
Pictures library, 44
platforms, Windows 10, 8
play back, media files, 91
playlists, 92–93
plug-and-play (PnP) technology, 174
PnP (plug-and-play) technology, 174
Pop-Up Blocker, 72
power plans, 48
Power Saver power plans, 48
power settings, configuring, 47–50
PowerShell Remoting, 116
print jobs, 172
Print Management administrative tool, 34
Print page, Settings section, 171
print queues, 172–173



266  |  Index

print spoolers, 172
Printer menu (print queue window), 173
printer permissions, 206
printer sharing, 188, 205–206

business case scenarios, 209–210
homegroups, 189–192
knowledge assessment, 207–209
skill summary, 207

printing
.PRN files, 171–172
documents, 170–172
to files, 171

printing devices, 166–174
internet printing, 173–174
local printers, 166–169
network printers, 170
print queues, 172–173
printing documents, 170–172

Privacy settings, 31, 70–74
Private catalog, 5, 7
private networks, 188
private virtual switches, 60
.PRN files, printing, 171–172
processes, managing with Task Manager, 141–144
processors, 7–9
Program Compatibility Troubleshooter, 126
Programs and Features, configuring, 124–125
Properties dialog boxes (printers), 175–176
protected mode, 76–77
proxy servers, 82
Public folders, 193
public networks, 188
public shares, 192

advanced sharing, 194
basic sharing, 193
combining NTFS and share permissions, 203
configuring, 193–196
effective NTFS permissions, 199–202
file system permissions, 197–199
mapping drives, 203–205
Public folders, 193
viewing effective permissions, 202–203

Q
quarantined items, 236
queues (printers), 172–173
Quick scans, 236

R
RAID-5 volume (dynamic disks), 146
RDC (Remote Desktop Connection), 100
RDP (Remote Desktop Protocol), 100
RDS (Remote Desktop Services), 100
Read & Execute permission, 197
Read permission, 197
real-time protection, 235
recommended updates, 226
recovering files

OneDrive, 165–166
Windows 7 File Recovery, 243–246

Recovery tab (Services, Properties dialog box), 136
Recycle Bin, 29
ReFS (Resilient File System), 147
remote access, 100–117

business case scenarios, 121
configuring

Remote Assistance, 104–106
Remote Desktop, 100–104
Remote Management settings, 106–108

knowledge assessment, 118–120
Microsoft Management Console (MMC), 108–111
remote Windows PowerShell, 116–117
skill summary, 118
Windows Remote Management (WinRM), 111–112
WinRS.exe, 112

Remote Assistance, configuring, 104–106
Remote Desktop, 6–7, 100–104
Remote Desktop Connection (RDC), 100
Remote Desktop Protocol (RDP), 100
Remote Desktop Services (RDS), 100
Remote Management settings, configuring, 106–108
RemoteApp, 6–7
Remove cmdlets, 113
removing local printers, 169
requirements, Windows 10, 10–11
Resilient File System (ReFS), 147
resolution, 47
resolving sync conflicts, 97–98
Resources by connection mode (Device Manager), 178
Resources by type mode (Device Manager), 178
Resources tab, devices, 179
restore points, 246, 248–249
restoring files, 243

business case scenarios, 259
knowledge assessment, 257–259
skills summary, 256
Windows 10 Backup, 245–246

Restricted sites zone, 75
rolling back updates, 229
Run, 86

S
safe mode, 255
scan options, 236
ScanState.exe command-line tool, 17
scheduling

offline files, 96
Windows 10 Backup, 243–245

screenshots, 87
Search Providers add-on, 78
Secure Sockets Layer (SSL), 81
security, 231–238

updates, 226
Windows Defender, 235–238
Windows Firewall, 232–234

security zones, configuring, 74–76
selecting a printer, 168
service packs, 226
Services, 133–138
Services administrative tool, 34
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servicing options, 230–231
Set cmdlets, 113
Settings section (Print page), 171
Settings, configuring Windows 10, 31–33
share permissions, 196, 203
shared folders, 193
sharing printers, 169
shortcuts, 53–54
signature detection, 235
simple volume (dynamic disks), 146
skill summary

applications, 159
backup methods, 256
configuring Hyper-V, 65
configuring Windows 10, 65
device management, 183–184
encryption, files and folders, 159
file sharing, 207
printer sharing, 207
remote access, 118
storage, 159
system recovery, 256
Windows 10, 20, 238
Windows Store Apps, 159

sleep mode, 47
sleep settings, 47
smartphones, 4
SmartScreen Filter, 78
snap-ins, 108
Snipping tool, 87–89
software programs (apps). See applications
solid state drives (SSDs), 212
Sound dialog box, 39
Sound Recorder, 86
spanned volume (dynamic disks), 146
spyware, 232
SSDs (solid state drives), 212
SSL (Secure Sockets Layer), 81
Standard user accounts, 25
Start cmdlets, 113
Start menu, configuring Windows 10, 40
Startup options, configuring, 127–128
startup RAM, 57
Startup Settings, 254
startup types, Services, 134–138
Sticky Notes, 87
storage, 144–153

business case scenarios, 162
cloud storage, 164–166
Disk Management snap-in, 148
disks and drives, 146–147
file systems, 147–148
knowledge assessment, 159–161
skill summary, 159
storage devices, 144–146

storage devices, 144–146
striped volume (dynamic disks), 146, 152
Sync Center, 87
sync conflicts, resolving, 97–98

synchronization of data, 93–98
offline files, 95–96
resolving sync conflicts, 97–98
scheduling for offline files, 96
synchronizing PC settings, 94

System Configuration administrative tool, 34
System Configuration utility (MSConfig), 138–141
system devices, management, 174

Device Manager, 177–180
Devices and Printers folder, 176–177
troubleshooting problems, 180–183

System Information, 222–223
System Information administrative tool, 34
system recovery

business case scenarios, 259
configuring

File History, 249–253
System Restore, 246–249
Windows 10 File Recovery drive, 249
Windows Recovery Environment (WinRE), 253–256

knowledge assessment, 257–259
skills summary, 256

system requirements, Windows 10, 10–11
System Restore, configuring, 246–249
System settings, 31, 35–37

T
Tablet PC, 87
tablets, 4
Task Manager, 141–144
Task Scheduler, 215–221
Task Scheduler administrative tool, 34
Taskbar settings, configuring Windows 10, 37–40
text user interface (TUI), 3
Time & Language settings, 31
Toolbars and Extensions add-on, 78
Tracking Protection, 72
Tracking Protection add-on, 78
triggers, 215
Trojan horse, 232
Trusted sites zone, 75
TUI (text user interface), 3
two-way sync, 95

U
UAC (User Account Control), 27–29
UI (user interfaces), 3
Universal Serial Bus (USB), 145
Universal Windows Platform (UWP), 128
Update & Security settings, 31
updates

configuring, 225
Insider Preview, 229–230
servicing options, 230–231
update history and rolling back updates, 229
Windows Update options, 226–229

device drivers, 179–180
managing, 225–231
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upgrade installation, 10
upgrading to Windows 10, 15–16
uploading files, OneDrive, 165
USB (Universal Serial Bus), 145
User Account Control (UAC), 27–29
user accounts, 25–27
user data, 42
User Experience control and lockdown, 6–7
user interfaces (UI), 3
user mode, 7–8
user profiles, configuring, 41–43
user registry, 41
user state, 41
User State Migration Tool (USMT), 17–19
USMT (User State Migration Tool), 17–19
UsmtUtils.exe command-line tool, 17
UWP (Universal Windows Platform), 128

V
versions, Windows 10, 4–7
video devices, 174
Videos library, 44
View menu (print queue window), 173
viewing

add-ons, 79
Compatibility View, 80–81
privacy settings, 71–73

Virtual desktops, 6–7
virtual disks, 62–64
virtual machine monitor (VMM), 54
virtual machines (VMs), configuring, 56–59
virtual switches, 60–62
viruses, 231
VMM (virtual machine monitor), 54
VMs (virtual machines), configuring, 56–59
volumes, dynamic disks, 146–147

W
Web Services for Management, 111
Windows 10, 2

activating, 14
business case scenarios, 23
configuring, 29

accessibility options, 50–53
business case scenarios, 67–68
Control Panel, 33–35
Date and Time, 37
Desktop and Taskbar settings, 37–40
display settings, 45–47
File Explorer, 40–41
folder locations, 43–44
knowledge assessment, 65–67
libraries, 44–45
power settings, 47–50
Settings, 31–33
shortcuts, 53–54
skill summary, 65
Start menu, 40
system settings, 35–37

user profiles, 41–43
editions, 4–5
features, 5–7
installation, 11

clean installation, 12–14
migrating to, 16–20
upgrading to, 15–16

knowledge assessment, 21–23
maintenance tools

Action Center, 221–222
business case scenarios, 241
Disk Cleanup, 214–215
Disk Defragmenter, 212–214
knowledge assessment, 239–240
skill summary, 238
System Information, 222–223
Task Scheduler, 215–221

platforms, 8
security, 231

business case scenarios, 241
knowledge assessment, 239–240
skill summary, 238
Windows Defender, 235–238
Windows Firewall, 232–234

skill summary, 20
system requirements, 10–11
updates

business case scenarios, 241
configuring Windows Update  

options, 226–229
Insider Preview, 229–230
knowledge assessment, 239–240
servicing options, 230–231
skill summary, 238
update history and rolling back updates, 229

versions, 4–5
Windows registry, 223–225

Windows 10 Anniversary Update, 226
Windows 10 Backup

restoring files, 245–246
scheduling, 243–245

Windows 10 Education, 5
Windows 10 Enterprise, 5
Windows 10 File Recovery drive, configuring, 249
Windows 10 Home, 4
Windows 10 Media Creation tool, 12
Windows 10 Pro, 4
Windows 7, 2
Windows 7 File Recovery, 243–246
Windows Defender, 235–238
Windows Defender Settings page, 237
Windows Deployment Services, 12
Windows Firewall, 232–234
Windows Firewall page, 233
Windows Hello, 6–7
Windows Insider program, 229
Windows Live ID, 129
Windows Management Instrumentation (WMI), 113
Windows Media Player, 87, 90–93
Windows Media Player 12, 90
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Windows Memory Diagnostic administrative tool, 34
Windows Mobility Center, 87, 98–100
Windows operating systems, 1–2

business case scenarios, 23
determining appropriate editions per device type, 3–7
drivers, 9–10
knowledge assessment, 21–23
processors and memory architecture, 7–9
skill summary, 20
user interfaces, 3
Windows 10. See Windows 10

Windows PowerShell, 87, 112–116
Windows Recovery Environment (WinRE), 253–256
Windows registry, 223–225
Windows Remote Management (WinRM), 111–112
Windows Spotlight, 6–7
Windows Store Apps

business case scenarios, 162
configuring Windows Store, 128–130
Group Policy, 132
implementing, 130–131

knowledge assessment, 159–161
skill summary, 159

Windows to Go, 6–7
Windows Update for Business, 6–7
Windows Update, configuring options, 226–229
Windows Vista, 2
Windows XP, 2
WinRE (Windows Recovery Environment), 253–256
WinRM (Windows Remote Management), 111–112
WinRS.exe, 112
WMI (Windows Management Instrumentation), 113
WordPad, 87
workgroups, 36
worms, 232
Write permission, 198

X
X86-64 platform, 8

Z
Zero Touch Installation (ZTI), 12
ZTI (Zero Touch Installation), 12
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